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Chapter 1: Setup
Geocart 3 runs on most modern Macintosh and Windows computers. The Geocart Installation Disk contains 
installers for both platforms. You may run Geocart on your platform of choice; your license key works for either. 
You must install from an account with administrator privileges.

Macintosh Information

Windows Information

Licensing Geocart

Technical Support

Macintosh Information 

Necessary Equipment

Geocart is designed to run on PowerPC G4, PowerPC G5, or Intel Macintosh computers, with a minimum of 
512 MB of RAM. 1 GB of memory is recommended for efficient performance, and large maps may require more.

Geocart has not been tested on PowerPC G3 Macintosh.

Geocart is compatible with the following Macintosh operating systems:

•	 Mac OS X 10.4 (Tiger) 

•	 Mac OS X 10.5 (Leopard)

•	 Mac OS X 10.6 (Snow Leopard).

Geocart should also run, but is not officially supported, on Mac OS X Server 10.4 and later server versions. 

Installing Geocart on Macintosh

To run Geocart 3 on your computer, you need to:

1.	 Identify your operating system version.

2.	 Install the Geocart 3 application.

3.	 Install the Required Databases.

Your Installation Disk also includes a number of supplemental databases that you can install at your discretion.

If you have a previous version of Geocart 3 on your computer, it will be updated by the installation process. If you are 
running Geocart 2, the installation process will not affect your old version of Geocart.

The Geocart 3 application for Macintosh comes in two versions: one intended for OS X 10.4 (Tiger), and another for 
OS X 10.5 (Leopard) and later. The 10.4 version of Geocart should work on newer versions of OS X; the 10.5 version 
is preferable (particularly for PowerPC G5 and Intel Macs), as it is faster and can use more than 3 GB of RAM.

Identifying your operating system version

•	 On the Apple menu, click About This Mac.
Result: The version number will be shown under the Apple logo and Mac OS X text.
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Installing the new Geocart 3 application on Macintosh

1.	 Insert the Geocart Installation Disk into your Computer. If a window showing the contents of the DVD 
does not appear, double-click the Geocart DVD icon on your desktop. For Geocart to work correctly, you 
must install both the application and the required databases.

2.	 View the contents of the Installation Disk.

3.	 Double-click the Application Installers folder.

4.	 Double-click Mac OS X 10.4 or Mac OS X 10.5 as appropriate for your computer.

5.	 Follow the prompts to install the application on your system.

Installing the Required Databases on Macintosh

1.	 Open the Geocart Installation Disk.

2.	 Double-click the Required Databases folder.

3.	 Double-click the Macintosh folder. 

4.	 Double-click the file Geocart 3 Databases.pkg.

5.	 Follow the prompts to install the databases onto your system.

Once the application and databases installation is complete, you can start Geocart. 

If this is the first time you have installed Geocart, the icon will be in the Applications folder of your system disk. 
On start up, you will be prompted to enter your license key (refer to Licensing Geocart for more information).

If you had a previous version of Geocart 3 on your computer, it will have been updated in-place by the installation 
process. If you are unable to see the Geocart icon, click the spotlight icon in the upper right corner of the menu bar to 
search for the Geocart application.

Installing the Sample Documents on Macintosh

Geocart 3 comes with sample documents and images for use in following the examples in Chapter 5: Examples as 
well as for general use. The installer for this material is contained in the Sample Documents directory on the 
Installation Disk.

To install the sample documents:

1.	 Insert the Installation Disk.

2.	 Double-click the Sample Documents folder.

3.	 Double-click the Macintosh folder.

4.	 Double-click the file Geocart 3 Sample Documents.pkg.

5.	 Follow the prompts to install the sample documents onto your system.

Once the installation is complete, you will be able to access the sample documents from the Help menu, Sample 
Documents command.

Installing Supplemental Databases on Macintosh

Geocart 3 comes with many optional geographic databases. They consume many gigabytes of disk space and are 
therefore not installed by default. The databases are contained in the Supplemental Databases directory on 
the Installation Disk. The professional edition of Geocart includes an Extra Databases disk with more databases. You 
can install any of the supplemental databases during the initial installation, or at any later time. 



 Setup 1.3

To install supplemental databases:

1.	 Insert either the Installation Disk or the Extra Databases disk.

2.	 Double-click the Supplemental Databases folder.
Result: Folders for each installable data set are displayed (for example, World Databank II).

3.	 Double-click on a data set folder to display its contents. Each data set contains a Read Me.txt file 
that describes the databases contained in the data set (for example, World Databank II.txt), and a 
Mac Installer file (for example, Double click me.command).

4.	 Double-click the .command file.

5.	 In the text-based installer window, select whether you want the databases to be accessible only to you, or to 
everyone who uses your computer.

Note: The database files are compressed, and some data sets are over one gigabyte in size. The installation may take 
several minutes to complete.

Uninstalling Geocart on Macintosh

In addition to throwing away the Geocart application that was installed into your Applications folder, you may 
want to find and remove the additional support files (such as the sample documents), that were installed.

To delete additional files available to all users:

1.	 On the top level of your system disk, double-click Library.

2.	 Double-click Application Support to open it.

If you want to expunge Geocart from the computer:

3.	 Delete the Mapthematics folder.

Or, if you want to delete specific database files:

3.	 Double-click Mapthematics to open it.

4.	 Double-click Databases to open it.

5.	 Delete the files you no longer need.

To delete additional files available only to you:

1.	 On the top level of your system disk, double-click the Users folder.

2.	 Double-click your account folder to open your application data folders.

3.	 Double-click Library to open it.

4.	 Double-click Application Support to open it.

5.	 Double-click Mapthematics to open it.

6.	 Double-click Databases to open it.

7.	 Delete the files you no longer need.
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Windows Information

Necessary Equipment

Geocart is designed to run on a Pentium II, AMD K6, or AMD Athlon CPU or newer. 

The minimum RAM requirement is 512 MB. However, at least 1 GB of memory is recommended for efficient 
performance, and large maps may require greater than 1 GB.

Geocart is compatible with the following Windows operating systems:

•	 Windows XP

•	 Windows Vista

•	 Windows 7

Geocart should also run, but is not officially supported, on Windows Server 2003 and later server versions.

Installing Geocart 3 on Windows 

If you have a previous version of Geocart 3 on your computer, you must uninstall the old version and its required 
databases before installing the new version. To uninstall old versions, refer to Uninstalling the Geocart Application 
and Required Databases in the Uninstalling Geocart section below before installing your new version.

Geocart 3 for Windows comes in both 32-bit and 64-bit versions. The 32-bit version works on any version of 
Windows but cannot make use of more than 2 GB of RAM. The 64-bit version is preferable as it is faster and can use 
all available memory (to draw larger maps). However, it requires you to have a 64-bit version of Windows. 

Identifying your Windows version

For Windows XP:

1.	 Click Start.

2.	 Right-click on My Computer.

3.	 Click Properties.

Result: The System Properties dialog will be displayed. If you are running a 64-bit version of Windows, you 
will see Professional x64 Edition in the System section near the top. 

For Windows 7 and Windows Vista

1.	 Click Start.

2.	 Right-click on Computer.

3.	 Click Properties.

Result: The View basic information about your computer dialog will appear. If you are running a 64-bit 
version of Windows, you will see either System type: 64-bit Operating System or System type: 32-bit Operating 
System in the System section in the middle of the dialog box.

Note: If you are still unsure about which version of Geocart to choose, try installing the 64-bit version. If your 
computer does not have a compatible operating system, the installer will display an error message: “This installation 
package is not supported by this processor type. Contact your product vendor.” If you see this error message, it means that 
you can only install the 32-bit version of Geocart on your computer.
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Installing the new Geocart 3 application on Windows

1.	 Insert the Installation Disk into your computer. For Geocart to work correctly, you must install both the 
application and the required databases. 
Note: If a window showing the DVD content does not appear, use the Windows Explorer to show it.

2.	 For Windows XP, click Start > My Computer.

	 – OR –

	 For Windows 7 or Vista, click Start > Computer.

3.	 From the top level of the Installation Disk, double-click on the Application Installers 
directory.

4.	 Double-click either the Windows 32-bit or Windows 64-bit directory as appropriate for your 
computer. 
Result: You will see two files: Geocart.msi and setup.exe

5.	 Double-click setup.exe and wait for the installer to start.

6.	 Follow the prompts to install the application on your system.

Windows Vista Users: You will receive a User Account Control dialog that says “An unidentified program 
wants access to your computer.” This is expected behavior as the installer is not digitally signed. Click Allow.

Windows 7 Users: You will receive a User Account Control dialog warning that says “Do you want to allow the 
following program from an unknown publisher to make changes to this computer?” This is expected behavior as the 
installer is not digitally signed. Click Yes to install the program.

Installing the Required Databases on Windows

1.	 From the top level of the Installation Disk, double-click on the Required Databases directory.

2.	 Double-click the Windows directory.
Result: You will see two files: Geocart Databases.msi and setup.exe.

3.	 Double-click setup.exe and wait for the installer to start.

4.	 Follow the prompts to install the required databases on your system.

Windows Vista Users: You will receive a User Account Control dialog that says “An unidentified program 
wants access to your computer.” This is expected behavior as the installer is not digitally signed. Click Allow to 
install the program.

Windows 7 Users: You will receive a User Account Control dialog warning that says “Do you want to allow the 
following program from an unknown publisher to make changes to this computer?” This is expected behavior as the 
installer is not digitally signed. Click Yes to install the program.

Once the application and required databases installation is complete, you can start Geocart:

•	 Click the shortcut icon  on your desktop.

	 – OR –

•	 Click Start > All Programs > Geocart.

Installing the Sample Documents on Windows

Geocart 3 comes with sample documents and images for use in following the examples in Chapter 5: Examples as 
well as for general use. The installer for this material is contained in the Sample Documents directory on the 
Installation Disk.
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To install the sample documents:

1.	 Insert the Installation Disk.

2.	 Double-click the Sample Documents folder.

3.	 Double-click the Windows folder.
Result: You will see two files: Geocart Sample Documents.msi and setup.exe.

4.	 Double-click setup.exe and wait for the installer to start.

5.	 Follow the prompts to install the sample documents onto your system.

Windows Vista Users: You will receive a User Account Control alert that says “An unidentified program wants 
access to your computer.” This is expected behavior as the installer is not digitally signed. Click Allow to install 
the sample documents.

Windows 7 Users: You will receive a User Account Control alert that says “Do you want to allow the following 
program from an unknown publisher to make changes to this computer?” This is expected behavior as the installer 
is not digitally signed. Click Yes to install the sample documents.

Once the installation is complete, you will be able to access the sample documents from the Help menu, Sample 
Documents command.

Installing Supplemental Databases on Windows

Geocart 3 comes with many optional geographic databases. They consume many gigabytes of disk space and are 
therefore not installed by default. The databases are contained in the Supplemental Databases directory on the 
Installation Disk. The professional edition of Geocart includes an Extra Databases disk with additional databases. 
You can install any of the supplemental databases during the initial installation, or at any later time.

To install supplemental databases:

1.	 Insert either the Installation Disk or the Extra Databases disk.

2.	 Double-click the Supplemental Databases directory.
Result: The directories for each data set that can be installed are displayed (for example, 
World Databank II).

3.	 Double-click on a data set directory to display its contents. Each data set contains a readme file that 
describes the databases contained in the data set (for example, World Databank II.txt), and a Win 
Installer file (for example, Double click me.cmd).

4.	 Double-click the .cmd file.

5.	 In the text-based installer window, select whether you want the databases to be accessible only to you, or to 
everyone who uses your computer. 

Note: The database files are compressed, and some data sets are over 1 GB in size. The installation may take several 
minutes to complete.

Uninstalling Geocart on Windows

Uninstalling the Geocart application, Required Databases, and Sample Documents

To remove Geocart from a computer using the Windows XP operating system:

1.	 On the Start menu, click Control Panel.

2.	 Double-click Add or Remove Programs.

3.	 For 32-bit Windows: Select Geocart and click Remove.
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	 – OR –

	 For 64-bit Windows: Select Geocart for 64-bit Windows and click Remove.

4.	 Select Geocart Databases and click Remove.

5.	 Select Geocart Sample Documents (if present) and click Remove.

To remove Geocart from a computer using Windows Vista or Windows 7 operating systems:

1.	 On the Start menu, click Control Panel.

2.	 Double-click Programs.

3.	 Click Uninstall a program.

4.	 For 32-bit Windows: Select Geocart and click Uninstall.

	 – OR –

	 For 64-bit Windows: Select Geocart for 64-bit Windows and click Uninstall.

5.	 Select Geocart Databases and click Uninstall.

6.	 Select Geocart Sample Documents (if present) and click Uninstall.

Windows Vista Users: You will receive a User Account Control alert that says “An unidentified program wants 
access to your computer.” This is expected behavior as the installer is not digitally signed. Click Allow to uninstall 
the program.

Windows 7 Users: You will receive a User Account Control alert that says “Do you want to allow the following 
program from an unknown publisher to make changes to this computer?” This is expected behavior as the installer 
is not digitally signed. Click Yes to uninstall the program.

Uninstalling Supplemental Databases 

The Geocart uninstallers will not remove any additional databases that you may have installed manually or by using 
the Supplemental Database installers. These databases take up a large amount of disk space, so there may be times 
when you wish to remove them to free up space.

To remove the Geocart supplemental databases from a computer using the Windows XP operating system:

1.	 On the Start menu, click My Computer.

2.	 Double-click the Address field at the top (it will default to My Computer).

3.	 In the Address field, enter C:\Documents and Settings\All Users\Application Data\
Mapthematics\Databases to see databases that are accessible to all users.

4.	 Press ENTER to display the directory.

5.	 Delete or move the database files.

6.	 In the Address field, enter C:\Documents and Settings\YourAccountName\Local 
Settings\Application Data\Mapthematics\Databases to see databases that are only 
accessible to you.

7.	 Press ENTER to display the directory.

8.	 Delete or move the database files.

To remove the Geocart supplemental databases from a computer using Windows Vista or 7 operating systems:

1.	 On the Start menu, click Computer.

2.	 Double-click the Location field at the upper left (it will default to > Computer >).
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3.	 In the Location field, enter C:\ProgramData\Mapthematics\Databases to see databases that 
are accessible to all users.

4.	 Press ENTER to display the directory.

5.	 Delete or move the database files.

6.	 In the Location field, enter 
C:\Users\YourAccountName\AppData\Local\Mapthematics\Databases to see 
databases that are only accessible to you.

7.	 Press ENTER to display the directory.

8.	 Delete or move the database files.

Licensing Geocart

When you start the Geocart application for the first time, you will be prompted to enter your name and license key 
You can find your license key printed on a sticker on the back of the case for the Geocart Installation Disk. Until you 
enter your name and key, Geocart will run in a 30-day demonstration mode, making some functionality unavailable.

Geocart does not have any heavy-handed product activation technology that may impede your legal use of the 
software, but it does require you to enter your license key to use the software on a particular computer—so don’t lose 
this number! The software will not display your license key to you after you have entered it, and you will need it again 
to install and use the software on other computers. Keep it in a safe place.

To enter your license key after installation:

1.	 Start Geocart.

2.	 In the License dialog, enter your name and license key exactly as it appears, including all dashes. 

Contained within your license key is your encrypted serial number. After you have entered your name and license key, 
you will see your name and decrypted serial number in the bottom right of the startup screen.

You can also see your name and decrypted serial number by accessing the:

•	 Apple menu > Geocart (Macintosh)

	 – OR –

•	 Help menu > About Geocart (Windows)

Please keep your license key secret, and abide by the licensing terms spelled out in Help menu’s Licensing Terms. 
If your license key leaks out, or we discover that you are abusing your licensing terms, your licensing key may be 
revoked—which means that it will not function with future updates of the software. A product as specialized as 
Geocart, without an onerous activation scheme, will not succeed unless you do your part.

Technical Support

For technical support, or help with how to use Geocart:

•	 Refer to our online support page for FAQs and Forums at http://www.mapthematics.com/Support.php.

•	 Send e-mail to Mapthematics at support@mapthematics.com.

Note: If you contact Mapthematics LLC for Geocart support, you will need to provide the serial number that appears 
in the startup screen.

mailto:http://www.mapthematics.com/Support.php?subject=Mapthematics%20Support
mailto:support%40mapthematics.com?subject=Geocart%20support%20inquiry
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Chapter 2: Introducing Geocart
This chapter introduces you to Geocart’s capabilities. First we show how to make a map, step by step. Following 
the sample map construction, you can find tables listing each of the menus and their commands. Each command is 
described briefly. For details about a command, please see its entry in the chapter for the menu it is found on.

An Example Map

You may not understand much of what you see or do when making the example map. Don’t worry; each operation is 
explained in another section. We recommend that you just relax for now and watch the effects of each step. To launch 
Geocart:

Macintosh

1.	 In the Finder, select Applications from the Go menu at the top of the screen.

2.	 A new Finder window will appear, displaying all the application programs that have been installed on 
your computer by normal means, and arranged according to your chosen view and arrangement. Geocart 
should appear in that list of applications.

3.	 Double-click the Geocart icon. 

Result: Geocart will launch, displaying the startup screen and menu bar. You may click on the startup screen at any 
time to dismiss it. It will disappear after several seconds in any case.

Windows

1.	 From the Windows Start menu, select All Programs.

2.	 Select Geocart from the (possibly very long) list of programs.

Result: Geocart will launch, displaying the startup screen and application window. You may click on the startup screen 
at any time to dismiss it. It will disappear after several seconds in any case.

Geocart startup screen

Note: If you cannot find the Geocart icon or progam, ensure that it is installed on your computer. Refer to 
Chapter 1: Setup.



2.2

Using the menus

At the top of the screen you can see Geocart’s menu bar.

Macintosh menu bar

Windows menu bar

Your menu bar may differ slightly depending upon the configuration of your system software.

Creating a map:

1.	 From the File menu, select New to create a document.

2.	 From the Map menu, select New.

Result: Geocart will draw a default world map using the sinusoidal projection.

Note: You do not need to create a new document if you already have a document open. You may create any number of 
maps in one document.

Default map projection: sinusoidal

Moving a map in the document

1.	 Click anywhere on the map to select it.

2.	 Click and drag the map around in your document.

Editing the map

1.	 From the  Pseudocylindric menu select loximuthal. Geocart will redraw the map in the new 
projection.

2.	 From the Projection menu, select Parameters.

3.	 In the Projection Parameters dialog, enter 0 as the Latitude of origin.
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4.	 Click OK. Geocart will redraw the map; allow it to finish before moving on to the next step so that 
you can see the effect of your actions. The map should become symmetric about the equator, whereas 
previously it was bottom-heavy.

5.	 From the Projection menu, point to Interruptions and select Segmented.

6.	 Allow Geocart to finish redrawing the map.

7.	 From the Map menu, select Graticule to open the Graticule dialog.

Graticule dialog

8.	 Enter 20 for Parallel spacing.

9.	 Enter 20 for Longitude spacing.

10.	 In the Pruning Options section, enter 20 for North pole, primary.

11.	 In the Pruning Options section, deselect North pole, secondary.

12.	 In the Pruning Options section, enter 20 for South pole, primary.

13.	 In the Pruning Options section, deselect South pole, secondary.

14.	 Click OK.

15.	 From the Map menu, select Line Styles to bring up the Line Styles dialog.

16.	 In the left pane, click on Equator within the Parallel section of the Graticule section.

17.	 In the Definitions for this coverage section, click on the pop-up menu that presently says Define new 
attributes.

18.	 Select Use parent’s attributes.

19.	 Click OK and watch the map draw. The red equator should change to light gray like the rest of the 
graticule.

20.	 From the Map menu, select Nominal Scale.
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21.	 In the top field of the Nominal Scale dialog, enter 200000000. Click OK.

Nominal Scale dialog

22.	 From the Map menu, select Final Quality and allow Geocart to redraw the map.

After redrawing, your map should look like this:

Loximuthal projection with segmented interruption

23.	 From the Edit menu select Copy.

24.	 From the Edit menu select Paste.

25.	 Drag the new map away from the old so that they do not overlap.

26.	 From the Map menu, select Distortion Visualization.

27.	 In the Distortion Visualization dialog, click the Finitized scale for indefinite limits radio button.

28.	 Click OK and let the map redraw.

29.	 From the File menu select Size Document to Content.

30.	 Click OK to accept the default margin and resize the document.
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Distortion visualization

The remainder of this chapter will provide a brief introduction to most of the menu items you saw as you created the 
example maps.

The Projection Class Menus 

When first making a map it is helpful to decide which projection to use. The guidelines from Appendix A: Which 
projection is best? can help. You may always change the projection later. The projections are divided between six menus 
representing the following categories.

	 	 The Cylindric projection menu contains projections whose meridians and parallels are straight 
lines when viewed from the equator.

	 	 The Pseudocylindric projection menu contains projections with straight parallels, and curved 
meridians with equal spacing along a parallel, when viewed from the equator.

	 	 The Conic projection menu contains projections whose meridians are straight lines and whose 
parallels are portions of concentric circles when viewed from the equator. It also covers certain 
variations (such as pseudoconic and polyconic).

	 	 The Azimuthal projection menu contains projections that, when viewed from a pole, have straight 
meridians that converge to the pole and have constant angle between each meridian. It also 
includes many relatives derived from them.

	 	 The Lenticular projection menu contains projections whose meridians and parallels curve away 
from the equator, when viewed from the equator. The distance between parallels does not increase 
when progressing from equator to pole.

	 	 The Miscellaneous projection menu contains projections unclassified by any of the above 
schemes.

Every Geocart map has a projection. A map acquires a default projection when you create a new map if you do not 
specify a projection at time of creation. It acquires the projection of the source map if it was a copy of the source map. 
Or, you set the projection directly. You can see what projection a map uses by looking in the projection menus. If you 
have one map selected, or several maps of the same projection, then one of the projection menus will have a projection 
name with a check mark next to it. If you have more than one map selected involving more than one projection, then 
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each projection of the multiple selection will be indicated by a dash next to the projection name in the menu of its 
projection class.

To change a map’s projection, select the projection you want from one of the six menus. Immediately Geocart will 
begin redrawing the map according to your selection. It will try to preserve as many traits of the old map as it can. 
However, sometimes the new map cannot be drawn with the same boundaries as the old map, for example. In 
such cases the projection change will fail, typically giving an error alert stating that the map is too big. See Change 
Projection explanation in Chapter 10: Projection menu for ways to resolve this.

Some of the projection names, such as Eckert, expand to a family of projections. To access these projections, open the 
sub-menu. For example:

1.	 Click on the  Pseudocylindric menu icon. The menu appears.

2.	 Find Eckert in the menu. Move the pointer over it. The submenu appears.

3.	 Select your specific Eckert projection (such as Eckert IV) from the submenu at right.

Projection menu excerpt with Eckert family sub-menu

A simple explanation of each of Geocart’s menu functions follows. Many of the functions in the menus are available 
without using the menus but instead through keyboard combinations. These keyboard combinations are called 
“shortcuts”. The Shortcut keys column of each table use these conventions:

Symbol Explanation
⌘ (Mac only) command key
^ (Windows only) control key
⇧ shift (Macintosh) or SHIFT (Windows) key
⌥ (Mac only) option key
⎇ (Windows only) ALT key

To use control keys, depress all of the keys shown as the shortcut for the menu function you want. For example, for 
the Save As menu command from the File menu is shown in the table below like this:

Command Shortcut keys Action
Save As ⇧⌘S 

⇧^S
Saves the front document to a new file, and with a different 
name if you choose.

To access the command from the keyboard, on Macintosh you would depress the shift key, the command key, and the 
S key simultaneously. On Windows you would depress the shift key, the control key, and the S key simultaneously.
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The Geocart Menu (Mac only)

Command Shortcut keys Action
About Geocart Displays the splash screen, giving version number, product 

configuration, and licensing information.
Preferences ⌘ , > General —Opens the Preference dialog.

> New Map Databases —Opens the Databases dialog to let 
you set up the databases you want added automatically for 
every new map.

> New Map Graticule —Opens the Graticule dialog to let 
you configure the graticule for every new map.

> New Map Line Styles —Opens the Line Styles dialog to let 
you configure the line styles for every new map.

> Reset New Map Databases —Clears any configuration 
you earlier performed from New Map Databases. From this 
point only databases in the Default folder of the installed 
databases folder will get added automatically to new maps.

> Reset New Map Graticule —Clears any configuration you 
earlier performed from New Map Graticule. From this point 
new maps’ graticules will get set up automatically according to 
the original defaults.

> Reset New Map Line Styles —Clears any configuration you 
earlier performed from New Map Line Styles. From this point 
new maps’ line styles will get set up automatically according to 
the original defaults.

Service System-level services. Geocart does not provice any services. 
Please refer to Macintosh documentation.

Hide Geocart ⌘H Hide Geocart’s windows, palettes, and menu bar, and switch to 
the last application you used.

Hide Others ⌥⌘H Hide all the windows of other applications.
Show All Bring all the windows of other applications back into view, 

though possibly obscured by Geocart’s windows and palettes.
Quit Geocart ⌘Q Ends the Geocart session. If you have unsaved documents, 

Geocart will first ask if you want to save them.
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The File Menu

Command Shortcut keys Action
New ⌘N

^N
Creates a new Geocart document.

Open ⌘O
^O

Displays the Open File Picker so that you can select a Geocart 
document to open.

Open Recent Lets you to select a Geocart document to open from a list of 
recently opened documents.

Close 
(Mac)

⌘W Closes the front document.

Save ⌘S 
^S

Saves the front document. If this is the first time it has been 
saved, Geocart will ask you to name it.

Save As ⇧⌘S 
⇧^S

Saves the front document to a new file, and with a different 
name if you choose.

Save a Copy 
(Windows only)

Creates a new copy of the document on disk, but does not 
change the document’s name.

Revert Discard all changes to the document since it was last saved.
Close 
(Windows)

^W Closes the front document.

Export Document Exports the entire contents of the front document to TIFF, 
JPEG, PSB (Adobe Photoshop® native) or PDF format. The 
exported document will have the same dimensions as the 
Geocart document, regardless of content.

Export Selected Items Exports any items selected in the front document to TIFF, 
JPEG, PSB (Adobe Photoshop® native) or PDF format. The 
exported document’s dimensions will be large enough to 
accommodate the selected content.

Export Database Creates a raster database from the front document. The 
document should contain exactly one placed image and one 
reference map. The reference map describes the projection, 
scale, resolution, and orientation of the placed image. Once 
exported, you may use the raster database like any other raster 
database.

Export Animation Frames Active when exactly two maps are selected. Opens the Export 
Animation Frames dialog so that you can configure an 
automated generation of animation frames, blending the two 
maps in successive proportions.

Place Image Opens the Place Image file picker for you to choose a TIFF, 
JPEG, or PSD/PSB (Adobe Photoshop® native) image to place 
onto Geocart’s front document.

Set Placed Image Resolution Forces the selected placed image to a resolution you specify. 
If the resolution is higher than its original resolution, this will 
shrink the size of the image and increase its pixel density. If 
lower, this will expand the size of the image and decrease its 
pixel density.
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Command Shortcut keys Action
Document Layout Opens the Document Layout dialog to let you to set the front 

document’s dimensions.
Size Document to Content ⌘T 

^T
Resizes the front document to fit the maps within it. You can 
specify a margin size.

Page Setup
(Mac only)

⇧⌘P Opens the Page Setup dialog to let you configure your 
printer’s media for the front document.

Print ⌘P 
^P

Prints the front document. See your computer’s 
documentation for instructions; Geocart does not customize 
the print operation.

Preferences
(Windows only; see Geocart 
menu for Mac)

^ , > General —Opens the Preference dialog.

> New Map Databases —Opens the Databases dialog to let 
you set up the databases you want added automatically for 
every new map.

> New Map Graticule —Opens the Graticule dialog to let 
you configure the graticule for every new map.

> New Map Line Styles —Opens the Line Styles dialog to let 
you configure the line styles for every new map.

> Reset New Map Databases —Clears any configuration 
you earlier performed from New Map Databases. From this 
point only databases in the Default folder of the installed 
databases folder will get added automatically to new maps.

> Reset New Map Graticule —Clears any configuration you 
earlier performed from New Map Graticule. From this point 
new maps’ graticules will get set up automatically according to 
the original defaults.

> Reset New Map Line Styles —Clears any configuration you 
earlier performed from New Map Line Styles. From this point 
new maps’ line styles will get set up automatically according to 
the original defaults.

Exit
(Windows only)

^Q Ends the Geocart session. If you have unsaved documents, 
Geocart will first ask if you want to save them.
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The Edit Menu

Command Shortcut keys Action
Undo ⌘Z 

^Z
Undoes the previous action.

Redo ⇧⌘Z 
^Z

Redoes the last undone action.

Cut ⌘X 
^X

Removes the selected object or objects from the document and 
places them on the clipboard.

Copy ⌘C 
^C

Copies the selected object or objects onto the clipboard. 
Thence you may paste the clipboard contents.

Paste ⌘V 
^V

Copies the most recent clipboard object onto the document.

Delete delete 
DEL

Deletes the selected object or objects.

Select All ⌘A 
^A

Selects all objects of the front document.

Deselect All ⌘D 
^D

Deselects all objects of the front document.

Copy Info Palette Text ⇧⌘X 
⇧^X

Copies the contents of the Information palette so that you can 
paste the text into other applications.

Find
(Mac only)

This is provided by the Mac OS. It does not function in 
Geocart.

Spelling
(Mac only)

This is provided by the Mac OS. It does not function in 
Geocart.

Special Characters
(Mac only)

⌥⌘T This is provided by the Mac OS. It does not function in 
Geocart.

A map is a graphical object that you can move around, duplicate, or delete. There is no particular limit to the number 
of maps you may create or paste into a document. 

To add a second map to a document:

1.	 From the Edit menu, select Copy.

2.	 From the Edit menu, select Paste.

	 – OR –

	 From the Map menu, select New.

Notes: Your new map may not be apparent as it may overlay your existing map. Drag the new map to see your original 
map. 

The Map Menu
The commands on this menu let you tailor your map. The commands always apply to the selected map or maps of 
front document. Some can only operate on one map, and will not be available if multiple maps are selected.
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Command Shortcut keys Action
New ⇧⌘N 

⇧^N
New creates a map using default settings for databases, 
line styles, and graticule. To change these defaults, see the 
Preferences command on the Geocart menu (Mac) or the File 
menu (Windows). The default projection is sinusoidal and 
cannot be changed.

New Blended Active when two maps are selected. Opens the Blend dialog to 
let you specify how to blend the two selected maps, creating a 
third map and possibly synthesizing a new projection.

Databases ⇧⌘B 
⇧^B

Opens the Databases dialog to let you to add and remove 
databases, operating on the selected map or maps. Databases 
contain map information, such as coastlines or boundaries, for 
Geocart to construct a map from.

Nominal Scale ⌘K 
^K

Opens the Nominal Scale dialog to let you to set the 
selected map’s scale. You may specify the scale as a ratio (e.g., 
1: 100,000) or as real distance per map distance.

Map Size and Resolution Opens the Map Size and Resolution dialog to let you set the 
overall size of the selected map and/or its level of detail.

Scale to Window Scales the selected map or maps to fit your document layout 
window.

Scale to Document Scales the selected map or maps to fit your document’s size.
Boundaries ⌘B 

^B
Opens the Boundaries dialog to let you specify the extents of 
the selected map.

Graticule Opens the Graticule dialog to let you configure the network of 
parallels and meridians of the selected map or maps.

Line Styles ⌘L 
^L

Opens the Line Styles dialog to let you set the drawing traits 
of the different kinds of lines on the selected map.

Distortion Visualization Opens the Distortion Visualization dialog to let you config-
ure a distortion diagram to draw in place of raster databases of 
the selected map.

Tissot Indicatrices When checked, draws an ellipse at each graticule intersection 
showing the distortion characteristics at that point. Longer, 
flatter ellipses indicate more angular deformation. Differences 
in ellipse area indicate comparative inflation in size.

Copy Attributes ⇧⌘C 
⇧^C

Copies all of the attributes from the selected map and places 
them on the clipboard. You may then use Paste Attributes to 
transfer some or all of those attributes to other maps.

Paste Attributes ⇧⌘V 
⇧^V

Pastes the map attributes from the clipboard to the selected 
map or maps.

Vector Generalization Accesses vector generalization choices for the selected map or 
maps. Line artwork consists of “vectors” retrieved from the 
databases you have specified from the Databases command. If 
the vectors in the database contain too much detail to be useful 
for your map, generalization will prune away excess detail. The 
default Douglas-Peucker method should serve most purposes 
well enough. Select None to preserve all detail.
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Command Shortcut keys Action
Draft Quality ⌘2 

^2
Sets rapid rendering trait for the selected map or maps, yield-
ing low quality. This setting does not affect line work from 
vector databases.

Proof Quality ⌘3 
^3

Sets better render quality for the selected map or maps, but at 
the expense of longer rendering times. This setting does not 
affect line work from vector databases.

Final Quality ⌘4 
^4

Sets best render quality for the selected map or maps, but at 
the expense of longest rendering times. This setting does not 
affect line work from vector databases.

The Projection Menu

Every map projection has attributes that you can modify. These attributes are controlled from the Projection menu. 
The commands on this menu always apply to the selected map or maps of the front document. Some can only operate 
on one map, and will not be available when multiple maps are selected.

Command Shortcut keys Action
Change Projection Opens the Change Projection dialog to let you change the 

map projection of the selected map or maps. You can configure 
which traits of the existing map you want to retain when 
you change projections. Also gives detailed information and 
pictures of each map projection.

Reset Projection Resets the selected map or maps to default traits appropriate 
for the projection.

Projection Center Opens the Projection Center dialog to let you change the 
aspect of your map; that is, whether it is viewed from the 
equator or pole or elsewhere.

Parameters Opens the Parameters dialog to let you configure the map 
projection of the selected map. If the projection has no special 
configuration parameters, this command will not be available.

Stretch and Rotation Opens the Stretch and Rotation dialog to let your rotate the 
selected map on the page and to stretch the height and/or 
width independently of the nominal scale.

Datum Opens the Datum dialog to let you select an ellipsoid and a 
geodetic datum for the selected map.

Interruptions Accesses the map Interruption options. Some map projections 
can be sliced up, or interrupted, in order to reduce distortion in 
areas of the map deemed important to its narrative.

The Object Menu
These commands operate on objects, whether images or maps. All operations apply to single or multiple objects. If 
objects are grouped, then they are considered to be a single object for these operations. Every object has a position in 
the stack of objects: It is either the back object, the front object, or is in front of and behind two other objects. This is 
true even if the objects do not overlap.
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Command Shortcut keys Action
Bring to Front ⌘ } 

^ }
Brings the selected objects to the front of the stack of objects.

Send to Back ⌘ { 
^ {

Sends the selected objects to the back of the stack of objects.

Bring Forward ⌘ ] 
^ ]

Brings each selected object upward one position in the stack of 
objects. 

Send Backward ⌘ [ 
^ [

Sends each selected object down one one position in the stack 
of objects.

Group ⌘R 
^R

Groups the selected objects so that they can be selected and 
positioned as if they were a single object. All selected objects 
will be brought to a position just behind the frontmost 
selected object when this command is given.

Ungroup ⇧⌘R 
⇧^R

Separates grouped objects into their original components.

Align Multiple Aligns the selected objets so that upper left corners coincide. 
Center in Window Centers the selected objects in the window.
Center in Document Centers the selected objects in the document.
Cancel Drawing Cancels any drawing waiting or in progress of any selected 

map.
Redraw Forces any selected maps to redraw. This is useful if you 

change some configuration outside of Geocart, such as 
changing the contents of a database.

The View Menu

Command Shortcut keys Action
New ⌥⌘N 

⎇^N
Creates a new window into the front document. The content 
is the same; this just lets you view the same content in 
different ways—for example, using different magnifications.

Zoom In ⌘= 
^=

Zooms in the window magnification.

Zoom Out ⌘- 
^-

Zooms out the window magnification.

Fit in Window ⌘0 
^0

Change the zoom level so that the entire document can be seen 
at once.

Actual Size ⌘1 
^1

Changes the zoom level to 100%.

Actual Pixels of Selected Object Changes the zoom level so that a pixel of the selected map or 
image corresponds to a pixel of the display.

Rulers Toggles to show/hide the document rulers.
Page Boundaries Toggles to draw/hide gray rectangles delineating page boundar-

ies. A page’s size is determined by Page Setup (Mac) or Print 
(Windows).
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The Window Menu (Windows)

Command Shortcut keys Action
Cascade ⇧F5 Arranges all document windows within the applicaiton 

window in cascading layers.
Tile ⇧F4 Arranges all document windows within the application 

window in a tiled fashion.
Arrange Icons Arranges any minimized document windows within the 

application window.
Close All Close all documents.
Navigator F5 Opens the Navigator palette to give you a miniature view of 

the entire document, and allows you to use a slider to select 
the zoom extent.

Information F6 Opens the Information palette which shows detailed 
information about the object under your mouse pointer.

The Window Menu (Mac)

Command Shortcut keys Action
Minimize ⌘M Moves the front window into the dock and sets the next 

window back to be the front window.
Zoom Sets the front window to the maximum size your display will 

allow.
Bring all to Front Brings all Geocart windows to the front of any other applica-

tion’s windows, but does not change the front-back ordering of 
Geocart windows.

Navigator F5 Opens the Navigator palette to give you a miniature view of 
the entire document, and allows you to use a slider to select 
the zoom extent.

Information F6 Opens the Information palette which shows detailed 
information about the object under your mouse pointer.

The Help Menu

Command Shortcut keys Action
About Geocart
(Windows only)

Provides details of the Geocart version and license. (On 
Macintosh, this appears on the Geocart menu.)

Available Fonts Displays the set of fonts installed on your system that are 
usable by Geocart.

Sample Documents Switches to the Finder (Macintosh) or Explorer (Windows) 
and opens the folder containing sample documents placed 
there by the Geocart installer.
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Command Shortcut keys Action
Release Notes Opens a window in your default Web browser with a page on 

the Mapthematics Web site for information about the version 
of Geocart you are using.

Check for Updates Opens a window in your default Web browser with a page on 
the Mapthematics Web site to inform you of any updates to 
your Geocart version.

Geocart Forums Opens a window in your default Web browser with the 
Geocart Forums page on the Mapthematics Web site.

Report a Bug Opens a window in your default Web browser with a page 
on the Mapthematics Web site for information about how to 
report a bug.

Credits Displays a window containing information about the 
developers of Geocart and all component technologies used by 
Geocart.

License Allows you to enter your name and license key to unlock the 
full functionality when Geocart is running in demonstration 
mode.

Relinquish License Allows you to relinquish your license and return Geocart to 
demonstration mode so you can install your licensed version 
of Geocart on another computer.

Licensing Terms Displays a window containing the Geocart Software License 
Agreement.
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Chapter 3: Essentials
The science of map projections is detailed and complex. Geocart makes this process easy for you; however you do need 
to understand some background information so that you can choose the most appropriate projections. This chapter 
explains some of the basic concepts of map projections. If you are already familiar with map projections, this chapter 
may still be useful to you because it describes how concepts relate to Geocart.

The Globe

You may find it useful to refer to a model globe or to Google™ Earth while reading this chapter.

Latitude and longitude

You will see that the globe has a network of vertical and horizontal lines overlaid on it. The horizontal lines are called 
parallels or lines of latitude because they run parallel to each other. Each location along a parallel has the same latitude, 
or distance from the equator.

The vertical lines are called meridians or lines of longitude. Any one shows all the places that have the same local time. 
Each location along a meridian has the same longitude, or angle between it, the north pole, and the prime meridian1.

	 	

Tip: To show parallels and meridians on Google Earth: on the View menu, select Grid.

Latitude and longitude are two very different things: On the surface of the earth, latitude is a distance, while longitude 
is an angle. You cannot tilt the earth on its side and expect the latitude lines to match the old longitude lines. The 
meridians converge to two points: the north and south poles, but the parallels don’t converge anywhere; they stay the 
same distance apart everywhere. 

1  The meridian you can see running through western Africa, western Europe, and England. The meridian was cho-
sen in 1884 at the International Meridian Conference in Washington, D.C. It has no physical significance.
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The coordinate system

Every point on the globe has a meridian running through it from north to south, and a parallel running through it 
from east to west. Maps and globes only show some of the meridians and parallels, because if they showed all of them, 
then the map would be black with lines and not very useful. 

Longitude and latitude are measured in degrees (°), minutes (′) and seconds (″). There are 360 degrees of longitude, mea-
sured 180 degrees east and west of the prime meridian, and 180 degrees of latitude, measured 90 degrees north and 
south of the equator.

Taking the earth to be perfectly spherical, one degree of latitude along a meridian (from one parallel to the next one 
1° away) always measures the same distance because latitude measures distance. That distance amounts to about 
111.1 km (69.1 mi) for the earth.

A degree of longitude, on the other hand, measures angle, so the distance covered by 1° of longitude is a different 
distance at every latitude. Again taking the earth to be a sphere, then at the equator 1° of longitude is the same as 1° of 
latitude; at 60° north or south the distance is half of that (55.6 km or 34.5 mi); and at either pole the distance is zero. 

Minutes and seconds measure smaller parts of a degree. There are 60 seconds in a minute, and 60 minutes in a degree. 
Hence on the equator, one minute is about 1.85 km (1.15 mi) and one second is about 0.0309 km or 30.9 m (101 ft).

The coordinate of a location is given by the intersection of the parallel and meridian that pass through that location, 
along with a direction stating north or south for latitudes, or east or west for longitudes. Typically the latitude is given 
first. For example the point 35°40′45″N, 139°46′14″E is on the grounds of the emperor’s palace in Tokyo.

Graticule

The network of meridians and parallels is called the graticule. Usually a globe will 
have a 10° or 15° graticule resolution, which means it shows meridians and parallels 
every 10° or 15°. Maps have widely varying graticule resolutions depending on their 
use and on the size of the area they are covering. Usually the meridians and parallels 
have the same resolution, but not always.

Scale

The earth is very nearly a sphere 10,002 km (6,215 mi) from equator to pole.2 A 
typical globe is only about 0.00024 km (0.00015 mi) from equator to pole, which is economically sound, but there is 
a bit of a size difference. The ratio of the two sizes is called the scale of the globe, which in this case is 0.00024: 10,002 
or 1: 41,675,000—in other words, the earth’s circumference is 42 million times that of a 12-inch globe.

Great circle

If the earth were flat then the shortest distance between two 
points would be a straight line, but since there is no such 
thing as a straight line on a sphere, then something else must 
show the shortest distance. That something is a great circle, 
and if it is drawn completely then it goes all the way around 
the earth to the antipode, or point on the opposite side, and 
back to the starting point. The center of a great circle is the 
center of the earth, and great circles may be thought of as 
paths on the surface of the earth where planes cut through 
the center of it.

All meridians are great circles, but no parallels are except the equator. A great circle going in a particular direction as 

2  In fact, the meter originally was defined to be 1/10,000,000 that distance, but the survey was off by 1,966 meters. It 
was a valiant effort for the 18th century.
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seen from some point is called an azimuth (muth, not myooth), and usually its direction is measured as a number of 
degrees clockwise from north.

Rhumb

Mariners who have only a compass to help them prefer to travel paths whose direction does not change: a course of 
constant bearing, called a rhumb, or, mathematically, a loxodrome.

A loxodrome crosses each meridian at the same angle. A loxo
drome is a great circle only if it is the equator or a meridian; any 
other rhumb between two points is longer than the great circle 
route between the same two points.

Small circle

Another important geometrical element on the globe is small 
circles. These are circles made by slicing through the earth with 
a plane at any angle such that the plane does not go through the 
center of the earth. All of the parallels except the equator are small circles, but none of the meridians are. Because a 
small circle is a circle it shows all of the points on the surface of the globe that are the same distance from the center of 
the small circle. 

Direction

Here we address the problem of direction. Direction means what you think it means in a local sense, but probably not 
in a global sense. The common perception of direction goes something like this: You determine which way is east, 
for example, by measuring 90° clockwise from north. Then, you point in that direction to another person who is due 
east of you. He points due east of himself to another person, and so on to form a chain all away around the world. 
You would probably say that everyone in the chain and every point between is east of you. This is actually false, and 
technically none of the people in the chain are east of you. Your chain has made a rhumb line, a loxodrome, which is 
an interesting and useful measure of direction, but it is not the official definition. 

According to the official definition, east follows the great circle that crosses your meridian at a 90° angle: the eastern 
azimuth. At first, this azimuth will be very close to your chain, but if you live in the northern hemisphere you will find 
the azimuth gradually dipping south, reaching the equator and going below it until it reaches the latitude of opposite 
sign: the latitude that is as far south as you are north. It continues circling the back side of the earth and eventually 
returns to you after crossing the equator again. 

When a projection has properties based on direction, you must understand clearly that these directions refer to the 
official meaning based on azimuths. Therefore, the retroazimuthal projections: those that let you find the direction to 
a center point from any other, for example, may not give you what you think you want. If you need maps that show 
intuitive direction then you should use those that have loxodromic properties: Mercator and loximuthal. 

Earth’s shape

As mentioned earlier, the earth is nearly a sphere—but not quite. In the language of mathematics the earth’s shape 
is closer to an ellipsoid, which is an ellipse (oval) rotated in three dimensions. Ellipsoids that are nearly spheres are 
sometimes called spheroids. Astronomers call a body shaped like the earth an oblate spheroid, which is a specific kind of 
ellipsoid made by rotating an ellipse in three dimensions around its shorter axis. But the earth has irregularities that 
keep it from being a simple geometric solid. The shape of its mean sea level is called the geoid. 

Although a perfectly spherical globe is not quite accurate in representing the earth, when making globes the difference 
is too small to worry about since variations in manufacturing technique can be proportionally greater than the geoid’s 
deviation from a sphere. However, accurate regional maps require the earth to be modeled on an ellipsoid.
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Hemisphere

The largest part of a globe that you can see at one time is a hemisphere, or half of it. Any half of the globe is a hemi
sphere but some of them are named. The northern hemisphere is all areas north of the equator and the southern hemi-
sphere is all areas south of it. The eastern hemisphere and western hemisphere are not so rigorously defined. Normally 
the eastern hemisphere means a bit more than a hemisphere: all of Africa, Australia, and Eurasia, and the western 
hemisphere means North and South America.

Projections

Problems with globes

Globes are the best representation of the earth because all distance, areas, and shapes are proportionally correct. 
Unfortunately globes of any size are rather inconvenient to tote about and store, and detailed images of even a large 
country would require globes larger than a room. Using portions of a globe would work, but they still don’t lie down 
flat and would be like trying to store large potato chips (potato crisps) of all different sizes in book form.

Developable surface

To deal with this problem, ancient peoples created maps. The earliest maps only showed very small portions of the 
earth and were very serviceable without worrying about spheres and such nonsense; indeed, they were not made as 
replacements for globes at all. But the Greeks had grander plans, and by at latest 600 bc, the idea arose of projecting 
the globe onto a developable surface.3 This launched cartography, the science of mapmaking. 

A developable surface is a surface that is capable of being unrolled onto a plane. Without allowing a surface having 
ripples, creases, or tears (all of which have critical drawbacks), a cylinder; a cone, and a plane (which was 2-dimen-
sional to start with) are the only three objects that can be developed.

Distortion

Maps always show a distorted view of the earth because they are not curved in three dimensions. The cartographer 
(mapmaker) usually tries to make as accurate a map as possible, and that is why there are so many different projec
tions: each projection distorts the earth in a different way and the cartographer tries to pick one that works best for the 
area being mapped.4 

Types of distortion

These distortions come in two principal varieties. Areal inflation causes different regions on the map to have dispropor
tionate sizes with respect to each other. For example, many maps show Greenland to be larger than South America, 
when really it is less than 1/7th the size. Distortion of shape technically is called angular deformation, and it usually 
manifests itself as shearing, which means that map features are twisted or bent. Since globes have many properties and 
any of those properties can be destroyed by the projection, there are many other possible kinds of distortion. Some of 
these are scale distortion, which means that distances are not shown correctly with respect to each other; direction distor-
tion, which means that directions are not shown correctly; and interruption, which means that two points next to each 

3  Yes, the Greeks knew the earth was a sphere, and they knew its exact size. In fact, so did medieval Europeans. The 
myth that people thought the earth is flat owes most of its life to fanciful American biographer Washington Irving and 
French Academy scholar Antoine-Jean Letronne, who promoted the myth to illustrate how enlightened society had 
become. The subject that Columbus tried to turn into an issue was the size of the earth, not the shape. Columbus was 
wrong, and the scholars knew it. [Russell, Inventing the Flat Earth 1991]
4  At least, that is the theory. Actually most maps have been created using the best projection that also happens to be 
easy to draw. Until recently cartographers had no computers, so for practicality’s sake they used tables of coordinates 
that had been computed laboriously for a few common projections applied to certain areas of the earth.
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other on the globe are separated on the map.

Scale distortion

Areal distortion and angular distortion can exist independently of each other, so a given projection might have only 
one of those two kinds of distortion. However all projections have scale distortion so it often is used as a convenient 
measure for the accuracy of a map. The amount of scale distortion is indirectly related to the amounts of angular and 
areal distortion. A map has a stated scale called the nominal scale or principal scale, which is somewhat arbitrary but 
usually equals the scale of the center of the map.5 At any point of the map the scale may vary from the nominal scale, 
and the ratio of the two is called the scale factor at that point. Unless the projection has no angular distortion at the 
point being measured, the scale factor at that point will vary according to direction, and in that case the scale distor-
tion could be defined in many different ways. 

Geocart defines scale distortion at a point to be a complex average of scale error in every direction from that point. 
When computing the average, distortion is always positive; i.e., negative values cannot cancel positive values. 

You should strive to be aware of scale distortion in maps. On maps that cover large areas of the globe you simply 
cannot measure the distance from any point on a map to another, multiply by the nominal scale, and expect to have 
obtained a correct distance. The measured distance on a map depends upon the real distance, the projection, the 
nominal scale of the map, the orientation of the globe before projecting, and the extent of the map. You can rely on 
measured distances only if the scale distortion along the path you measure is constant and if you happen to know what 
that constant is. There are special maps used for measuring distances from a specific point to any other point on the 
globe, so you should use them instead whenever possible.

Tissot indicatrix

A map’s distortion at a point can be shown conveniently by the Tissot indicatrix, an ellipse whose size and amount of 
squash show you how much distortion the map has at the ellipse’s center. If the ellipse is a circle then it signifies no 
angular deformation. Change in the areas of the ellipses across the map signifies relative differences in areal inflation. 
Usually Tissot indicatrices are drawn at regular intervals on the graticule, rather than in isolation, so that you can com-
pare them in order to understand how distortion is distributed across the map.

Natural projections

The three developable surfaces give rise to the three natural projection classes that have members—true projections—
which can be displayed physically by projecting a light source through a transparent globe onto a developable surface 
used as a screen. The classes are called cylindric, conic, and azimuthal (because all azimuths from the center are straight 
lines and their directions are true).

Within the natural projection classes are many projections that cannot be projected physically, but rather are derived 
mathematically. They still fit within the three classes because they have similar appearances and obey certain critical 
mathematical rules. Any representation of the globe or part of the globe on a flat surface, such as a sheet of paper, can 
be called a projection. 

5  Or, more precisely, the scale of the globe from which the map is being projected.
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	 Cylindric	 Conic	 Azimuthal

Mathematical projections

Other categories of projections arise as modifications of the basic three groups or as mathematical abstractions. Many 
taxonomic systems have been devised to describe them. The pseudocylindric group is universally accepted, being projec
tions whose meridians curve toward the poles and whose parallels are each straight and scale-invariant (scale is constant 
along its length). There are also references to pseudoazimuthal, polyconic, polycylindric, pseudoconic, and others.

Pseudocylindric

Geocart’s projection classes

Geocart’s projection menus consist of the cylindric, pseudocylindric, conic, and azimuthal 
groups mentioned before. In addition, a class of mathematically derived projections has been added that are both 

numerous and useful enough for their own designation: lenticular, or lens-shaped. These are projections whose 
meridians and parallels curve toward the poles and maintain or decrease their distances from each other going from 
the center of the map to the edges. Some writers herd some of these into the polyconic class and others into the pseu-
doazimuthal or miscellaneous classes, but this author has found their similarities to each other to be more useful than 

their lineage in describing their properties and has thus named and grouped them into a new class. One final 
miscellaneous class covers any that don’t fit into the others. 

	 	

	 Lenticular	 Miscellaneous

In practice the distinction between true projections and mathematical projections is not so useful. Indeed, many true 
projections are cartographically useless while many mathematical projections are valuable, which is why they were 
developed. All projections are described mathematically in the end, otherwise Geocart could not plot them. 
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Projection properties

The map on the left of the next page is conformal, which means it has no angular distortion: any small area’s shape is 
correct. But as you look toward the poles from the equator you see the circles becoming larger and larger, and in fact 
the poles cannot be shown because they are infinitely far from the equator. So a large area looks incorrect even though 
a small area does not because the different parts of the large area have the wrong sizes with respect to each other. On 
the other hand the map on the right has almost no correct shapes anywhere, but it has no areal distortion so it is called 
equal-area. If you measure the area of any region of the globe and then measure the area of the projected region on an 
equal-area map that has the same scale as the globe, you will find the two areas to be exactly equal. 

	 	

	 Correct local shapes but 	 Correct areas but 
	 Severe area distortion	 severe shape distortion

	 	

	 Tissot indicatrix	 Tissot indicatrix

No map can be both conformal and equal-area. Many maps are neither. Conformality (the property of being confor-
mal) is important in surveyors’ maps because conformal maps have no angular distortion and therefore local directions 
coincide with angles from map north. Conformality is also important for showing correct shapes in maps smaller 
than a hemisphere. Equivalence (the property of being equal-area) is important in maps approaching or exceeding a 
hemisphere in scope. At this size, areal inflation in conformal maps becomes plainly visible and should be avoided. 
Equal-area maps will distort the shape, but conformal maps will distort large shapes also. It is better to preserve sizes 
than to preserve neither shapes nor sizes. 

One may choose a compromise projection that is neither equal-area nor conformal but that has some other desirable 
property. There are many other interesting properties: minimum error, which provides the least scale (or some other) 
distortion possible for the mapped area; azimuthal, which gives correct directions to all locations from the center; 
retroazimuthal, which gives correct direction to the center from all locations; equidistant, which gives correct distances 
to all locations from one or two points (or, another meaning which states that all meridians have correct scale); perspec-
tive, which provides a natural view of the earth from high altitude; loxodromic, which provides straight rhumb lines; 



3.8

gnomonic, providing straight great circles. Or perhaps a particular shape is interesting or more æsthetic than another. 
All of these are legitimate reasons for choosing a specific projection. Some projections can have more than one of these 
properties, but many properties are mutually exclusive in the same way that conformality and equivalence are. 

Aspect

An aspect must be chosen when projecting the globe. Simply speaking, the aspect is the position from which the earth 
is viewed when it is projected. Historically the aspects have been divided into equatorial, or seen from the equator; 
polar, or seen from one of the poles; or oblique, which means seen from anywhere else. For example, in the middle 
map below the aspect is oblique, being centered at 45°N, 0°E. The aspect always corresponds to the point at the center 
of the map if the map is bilaterally symmetrical (the graticule is symmetrical about both the horizontal and vertical 
axes). In reality the idea of aspect is somewhat arbitrary because the polar aspect occurs at only two points, the equato-
rial aspect covers an entire great circle, and the oblique aspect covers everything except one great circle and two points. 
These unbalanced definitions made sense from a computational standpoint in times past: conics and cylindrics are 
easily computed in the equatorial aspect and azimuthals are simple in polar aspect. 

	 	 	

	 Equatorial aspect	 Oblique aspect	 Polar aspect

But programs like Geocart obviate the old reasons for doing things. Now any aspect is as feasible as any other. Because 
the concept of aspect is, in a sense, outdated, Geocart uses the idea of the projection center instead. The projection 
center is a numerically precise expression of aspect. The polar aspects have projection centers of 90°N or 90°S with 
any longitude. The equatorial aspect’s projection center is 0°N with any longitude, and the oblique aspects have any 
other projection center. You may consider the polar and equatorial aspects to be special cases of the oblique aspect, and 
Geocart always to be working in oblique aspect. Most projections default to a projection center of 0°N, 0°E or 90°N, 
0°E.6 The exceptions are those few projections whose centers are important in the definition of the projection, such as 
Briesemeister or GS50. Some projections have no clear notion of projection center because they have no symmetry.

If a projection is a simple perspective, like the circular ones in this chapter, then its oblique aspect looks perfectly 
natural—just like what you see when you look at a globe. But almost all projections are mathematical, not perspective, 
and since the shapes of their graticules were made for the equatorial aspect they often look unusual when displayed 
in oblique and polar aspects (azimuthal projections look normal in polar as well). Of the following maps, the first is 
equatorial aspect, the last is polar, and the remainder are oblique. 

	 	 	

	 Center 0°N, 0°W	 Center 15°N, 15°W	 Center 30°N, 30°W

6  As a matter of fact, Geocart does not base any actions or computations on a projection’s category.
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	 Center 45°N, 45°W	 Center 60°N, 60°W	 Center 75°N, 75°W

		

		  Center 90°N, 90°W

Transversal rotation

Besides changing the center of the projection, it is possible to rotate the globe around the projection center before pro-
jecting. This is called transversal rotation. If the aspect is equatorial and the rotation is 90° then a transverse projection 
results wherein the poles of the globe lie on the original equator of the projection. Of the following maps the first is a 
standard equatorial aspect and the last is a transverse projection. 

	 	 	

	 Rotate 0°	 Rotate 15°	 Rotate 30°

	 	 	

	 Rotate 45°	 Rotate 60°	 Rotate 75°

		

		  Rotate 90°

Most texts and mapping programs have you specify the coordinate on the original globe that you will be moving the 
north pole to when rotating the globe. As shown above, Geocart requires a rotational angle instead.

To restate, you can rotate the globe three independent ways before projecting: longitudinal, spinning the globe on its 
natural axis to bring a particular meridian to the projection center; latitudinal, bringing a particular latitude to the 
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projection center; and transversal, spinning the earth around the axis formed by the projection center and the center of 
the globe. Longitudinal and latitudinal rotations are automatic when you specify the projection center.

	 	 	

	 Longitudinal rotation	 Latitudinal rotation	 Transversal rotation

As you may have noticed by now, none of the rotations applied to the globe ever change the shape of the map’s outline. 
If the rotation is only longitudinal then even the graticule looks the same (if the angle of rotation is an integer multiple 
of the graticule’s resolution). Latitudinal and transversal rotations both change the appearance of the graticule. 
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Chapter 4: Documents, Windows, Maps
This chapter describes Geocart documents, their display in windows, and how to place maps.

Documents

Geocart works with documents as its fundamental medium. A document is the space upon which you lay out your art-
work, such as maps and images. When saved, a single document corresponds to a single file on disk. A document has 
a title, which is the file name, or, if you have not saved it yet, a title of Untitled. (On Macintosh, there will be only 
one document Untitled, and after that they will be Untitled X, where X is some number intended to make the 
name unique amongst open documents that have not yet been saved.)

You use the File menu to open and close documents. The number of documents you can have open at once is lim-
ited only by the amount of memory your machine has. You may freely specify the dimensions of a document (see 
Document Layout). You will want your document to be at least as large as the map you are making. If you intend to 
print onto paper medium, you probably want your document size to coincide with the sheet size.

A document may contain any number of images and maps. Collectively these, and groups of these (see the Group 
command of the Object menu), are document objects. To help you position them, you can display rulers at the top and 
left edges of the document’s window.

You may move document objects around in the document’s space by selecting them and dragging them to where you 
want them to be. Releasing the mouse button finishes the drag operation. There is no way to move a document object 
entirely outside the document’s area, though it may hang partially off. You may also use the arrow keys to “nudge” doc-
ument objects in the direction of the arrow by one pixel on-screen. Hold down the shift key to nudge by 10 pixels.

Document objects have an implicit front-to-back ordering, in a stack. This ordering determines the order in which 
objects get drawn, and therefore which will be seen when opaque objects overlap. You can change the front-to-back 
ordering in the stack using commands from the Object menu.

Document objects, maps in particular, often contain fully and partially transparent parts. The position of the docu-
ment object in the front-to-back stack determines how these areas of transparency will render.

Windows

Every open document has its own window, or possibly several (see View > New). A window is a view into a docu-
ment’s contents. The space of the document is represented as a white background within the window. Areas outside of 
the document are represented as gray, and have no function.

The window may be smaller or larger than the document. If smaller, the window will have a scroll bar along the 
dimension in which it is smaller. Scroll bars let you to shift the view around so that you can see areas of the document 
that were out of sight. See your operating system’s instructions for detailed information on sizing, rearranging, and 
scrolling around in windows.

A document window has a magnification factor. At 100%, your document displays at real-world size according to 
your display settings (see Preferences > Display). At 50%, your view into your document is half of real size. You may 
change the window’s magnification using the magnifying glass.

Because you may specify your maps to be any reasonable resolution, a window may show less detail than actually exists 
in the map. Or, it may magnify the map beyond the level of detail it actually contains, giving a large, blurry represen-
tation. You can see a map at the resolution it is specified, so that one map pixel corresponds to one screen pixel, using 
Actual Pixels of Selected Objects.
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Besides document windows, Geocart has several palette windows. Palettes float above document windows, so they are 
never obscured when Geocart is the front application. When you work in other applications, so that Geocart is no 
longer in front, the palettes disappear. They reappear when you resume work in Geocart.

A document window

Tool palette

The Tool palette, which is always present, contains tools for controlling what mouse gestures do. The tools are 
modal; that is, when you select a different tool, the meaning of a click or drag changes. You select a tool by 
clicking on it in the palette window.

Arrow pointer

The arrow pointer is for selecting document objects. It works just like the arrow pointer in any normal context 
on your computer. As with all tools, as you move the arrow pointer over a map, information for each point gets 

displayed in the Information palette.

Type S to switch to the arrow pointer using the keyboard.

Grabber tool

The grabber tool is for panning around within a window. It is akin to using scroll bars but can be faster, especially if 
your document is large or you view it under high magnification. Select the grabber tool in the Tool palette to use it, 
and then, clicking in the document window and holding down, “drag” the document in the opposite direction of the 
contents you want to reveal. Release the mouse button when you have finished dragging. If a window already contains 
a document’s edge, then you cannot drag further away from that edge. Hence if the window’s view already shows the 
entire document then the grabber tool has nothing to do and will be inoperative.

Type H to switch to the grabber tool using the keyboard, or depress the space bar to use it while the space bar is down.

Magnifying glass

The magnifying glass zooms the window view in or out. After you select the magnifying glass, you can click in a win-
dow. The magnification of the window’s view will increase to the next increment, and the content at the location you 



  Documents, Windows, Maps 4.3

clicked will shift to the center of the window if it can. Used alone, the magnifying glass zooms in the window’s view, 
blowing up the pixel’s sizes up to a limit of 4,000%. This does not increase the detail of the map; it merely allows you 
to uncover whatever detail it has, and beyond that, to examine that detail in larger and larger pixels. If you hold down 
the option key (Mac) or ALT key (Windows) when clicking, then the magnifying glass becomes a shrinking glass, 
ratcheting down the magnification in increment with each click. The minimum magnification is 5%.

You may click-and-drag instead of just clicking: Continue pressing the mouse button from your original click and drag 
the pointer around. Click-and-drag magnifies the window view so that the area you dragged across fills the window.

Type Z to switch to they magnifying glass using the keyboard.

Crosshairs

The crosshairs lets you pinpoint a location on your map for which you want detailed information, such as geographic 
coordinates. As you move the crosshairs over a map, information for each point gets displayed in the Information pal-
ette. While this is true of all tools, the crosshairs lets you see more easily just which point you are hovering over. Unlike 
other tools, clicking has no effect when you are using the crosshairs, and neither does dragging.

Type M to switch to the crosshairs using the keyboard.

Navigator

The navigator gives you a shrunken view of the entire document and the ability to quickly pan to any section of it. See 
Navigator for details.

Information palette

The Information palette displays information about the document object over which the mouse tool is hovering. See 
Information for details.

Maps

A document may contain any number of maps. Maps are drawn from a collection of attributes, all of which you have 
control over. Attributes are things like the projection, the graticule characteristics, the line styles, and the geographic 
databases used in the map. You can choose to turn on or off the drawing of any of these attributes. Hence a map may 
even be present but not visible.

You can add a map to a document in several ways:

•	 By using the New command from the Map menu.

•	 By holding down the shift key (Mac) or SHIFT key (Windows) while selecting a projection from one of 
the six projection menus.

•	 By pasting a map that you previously copied or cut. (See Copy and Cut).

Map layers

A map consists of up to three layers of content:

•	 Raster imagery. (Lowest layer, drawn first.)

•	 Vector imagery. (Middle layer, drawn second.)

•	 Graticule, text, and metric line layer. (Upper layer, drawn last).

You cannot manipulate the layers directly. If you change the settings or databases used to draw the content of a layer, 
then the affected layers will get rendered anew.
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Selecting maps

A map must be in the document of the front window in order to make changes to it. The map (or maps) you want to 
change also must be selected. You select a map by positioning the mouse pointer over the map and clicking the mouse 
button. To select two maps, you can click somewhere away from both maps, and, holding down the mouse button, 
dragging the highlight rectangle over both maps. This works for more than two maps as well. If some maps are already 
selected and you want to select more, click on each of the other maps you want selected while holding down the shift 
key. This also works for dragging. These instructions apply to any document object.

A map has a bounding rectangle that is a little larger than the smallest rectangle that can contain the map. It is this 
bounding rectangle that comprises the document object, not the shape of the map. Hence, when you click or other-
wise select a map, it suffices to click anywhere in the bounding rectangle even if the area you click on appears empty. 
When selected, the entire contents of the bounding rectangle turns a light pink.

Bounding rectangle

Modifying maps

You will use menu commands to make changes to maps. Some changes may only apply to one map at a time; in those 
cases the menu command for that change will not be available when multiple maps are selected. 

Undrawn areas of a map are transparent. Maps may overlap each other. In fact there is no way to tell that two maps are 
superimposed if they have the same attributes. If a map that you want to select is obscured by another map, you must 
first move the top map or send it behind the other maps (see Send Backward) before you click on the map you want.

Geocart begins drawing a map after every change you make in its attri-
butes. Scrolling, map movement, and most operations from the menus 
can occur in parallel with map drawing; thus you need not wait for 
drawing to finish before manipulating the map. Drawing also occurs in 
the background while you are using another application.

You can tell whether a map is drawing or queued up for drawing: The 
upper left corner will contain a rotating indicator. When Geocart is able 
to estimate a completion time span, it will note it to the right of the 
indicator. The indicator disappears when the map has finished drawing.
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Chapter 5: Examples
This chapter shows you how to create lots of different kinds of maps, step-by-step. Besides being a good way to 
familiarize yourself with Geocart, there is a good chance that a map similar to the one you are trying to make appears 
here.

Examples consists of all or part of:

Theme or general description of the desired map.

Analysis of the attributes of the ideal projection for the map.

Conclusion to select a particular projection.

Requirements of the map outside of the projection itself.

Process to give step-by-step instructions for constructing the map.

Technical Note that explains calculations that led to the Conclusion.

You should examine Appendix A: Which projection is best? and Appendix B: Projection gazetteer in order to understand 
why the Conclusion of each example chooses the specific projection.

The earlier examples contain most of the information needed for printing or exporting the map for an illustration or 
image editing program.

The Examples

	 1.	 A base map for world mineral deposits.

	 2.	 A general reference world map.

	 3.	 A base map for showing world precipitation statistics.

	 4.	 A base map from which to make a globe.

	 5.	 A base map for showing corporate sales activity.

	 6.	 A set of globe views to show the entire earth ‘naturally’.

	 7.	 A map to measure distances and directions from Mecca.

	 8.	 Two hemispheric maps to show the world accurately.

	 9.	 A base map of the Americas for reference.

	 10.	 A base map of Eurasia for showing railroads.

	 11.	 A political map of Africa.

	 12.	 A base for a road map of the United States.

	 13.	 A high-accuracy map of Japan.

	 14.	 A base for a cultural map of France.

	 15.	 Small-scale, high resolution raster reprojection.

	 16.	 Large-scale reprojection with datum shift.
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Example One 
A base map for world mineral deposits

Analysis	 Mineral deposits do not depend on latitude, so we are not forced to use a cylindric, 
pseudocylindric, or even equatorial aspect projection. But this kind of theme map presents 
spatial data, so it should be equal-area. We can emphasize land masses since very little mining 
occurs at sea. The distribution of some mineral deposits depends somewhat on the primeval 
Pangæan land mass, so it would be nice to display the map in a fashion that emphasizes the 
common origin of the continents.

Conclusion	 Briesemeister fits all the above requirements.

Requirements	 There is little need for a graticule, lakes, or river data. The base map is to be exported for 
embellishment using a graphics program, suitable for print.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the Map menu, select New to create a map.

4.	 From the  (Lenticular) menu, select Briesemeister.

5.	 From the Map menu, select Nominal Scale to open the Nominal Scale dialog box.

6.	 Enter 200000000 as your map scale into the top field. 
This give a map scale of 1: 200,000,000. Click OK.

7.	 From the Map menu, select Line Styles to open the 
Line Styles dialog box.

8.	 Select the top level Graticule coverage at the left. At 
the right, under Definition for this coverage, select Hide 
coverage and all children from the pop-up menu. This 
removes the graticule from the map. Click OK.

9.	 From the File menu, select Save As, and save your map 
as World Mineral Deposits.

10.	 From the Map menu, select Map Size and Resolution. 
In the Resolution field, select pixels/inch from the pop-up 
menu, and enter a value of 300. This provides detail for 
printing Click OK. 
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Result

Example One Result—Base map for world mineral deposits

11.	 From the File menu, select Export Selected Items.

12.	 Enter World Mineral Deposits as the file name.

13.	 Select JPEG as the export file type. Click Export.

14.	 Click OK to accept the default settings for the JPEG export.

15.	 You can now open this file into Adobe Illustrator or another graphics editing program to complete the 
map details.

Note: You can set your preferences for the units of measure for displaying and working with documents from the File, 
Preferences, General window. For more information on how to change these settings, refer to the Preferences dialog 
box.
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Example Two 
A general reference world map

Analysis	 A general reference world map requires many compromises, but it is not clear that 
compromising area fidelity gains anything, so we will require an equal-area map. Since we 
will display the graticule, we will allow mildly curved parallels in order to help reduce angular 
distortion. We will also allow the poles to be stretched into lines for the same reason. It would 
be nice to keep any continent from having breaks in it. It also would be nice if the map were 
vaguely rectangular in shape since the paper is. We don’t want anything to look too odd.

Conclusion	 Juggling this wish-list is not easy. Avoiding breaks in continents requires a slight reorientation 
of the globe before projecting it, so that it is centered on 11°E, 11°S. A rectangular shape (a 
cylindrical projection) is blatantly incompatible with the other requirements, but we can come 
close by choosing Strebe-Kavrayskiy V.

Requirements	 The map needs a graticule, international borders, lakes, and river data in addition to 
physiography, in detail suitable for Web graphic presentation. The map will be completed in an 
illustration program, and requires colored lines to distinguish features.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the  (Lenticular) menu, hold down shift and select Strebe equal-areas: Kavraiskiy V. Allow 
Geocart to finish drawing the map.

4.	 From the Map menu, select Databases to open the Databases dialog box.

5.	 Click Add Installed Database.

6.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

intl borders.mcam 
lakes.mcam 
major rivers.mcam

7.	 Click Open.

8.	 You should now see the four selected databases in the Databases to draw on the map list with the default 
Stylized World Topo 5400x2700.raw file.

9.	 Click OK. Allow Geocart to finish redrawing the map.

10.	 From the Projection menu, select Projection Center. Enter 11°E into the Latitudinal field and 11°S 
into the Longitudinal field. This procedure centers the projection at a place that prevents any land masses 
from being broken up.

11.	 Click OK. Allow Geocart to finish redrawing the map.

12.	 From the Map menu, select Line Styles to open the Line Styles dialog box.

13.	 From the left, select Coverage: Political: International de facto, and at the right, under Definition for this 
coverage, select Define new attributes from the pop-up menu. Click on the Stroke color control below to 
open the Color picker. Select some shade of red for international borders.

14.	 Click OK to close the Line Styles dialog box and allow Geocart to finish redrawing the map.

15.	 From the Map menu, select Graticule to open the Graticule dialog box.
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16.	 Enter 10° for both Parallel spacing and Meridian spacing.

17.	 In the Pruning Options section, enter 20° for North pole, primary and South pole, primary, then enter 
10° for North pole, secondary and South pole, secondary. This will remove some of the meridians as they 
approach the poles and will keep the map less crowded. Click OK.

18.	 From the Map menu, select Scale to Document. Allow Geocart to finish redrawing the map. 

Result

Example Two Result—General reference world map

19.	 From the File menu, select Save As and save the map as General Reference Map.

20.	 From the File menu, select Export Selected Items.

21.	 Enter General Reference Map as the file name.

22.	 Select PDF as the export file type.

23.	 You can now open this file with Adobe Illustrator or another graphic editing application to complete the 
map details.
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Example Three 
A base map for showing world precipitation statistics

Analysis	 Precipitation at some location depends on many factors, one of which could be latitude 
(prevailing winds and ocean currents depend somewhat on latitude). Thus we should choose 
a projection that shows parallels as straight lines. The relationship of land forms to ocean is 
important, so we probably ought not interrupt the map. Precipitation levels are a form of 
spatial datum and properly require an equal-area map.

Conclusion	 Eckert IV meets the demands.

Requirements	 The map needs a graticule, lakes, and river data in addition to coastlines. The map must be 
13 cm (5″) wide with a resolution suitable for textbook printing, will be completed in an image 
editing program, and requires colored lines to distinguish features.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the Map menu, select New to create a map.

4.	 From the  (Pseudocylindric) menu, select Eckert: IV.

5.	 From the Map menu, select Databases to open the Databases dialog box.

6.	 Click Add Installed Database.

7.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

coastlines.mcam 
lakes.mcam 
major rivers.mcam

8.	 Click Open.

9.	 Select Stylized World Topo 5400x2700.raw from the Databases to draw on the map list. Click 
Remove.

10.	 You should now see just the three selected databases in the Databases to draw on the map list. Click OK.

11.	 From the Map menu, select Line Styles.

12.	 Select Coverage: Ocean: Coast, and at the right, under Definition for this coverage, select Define new attributes 
from the pop-up menu. Click on the Stroke color control below to open the Color picker. Select a medium 
gray for coastlines.

13.	 Click OK to close the Line Styles dialog box.

14.	 From the Map menu, select Map Size and Resolution. Set the Width units to cm. Enter 13 into the 
Width field. Set the Resolution units to pixels/inch. Enter 300 into the Resolution field. Click OK. 
Allow Geocart to finish drawing the map.
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Result

Example Three Result—Base map for world preciptation statistics

15.	 From the File menu, select Save As and save the map as World Precipitation Statistics.

16.	 From the File menu, select Export Selected Items.

17.	 Select JPEG as the export file type.

18.	 You can now open this file into an image editing program to complete the map details.
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Example Four 
A base map from which to make a globe

Analysis	 We need a projection whose meridians are evenly spaced and whose poles are the correct 
distance from the equator. Parallels should meet the meridians at right angles to form a smooth 
joint with the next neighboring segment when curled around a ball.

Conclusion	 Rectangular polyconic is ideal.

Technical Note	 Using the Distortion Visualization facility from the Map menu, the distortion characteristics 
of the rectangular polyconic within the 30° central segment were verified to be as good or 
better than other obvious candidates, such as sinusoidal, transverse plate carrée, or American 
polyconic.

Requirements	 This will be a base map to glue onto a ball of 20 cm circumference. It requires only 
physiography and graticule, and will be printed on a 2400 dpi inkjet printer, yielding better 
than 300 dpi contone.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the  (Conic) menu, hold down shift and select rectangular polyconic.

4.	 From the Map menu, select Nominal Scale to open the Nominal Scale dialog box. 
The earth’s radius is 6,371,007 meters, or 637,100,700 cm. (You can see this in the Datum dialog box, 
Semiminor axis, accessible off the Projection menu by selecting Datum.) That gives a circumference of 2 × 
π × 637,100,700 cm = 4,003,021,757 cm. The ball is 20 cm, so the map’s scale will be 20: 4,003,021,757 
= 1: 200,151,087.

5.	 Enter 200151087 as the scale. Click OK.

6.	 From the Projection menu, select Parameters. Enter a Standard Parallel of 0°. The Latitude of origin does 
not matter. Click OK.

7.	 From the Map menu, select Graticule. Enter 15° in both Parallel spacing and Meridian spacing fields.

8.	 In the Pruning section, enter 15° for North pole, primary and South pole, primary. Deselect Secondary for 
both north pole and south pole. Click OK.

9.	 From the Map menu, select Databases to open the Databases dialog box.

10.	 Click Add Installed Database.

11.	 Select the following file:

coastlines.mcam

12.	 Click Open. You should now see coastline.mcam in the Databases to draw on the map list with the 
default Stylized World Topo 5400x2700.raw file. Click OK.

13.	 From the Map menu, select Line Styles.

14.	 On the left, under Line Type / Coverage, Select Graticule coverage. Type 4 2 as the Dash pattern.

15.	 Select the Coverage: Ocean: Coast line type, and at the right, under Definition for this coverage, select Define 
new attributes from the pop-up menu. Click on the Stroke color control below to open the Color picker. 
Set 
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Red: 100

Green: 170

Blue: 180

16.	 Click OK. This gives a light halo to the coastlines.

17.	 From the Map menu, select Final Quality.

18.	 From the Projection menu, select Interruptions: Gores, and set the number of gores to 12.

19.	 From the File menu, select Save, and save your map as Globe.

Result

Example Four Result—Globe gores

20.	 If you wish to print: From the Map menu, select Map Size and Resolution. In the Resolution field, select 
pixels/inch from the pop-up menu, and enter a value of 300. Click OK. This increases the detail of the map 
to make it suitable for printing. Wait for the map to image. Select Print from the File menu and follow 
the usual instructions for your operating system.
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Example Five 
A base map for showing corporate sales activities

Analysis	 No technical aspect of a corporate sales map needs to be especially accurate. A pleasing overall 
shape combined with recognizable land shapes suffices. Oceans and Antarctica are irrelevant.

Conclusion	 Armadillo is fine.

Requirements	 The map needs no graticule and no physiography other than coastlines. International and 
U.S. state borders should be emphasized. Level of detail should be suitable for overhead 
presentation.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the Map menu, select New to create a map.

4.	 From the  (Miscellaneous) menu, hold down shift and select armadillo.

5.	 From the Map menu, select Databases to open the Databases dialog box.

6.	 Select the default Stylized World Topo 5400x2700.raw database that is already listed under 
Databases to draw on the map. Click Remove so that the database does not get drawn.

7.	 Click Add Installed Database.

8.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

Intl borders.mcam 
coastlines.mcam 
lakes.mcam 
provinces.mcam

9.	 Click Open. We include lakes so that the Great Lakes and other major bodies will be present. The 
coastlines.mcam database does not include them.

10.	 You should now see Intl borders.mcam, coastline.mcam and provinces.mcam in the 
Databases to draw on the map list. Click OK.

11.	 From the Projection menu, select Projection Center.

12.	 Enter 11° for Longitudinal. This will show more of Australia on the map.

13.	 From the Map menu, select Line Styles.

14.	 Select the Graticule line type, and at the right, under Definition for this coverage, select Hide coverage and all 
children from the pop-up menu.

15.	 Select the Coverage: Ocean: Coast line type, and at the right, under Definition for this coverage, select Define 
new attributes from the pop-up menu. Set the Stroke color to something brownish. (You can click on the 
rectangle to the right of Stroke color to bring up a color picker.) Enter 1 for the Width (points).

16.	 Select the Coverage: Political boundary: International de facto line type, and at the right, under Definition for 
this coverage, select Define new attributes from the pop-up menu. Set the Stroke color to something reddish. 
Enter 2 for the Width (points).

17.	 Select the Coverage: Political boundary: Provincial line type, and at the right, under Definition for this 
coverage, select Define new attributes from the pop-up menu. Set the Stroke color to a medium gray. Enter 1 
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for the Width (points).

18.	 Click OK.

19.	 From the File menu, select Save, and save your map as Corporate Sales Activities.

Result

Example Five Result—Corporate sales activities base map

20.	 From the File menu, select Export document.

21.	 Export the file as Corporate Sales Activities, and select JPEG for the Save As Type.

22.	 Click Save.

23.	 Your map can now be imported into a graphics program for finishing.
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Example Six 
A set of globe views to show the entire earth ‘naturally’

Conclusion	 Orthographic is the only “globe view” from a distance.

Requirements	 The basic map will be a cloudless satellite view. We will form a ring of six hemispheric views 
surrounding a seventh. The maps are to be read into an image editing program.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the  (Azimuthal) menu, hold down shift and select orthographic.

4.	 From the Map menu, select Databases. In Databases to draw on the map, select the default:

Stylized World Topo 5400x2700.raw 

5.	 Click Deactivate so that the database does not get drawn.

6.	 Click Add Installed Database.

7.	 Select the following file:

world.topo.2004.3x2700x1350.raw

8.	 Click Open. You should now see the world.topo.2004.3x2700x1350.raw database with a + sign 
beside it, and the Stylized World Topo 5400x2700.raw database with a – sign beside it in the 
Databases dialog box. Click OK.

9.	 From the Map menu, select Line Styles.

10.	 Select the Graticule line type, and at the right, under Definition for this coverage, select Hide coverage and all 
children from the pop-up menu. Click OK.

11.	 From the Edit menu, select Copy.

12.	 From the Edit menu, select Paste. 

13.	 From the Edit menu, select Paste or type command+V (Mac) or CTRL+V (Windows) another five 
times so that you have a total of seven identical maps.

14.	 Drag one of the maps to the 12:00 position, repeat this step, moving the maps to 2:00, 4:00, 6:00, 8:00, 
and 10:00 positions. Your arrangement should resemble this: 
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Seven identical orthographic maps

15.	 Select the map at the 12:00 position.

16.	 From the Projection menu, select Projection Center. Enter the values:

Latitudinal: 90N

Longitudinal: 30N

Transversal: 0

17.	 Click OK.

18.	 Repeat the last step for the remaining maps according to the settings below:
Position Latitudinal Longitudinal Transversal

center 0°N 0°N 0°
02:00 30°N 60°E 60°
04:00 30°S 120°E -60°
06:00 90°S 180°E 0°
08:00 30°S 60°W 60°
10:00 30°N 120°W -60°

19.	 From the Edit menu, select Select All.

20.	 From the Map menu, select Final Quality.

21.	 From the File menu, select Size Document to Content. Accept the default values and click OK.

22.	 Your layout should now look like the result.
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Result

Example Six Result—Orthographic hemisphere views

23.	 From the File menu, select Save, and save your map as Views of Earth.

24.	 From the File menu, select Export document.

25.	 Export the file as View of Earth, and select JPEG for the Save As Type.

26.	 Click Save.
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Example Seven 
A map to measure distances and directions from Mecca

Analysis	 For correct distances and directions there are two reasonable candidates: plate carrée and 
azimuthal equidistant. Azimuthal equidistant requires a protractor to measure directions 
between displayed azimuths, whereas plate carrée requires only a ruler. Plate carrée, however, 
badly distorts the region around the point of interest.

Technical Note	 Note that this is an inversion of the usual “Qibla problem”. The usual problem is to find the 
direction to Mecca for the Muslim prayer. Use one of the retroazimuthal projections for that 
purpose.

Conclusion	 Plate carrée, with Mecca moved to the south pole, makes trivial direction measurements.

Requirements	 The map does not need the regular graticule, but only one for showing distance and direction. 
There is no need for political borders and waterways. The map will be printed.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the Map menu, select New to create a map.

4.	 From the  (Cylindric) menu, select plate carrée.

5.	 From the Map menu select Map Size and Resolution. Select pixels/inch from the Resolution pop-up menu. 
Set the Resolution value to 300. Click OK.

6.	 From the Edit menu, select Copy.

7.	 From the Edit menu, select Paste to create a copy of your map.

8.	 Select the new map.

9.	 From the Map menu, select Databases. Select

Stylized World Topo 5400x2700.raw 

10.	 Click Deactivate. Click OK.

11.	 From the Map menu, select Graticule. In the Pruning Options section, uncheck North pole, primary and 
South Pole, primary. At the upper right, uncheck Tropics and Polar circles. Click OK.

12.	 You should now have one map that shows only graticule lines. Drag this map so that it does not overlap 
the original map.

13.	 Select the original map.

14.	 From the Map menu, select Graticule. Uncheck Draw parallels and Draw meridians. Click OK.

	 Referring to an atlas, we find that Mecca is located at 25°21′N, 39°49′E. To place Mecca at the south pole, 
we must add 90° to its latitude to determine which location must become the center of the map.

jcenter = 25°21′N + 90° = 115°21′N

	 But this value is greater than 90°, which means we have moved to the back side of the globe. We subtract 
the latitude from 180° to get the real latitude, and subtract 180° from the longitude to compute the 
longitude at the other side of the globe:
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jcenter = 180°N - 115°21′N = 64°39′N
jcenter = 39°49′E - 180°E = 140°11′W

	 Further, when we went to the back side, we reversed our orientation, so we need to rotate the projection 
180°. 

15.	 From the Projection menu, select Projection Center. Enter the values:

Latitudinal: 64/39N

Longitudinal: 140/11W

Transversal: 180

16.	 Click OK.

17.	 From the Edit menu select Select All. 

18.	 From the Object menu select Align Multiple.

19.	 From the File menu, select Save, and save your map as Globe.

Result

Example Seven Result—Distances from Mecca base map

20.	 From the File menu, select Print.

21.	 Follow your normal procedures for printing.

Note: Mecca is stretched into the line at the bottom of the map. Compute distances from Mecca by measuring the 
length of the vertical line from the destination to the bottom of the map, and then multiplying by the map’s scale. 
Compute direction to the destination by measuring the horizontal distance from the central vertical line to the 
destination point (points to the left of center are negative). Divide that by the map’s width, and then multiply by 360°. 
That gives the distance in units of arc. Multiply by 111.1 km for kilometer values.
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Example Eight 
Two hemispheric maps to show the world accurately

Analysis	 Many projections exist which could be used for hemispheres, but the prime concern here is 
overall map accuracy rather than some specific feature.

Conclusion	 Airy is a good choice, with a 90° optimization radius from center.

Requirements	 We will show waterways, international borders, and graticule in addition to coastlines. The map 
will be exported to an illustration program for completion, with resolution suitable for Web 
presentation.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the Map menu, select New to create a map.

4.	 From the  (Azimuthal) menu, select Airy.

5.	 From the Map menu, select Boundaries. In the Boundaries (Before Projecting) pane, Small Circle item, set 
the Radius to 90. This pares down the map to a hemisphere. Click OK.

6.	 From the Map menu, select Databases to open the Databases dialog box.

7.	 Click Add Installed Database.

8.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

intl borders.mcam 
lakes.mcam 
major rivers.mcam

9.	 Click Open.

10.	 You should now see the three selected databases in the Databases dialog box with the default 
Stylized World Topo 5400x2700.raw file.

11.	 Click OK. Allow Geocart to finish redrawing the map.

12.	 From the Map menu, select Line styles.

13.	 Select the Coverage: Political boundary: International de facto line type, and at the right, under Definition for 
this coverage, select Define new attributes from the pop-up menu. Set the Stroke color to something reddish. 
(You can click on the rectangle to the right of Stroke color to bring up a color picker.) Enter 0.5 for the 
Width (points).

14.	 From the Projection menu, select Parameters.

15.	 In the Parameters dialog box confirm that 90° is set as the Radius of minimum error. This will optimize 
the projection for a radius of 90 arc degrees from the center in all directions, which is a hemisphere. Click 
OK.

16.	 From the Map menu, select Graticule.

17.	 Ensure that the Pruning Options for the North pole, primary and South pole, primary are selected and that 
they are pruned at 30°. Ensure that the Pruning Options for the North pole, secondary and South pole, 
secondary are selected and that they are pruned at 15°. Click OK.
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18.	 From the Edit menu, select Copy and then Paste.

19.	 Drag the copy of your new map adjacent to the original map.

20.	 Ensure that your second map is selected.

21.	 From the Projection menu, select Projection Center.

22.	 Enter 0° as the Latitudinal rotation. This gives centers the projection on the equator. Enter 70°E as the 
Longitudinal rotation. This centers the projection in the eastern hemisphere. Click OK. Allow Geocart to 
finish drawing the map.

23.	 Select the first map.

24.	 Select Projection Center from the Projection menu.

25.	 Enter 0° as the Latitudinal rotation. This gives centers the projection on the equator. Enter 110°W into 
the Longitudinal box. This centers the map in the western hemisphere. Click OK.

26.	 Allow Geocart to finish drawing the map. Now arrange the two maps so that they resemble the result.

Result

Example Eight Result—Double hemispheric map

27.	 From the File menu, select Export Document.

28.	 Enter Hemispheres as the file name.

29.	 Select PDF as the export file type.

30.	 You can now open this file into Adobe Illustrator or another graphics editing program to complete the 
map details.
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Example Nine 
A reference base map of the Americas

Analysis	 Again, the primary concern here is overall map accuracy.

Conclusion	 Bipolar oblique conic conformal was created exactly for this task.

Requirements	 We will show waterways, international borders, and graticule in addition to physiography.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the Map menu, select New to create a map.

4.	 From the  (Conic) menu, hold down shift and select bipolar oblique conic conformal.

5.	 From the Map menu, select Databases to open the Databases dialog box.

6.	 Click Add Installed Database.

7.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

intl borders.mcam 
lakes.mcam 
major rivers.mcam

8.	 Click Open.

9.	 You should now see the three selected databases in the Databases dialog box with the default 
Stylized World Topo 5400x2700.raw file.

10.	 Click OK. Allow Geocart to finish redrawing the map.

11.	 From the Map menu, select Line Styles to open the Line Styles dialog box.

12.	 Select the Map: Boundary line type, and at the right, under Definition for this coverage, select Hide coverage 
and all children. This turns off drawing of the outer boundary.

13.	 Select the Coverage: Drainage: Lake line type, and at the right, under Definition for this coverage, select 
Define new attributes from the pop-up menu. Enter 0.2 for the Width (points).

14.	 Select the Coverage: Drainage: River line type, and at the right, under Definition for this coverage, select 
Define new attributes from the pop-up menu. Enter 0.5 for the Width (points).

15.	 Select the Coverage: Political boundary: International de facto line type, and at the right, under Definition for 
this coverage, select Define new attributes from the pop-up menu. Set the Stroke color to red. (You can click 
on the rectangle to the right of Stroke color to bring up a color picker.) Enter 0.5 for the Width (points).

16.	 Click OK.

17.	 From the Map menu, select Nominal Scale to open the Nominal Scale dialog box.

18.	 Enter a value of 1500 km/cm. Click OK.

19.	 From the Map menu, select Graticule to open the Graticule dialog box.

20.	 Ensure that Draw parallels is checked and enter 10° for the Parallel spacing.

21.	 Ensure that Draw meridians is checked, and enter 10° for the Meridian spacing.
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22.	 In the Pruning Options section, ensure that North pole, primary and South pole, primary are checked, and 
enter 10°. Deselect North pole, secondary and South pole, secondary.

23.	 Click OK. Allow the map to draw to completion. It should look like this:

24.	 From the Map menu, select Boundaries.

25.	 In the Cropping (After Projection) section, drag out a rectangle to clip out bulging portions of the map, 
similar to this:

26.	 Click OK. Allow the map to draw to completion.

Result

Example Nine Result—Bipolar oblique conic map of the Americas
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Example Ten 
A base map of Eurasia for showing railroads

Analysis	 The primary requirement for a railroad map is minimum scale distortion. There is no need 
for special directional properties nor even, technically, any need for strictly correct shapes 
(conformality). Unfortunately, Eurasia is both huge and uncooperatively shaped.

Conclusion	 Classically, such a map would be based on Albers equal-area conic, Lambert conformal conic, 
or Lambert azimuthal equal-area. But we can wring the most accuracy out of Chamberlin 
trimetric, which excels in minimizing scale error in oval-shaped regions. The bounding points 
will be west of the Iberian Peninsula at 35°N, 15°W; beyond the tip of the Malaysian Peninsula 
1°N, 105°E; and east of the Kamchatka Peninsula at 55°N, 165°E. The points with the most 
distortion will lie outside that triangle: the Arabian peninsula and the Chuckchee (eastern 
Siberian) Peninsula, neither possessing substantial railroads.

Requirements	 As a base map, nothing is required but the physiographic imagery and graticule.

Process

1.	 Select New from the File menu.

2.	 From the  (Azimuthal) menu, hold down shift and select Chamberlin trimetric.

3.	 Select Parameters from the Projection menu. Set the three anchor points as follows:

Anchor point 1: 35, -15

Anchor point 2: 0, 105

Anchor point 3: 55, 165

The great circles connecting these points roughly delimit the area of minimal scale error.

4.	 Select Boundaries from the Map menu. Select Boundaries are defined relative to graticule so that the 
boundaries you enter next will be the graticule extents that form the boundary of the map. In the Corners 
palette, enter these values: 

North: 80°N South: 1°N

West: 11°W East: 179°E

5.	 Click OK. This defines the extent of the map.

6.	 Select the Nominal Scale item from the Map menu.

7.	 Set a nominal scale of 1: 100,000,000 by typing 100000000 into the top field. Click OK.
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Result

Example Ten Result—Base map of Asia

Continuation for Pro version

8.	 If you purchased the Professional edition and have installed the DCW data set, you may continue on to 
add railroads. Warning: This will make an enormous map that can take many minutes to image.

9.	 From the Map menu, select Databases. Select from Databases to draw on the map:

Stylized World Topo 5400x2700.raw

10.	 Click Remove.

11.	 Click Add Installed Database.

12.	 From the list of available databases, select:

 Stylized World Topo 21600x10800.raw

13.	 Click Open.

14.	 In the list of available databases, you should see the DCW folder. Open that. Two subfolders of interest 
should be visible: Eurnasia and Sasaus, meaning “Europe and Asia” and “South Asia and Australia”. 
You will perform the same steps for both.

15.	 Open the Eurnasia folder. You should see a list of folder, one names RR. Open that folder. Select all of 
its contents. Click Open.

16.	 Repeat the last step except with the Sasaus folder.

17.	 Click OK.

18.	 From the Map menu, select Line Styles to open the Line Styles dialog box.

19.	 Select the Coverage: Railroad line type, and at the right, under Definition for this coverage, select Define new 
attributes from the pop-up menu. Set the Stroke color to some dark yellow. (You can click on the rectangle 
to the right of Stroke color to bring up a color picker.)

20.	 Select the Coverage: Railroad: Multiple track: Inoperative line type, and at the right, under Definition for this 
coverage, select Define new attributes from the pop-up menu. Set the Stroke color to red. (You can click on 
the rectangle to the right of Stroke color to bring up a color picker.)
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21.	 Select the Coverage: Railroad: Single track: Inoperative line type, and at the right, under Definition for this 
coverage, select Define new attributes from the pop-up menu. Set the Stroke color to red. (You can click on 
the rectangle to the right of Stroke color to bring up a color picker.)

22.	 Click OK.

23.	 Select the Nominal Scale item from the Map menu. Set a nominal scale of 1: 7,400,000 by typing 
7400000 into the top field. Click OK.

24.	 Select Final Quality from the Map menu.

25.	 From the File menu, select Size Document to Content. Accept the default values and click OK. Confirm 
that you can see the network of railroads.
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Example Eleven 
A political map of Africa

Analysis	 A political map usually needs minimal scale distortion so that a viewer can measure distances 
reasonably accurately. There is no need for special direction properties. The region is vaguely 
circular or triangular in shape when viewed from a north-south perspective. But if we throw 
away a north-south prejudice and instead view it from northwest to southeast, including 
Madagascar, we find it to be roughly rectangular or oval.

Conclusion	 Miller oblated stereographic, rotated −35°, centered on 3°N, 18°30′E, with east-west 
minimum-error radius of 33° and a north-south radius of 41°, will show all of Africa and 
Madagascar conformally and with distortion under 5.3%.

Technical Note	 The center of this projection is also the center of the region of interest, and it was found as 
follows: The Miller oblated stereographic, having been chosen as the map projection, was set 
up with the default parameters. The boundaries were cropped to just the African continent 
with some margin. A guess was made for the center of the region of interest, and entered as 
the projection’s center. Distortion visualization (Map menu) was turned on in order to see 
the distortion pattern. The projection center and rotation were adjusted until the distortion 
pattern looked symmetrical around the extreme points of the continent and Madagascar. The 
projection parameters were experimented with until the scalar distortion at the center point and 
at the extremities were the same value. The result looks like this:

Requirements	 The map will include all available geographical and geopolitical data. Final output will be to an 
illustration program for finishing. The purpose is a Web graphic.

Process

1.	 Select New from the File menu.

2.	 From the  (Azimuthal) menu, hold down shift and select oblated stereographic.

3.	 Select Projection Center from the Projection menu. Type 3 into the Latitudinal field and 18.5 into the 
Longitudinal field. Type −35 into the Transversal field. This centers the projection in the middle of the 
low-distortion oval and orients it along the semi-major axis of the ellipse that will circumscribe the African 
continent.

4.	 Select Boundaries from the Map menu. In the Boundaries (Before Projection)/Small Circle section, enter 
the values:  

Center: 3N 18/30N

Radius: 45

5.	 Click OK. This defines the extent of the map as a small circle of radius 45 degrees of arc centered at the 
same place we centered the projection. 

6.	 Select Parameters from the Projection menu. Type 33 in the East/west elliptical radius in degrees field and 
41 in the North/south elliptical radius in degrees field. These values are half the major and minor axes of the 
oval within which scale error is to be minimized.

7.	 Select Graticule from the Map menu. Type 5 into the Parallels spacing and Meridian spacing fields. Click 
OK.

8.	 Select Scale and Rotation from the Projection menu. Type 35 into the Rotate (CCW) field. Click OK. 
This compensates for the −35° rotation around the projection axis, keeping north oriented toward the top 
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of the page.

9.	 Select the Nominal Scale item from the Map menu. Type 50000000 in the topmost field. Click OK. 
This sets the nominal scale of the map to 1: 50,000,000.

10.	 From the Map menu, select Databases. From Databases to draw on the map, select

Stylized World Topo 5400x2700.raw

11.	 Click Remove.

12.	 Click Add Installed Database. In the list of available databases, you should see the Natural Earth 
folder. Open that. A folder named 50 Million should be visible; open that.

13.	 Open the NE2_50M_SR subfolder, and from within it, select the NE2_50M_SR.tif database, and click 
Open.

14.	 Click Add Installed Database. Navigate into the Natural Earth folder again, and the 50 Million 
folder within again, and open the cultural subfolder.

15.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

50m_admin_0_boundary_breakaway_disputed_areas.shp 
50m_admin_0_map_units.shp 
50m_urban_areas.shp

16.	 Click Open.

17.	 Click Add Installed Database. In the list of available databases, you should see the Labels folder. Open 
that.

18.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

Nations labels.txt 
World capitals labels.txt

19.	 Click Open. Click OK.

20.	 From the Map menu, select Line Styles to open the Line Styles dialog box.

21.	 Select the Graticule: Meridian: Normal line type, and at the right, under Definition for this coverage, select 
Define new attributes from the pop-up menu. Set the Stroke color to medium gray. (You can click on the 
rectangle to the right of Stroke color to bring up a color picker.)

22.	 Select the Graticule: Parallel: Normal line type, and at the right, under Definition for this coverage, select 
Define new attributes from the pop-up menu. Set the Stroke color to the same gray you used for meridians.

23.	 Select the Coverage: Political boundary: International de facto: Disputed area line type, and at the right, 
under Definition for this coverage, select Define new attributes from the pop-up menu. Set the Stroke color to 
a deep red. In the dash pattern below, type 6 3 to define a dash of length 6 points with spaces of 3 points.

24.	 Select the Coverage: Territorial shape: Country line type, and at the right, under Definition for this coverage, 
select Define new attributes from the pop-up menu. Set the Stroke color to the same red as the Disputed area 
line type. Set its Alpha value to 128 to make it halfway transparent. In the Width (points) field below, type 
2 to create a line weight of 2 points.

25.	 Select the Coverage: Territorial shape: Urban line type, and at the right, under Definition for this coverage, 
select Define new attributes from the pop-up menu. Set the Stroke color to a purple.

26.	 Select the Coverage: City line type, and at the right, under Definition for this coverage, select Define new 
attributes from the pop-up menu. Set the Stroke color to a maroon. Set the Width (points) field below to 4. 
Click OK.



5.26

27.	 From the Map menu select Final Quality.

Result

Example Eleven Result—Political map of Africa
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Example Twelve 
A base for a road map of the United States

Analysis	 The United States is divided into three major geographical sections: the contiguous 48 States, 
Alaska, and Hawaii. Nobody drives to Hawaii, so it need not be spatially connected with the 
main map. For practical purposes, Alaska need not be connected either since automobile traffic 
between there and the Lower 48 is very light. Thus each region may be represented by its own, 
independent map, but they should all have the same scale. For measuring distances scale error 
is the prime concern, and if the whole United States were to be represented on one map then 
GS50 would be the correct choice. For the 48 states a conic is better.

Conclusion	 Equidistant conic with standard parallels at 29°30′ and 45°30′ has the least scale error, slightly 
beating Albers equal-area conic and Lambert conformal conic. Alaska, being roughly circular, 
will take Airy, centered at 63°N and 148°30′W, and using a minimum-error radius of 8°. The 
Hawaiian archipelago is quite narrow and roughly follows a great circle route, so we will use a 
plate carrée centered at 23°N, 157°30′W and rotated transversally 30° in order to attain correct 
scale along the center of the chain and perpendicular to it.

Technical Note	 The standard parallels given above for the equidistant conic have been used for decades 
in Albers maps of the United States. They were verified to give the least scale error in the 
equidistant conic map by using the Distortion Visualization function off the Map menu to 
compare to other similar candidate parallels, all of which produced higher distortion figures. 
The minimum-error range for Airy was determined in the same fashion as described by the 
Technical Note of Example Eleven. The rotation for Hawaii was measured by making the same 
map without rotation and then using Scale and Rotate to rotate the map until the archipelago 
became roughly horizontal. The needed value is the negative of that angle.

Requirements	 The map will include all available geographical and geopolitical data. Final output will be 
printed. Alaska and Hawaii will appear true to scale but be placed directly above the mainland 
map.

Process

1.	 Select New from the File menu.

2.	 Select New from the Map menu.

3.	 Select equidistant (equidistant conic) from the  (Conic) menu.

4.	 Select the Nominal Scale item from the Map menu. Type 15000000 into the topmost field. Click OK. 
This sets the nominal scale of the map to 1: 15,000,000.

5.	 Select Boundaries from the Map menu. In the Boundaries (Before Projection) pane, Corners item, fill in the 
values: 

North: 50N South: 24N

West: 128W East: 64W

6.	 Click OK. This defines the extent of the mainland map.

7.	 Select Projection Center from the Projection menu. The average of the east and west extents of the map 
is ½ (–128° + –64°) = –96°, so set the Longitudinal rotation to –96 to bring the center of the projection to 
the center of the map extents. Click OK.

8.	 From the Projection menu select the Parameters item. Enter the parameters:
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Standard parallel 1: 29/30

Standard parallel 2: 45/30

9.	 Click OK. This optimizes the equidistant conic projection for the conterminous US.

10.	 Select Graticule from the Map menu. Type 5 into the Parallel spacing field and also into the Meridian 
spacing field. Click OK.

11.	 From the Map menu, select Databases. From Databases to draw on the map, select:

Stylized World Topo 5400x2700.raw

12.	 Click Remove.

13.	 Click Add Installed Database. In the list of available databases, you should see the Natural Earth 
folder. Open that. A folder named 10 Million should be visible; open that.

14.	 Open the NE1_HR_LC_SR_W_DR subfolder, and from within it, select

NE1_HR_LC_SR_W_DR.tif

15.	 Click Open. This gives us a shaded-relief background with lakes and rivers.

16.	 Click Add Installed Database. Navigate into the Natural Earth folder again, and the 10 Million 
folder within again, and open the cultural subfolder.

17.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

10m_admin_0_boundary_lines_land.shp 
10m_admin_0_boundary_lines_maritime_indicator.shp 
10m_admin_1_states_provinces_shp.shp 
10m_urban_areas.shp

18.	 Click Open.

19.	 Click Add Installed Database. Navigate into the Natural Earth folder again, and the 10 Million 
folder within again, and open the physical subfolder.

20.	 Select the following file:

10m_river_lake_centerlines.shp

21.	 Click Open. This adds rivers. We already have rivers in the raster layer from the NE1_HR_LC_SR_W_
DR.tif database, but we want the rivers to ride above the political boundaries. We used the NE1_HR_
LC_SR_W_DR.tif database for its lakes, not its rivers.

22.	 Click Add Installed Database. In the list of available databases, you should see the Labels folder. Open 
that.

23.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

US states labels abbrev.txt 
US cities labels.txt

24.	 Click Open. At this point the databases are ordered like this:

NE1_HR_LC_SR_W_DR.tif 
10m_admin_0_boundary_lines_land.shp 
10m_admin-0_boundary_maritime_indicator.shp 
10m_admin_1_states_provinces_shp.shp 
10m_urban-areas.shp 
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10m_rivers_lake_centerlines.shp 
US states labels abbrev.txt 
US cities labels.txt

25.	 But we want international boundaries to draw above state/provincial boundaries. Hold down the 
command (Mac) or CTRL (Windows) key and select the following from the list of installed databases:

10m_admin_0_boundary_lines_land.shp 
10m_admin_0_boundary_maritime_indicator.shp

26.	 There is a down arrow button (Mac) or Down button (Windows) just below the Add any database button. 
Click twice on the down button to move the international boundaries downward and force their draw 
sequence to be later than urban areas. We want rivers to be last so that they draw on top of any boundaries. 
Because we will leave their line width to be narrow, we will still be able to see the boundaries underneath.

27.	 Click OK. The vector databases are now added to the map and ordered front-to-back how we want them.

28.	 From the Map menu, select Line Styles to open the Line Styles dialog box.

29.	 Select the Graticule: Meridian: Normal line type, and at the right, under Definition for this coverage, select 
Define new attributes from the pop-up menu. Set the Stroke color to dark gray, so that each of Red, Green, 
and Blue are at 75. Set the Alpha to 225.

30.	 Select the Graticule: Parallel: Normal line type, and at the right, under Definition for this coverage, select 
Define new attributes from the pop-up menu. Set the Stroke color to dark gray, so that each of Red, Green, 
and Blue are at 75. Set the Alpha to 225.

31.	 Select the Coverage: City line type, and at the right, under Definition for this coverage, select Define new 
attributes from the pop-up menu. Set the Stroke color to a dark maroon. Set the Width (points) field below 
to 4. Click OK.

32.	 Select the Coverage: Political boundary: International de facto line type, and at the right, under Definition for 
this coverage, select Define new attributes from the pop-up menu. Set the Stroke color to the a deep red. In 
the Width (points) field below, type 2 to create a line weight of 2 points.

33.	 Select the Coverage: Territorial shape: Provincial line type, and at the right, under Definition for this coverage, 
select Define new attributes from the pop-up menu. Set the Stroke color to mauve (Red = 210, Green = 50, 
Blue = 95). Set the Width (points) field below to 1, and set the Alpha to 196. Click OK.

34.	 Select the Coverage: Territorial shape: Urban line type, and at the right, under Definition for this coverage, 
select Define new attributes from the pop-up menu. Set the Stroke color to a deep purple. Set the Width 
(points) field below to 1. Click OK.

35.	 From the Map menu select Final Quality.

36.	 Wait for Geocart to finish, and verify that the map looks like this:

37.	 Select Copy from the Edit menu, and then Paste from the same menu.

38.	 Select Airy from the  (Azimuthal) menu.

39.	 Select Boundaries from the Map menu. Enter the following values in the Corners item of the Boundaries 
(Before Projecting) pane:

North: 72N South: 50N

West: 170W East: 128W

40.	 Click OK. This defines the extent of the Alaska map.

41.	 From the Projection menu, select Projection Center. Set Latitudinal to 61N, and Longitudinal to 150W. 
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We center on Anchorage rather than the center of the map extents, since most of Alaska is not accessible 
by road. Click OK.

42.	 From the Projection menu select the Parameters item. Type 8 into the Radius of minimum error field. 
Click OK. This sets the radius of the optimized area. Again, since most of Alaska is not accessible by road, 
we concern ourselves with the region around Anchorage. Click OK.

43.	 From the Projection menu select the Stretch and Rotatation item. Set the Rotate (CCW) field to 8.25. 
This compensates for the tilt the map acquired as a consequence of the projection center not coinciding 
with the center of the extents of the map. This value was not computed, but merely homed in on visually. 
Click OK.

44.	 Wait for Geocart to finish, and verify that the map looks like the one at right. Then click anywhere on the 
map and, holding the mouse button down, drag it away from the mainland map.

45.	 Select Copy from the Edit menu, and then Paste from the same menu.

46.	 From the  (Cylindrical) menu, select plate carrée.

47.	 Select Boundaries from the Map menu. Enter the following values in the Corners item of the Boundaries 
(Before Projecting) pane:

North: 24N South: 18N

West: 162W East: 152W

48.	 Click OK. This defines the extent of the Hawaii map.

49.	 From the Projection menu select the Projection Center item. Enter these values: 

Latitudinal: 23N

Longitudinal: 157/30W

Transversal: 30

50.	 Click OK. This centers the projection and sets the line of constant scale along the axis of the islands.

51.	 From the Projection menu, select Stretch and Rotation and type –30 in the Rotation (CCW) field. This 
compensates for reorientation caused by the projection rotation. Click OK.

52.	 Wait for Geocart to finish, and verify that the map looks like the one at right. Then click anywhere on the 
map and, holding the mouse button down, drag it away from the mainland map.

53.	 Arrange the three maps so that they look like the result.
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Result

Example Twelve Result—Base for a road map of the US
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Example Thirteen 
A high-accuracy map of Japan

Analysis	 Japan is small enough that the choice of map projection begins to become irrelevant. However, 
even though it is narrow it is also quite long, so we must be careful to make a projection having 
low distortion along its axis. We will not concern ourselves with the amount of distortion away 
from the main islands.

Conclusion	 Mercator, based on the WGS 84 ellipsoid, centered at 36°N, 136°30′E, rotated by -50°, and 
scaled up by a factor of 1.00055, will give a conformal map with distortion below 0.08% across 
the main islands. This is only one fourth the distortion of a transverse Mercator.

Technical Note	 The center point of the map is an estimation. The rotation angle was determined in the same 
way as described in the Technical Note of Example Twelve. The optimum scale factor can be 
determined by formula, but in the absence of a formula it can decided empirically, using the 
Distortion Visualization facility. The scale distortion along the spine of the projection should 
equal the distortion at the edges of the region of interest.

Requirements	 The map will include national and subnational boundaries on satellite imagery. Final output 
will be to an illustration program for finishing.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the Map menu, select New to create a map.

4.	 From the  (Cylindric) menu, select Hotine. This an ellipsoidal oblique form of the Mercator. Notice 
that the datum has automatically changed to WGS 84. (See the Information palette.) There is no spherical 
form for Hotine. We could achieve the same results by selecting Mercator, setting an ellipsoidal datum, 
and then changing the projection center to create an oblique aspect.

5.	 From the Map menu, select Boundaries. Click Boundaries are defined relative to graticule. We do 
this so that the boundaries we set won’t move when we change the projection center later. In the 
Boundaries (Before Projection) pane, set the Corners values:

North: 49N South: 15N

West: 120E East: 150E

6.	 Click OK.

7.	 From the Projection menu, select Projection Center. Enter the values:

Latitudinal: 36N

Longitudinal: 136/30E

Transversal: -50

8.	 Click OK. This sets up the oblique aspect with axis down the spine of Japan.

9.	 From the Projection menu, select Stretch and Rotation. Enter 51/45 as the Rotation (CCW), meaning 
51°45′. This undoes the projection rotation to orient the map with north up. It is not exactly 50° because 
the map is not symmetrical about the projection center. The value was found by trial, so that the upper left 
and upper right corners align horizontally. Click OK.
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10.	 From the Map menu, select Databases. From Databases to drawn on the map, select:

Stylized World Topo 5400x2700.raw

11.	 Click Remove.

12.	 Click Add Installed Database. From the list of available databases, select:

Stylized World Topo 21600x10800.raw 

13.	 Click Open.

14.	 Click Add Installed Database. Navigate into the Natural Earth folder, and within that, the 10 
Million folder. Open the physical subfolder.

15.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

10m_lakes.shp 
10m_river_lake_centerlines.shp

16.	 Click Add Installed Database. Navigate into the Natural Earth folder again, and the 10 Million 
folder within again, and open the cultural subfolder.

17.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

10m_admin_0_boundary_maritime_indicator.shp 
10m_admin_0_breakaway_disputed_areas.shp 
10m_admin_1_states_provinces_lines_shp.shp

18.	 Click Open. The disputed areas are relevant to Japan, so we have installed the database for them. We do not 
install international boundaries over land because they are not relevant to Japan and they would superpose 
over the disputed areas boundaries.

19.	 Click Open. Click OK.

20.	 From the Map menu, select Line Styles to open the Line Styles dialog box.

21.	 Select the Coverage: Political boundary: International de facto line type, and at the right, under Definition for 
this coverage, select Define new attributes from the pop-up menu. Set the Stroke color to:

Red: 196

Green: 0

Blue: 0

Alpha: 196

22.	 This sets the international boundaries color to a partially transparent red. In the Width (points) field below, 
type 3 to create a line weight of 3 points.

23.	 Select the Coverage: Political boundary: Provincial line type, and at the right, under Definition for this 
coverage, select Define new attributes from the pop-up menu. Set the Stroke color to:

Red: 196

Green: 196

Blue: 0

Alpha: 196

24.	 This sets the prefecture boundaries to a partially transparent yellow. In the Width (points) field below, type 
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2 to create a line weight of 2 points.

25.	 Select the Coverage: Territorial shape: International de facto: Breakaway or disputed area line type, and at the 
right, under Definition for this coverage, select Define new attributes from the pop-up menu. Set the Stroke 
color to:

Red: 196

Green: 0

Blue: 0

Alpha: 196

26.	 Set the Width (points) field below to 3, and set the Dash pattern to 6 3. Click OK.

27.	 From the Map menu, select Graticule. Ensure that Draw parallels is selected, and enter 5° as the Parallel 
spacing. Ensure that Draw meridians is selected, and enter 5° as the Meridian spacing. Click OK.

28.	 Select Final Quality from the Map menu.

29.	 From the Map menu, select Nominal Scale. Enter 10000000 into the top field to set a scale ratio of 
1: 10,000,000. Click OK.

30.	 From the File menu, select Size Document to Content.
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Result

Example Thirteen Result—High-accuracy map of Japan
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Example Fourteen 
A base for a cultural map of France

Analysis	 A cultural map has no need of high accuracy, and France is not very large anyway. Any 
projection with correct scale at its center will do fine.

Conclusion	 Use the azimuthal equidistant projection.

Requirements	 The map will consist of a hypsometric background with international and departmental borders 
superposed. It will be completed in an illustration program, suitable as a Web graphic.

Process

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the  (Azimuthal) menu, hold down shift and select equidistant (azimuthal equidistant).

4.	 From the Projection menu, select Projection Center. Set Latitudinal to 47 and Longitudinal to 1.5. The 
centers the projection at the average of the boundaries we will use below. Click OK.

5.	 From the Map menu, select Boundaries. In the Boundaries (Before Projection) pane, select Corners 
and enter the following coordinates: 

North: 52N South: 42N

West: 6W East: 9E

6.	 Click OK.

7.	 From the Map menu, select Databases. From Databases to draw on the map, select:

Stylized World Topo 5400x2700.raw 

8.	 Click Remove.

9.	 Click Add Installed Database. In the list of available databases, you should see the Natural Earth 
folder. Open that. A folder named 10 Million should be visible; open that.

10.	 Open the HYP_HR_SR_W_DR subfolder, and from within it, select: 

HYP_HR_SR_W_DR.tif

11.	 Click Open. This gives us a shaded-relief background with lakes and rivers.

12.	 Click Disable filtering. The supplied databases do not need filtering, which would render them slightly 
more blurry.

13.	 Click Add Installed Database. Navigate into the Natural Earth folder again, and the 10 Million 
folder within again, and open the physical subfolder.

14.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

10m_coastline.shp 
10m_lakes.shp 
10m_river_lake_centerlines.shp

15.	 Click Open. This adds rivers. We already have rivers in the raster layer from the 
HYP_HR_SR_W_DR.tif database, but we want the rivers to ride above the political boundaries. We used 



Examples 5.37

the HYP_HR_SR_W_DR.tif database for its lakes, not its rivers.

16.	 Click Add Installed Database. Navigate into the Natural Earth folder again, and the 10 Million 
folder within again, and open the cultural subfolder.

17.	 Hold down the command (Mac) or CTRL (Windows) key and select the following files:

10m_admin_0_boundary_lines_land.shp 
10m_admin_1_states_provinces_shp.shp 
10m_urban_areas.shp

18.	 Click Open.

19.	 Because we want the urban areas to draw earlier, so that the other coverage obscure them if they overlap, 
click on 10m_urban_areas.shp and, using the arrow buttons below, maneuver the database to the 
top of the list of vector databases. Its position with respect to HYP_HR_SR_W_DR does not matter; raster 
databases always get drawn before vector. Click OK.

20.	 From the Map menu, select Line Styles. Select the Graticule line style and select Hide coverage and all 
children from the pop-up menu under Definition for this coverage.

21.	 Select the Coverage: Ocean: Coast line type, and at the right, under Definition for this coverage, select Define 
new attributes from the pop-up menu. Set the Stroke color to:

Red: 120

Green: 155

Blue: 200

Alpha: 255

22.	 This sets a slate blue transition between the land and water. In the Width (points) field below, set a line 
weight of 2.5 points. We will use this coverage to obscure the coastal segments of the provincial coverage. 
We could have chosen the 10m_admin_1_states_provinces_lines_shp.shp database instead, 
which does not contain coastal segments, but then the French departments would not be polygons. If we 
wish to color the departments in a graphics editing program, we will want polygons.

23.	 Select the Coverage: Political boundary: International de facto line type, and at the right, under Definition for 
this coverage, select Define new attributes from the pop-up menu. Set the Stroke color to:

Red: 196

Green: 0

Blue: 0

Alpha: 196

24.	 This sets the international boundaries to a partially transparent red. In the Width (points) field below, type 
6 to create a line weight of 6 points. Overlaying the wider international boundary on top of the narrower 
departmental boundaries will give a cased-line effect. 

25.	 Select the Coverage: Territorial shape: Provincial line type, and at the right, under Definition for this coverage, 
select Define new attributes from the pop-up menu. Set the Stroke color to:

Red: 255

Green: 255

Blue: 0

Alpha: 128
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26.	 Set the Width (points) field below to 2.5. Click OK. This gives a bright, but translucent, yellow line for 
department boundaries.

27.	 Select the Coverage: Territorial shape: Urban line type, and at the right, under Definition for this coverage, 
select Define new attributes from the pop-up menu. Set the Stroke color to:

Red: 210

Green: 95

Blue: 115

Alpha: 128

28.	 Set the Width (points) field below to 3. This gives a translucent light salmon coloring for urban areas.

29.	 Click OK to close the Line Styles dialog box.

30.	 Select Final Quality from the Map menu. 

31.	 From the Map menu, select Nominal Scale. Enter 4000000 in the top field to set a nominal scale of 
1: 4,000,000. Click OK.

Result

Example Fourteen Result—A base for a cultural map of France
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Example Fifteen 
Small-scale, high resolution raster reprojection

Requirements	 You will start with a high resolution image called MCR0001_circumpolar_2008.jpg, 
an image from the Natural Resources Canada’s Atlas of Canada.1 The resolution of the image is 
2.08333 pixels per point, with dimensions of 6,135 x 5,154 pixels. The map states that is has a 
nominal scale of 1: 9,000,000 on the azimuthal equidistant projection. The task is to create a 
raster reprojection database so that maps of other projections can be made from the image. In 
particular, you need an equal-area map.

Creating the database

1.	 Start Geocart.

2.	 From the File menu, select New.

3.	 From the Geocart menu (Mac) or the File menu (Windows), open the Preferences submenu and select 
General. In the General tab, select points (72/inch) as the Unit of measure for rulers and display.

4.	 Click OK.

5.	 From the Window menu, select Information to open the Information palette. You will refer to the info 
palette during subsequent operations. It will also be helpful to use the Navigator palette. Select Navigator 
from the Window menu.

6.	 From the File menu, select Place Image. Navigate to:

(Mac)
Library/Application Support/Mapthematics/Geocart/Version 3/
� Sample Documents/MCR0001_circumpolar_2008.jpg 
(Windows XP)2

C:\Documents and Settings\All Users\Application Data\ 
� Mapthematics\Geocart\Version 3\Sample Documents\
� MCR0001_circumpolar_2008.jpg 
(Windows Vista+)3

C:\ProgramData\Mapthematics\Geocart\Version 3\Sample Documents\
� MCR0001_circumpolar_2008.jpg

7.	 Click Open. You should see a detailed polar map filling your document.

8.	 Move your cursor over the image and note that the Information palette details the location of the file, the 
pixel size of the image, the color format of the image, and the resolution (2.08333 pixels/point).

9.	 From the File menu, select Size Document to Content. Accept the default values by clicking OK.

10.	 Examining the map, note that the parallel spacing is 5° and the meridian spacing is 10°. Note that the map 
does not extend further south than 35°N. Note that the central meridian is 90°W.

11.	 From the  (Azimuthal) menu, hold down shift and select equidistant (azimuthal equidistant).

12.	 From the Map menu, select Databases. Select any databases present and click Remove. Click OK.

1  NRC makes this image available “... with the intent that it be readily available for commercial, personal and public use 
and may be reproduced, in part or in whole and by any means, without charge or further permission from Natural Resources 
Canada.”
2  Windows hides this directory, ostensibly for your protection. See Appendix G for how to make it visible.
3  Windows hides this directory, ostensibly for your protection. See Appendix G for how to make it visible.
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13.	 To match the graticule spacing of your projection to the base image, select Graticule from the Map menu. 
Ensure that Draw parallels and Draw meridians are selected. Set Parallel spacing to 5 and Meridian spacing 
to 10. Click OK.

14.	 From the Projection menu select Projection Center. Set the Longitudinal field to 90W so that the central 
meridian coincides with the base image’s.

15.	 From the Map menu select Boundaries. We noted the southernmost extent of the map was 35°N, which is 
55° from the north pole. Select Small circle, and set its fields:

Center: 90N 0N

Radius: 55

16.	 Click OK. Your overlay map now has approximately the same extents as the image.

17.	 To make your projection overlay’s graticule stand out, select Line Styles from the Map menu. Select the 
Graticule line type, and at the right, under Definition for this coverage, select Define new attributes from the 
pop-up menu. Set the Stroke color to:

Red: 255

Green: 0

Blue: 0

Alpha: 128

18.	 Set the Width (points) field below to 0.48. This is 1/2.08333 so that the line width will be one pixel wide 
at full resolution. The line will be translucent because of the medium alpha value.

19.	 Click OK to close the Line Styles dialog box. You will receive a graticule transparency warning; ignore it.

20.	 From the Map menu select Map Size and Resolution. At the Resolution field, select pixels/point from the 
pop-up menu. Enter 2.08333 in its field in order to match the map image. Click OK.

21.	 From the Map menu select Nominal Scale. Set the first field to 9000000 for a scale ratio of 
1: 9,000,000. Click OK. The overlay map will take some time to image.

22.	 From the View menu select Actual Pixels of Selected Object. This lets you position your overlay precisely.

23.	 Click around in the Navigator palette until you find the center of your overlay image, where the meridians 
converge at the north pole. Drag your overlay so that its north pole coincides with the underlying image’s 
north pole. Precision is important. Clicking around in the Navigator palette or scrolling around, confirm 
that the overlay’s graticule aligns precisely with the underlying map’s graticule throughout the map.

24.	 From the File menu, select Export Database. Choose a folder to export your database into. Title 
your database AtCanPolar. Click Export. You may now use your database to create maps on other 
projections.

25.	 Close your database document.

Using your database

26.	 From the File menu select New.

27.	 From the  (Conic) menu, holding down the shift key, select Albers.

28.	 From the Map menu select Boundaries. Like the database map, set the boundaries by Small circle:
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Center: 90N 0N

Radius: 55

29.	 Click OK.

30.	 From the Projection menu select Parameters. Because this is a map of only the northern countries, high 
standard parallels are appropriate. Ignore Latitude of origin. Enter these values:

Standard parallel 1: 55

Standard parallel 2: 70

31.	 Click OK.

32.	 From the Map menu select Graticule. The database image already has a graticule, so deselect Draw 
parallels and deselect Draw meridians. Click OK.

33.	 From the Map menu select Database. Select any databases present in the Databases to draw on the map 
section, and click Remove. Click Add any database and navigate to the AtCanPolar.geo3db database 
you created. Click Open. Click OK.

34.	 From the Map menu select Map Size and Resolution. Select pixels/point from the pop-up menu on the 
Resolution field. Enter 2 into the Resolution field to set 2 pixels/point. Click OK.

35.	 From the Map menu select Nominal Scale. Enter 8000000 into the first field to set a scale ratio of 
1: 8,000,000. Click OK. The map will take a long time to draw.

36.	 At any time while drawing or after, select Size Document to Contents from the File menu. Click OK, 
accepting the default values.

Result

You will have converted a non-equal-area azimuthal map to an equal-area conic, and changed its scale and resolution. 
The results are publication quality throughout the map except in the regions of highest distortion, where the text looks 
odd, but remains legible.
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Example Fifteen Result—Reprojected circumpolar map
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Example Sixteen 
Large-scale reprojection with datum shift

Requirements	 You will start with an image called Sample UTM NAD27.tif. The resolution for this 
image is 4.16667 pixels/point, and the geographical coordinates for its corners are:

			   N	 = 33°59′30″N
		  S	 = 33°56′0″N
		  E	 = 124°13′12″W
		  W	 = 124°19′00″W

	 The parallels are spaced at every 30″ (note: seconds rather than degrees); and the meridians are 
spaced at 36″. The map projection is UTM on a NAD27 datum. Your task is to create a new 
map from this image rendered against the NAD83 datum at a scale of 1: 12,000.

	 In this exercise you will:

•	 Convert a TIFF image of a topographic map as a database.

•	 Reproject the database.

•	 Apply a datum shift.

	 The TIFF image you will be using is a large scale map, meaning that it has a low scale ratio (e.g. 
1: 25,000). These maps are typically used to convey detailed information such as topography, or 
city planning schemes.

Creating a database

1.	 Start Geocart.

2.	 From the File menu, select New to create a new document.

3.	 From the Geocart menu (Mac) or the File menu (Windows), open the Preferences submenu and select 
General. In the General tab, select points (72/inch) as the Unit of measure for rulers and display.

4.	 Click OK.

5.	 From the Window menu, select Information to open the Information palette. You will refer to the info 
palette during subsequent operations.

6.	 From the File menu, select Place Image. Navigate to:

(Mac)
Library/Application Support/Mapthematics/Geocart/Version 3/
� Sample Documents/Sample UTM NAD27.tif 
(Windows XP)4

C:\Documents and Settings\All Users\Application Data\ 
� Mapthematics\Geocart\Version 3\Sample Documents\
� Sample UTM NAD27.tif 
(Windows Vista+)5

C:\ProgramData\Mapthematics\Geocart\Version 3\Sample Documents\
� Sample UTM NAD27.tif

7.	 Click Open.

4  Windows hides this directory, ostensibly for your protection. See Appendix G for how to make it visible.
5  Windows hides this directory, ostensibly for your protection. See Appendix G for how to make it visible.
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8.	 Move your cursor over the image and note that the Information palette details the location of the file, the 
pixel size of the image, the color format of the image, and the resolution (4.16667 pixels/point).

9.	 Holding down the shift key, select UTM from the  (Cylindrical) projection menu. Result: A tiny 
rectangular map appears at the top left of your screen, overlaying the topographic map image.

Screenshot of step 9 showing inserted UTM projection

10.	 From the Projection menu, select Parameters. Enter 10S as the UTM Zone. This is the UTM zone that 
covers the region of the map. See Appendix B: Projection gazetteer for information on UTM. Click OK.

11.	 From the Map menu, select Databases. Select any databases present, and click Deactivate or Remove. Click 
OK.

12.	 From the Projection menu, select Datum. In the Datum section, select from the pop-up menus:

Datum: North American Datum 1927

Transform: 1175: USA West Molodensky

13.	 Click OK.

14.	 From the Map menu, select Boundaries. Select Boundaries are defined relative to graticule.

15.	 In the Boundaries (Before Projection) section, select Corners, and enter the following coordinates:

North: 34°1′20″N South: 33°58′15″N

West: 124°17′0″W East: 124°11′35″W

Notes: You can use / between degrees, minutes and seconds. For example, 33/59/30. Ensure that you 
add the hemisphere (E or W) after the coordinate.

16.	 Click OK.

17.	 From the Map menu, select Nominal Scale. Enter 27090 into the top field to set a scale ratio of 
1: 27,090. Click OK.

18.	 From the Map menu, select Graticule. Ensure that Draw parallels is selected, and enter 30″ as the Parallel 
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spacing. Ensure that Draw meridians is selected, and enter 36″ as the Meridian spacing.
Note: The default values will be degrees (°); ensure that you overwrite this with seconds (″).

19.	 Click OK.

20.	 From the Map menu, select Line Styles. Select Graticule and enter 0.2 as the Width (points) value.

21.	 Click Stroke Color, and select black on the Color picker. Click OK.

22.	 From the Map menu, select Map Size and Resolution. Enter 4.16667 pixels/point as the Resolution. 
Ensure that Preserve the value I don’t change; rerender the map is selected. Click OK.

23.	 From the View menu, select Actual Pixels of Selected Object. This sets your view of the image to be the 
full resolution of the image to help you refine the operation.

24.	 Move the top graticule you have created over the topographic image so that the lowest left-most graticule 
intersection coincides with the image’s lowest left-most graticule intersection. There should be no complete 
graticule square off of the image all around.

25.	 From the File menu, select Export Database.

26.	 Export the file as Sample NAD27. This creates the database that can be projected to any other map 
projection.

Using your database

27.	 From the File menu, select New.

28.	 From the Window menu, select Information to display the Information palette.

29.	 Holding down the shift key, select UTM from the  (Cylindric) projection menu.

30.	 From the Projection menu, select Datum. In the Datum section, select from the pop-up menus:

Datum: North American Datum 1983

Transform: 1580: Molodensky

31.	 Click OK.

32.	 From the Projection menu, select Parameters. Enter 10S as the UTM Zone. Click OK.

33.	 From the Map menu, select Boundaries. Click Boundaries are defined relative to graticule.

34.	 In the Boundaries (Before Projection) section, select Corners, and enter the following coordinates:

North: 34°1′20″N South: 33°58′15″N

West: 124°17′00″W East: 124°11′35″W

Notes: You can use / between degrees, minutes and seconds. For example, 33/59/30. Ensure that you 
add the hemisphere (E or W) after the coordinate.

35.	 Click OK.

36.	 From the Map menu, select Nominal Scale. Enter 12000 in the top field to give a scale ratio 
of 1: 12,000. Click OK.

37.	 From the File menu, select Size Document to Content. Accept the default values by clicking OK.

38.	 From the Map menu, select Graticule. Ensure that Draw parallels is selected, and enter 30″ as the Parallel 
spacing. Ensure that Draw meridians is selected, and enter 36″ as the Meridian spacing. Note: The default 
values will be degrees (°); ensure that you overwrite these with seconds (″).
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39.	 Click OK.

40.	 From the Map menu, select Line Styles. Select Graticule and enter 0.5 as the Width (points) value.

41.	 Click Stroke Color, and select some shade of red on the Color picker. Enter 128 as the Alpha transparency 
value.

42.	 The following message box will be displayed: Graticule Transparency Warning. You’ve 
chosen different transparency (alpha) values for different parts of the 
graticule. Only the Graticule: Normal value will be used. You may ignore it. 
Click OK.

43.	 From the Map menu, select Map Size and Resolution. Enter 2 pixels/point. Click OK.

44.	 From the Map menu, select Draft Quality. Note: If you want a printable version of the map, select Final 
Quality, but depending on your computer’s system speed, selecting this option may make the next step 
take a few minutes for the map to render.

45.	 From the Map menu, select Databases. Select any databases present, and click Deactivate or Remove.

46.	 Click Add any database. In the Select database to add dialog box, navigate to where you saved the file 
Sample NAD27.

47.	 Click Open. Click OK.

48.	 Allow Geocart to finish redrawing the map.

49.	 From the View menu, select Actual Pixels of Selected Object. This sets the full resolution of the image to 
help you refine the operation.

50.	 From the Tool palette, select the crosshairs cursor.

51.	 Position the cursor over the lower left red graticule intersection on the map. Parallels should coincide with 
the black pixels underneath, so it may be difficult to see. The meridians should be seen easily. 
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Graticule intersection with crosshairs.

52.	 Copy the information from the Information palette using command+shift+X (Mac) or 
CTRL+SHIFT+X (Windows) and paste into a text editior.

53.	 The coordinate should resemble this:
φ,λ = 33°58′29.987″N, 124°16′47.989″W
Probably it will not be identical, but it should be close.

54.	 In the Web browser of your choice, navigate to the following Web site:

http://www.ngs.noaa.gov/cgi-bin/nadcon.prl

55.	 Paste the latitude into Web page’s Enter Latitude field, and the longitude 
into the Enter Longitude field.

56.	 Edit the values you pasted to replace the degree, minute and second 
symbols with spaces, and remove the N and W. Round the figures to the 
nearest second because the graticule parallels and meridians are spaced on even seconds. For example, the 
values used above, should now look like: 

Enter Latitude: 33 58 30.0

Enter Longitude: 124 16 48.0

57.	 Click the Web page button Compute Datum Shift for a Single Location.

58.	Result: You will be given a conversion from NAD 27 to NAD 83, with the new NAD 83 values listed on 
the NAD 83 datum values row.

http://www.ngs.noaa.gov/cgi-bin/nadcon.prl
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Latitude Longitude
NAD 27 datum values: 33 58 30.00000 124 16 48.00000

NAD 83 datum values: 33 58 30.00978 124 16 51.94301

NAD 83 - NAD 27 shift values: 0.00978 3.94301 (secs.)

0.30100 101.21700 (meters)

Magnitude of total shift: 101.217(meters)

59.	 On your Geocart map, position the crosshairs over the black graticule intersection at the map’s lower left, 
just to the right of the thick black margin, and a short way left of the red graticule intersection you 
examined before.

60.	 With the cursor precisely aligned to the cross of the 
graticule, note the coordinate shown in the Information palette. 
Confirm that it is within 1 second of the value given on the 
NADCON site. This shows that the NAD27 map has been 
converted successfully to NAD83.
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Chapter 6: Geocart menu (Mac)
This chapter describes the Geocart menu, which is found only on the Macintosh version. The Geocart menu pertains 
to settings and operations for the entire application.

About Geocart

This command displays the About Box, which gives information about the Geocart prod-
uct. You may need any or all of this information if you contact Mapthematics for support. 
In the upper right, you can find the version number of Geocart, which operating system, 
and which computer processor architecture the Geocart application was created for. At 
lower right, the name of the license holder appears, as recorded by the person who entered 
the license key. Beneath that is the serial number, and beneath that is the type of license 
tied to the license key.

About box

Preferences

The settings available from this submenu determine how your Geocart environment behaves and what happens auto-
matically when you create a new map.
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Preferences > General

The Preferences dialog contains three panes for setting Geocart’s environment: General, Display, and Advanced.

General

You can instruct Geocart to make certain trade-offs to improve your experience, depending on your computer’s power 
and your own preferences. You can select your preference of measurement unit for rulers and dialog boxes.

General panel of Preferences dialog

Undo history steps: Geocart has an undo facility (see Undo), letting you step back through your changes in case you 
need to return to a previous state of your map. You can step back as far as is permitted by this control’s setting. If your 
computer is equipped with lots of memory, you may wish to increase the number of undo steps permitted. Ultimately 
how much memory is consumed by an undo step depends on the map content. Generally the larger the map, the more 
memory it takes, both when current and when in the undo history. If you work with maps many thousands of pixels 
on a side, but you only have a gigabyte or two of RAM, you should cut down the number of undo steps to some mini-
mum that you think will work well with your style of work.

Embed images: When Geocart finishes drawing a map, it keeps the completed image until you change something that 
requires it to redraw the map. This option instructs Geocart to retain completed images when you save your docu-
ment. When you have Geocart open the document again, it won’t have to redraw the map because it can just read its 
image out of the document’s file.

vs.

Do not embed, recalculate on open: The file for a document containing a single map 10,000 x 5,000 pixels, for example, 
might take up 150 MB of disk space. If you are concerned about the storage space or the Internet transmission time of 
documents that large, you may not wish to have Geocart store the completed image into the document’s file when you 
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save. The disadvantage is the amount of time Geocart might require to redraw the map when you open the document.

Use fast compression: Geocart always compresses images it saves in documents in order to conserve space. The compres-
sion is lossless, meaning the decompressed, or restored, image is identical to the saved image. Geocart supports two lev-
els of compression: faster, or more compressed. If you are more concerned with how quickly Geocart saves documents 
than you are about the size of documents’ files, then select Use fast compression option.

vs.

Use best compression: If you are more concerned about the size of documents’ files than you are about how quickly they 
save to disk, then select this option.

Unit of measure for rulers and display: Choose your measurement units throughout Geocart’s UI here.

Display

Settings in this panel pertain to Geocart’s behavior in rendering maps.

Display panel of Preferences dialog

Show changes frequently: Geocart does not update the screen for every pixel it renders. That would slow it down drasti-
cally. Instead, it updates the screen periodically in chunks. If you prefer more of a real-time view of the map drawing, 
pick this option. The disadvantage is that more of the computer’s processing power is stolen away from rendering the 
map in order to update the screen frequently.

vs.

Update less often: If you have a slow computer (for example, under 1 GHz), you should consider using this option. It 
will complete the drawing of your map faster, but it will update the screen with its progress less often.

A map’s scale is important. Representing scale reliably can be difficult on a computer. Because computers store 
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information digitally, images have no real-world length or height. They just have pixels. Image formats contain extra 
information that states how dense the pixels are supposed to be, and therefore the real world dimensions of the image.

Computer monitors are problematic in this regard. Depending on the operating system, the monitor, and on what 
kind of connection it has to the computer, the operating system may be unable to determine the size of the pixels on 
the screen. Or, even if it knows, for many purposes it will still treat one pixel as a fixed size, no matter how tiny or 
large the pixel is. Or the monitor may not report the size of its pixels accurately. And so on. Using the remaining con-
trols in this panel you can get as accurate as you want.

Use the system reported value: If you wish to defer to the operating system’s notion of your screen’s pixel density, select 
this. You might do this if you know it’s correct, or because it’s good enough, or because you don’t care.

vs.

Use a custom resolution: If you find that Geocart’s rulers and the maps Geocart produces don’t seem to match real-world 
measurements when you print or when you measure them with a ruler on-screen, you should calibrate Geocart’s 
understanding of the screen’s pixel density using this control. Measure the black bar using a real ruler pressed up 
against your screen, and enter its precise width in The bar above measures field. Or, if you know the pixel size from the 
monitor’s documentation, you can enter it into The custom resolution is field.

Advanced

The on-screen instructions suffice for most of the functionality controlled by this pane. With regard to Enable OpenGL  
hardware acceleration, some computers, particularly older ones or ones with exotic graphics cards, may not draw or 
update their screens reliably when this option is checked. If you experience bizarre screen behavior unrelated to a spe-
cific map or projection, try turning off this option.

Advanced panel of Preferences dialog
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Preferences > New Map Databases

When you first install Geocart and create a new map, the map will get drawn with default settings, one of which is 
geographic databases. You may have a collection of databases that you use commonly, and therefore you might prefer 
that those databases get automatically added to each new map you create. You specify those databases using this com-
mand. It brings up the Databases dialog, where you can add and configure as many databases as you like.

Although the databases you specify here will get added automatically to new maps, you can still go back into the 
Databases dialog to add or remove databases if your usual collection isn’t right for a map or if they need adjusting.

Use Preferences > Reset New Map Databases to undo the settings you have made with this command, reverting to 
the settings from the time you first installed Geocart 3.

Preferences > New Map Graticule

When you first install Geocart and create a new map, the map will get drawn with some default settings. One of those 
settings is the graticule that will get drawn on your map. You may commonly work with a particular style or scale of 
map and therefore prefer some other graticule setting by default. You can set a preferred graticule configuration using 
this command. It brings up the Graticule dialog.

Although the graticule you specify using this command will get drawn automatically on new maps, you can still go 
back into the Graticule dialog for each map to customize it if your common configuration isn’t right for that map or if 
it needs some adjusting.

Use Preferences > Reset New Map Graticule to undo the settings you have made with this command, reverting to the 
settings from the time you first installed Geocart 3.

Preferences > New Map Line Styles

When you first install Geocart and create a new map, the map will get drawn with some default settings. One of those 
settings is the line styles that will get used to draw the vector elements of your map. You may have a distinctive graphi-
cal style that you give most maps, and therefore you might prefer that style be present automatically in each new map 
you create. You can set up line styles appropriate to your graphical style using this command. It brings up the Line 
Styles dialog, where you can customize all line styles available.

The normal Line Styles dialog only presents you with line styles actually in use in your document (as determined by 
the databases you have added to the document) in order to avoid clutter. In contrast, the Line Styles dialog you are 
presented with by this New Map Line Styles command contains all the line styles Geocart knows about, as determined 
by the coverage mapping files you have installed. The presentation of line styles may be extensive. You need only 
modify those line styles you care about.

Although the line styles you specify using this command will get used automatically in drawing new maps, you can 
still go back into the Line Styles dialog for each map to change line styles if your usual graphical style isn’t right for 
that map or if it need some adjusting.

Use Preferences > Reset New Map Line Styles to undo the settings you have made with this command, reverting to 
the settings from the time you first installed Geocart 3.

Preferences > Reset New Map Databases

You revert your Preferences > New Map Databases changes using this command. This restores the list of databases 
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that will be added to new maps to the state it was in when you installed Geocart. If you made no changes, then this 
command will not be available.

Preferences > Reset New Map Graticule

You revert your Preferences > New Map Graticule changes using this command. This restores the specification of the 
graticule that is to be drawn on new maps to the state it was in when you newly installed Geocart. If you made no 
changes, then this command will not be available.

Preferences > Reset New Map Line Style

You revert your Preferences > New Map Line Styles changes using this command. This restores the list of line styles 
that will be used for new maps to the state the state it was in when you newly installed Geocart. If you made no 
changes, then this command will not be available.

Services

This menu item is provided by the Mac OS. Please refer to Mac OS documentation for instructions on how to use it. 
Its contents should not affect Geocart in general.

Hide Geocart

This command hides Geocart’s windows, palettes, and menu bar, and switches to the last application you used. You 
can return to Geocart by finding it in the Finder’s Dock.

Hide Others

This command hides all the windows of all other applications you have running. If you switch applications often, you 
may find that Geocart’s windows become interleaved with those of the other applications, obscuring some of Geocart’s 
windows. Use this command to move all of Geocart’s windows to the front.

Show All

This command brings all the windows of other applications out of hiding, though they will still be obscured by 
Geocart’s windows and palettes.

Quit

This command shuts down Geocart. If you have any documents whose contents have changed since the last time you 
saved them, then this command first asks if you wish to save them.
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Chapter 7: File menu
The File menu offers document and file controls, such as creating, saving, opening, and closing them.

�

New

This command creates a new Geocart document with no content. If rulers were set to visible on the previous window 
opening (see Rulers), then the new window will have rulers; otherwise it won’t. The new document’s window will be 
placed in front.

Open

This command displays the Open File Picker so that you can select a Geocart document to open. It operates as any 
other application’s Open File Picker. Consult your operating system’s documentation for instructions. You may 
open any Geocart document, whether of standard .geo3 format, .geo3db reprojection database format (see Export 
Database), or Geocart 2 format.

If the newly opened document was of Geocart 2 format, it will get converted to Geocart 3 format and renamed to the 
same name plus (converted). If you save this document, it will save as Geocart 3 format. There is no way to save 
back to Geocart 2 format.

Upon opening, Geocart will redraw any maps that were not completely drawn at the time the document got saved. It 
will redraw all maps if the document was saved without image embedding. (See Do not embed.)
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Open recent

The submenu displayed off this menu item provides a list of Geocart documents you recently opened. Just select the 
name of the document you want to open. From there the document will open as normal and will become the front 
window.

Close (Mac)

If the front window’s document has not changed since it was last saved, this command simply closes all windows asso-
ciated with the document. If the document’s contents have changed since it was last saved, Geocart asks if you wish to 
save the document. You may:

•	 Don’t Save, which discards changes and closes.

	 – OR –

•	 Cancel, which aborts the close and returns to whatever Geocart was doing.

	 – OR –

•	 Save. If the document has been saved before, it saves and closes. If it has never been saved before, you will 
be asked to provide a name for the document and a location to save to. Then Geocart closes the document.

Save

If the document of the front window has been saved before, this command saves the document in its current state. If 
any maps have not finished drawing, then their images will not get put into the file. When Geocart opens the docu-
ment the next time, it will redraw any maps without images.

If the document has never been saved before, then the standard Save File dialog displays, requesting you to provide a 
name for the file and to specify a location in your file system to save it into. Consult your operating system’s documen-
tation for instructions.

Save As

Use this command if you want to save the document to a file of a different name. You may want to do this to, for 
example, preserve the prior version of the document.

Save As always brings up the standard Save File dialog, requesting you to provide a name for the file and to specify a 
location in your file system to save it into. Consult your operating system’s documentation for instructions.

Once you create a copy by performing a Save As, the open document is associated with the new file on disk. The origi-
nal file is closed. You may open it as a separate document if you like.

Save a Copy (Windows only)

Use this command to create on disk a new file containing the document’s contents, giving the file another name or 
location. The name and location are only for the copy and do not affect the open document’s name or location.
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Revert (Windows only)

Discards all changes made to the front window’s document since the last save, with the effect of closing the document 
without saving, and then opening it anew.

Close (Windows)

See Close (Macintosh).

Export Document

Exporting a document converts it to a standard format that other applications can read. The entire document, includ-
ing all maps, all images and all blank areas, will be represented in the output, which will have the dimensions of the 
document. Any document objects hanging off the page will be cut off and not visible in the resulting image. The back-
ground will be transparent if the export format allows (PSB, TIFF).

When you choose Export Document, a Save File dialog displays, requesting you to provide a name for the exported 
file. At the bottom of the Save File dialog you can select the format of the exported file. Which format you export to 
depends on what you intend to do with the exported document, and to some extent on the content of your map.

Raster

Graphical content can be represented two fundamentally distinct ways on a computer: as raster, or as vector. Raster 
imagery is comparable to a photograph. The amount of detail is fixed at the time the image is created and cannot be 
usefully increased. The image consists of cells of color of a consistent size called pixels. If you peer carefully at your 
computer’s screen, each tiny dot you see is a pixel.

Raster imagery can be scaled up to create a larger image, but that does not result in more detail. While it can look 
smooth, the greater you increase its size, the blurrier it gets because the same amount of detail gets smeared over more 
and more pixels. Raster imagery can be scaled down, generally without bad effects. The important concept in raster is 
the amount of detail present in the original image.

Vector

Where raster imagery is comparable to a photograph, vector line work is comparable to the process of painting. The 
characteristics of each stroke are recorded: Its thickness, color, and whether areas in between get painted solid and in 
what color. In the end, in order to display it, vector line work gets rendered into a raster image. Everything on your 
screen is raster, regardless of whether it originated as raster or as vector. The advantage of vector, however, is that you 
can scale up or down from the original dimensions before you render it in raster. That means, regardless of size, you can 
achieve a sharp, pleasing graphic.

If the image consists largely of lines, such as a map’s graticule, or administrative boundaries, or roads, then vector is an 
appropriate format. If the image consists largely of  land cover, for example, then raster is probably more appropriate. 
Maps being maps, it is very common to mix both raster and vector to create a map.

Picking a format

If you need to preserve the distinction between raster and vector sources in your map, you must choose PDF as your 
export format, since it is the only such format that Geocart supports. Adobe Illustrator™ can read Geocart’s PDF out-
put, leaving raster as raster and vector as vector. More general PDF-consuming software can read Geocart’s files as well, 
but often only with the intent to render, as opposed to further editing. PDF has nothing to configure when you export 
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to it.

If your map is complete in the form Geocart rendered it, or if you will only be adding elements to it after importing it 
into other software (as opposed to changing elements already on the map), then any of several raster formats might be 
appropriate.

TIFF

If you need to retain the highest fidelity raster output, TIFF is a good choice. It retains every pixel Geocart creates, 
exactly as it was created. It retains any color transparency inherent in your image. Compression without loss of fidelity 
is part of the TIFF format, so it works well as a portable format. Almost any software that deals with raster imagery 
can read Geocart’s TIFF output. The only caveat with TIFF is that it cannot adequately represent the largest images 
Geocart is able to create. For those you must use PSB.

At export time you can elect to employ lossless compression. Compression does not affect image quality. It just takes 
longer to write the files, but generally results in a significantly smaller file. It may increase or decrease the time to read 
the file, depending on your processor and hard disk characteristics.

PSB

PSB is Adobe Photoshop’s™ native large-document format. Geocart provides the PSB export option because it is the 
only reliable, portable raster format for the largest raster images. If your image exceeds 2 GB, you must use PSB. 
An example of a 2 GB image is 15,800 x 31,600 pixels in 8-bit per channel RGB + alpha. (The alpha channel car-
ries transparency information.) At publication quality (300 dpi continuous tone), that amounts to a 2,675 mm x 
1,338 mm (= 105 in x 53 in) map. If the size and resolution of your map approach these dimensions, you will be using 
PSB format.

Why not use PSB all the time? PSB format is not nearly as widely read as TIFF. PSB’s format is not compressed, so it 
generally consumes far more disk space than TIFF. Finally, Geocart essentially must embed two copies of the image 
into the file, making an already enormous file yet twice as large.

JPEG

Images posted on the Web need to be the smallest files possible while retaining the essence of their content. Disk 
storage consumption can also be a consideration, particularly with maps because of their large size. JPEG is a lossy 
compression format. Lossy means that the full fidelity of the original image is not preserved. Instead, compromises are 
made in the image quality in order to squeeze down the size of the resulting file. Depending on what level of quality 
you choose, you may notice no difference from the original, or you may notice considerable degradation.

Geocart exposes three quality levels: Good, better, and best. How much compression you can expect depends on too 
many factors to give confident numbers. But, for example, on the default map Geocart creates, “good” JPEG compres-
sion results in a 9:1 compression over lossless TIFF compression. “Best” results in a file two-thirds the size. Whether 
you can tolerate the degradation in image quality in either case depends on your use and constraints.

Color space

Each of the raster output formats let you choose a color space, either RGB or grayscale. RGB (= red, green, blue) just 
means full color. Grayscale means levels of gray from black to white. If the map as drawn on the screen is in full color 
and you select grayscale, Geocart will convert the map to grayscale at the time it exports it. This does not affect the 
map in the document. If the image is grayscale in the document and you export to RGB, then Geocart will produce 
an image that looks like the original grayscale map but consists of the red, green, and blue channels mixed to result in 
gray colors.

A reason you might want or need these kinds of conversions is you may have several maps in your document, and they 
may be of different color spaces. At export time, since you are creating a single image out of what was several images, 
you will need to choose a single color space for the entire image.
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Bits per sample

Or bits per channel. This is how much detail each of the red, green, blue, and alpha channels can hold. 8 bits is com-
mon and suffices for many purposes. TIFF and PSB also allow 16 bits per sample. If your original raster databases were 
only 8 bits per sample then you won’t gain any benefits by selecting 16 bits per sample. You will only increase the size 
of the file you generate. Also, many TIFF readers cannot properly handle files with 16 bits per sample.

If, on the other hand, one or more of your raster databases contains 16-bit-per-sample imagery, Geocart will have 
rendered the map in 16-bit-per-sample color, and it would be best to preserve the detail if you will print the map. (It 
does not matter for purely screen representation because computer monitors only display 8-bit samples.) The deficien-
cies of 8-bit samples are most evident in gradations such as are often seen in water or sky hues. If you do choose 16-bit 
samples, be sure the consuming application properly reads them.

Resolution

All of the raster export formats let you choose the output resolution. Normally this should be the same as the map you 
are exporting, and that will be the default value when you export. If you don’t need all the detail of the original map 
when you export, you can choose to downsample it by selecting a lower value. You may also select a higher value, but 
that does not cause Geocart to render the map anew at higher detail. Geocart will just interpolate, much like blowing 
up a photograph in Photoshop. There is rarely any reason to do this for a single map.

If you have several maps of mixed resolution, however, you will need to decide on a single output resolution. Normally 
this should be the highest resolution present in your maps. This is the default value presented to you when you export.

Export Selected Items

Often you don’t need the entire document’s area in your export. Most commonly you will only have one map in your 
document, and that’s what you want exported. Whether one map or several, or mixed with placed images, this com-
mand exports all selected document objects. The resulting image will be of a size needed to contain all the selected 
objects. The background will be transparent if the export format allows it.

See Export Document for details. Unlike Export Document, however, all of the content of all selected document 
objects will appear in the resulting image, even those partially hanging outside the document’s area.

Export Database

Using Export Database, you can create a geographic database out of raster imagery you acquired from whatever 
source. The database you create then can be added to Geocart maps and projected into any map projection. This kind 
of database is called a general reprojection database.

Two components are needed to set up a document so that it can be exported as a general reprojection database. The 
first is the source image in the form of a placed image. Normally the placed image will be a map: one that you want to 
transform to a different projection, or one that you want to be able to reproject to any projection.

The second component is a Geocart map that you overlay onto the source image to serve as georeferencing. This is 
called the reference map.  Normally you would remove all databases from the reference map, using just the graticule as 
an overlay. However, the graphical content of the map, such as line styles and geographic databases, are not relevant for 
the purposes of georeferencing. You are free to configure them how you like. The important elements are the projec-
tion details and the boundary.

Setting up a document to export as a database consists of these steps:

•	 Placing the source image.
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•	 Creating the reference map to match the projection characteristics of the source image.

•	 Aligning the reference map to the source image.

•	 Running the Export Database command from the File menu to save the document as a database.

In practice, finding the right projection characteristics so that your reference map aligns perfectly to your source image 
can be arduous. Occasionally it is impossible. Here are some factors that can interfere in setting up the reference map:

•	 You do not know the projection of the source image.

•	 You know the projection but not the parameters.

•	 You do not know the geographic coordinates of any place on the source image (because it has no graticule, 
for example).

•	 The source map was warped, since all paper is subject to dimensional instability.

•	 The scan of the source map lost fidelity or introduced positional errors.

•	 Geocart does not support the projection of the source image.

For material that has not already been georeferenced at the time it was digitized, you are effectively going to be geore-
ferencing it yourself as you iterate toward a suitable reference map. In practice it does not matter if you do not know 
the projection characteristics of the source map, and it may not even matter if Geocart does not support the projection 
of the source map. What matters is that geographic coordinates in the reference map match the known geographic 
coordinates in the source image to sufficient precision for your needs. If you are able to improvise a projection that 
meets those criteria, then you will have succeeded.

Once you have created the general reprojection database, you add it to your maps like any other geographic database 
using the Databases command. Geocart automatically reprojects the general reprojection database’s source image to 
the projection of the map you have added the database to.

See Chapter 5, Example 15 and Example 16, for detailed tutorials on using this powerful facility.

Export Animation Frames

This command is available when two maps are selected. Using Export Animation Frames, you can create a sequence 
of maps that you can use other software to turn into an animation clip. The basic process is the same as blended maps, 
repeated across a change of proportion. Please see the explanation at New Blended. When you open the dialog, the 
map whose left edge was more left in the document will be presented on the left side in the dialog.

In creating the animation frames, you choose a starting parameter and an ending parameter. A parameter specifies the 
proportion of the map on the right used in creating the blend. The proportion of the map on the left to use in the 
blend thereby becomes 1 – P. The starting parameter is the parameter value to use for the first frame of animation. 
The ending parameter is the parameter value to use for the final frame of animation. The intermediate frames will be 
created by stepping linearly between the start and end parameters. You may specify a Start P greater than the End P. 
Hence if you want to start the animation with the map on the right side and progress toward the map on the left side, 
then set Start P to 1 and End P to 0.

Besides the start and end parameters, you can specify the number of frames, the resolution to render the maps at, a 
folder to dump the resulting frames into, and relative positioning of the frames. There is no practical limit to the num-
ber of frames you can instruct Geocart to create, but creating a high-quality animation can take hours or even days, 
if many thousands of frames are involved. You can specify the output resolution independently of the resolution of 
the original maps, but in general it is not a good idea to increase the resolution significantly beyond that of the source 
maps. Geocart must synthesize an outer boundary for the blended map at the resolution of the source maps, so if you 
specify something significantly greater, you may end up with an outer boundary that is not sufficiently detailed for the 
blended map.
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Export Animation Frames dialog

You must designate an output folder before you begin creating frames. It is best to designate a folder that is empty. 
Geocart populates the folder with TIFF images whose file names contain the frame number. Software that creates 
animation clips can read sequences of still graphic images thus numbered in order to create an animation sequence. 
Geocart first generates all the frames; then situates each image within a standardized frame size that can be determined 
only once all the frames have been generated. Therefore the folder will be populated first with a sequence of temporary 
frames with names that include -tempframe, and then with the final frames. It is the final frames which you should 
use to generate your animation from. Geocart retains the temporary frames in case you need to restart the animation. 
If you specify an output folder which already contains temporary frames, then Geocart will only generate the missing 
frames, if any.

You can align the animation frames as deposited in their final form either by specifying to center the map images in 
each frame, or that a given geographic coordinate should fall on the same pixel location. Which you should choose 
depends on the details of your animation intent. In some cases, neither choice is best, and you will only be able to 
achieve your intent using animation editing software.

For best results, use Final Quality rendering mode by giving both source maps that setting. This is particularly impor-
tant in animations in order to prevent shimmering and speckling artifacts during playback. You cannot export frames 
if the quality settings differ between the two source maps. See the documentation for your animation software in order 
to choose settings and a codec appropriate to your animation within the animation software.
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Place Image

You may place images from your disk into your document, and move them around on your document space wherever 
you want once they are placed. Some reasons you might do this are to:

•	 Create a general reprojection database.

•	 Provide an image to georeference against.

•	 Add external content to your map.

•	 Compare your map to an existing map.

The image formats you may place are all raster formats:

•	 TIFF (.tiff, .tif, .TIFF, .TIF)

•	 JPEG (.jpg, .jpeg, .JPG, .JPEG)

•	 Photoshop native format (.psd, .PSD)

•	 Photoshop large document format (.psb, .PSB)

The TIFF format provides enormous diversity of structure and content. Geocart may not be able to read some of the 
less commonly used variants. If you run into difficulty, try opening the TIFF file in another image reader and then sav-
ing it out again. Geocart may be able to read the newly saved version.

Set Placed Image Resolution

You may need to match the resolution (pixel density) of a placed image to the resolution of a map you are creating. 
You can control the resolution of a placed image using this command. Geocart will not resample the image; that is, 
Geocart will not change the pixels in the image. Instead it will change the dimensions of the image in order to increase 
the interpretation of the pixel density of the image.

If, for example, you place an image of 2,000 x 1,000 pixels and a stated width of 200 mm, then the image has a 
resolution of 10 pixels/mm. If you need to match the image to a map whose resolution is 5 pixels/mm, then you can 
decrease the image’s resolution to 5 pixels/mm using this command. The effect will be to double the size of the image 
because the pixel density will have become half what it was without changing the pixels themselves. Hence the result 
will be an image still 2,000 x 1,000 pixels but with width 400 mm.

Document Layout

Use this command to set the dimensions of the document’s space. You can set the width and height in your choice of 
units. The rulers will resize to match if you have them turned on.

One of the units available is “pages”. Using Page Setup (Mac) or Print (Windows), you can select the paper medium 
you will print on. The size of the paper medium you select is the “page size”. Hence in the Document Layout dialog 
you can set your document’s size in terms of the number of pages you will print to.

Size Document to Content

Your map or maps commonly will not fit your document size just right. You can force the document size to fit the 
expanse of the content using this command. A dialog appears with a setting for the amount of margin you want 
around the document’s content. You may set the margin to any non-negative value.
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Page Setup (Mac only)

Page Setup tells Mac OS about the medium you intend to print on: which printer, the size of the paper, scaling, and 
so forth. You should set these values before you print. Geocart does not control the content or appearance of this dia-
log. See your Mac OS documentation for details.

Print

Geocart does not modify the Print dialog. Refer to your operating system’s documentation and your printer’s manual 
for instructions on how to configure and use the print facilities.

On Windows, printing is constrained to a maximum resolution of 300 dpi contone. (Contone means continuous tone. 
It refers to the fact that a given hue can be expressed in hundreds of levels of brightness [hence, nearly continuous] 
the way a computer display works. This is in contrast to half-toning, where the printer deposits clusters of tiny dots 
of saturated colors mixed with empty space in order to simulate levels of brightness.) In contone, 300 dpi is generally 
considered equivalent to 2540 dpi half-toning in printers, and is therefore suitable for publication. If you need higher 
resolution, you can instead create and export the document at higher resolution and use another program to print it.

Preferences (Windows)

See the explanation at the Macintosh Geocart menu Preferences.

Exit (Windows only)

This command shuts down Geocart. If you have any documents whose contents have changed since the last time you 
saved them, then this command first asks if you wish to save them.
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Chapter 8: Edit menu
The Edit menu offers standard edit controls, which in Geocart operate on document objects.

�

Undo

If you do not like the effect of the last step you took in creating your map, you can reverse it with Undo. This applies 
to any kind of operation that makes changes to the contents of a document, but not to other kinds of operations, 
such as resizing a document window, or opening, closing, or saving a document. These latter operations neither can be 
undone, nor do they affect your ability to undo earlier operations that were undoable.

Geocart keeps track of each operation in its undo history. You can backtrack as far as the number of steps set in the 
Undo history steps preference. That is, if your mistake were five operations past, you can undo five times to restore the 
state before the error.

Redo

If you do not like the effect of undoing an operation, you can restore the effect of that operation using Redo. In other 
words, a sequence of Undo, then Redo, will return you to the point before the undo. You can redo back as many steps 
as you have undone.

Cut

Cutting removes all selected objects from the front window’s document, and puts them into the clipboard so that you 
may paste them if you wish. You may paste what you have cut into any Geocart document. This is a way to transfer 
document objects from one document to another.

The clipboard is an invisible storage area whose only function is to hold things you have cut or copied.
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Copy

This command copies all selected objects from the front window’s document, and puts the copies into the clipboard so 
that you may paste them if you wish. You may paste what you have copies into any Geocart document. This is a way 
to transfer document objects from one document to another. 

The clipboard is an invisible storage area whose only function is to hold things you have cut or copied.

Paste

The clipboard is an invisible storage area whose only function is to hold things you have cut or copied. If you have 
transferred anything into the clipboard, you may subsequently paste those items into any Geocart document using this 
command. The pasted items will be identical to what you cut or copied other than perhaps their positions in the docu-
ment. (Their relative positions will be preserved.)

In some programs you may paste items you cut or copied from other programs. Presently Geocart has no public data 
formats that can be copied from the clipboard into other programs other than text that you copy out of dialogs. Nor 
are there any public formats that Geocart recognizes for pasting into Geocart documents.

Delete

This deletes all selected objects from the front window’s document without putting the deleted objects into the 
clipboard.

Select All

Use this command to select every document object of the front window’s document.

Deselect All

If anything is selected in the front window’s document, this command will change it so nothing is selected. Most of 
the menu commands will become unavailable with nothing selected.

Copy Info Palette Text

The Information palette contains useful information about the map or image under the mouse pointer. You may want 
a copy of that information to freeze it in time or to except parts for use in other applications. This command copies 
the text to the system’s clipboard, whence you may paste it into any standard text editing application, such as TextEdit 
on Macintosh or Notepad on Windows.

Note that this command is not useful as a menu item, since you must move the mouse to access it. Moving the 
mouse changes the Information palette content. Instead use the keyboard shortcut shift+command+X (Mac) or 
SHIFT+CTRL+X (Windows).
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Find (Mac only)

This is provided by the Mac OS. It does not function in Geocart.

Spelling (Mac Only)

This is provided by the Mac OS. It does not function in Geocart.

Special Characters (Mac Only)

This is provided by the Mac OS. It does not function in Geocart.
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Chapter 9: Map menu
The Map menu offers settings for constructing your maps.

�

New

New creates a new map in the document of the front window, placing it toward the upper left of the document. The 
map’s projection will be the sinusoidal. The geographic databases used in the map will come from the settings in New 
Map Databases. The graticule will render according to the settings specified in New Map Graticule. The line styles 
used in the new map will come from the settings specified in New Map Line Styles. If any of these preferences have 
never been set or have been reset, then the corresponding elements of the map will get drawn according to standard 
defaults present from Geocart installation time.

Once the map is created, you may change any of its characteristics, including projection. However, when you change 
projections Geocart tries to preserve as many traits of the original map as possible. Sometimes those traits don’t yield a 
meaningful map in the target projection. Boundaries can be particularly problematic.

Another way to create a new map is to hold down the shift key (Mac) or SHIFT key (Windows) while selecting the 
projection of choice from any of the projection menus. This method is actually preferred over the New command 
because the map will get drawn according to defaults known to work well with the chosen projection.

New Blended

This is available when you have two maps selected. The purpose of New Blended is to create a new map by blending 
attributes from the two selected map. The new map’s projection will be synthesis of the two selected maps’ projections. 
Selecting New Blended brings up a dialog to give you information on how the synthesis will take place (or even if it 
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can take place) and to allow you to control the proportions of the contributions of the two maps.

Blend dialog

The informational portion of the dialog shows the differences between the two maps. Differences may participate in 
creating the blended map, or they may disqualify the two maps from being able to blend. Differences shown in red are 
irreconcilable. Differences shown in black will contribute proportionately from the two maps. The proportion of the 
contribution from the map on the right side is the P value that you may set, ranging from 0…1. If P = 0.0 then the 
resultant map is just the left map. If P = 1.0 then the resultant map is just the right map. If P = 0.5 then the resul-
tant map receives equal contribution from both source maps.

It is common for maps not to be blendable even if they have no differences flagged in red. These will show up after 
you hit the OK button. In such cases, the mathematics are not reconcilable, generally because the resulting map would 
have overlapping (folded-over) regions, for example. Differing projection centers often cause such problems.

If the two maps have the same map projection then they generally can blend. This is because the blending comes from 
weighting the projection parameter values and the projection centers, which normally can vary freely. However, a 
parameter that only takes discreet values will not blend for any arbitrary P.

A difference in projection center normally results in a blend that puts the projection center along the great-circle path 
between the two centers. However, if the source and destination maps have the latitude for their projection centers, 
and the transversal rotation is also the same, then the resulting projection center will be along the common parallel.

You can use the blending principle to create animation frames. See Export Animation Frames.
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Databases

This command functions for all selected maps. The databases and their state from the map created earliest are what 
populate the dialog upon entry. If you confirm the dialog by clicking the OK button, then the databases for all selected 
maps will update to become the same, reflecting the state of the dialog when confirming it.

Databases contain the geographic information Geocart uses to draw maps. If your map shows rivers, roads, toponyms, 
or satellite imagery, for example, then those features were all extracted from databases. Some kinds of map features 
do not come from databases, but instead are computed. The outside boundaries of the map, for example, are always 
computed. The configurable graticule is also computed. Drawing of computed features is controlled elsewhere (see 
Boundaries and Graticule).

A new map will get constructed according to defaults (if you have not set up preferences) or preferences (if you have), 
including what geographic databases the map has to draw from. (See New Map Databases.) Using this command, 
you can change the databases used to draw the map. Since the geographic information in a map largely determines the 
character of the map, what you do in this dialog will profoundly impact your map’s purpose and appearance.

Geographic features in a database are always associated with geographic coordinates. Geocart knows where to draw the 
features because of these coordinates. You may add any databases you like to your map, but Geocart will only draw 
features from those databases whose coordinates lie within the boundaries of the map (see Boundaries).

Geocart’s installer placed many geographic databases in a canonical location on your hard drive to use with Geocart. 
(See Appendix G: Managing your databases.) You can use those in maps, but you can also use any recognizable file 
available to your computer anywhere.

The diversity of geographic data cannot be represented in a single way that works well for all circumstances. Hence 
databases you use with Geocart come in several varieties. Raster databases contain geographic information arranged 
in a regular grid of squares, or pixels. If you peer carefully at your computer’s screen, each tiny dot you see is a pixel. 
Satellite imagery is an obvious example of raster.

Vector databases contain geographic information encoded as sequences of lines to be drawn. The reason to use vectors 
is that you can control the thickness and color (or weight) of their lines at the time they get drawn, allowing for con-
siderable flexibility in map design. This contrasts with raster, where you have no control over individual features. Some 
example uses for vector databases are administrative boundaries, roads, and coastlines.

Typesetting databases contain instructions for placing text. Normally you do not want your text in raster form because 
it will get warped by projection and because you cannot manipulate its placement. Similarly you do not want it in vec-
tor form because you will not be able to search for words or to change the font they get drawn in.

Metric lines databases contain instructions for drawing lines that express map projection distortion or computed 
paths on earth’s surface. Distortion metrics come in the form of isocols, which show points having the same measure 
of distortion, and Tissot indicatrix ellipses, which show how little circles on the sphere get distorted when projected. 
Computed paths include great circles, small circles, geodesics, and rhumbs. Point locations are also considered to be 
metric lines.

The following list describes the kinds of databases you can add to your Geocart maps.

Database type Filename 
extensions

Description

Editable polygon 
(vector)

.txt These are simple lists of polygons. You may find them useful when you need 
to manually or programmatically construct some line work. See Appendix E: 
Creating vector databases. Geocart does not install any editable polygon 
databases.

SMSB 
(vector)

.smsb This is a binary format now little used in computer mapping. Geocart 3 
installs some databases in this format for compatibility with Geocart 2.
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MCAM 
(vector)

.mcam This is a binary format from the public domain MicroCAM project. Geocart 
3 installs some databases in this format for compatibility with Geocart 2.

ESRI® Shapefile 
(vector)

.shp 

.dbf 

.prj 

.shx

This format is well known in computer mapping. The vector data is held in 
the .shp file. Metadata is held in the accompanying mandatory sidecar files. 
You may add any or all of the sidecar files; Geocart will automatically choose 
only the .shp file. While Geocart does not use information from the sidecar 
files, it does check for the presence of all sidecar files required by the specifi-
cation and rejects any Shapefile database missing them.

Geocart can read only a subset of Shapefiles, as follows: It parses the entire 
.prj file, requires it to be correctly formed, and requires the PROJCS coor-
dinate system to be GEOGCS. The PROJCS AXIS must be one of NORTH, 
SOUTH, EAST, or WEST. If an AUTHORITY is declared for the PROJCS, it 
must be EPSG, and it must be one of 9101, 9201, or 9122. If it is 9122, 
then the supplier-defined definition of degree must match 0.01745329 to 
within ±0.0000001.

Raw raster .raw This format consists of RGB samples, 8-bit each, non-interlaced, with the 
imagery assumed to be in “geographic” projection. Two variants exist. If 
the file has no header, then the image is assumed to be of global extent and 
must have twice as many pixels horizontally as vertically; otherwise it will be 
rejected. If a 128-byte header is present with the first four bytes comprising 
a GeoR signature, then the header describes the west, north, east, south 
extents of the image.

Global raster .tif 
.tiff 
.jpg 
.jpeg 
.psd 
.psb

Files of these types are assumed to be in “geographic” projection and of 
global extent. If the horizontal pixel count is not twice the vertical pixel 
count, the file will be rejected, since a geographic projection of the whole 
earth is twice as wide as it is high. Conversely, if that condition is met then 
the file will be accepted regardless of graphical content.

General reprojection 
(raster)

.geo3db These are databases that you create from raster imagery of any projection, 
such as scanned maps. See Export Database.

Typesetting .txt These place text according to geographic location. Geocart installs a small 
suite of toponyms in this format. See Appendix F: Typesetting databases for 
information about the structure of these databases.

Metric lines .metric These are databases that you create to instruct Geocart to draw metric lines. 
See Appendix J: Metric line databases to learn how to make these databases.

You may add as many databases as you want to be drawn into your map. Regardless of what order you add them in, 
raster databases will be drawn first, then vector, then typesetting and metric lines on top. Raster imagery that is opaque 
will obscure any other raster imagery below it. Hence it is uncommon to add more than one raster database to a map 
unless they cover different regions without overlap.

The upper left section of the Databases dialog is where you control what databases are present in the map, what order 
they will get drawn, and even whether or not they will get drawn. Databases to draw on the map is the list of databases 
that have been added to the map. The order in the list is significant: Entries higher in the list will get drawn first. You 
may select multiple entries using standard selection techniques: shift-clicking for contiguous spans; command-click-
ing (Macintosh) or CNTL-clicking (Windows) for discontiguous entries. Move selected entries higher in the list using 
the up-arrow dialog button (not your keyboard arrow keys). Move them lower by using the down-arrow dialog button.

Add installed database

You add new databases from Geocart’s shared-use database location using this button. It presents you with a standard 
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file picker already navigated to Geocart’s shared-use database location. (See Appendix G: Managing your databases.) 
Any of the supported database types will be available for selection. You may select multiple files at once.

Databases list portion of Database dialog

Add user database

You add new databases from your private-use database location using this button. It presents you with a standard file 
picker already navigated to your private-use database location. (See Appendix G: Managing your databases.) Any of the 
supported database types will be available for selection. You may select multiple files at once.

Add any database

You add new databases from any location using this button. It presents you with a standard file picker navigated to the 
last location you chose a database from. Any of the supported database types will be available for selection. You may 
select multiple files at once.

Add recent database

This button presents you with a list of the most-recently added databases. Choosing one adds it to the Databases to 
draw on the map list.

Relink

If Geocart cannot find a database that you have added (because you have moved it or because you are opening the 
document on a different computer, for example), it will append (missing) to the name of the database in the list. 
You can show Geocart where to find the database using this button.
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Activate

If any of the selected databases have been deactivated, this button will reactivate them. An activated database shows 
with a + to the left of its name.

Deactivate

You can keep databases in the list without having them draw by deactivating them. Deactivated databases show with 
a – to the left of its name.

Remove

Remove all selected databases in the list from the map using this button.

Filtering portion of Databases dialog

Filtering

Filtering is an image-processing technique for removing speckly artifacts from an image. It is something like a slight 
blurring. Many scanned images and JPEG images contain such artifacts, so Geocart assumes it should filter them. You 
can control whether a global raster database should be filtered or not using these buttons. Databases slated for filtering 
have (filtered) appended to their name as displayed in the databases list.

Datum portion of Databases dialog

Assign Datum

Databases encode the latitude/longitude coordinates of the information they contain either implicitly, as the pixel posi-
tion, or explicitly, as coordinates. But latitude and longitude do not suffice for high-accuracy mapping. The earth has 
been mapped by thousands of surveys over the centuries, each with its own model of the earth’s shape and origin for its 
coordinate system. Hence two different surveys might assign slightly different coordinates to the exact same location 
on the earth’s surface. The datum of a map projection describes the model it uses for the earth along with the location 
of the coordinate system’s origin. (See Datum on the Projection menu.) It is irrelevant for small-scale mapping, such 
as world or continental maps. It is critical in large-scale maps, such as town surveys or topographic quadrangles.

By default Geocart assumes that the datum of a database you have added to a map matches the datum of the projec-
tion you have set up. However, you may be aggregating databases from many sources. Or, you may want a different 
datum for your map than your databases were recorded in. Clicking the Assign Datum button will bring up the Datum 
dialog. You specify the datum by which you want the selected databases to be interpreted.

When a databases’s datum differs from a map’s datum, Geocart performs a datum conversion. How it converts depends 
on the datum details. See Datum on the Projection menu. The Selected database details pane shows you what datum a 
database is interpreted by.
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Assign Coverage

Coverage portion of Databases dialog

When you have selected vector databases in the database list, you will be able to assign coverages to them to override 
Geocart’s normal interpretation. A coverage is a description of the geographic meaning of the vectors in the database. 
It may be “rivers” or “coastlines”, for example. Normally coverages are determined by coverage mapping files installed 
in your shared-use or private-use database locations. (See Appendix D: Coverage mapping files for information about 
where these files reside and how they are constructed. See Line Styles for information about how coverages are drawn.)

Coverage mapping files decide coverages by examining the file names of the vector databases. You may have vector 
databases whose names do not match any pattern recognized by your coverage mapping files, and you may find it 
easier to assign the coverage here than to deal with coverage mapping files. Or, you may have a database whose name 
matches a pattern that the coverage mapping files recognize, but whose associated coverage is not appropriate to your 
file. Or you may wish to override the coverage mapping file’s interpretation for some other reason.

You can revert any coverage assignment you have made to the selected databases using the Revert Coverage button. 
Geocart will thence interpret the coverage through its normal mechanisms: the coverage mapping files when recog-
nized, or Coverage/Unspecified if the file name matches no known pattern.

Nominal Scale

This command functions when one map is 
selected.

Nominal scale is how you tell Geocart what size to 
draw the selected map. It establishes the baseline 
for measuring distortion and for any special prop-
erties the map projection has, such as correct scale 
along parallels. Essentially, it is the scale of the 
globe which you are projecting to create your map.

Because scale varies across all maps, sometimes 
drastically, you must not think of nominal scale 
as something you can use for accurately measur-
ing distances. While maps of large enough scale 
on appropriate projections can yield accurate 
(enough) distance measurements, any map of 
global coverage is completely unreliable for dis-
tance measurement.

You may set a map’s scale in your choice of units. 
As you type in the field of your choice, the others 
will update to equivalent values automatically. The 
meters setting means the radius or semimajor axis of the globe from which you are projecting.

Normally when you change scale, Geocart will redraw the map, enlarging or shrinking it according to your new selec-
tion. That is the Preserve resolution option.
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You may wish not to change the pixels in your map at all, but only to change the interpretation of its real-world size by 
increasing or decreasing the density of pixels. That is the Preserve map option. Its effects are largely instantaneous, since 
it does not redraw the map but only scales it for display.

Map Size and Resolution

This command functions when one map is selected.

Geocart lets you state a real-world size for your map. It also lets you state a resolution (pixel density). You can state 
them separately in order to redraw the map at a new size and pixel density, yielding new pixels to represent the map. 
Or, you can force one to change in response to changes in the other so that the map will still contain the same pixels. 
This causes the interpretation of pixel size to change.

Typically you set a pixel resolution according to the 
needs of the medium, regardless of the size of your 
map. To print, for example, you might want 300 dpi 
so that your map contains as much detail as the eye 
can easily resolve. This would be true whether the 
map were 10 cm wide or 100 cm wide as long as the 
expected viewing distance from the map were the 
same. For a Web map you might want 96 dpi, which 
is similar to most computer displays, and irrespective 
of the size of the map. This typical usage corresponds 
to Preserve the value.

With Preserve the value, you may change Width or 
Height without affecting the Resolution field, and 
conversely you may change the Resolution field with-
out affecting the Width and Height fields. When you 
confirm the dialog, Geocart will resize the map if you have changed its size, and render it at the requested resolution.

Occasionally you may simply want to impose a different interpretation for the size of the pixels that are already in 
the map, without rendering the map anew. This practice corresponds with Preserve the map. Since the same pixels will 
compose the map, and since you have stated a different size for them, then the size of the map itself must change. 
Hence, when Preserve the map is selected, changing the Resolution field will also change the Width and Height fields. 
When you confirm the dialog, Geocart will not render the map again; it will just change its real-world size and scale its 
representation on the screen to match.

Width and Height affect each other in all cases because otherwise the map’s proportions would change. Normally that 
would be undesirable. 

Scale to Window

This command functions for all selected maps. Each selected map gets scaled and positioned so as to fit snugly in the 
window.

Scale to Document

This command functions for all selected maps. Each selected map gets scaled and positioned so as to fit snugly in the 
document space.
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Boundaries

This command functions when one map is selected.

Boundaries are the extents of your map. A map projection has a natural boundary, which is the maximum extent that 
Geocart can draw. Then it has the boundaries you specify here. That map that gets drawn will be the portions that are 
common to both the interior of the natural boundary and the interior of the boundary you specify.

A common way to specify boundaries is to give 
the north, west, south, east (NWSE) extents. 
That works well for many situations, but not all. 
Another simple way to express boundaries is to 
choose a center point and a radius, such that all 
regions within the radius will get drawn. These two 
methods take care of most needs.

Unconstrained

Click on the unconstrained button to remove any 
specified boundaries. The map will be left with the 
natural boundaries of the projection.

Corners

To specify NWSE, enter the extents into the Corners section of the Boundaries (Before Projection) pane. North must 
be greater than south to be meaningful. West and east, however, wrap around the globe; there is no requirement of 
ordering. For simplicity, you may type slashes between degrees, minutes, and seconds. So, for example, if you wished 
to enter 47°30′40.457″S, you may type 47/30/40.457S. Be sure to append S or W to your numbers if they are in 
the southern or western hemispheres.

You can also drag out the boundaries in the map pane of the this dialog. After clicking the Corners radio button, click 
on the map at one corner of your desired boundaries. Hold down the mouse button and drag to the other corner.

Small Circle

To specify a center point with radius as the boundary 
for your map, click on the Small Circle radio button. (A 
small circle is the path on the globe that is a fixed distance 
from a chosen center point.) Enter the center point of the 
region, latitude in the left field and longitude in the right. 
Enter the radius, in degrees of arc, in the Radius field. A 
degree of arc is the same distance as a degree of latitude.

You can also drag out a small circle in the map pane of 
this dialog. Click at the center of the region and, holding 
the mouse button down, drag away from it until you have 
covered the region of interest.

Use Antipodal to “invert” the small circle so that regions 
outside become interior, and regions inside become exte-
rior. This is useful for defining what you want to exclude 
from the map, rather than what you want to include.
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Custom

In some unusual circumstances you may need to specify more elaborate boundaries. Using the Custom option you 
can specify a boundary of arbitrary complexity, building it up from small circle segments. See Appendix H: Defining 
custom boundaries for details.

Map pane

The map pane of the dialog will update as you edit your boundaries. The bright regions of the map show the portions 
that will appear on your map. The dark regions show the portions that are outside of the boundaries you have chosen.

Some map projections cannot map the entire earth, so the entire map will not brighten even if you choose 
Unconstrained. In this case, you will be able to specify boundaries that lie outside the natural boundaries, but those 
outside the natural boundaries will have no effect. Regions inside your specified boundary but outside the natural 
boundary will be displayed in intermediate brightness. See the example at right, showing a small-circle boundary that 
overlaps a wedge region outside the map projection’s natural boundaries. Only the brightest region will get drawn in 
the final map.

As described above, if you have Corners or Small Circle selected, you may click and drag directly on the map view to 
create your boundary.

View type

The map pane has several display modes. These modes do not affect the boundary, but only your view of the space on 
which you describe the boundary. Select the view most useful to your mapping.

•	 Physiographic. This shows a the world with continents colored by terrain and vegetation.

	 – OR –

•	 Political. This shows the world as sovereign nations.

•	 2D. This shows the world in a simple rectangular projection.

	 – OR –

•	 3D. This shows the world in two hemispheres whose orientation you can control. To spin a globe transver-
sally, click and drag at one of the axes. Or, use the controls in the upper left corner for a complete suite of 
manipulations. Both globes will move so that you always see the entire earth in two hemispheres.

Boundaries relative to graticule

Consider the normal equatorial Mercator projection at right. It 
is bounded north and south at the 82nd parallel. The reason the 
Mercator is bounded north and south at 82° latitude by Geocart’s 
default is because the projection is not naturally bounded: It 
would naturally extend infinitely upward and downward. One 
way to think about the boundary is as NWSE (north/west/south/
east) extents:

North: 82°N South: 82°S
West: 180°W East: 180°E

This means that the boundaries lie along the graticule. The pieces 
of the boundary follow some parallels and some meridians. If the 
graticule moves (because we changed the projection center), then 
the same meridians and parallels will continue to describe the 
boundary, even though they have moved. This is what it means to 
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say the Boundaries are defined relative to graticule.

Normally you would use this setting if some specific geographic region of the earth is the subject of your map. If, for 
example, you intend to show Australia, you need the boundaries to circumscribe Australia regardless of what you do 
with the projection.

Boundaries move with center

If we think of the boundaries as tied to the graticule and then 
change the projection center to an oblique aspect, notice what 
happens: The latitude 82° boundaries become holes in regions 
that could otherwise be mapped. Meanwhile the portions of the 
map that are infinite do not receive proper bounding. (The illus-
tration at right is clipped off for practicality; in actuality Geocart 
would draw a very large map.)

We cannot find a NWSE boundary that works for this oblique 
case. Nor can we find a small circle case that works, either. 
However, that the original boundaries on the normal Mercator 
would work just fine for the oblique aspect if we left the bound-
ary in equatorial aspect while we changed the interior of the 
projection to oblique.

We can do this by declaring that the Boundaries move with projec-
tion center. This means that boundaries glide over the surface of 
the globe in response to changes in the projection center so that 
their position remains unchanged with respect to the natural 
boundaries of the projection, instead of unchanged with respect 
to the graticule. They are no longer necessarily NWSE descrip-
tions; they are instead a path described by a sequence of four 
pieces of small circles. Hence “corners” rather than NWSE.

Geocart can work with arbitrarily complex boundary descriptions 
composed of sequences of pieces of small circles. The Small Circle 
option is one small circle, complete. The Corners option is pieces 
of four small circles. (Meridians are great circles, but great circles 
are also a kind of small circle.) If you need some other way to 
describe a boundary, see Appendix H: Defining custom boundaries.

Cropping

Needing a rectangular map is common. Meanwhile the boundar-
ies you selected may not provide a map of convenient shape, and could end up with substantial portions you don’t 
care about but that cost render time anyway. The purpose of Cropping is to give you a chance to pare down the expanse 
of your map to a rectangular shape before actually drawing it.

The view of the regions you see in the large map pane is the view on the globe (3D) or on the geographic projection 
(2D), not on your final map. You can see the effect of your boundary choice in the Cropping (After Projection) pane. 
The green regions are a caricature of your map as it will be drawn in your document. Within the white portion of the 
circle, the shape will be faithful. If it extends into the pink ring, the shape will be distorted because it portrays your 
entire map, even if infinite in extent, within a finite space.

Zoom to crop rectangle

If your crop rectangle is a small part of the caricature, you can improve your accuracy by zooming into it and refining 
your rectangle. Check this control to zoom in. Uncheck to restore the diagram to the full boundary display.



9.12

Cropping section of Boundaries dialog

None

This turns off cropping. The map will be rendered according to your boundary choice.

vs.

Arbitrary Rectangle

With this choice, you drag out a rectangle in the caricature box. Understand that this is a rough operation because 
normally the caricature box is much smaller than the map you are constructing. You won’t necessarily be able to place 
the edges precisely where you want them. You should err on the side of too much rather than too little. 

vs.

Constrained Rectangle

You can specify an aspect ratio for the rectangle you drag out, retaining the height-to-width proportions, if the map 
you are constructing needs to be of some specific proportion. This way you need only focus on one dimension as you 
drag out the rectangle; the other dimension will be taken care of automatically.

Graticule

This command functions for all selected maps. It is the map created earliest whose values populate the dialog on entry.

Many maps need no more than the basic controls: whether to draw parallels and meridians or not, and how far apart. 
These controls are found in the upper section of the dialog box. Pruning options are found in the middle. Because 
meridians converge at the poles, they can become too dense for practicality and æsthetics on some projections. The 
pruning options let you specify that some meridional sections toward the poles should be weeded out from drawing. 
This is common practice in polar maps particularly. The lower section of the dialog box provides some advanced, 
uncommon controls.

If your work has you making a particular style of map with a standardized graticule, you may find the Preferences > 
New Map Graticule settings to be useful. You can set up a graticule that all new maps will inherit.

Draw parallels

When checked, Geocart will draw all parallels (lines of latitude) specified to get drawn.1 Unchecked disables drawing 
of all parallels, including tropics and polar circles and any custom additions, even if they are otherwise set to be drawn. 
Parallels will be drawn as specified by the Graticule > Parallel line style (see Line Styles) and its descendents.
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Graticule basic controls

Draw meridians

When checked, Geocart will draw all meridians (lines of longitude) specified to get drawn.1 Unchecked disables draw-
ing of all meridians, including custom additions, even if they are otherwise set to be drawn. Meridians will be drawn 
as specified by the Graticule > Meridian line style (see Line Styles) and its descendents. Note that the prime meridian’s 
line style can be specified separately as the Graticule > Meridian > Prime meridian.

Parallel spacing

This field specifies the spacing of the automatically generated set of parallels. Units are degrees. When set to 15°, for 
example, a parallel will be drawn every 15 degrees. By default the spacing gets counted from the equator, but you can 
set it to whatever you wish. (See Origin of latitude spacing.) The line style attributes of parallels in this automatic set are 
specified by the Graticule > Parallel > Normal line style (see Line Styles).

Meridian spacing

This field specifies the spacing of the automatically generated set of meridians. Units are degrees. When set to 15°, 
for example, a meridian will be drawn every 15 degrees. By default the spacing gets counted from the prime meridian, 
but you can set it to whatever you wish. (See Origin of longitude spacing.) The line style attributes of meridians in this 
automatic set are specified by the Graticule > Meridian > Normal line style (see Line Styles).

Tropics

When checked, the tropics of Capricorn and Cancer will be drawn unless Draw parallels is unchecked.1 The line style 
attributes of the tropics are specified by the Graticule > Parallel > Tropic line style (see Line Styles).

Polar circles

When checked, the arctic and antarctic circles will be drawn unless Draw parallels is unchecked.1 The line style attri-
butes of the polar circles are specified by the Graticule > Parallel > Polar circle line style (see Line Styles).

Graticule pruning controls

1  Line drawing styles for different components of the graticule can be specified in the Line Styles dialog. Note that 
one setting for any line style is to Hide coverage and all children. Selecting that in the Line Styles dialog will turn off 
drawing for that graticule component even if the setting here in the Graticule dialog is to draw it.
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North pole, primary

When checked, Geocart will not draw some meridians within the specified degree radius of the north pole. It will 
draw some, as specified in the retain field. For example, if the retain field holds a 3 as shown above, then Geocart will 
draw every third meridian all the way to the pole (unless further constrained by the Secondary checkbox; see below). 
In a graticule of 15° spacing, and considering just the 0°, 15°, 30°, 45°, 60°, 75° 90° meridians, normally all would get 
drawn from pole to pole. But if this primary checkbox is checked, and the degrees field is 30°, and we retain every 3 
meridians, then only the 0°, 45°, and 90° meridians from that set will get drawn above 60°N latitude. The others will 
stop at 60°N latitude.

The retain value must be an integer 0 or greater. A value of 1 disables pruning, in effect. Retain counts start from the 
prime meridian in both directions. 

North pole, secondary

We can further prune meridians as they get closer to the pole. This checkbox and 
settings prune away survivors of the primary pruning. The settings shown in the 
Graticule pruning controls illustration above yield the effect shown at right. (The 
prime meridian is shown in red; parallel and meridian spacing are both 15°.)

Notice that most meridians stop at 60°N. This is because the North pole, primary 
degrees field is set to 30°, forcing meridians to stop drawing within 30° of the 
north pole. Notice that every third meridian continues beyond 60°N. Of those that 
continue, however, some still stop short of the north pole. That is a consequence of 
the Secondary degrees field being set to 7°30′, cutting off some meridians at 82°30′. 
Of those that survived the first pruning, every second meridian also survived the 
secondary pruning, by virtue of the retain 2 meridians setting.

The Secondary degrees field’s value need not be less than the Primary degrees field, though the effect probably is not use-
ful. The retain value must be an integer 0 or greater. A value of 1 disables secondary pruning, in effect. Retain counts 
start from the prime meridian in both directions.

South pole, primary

See discussion at North pole, primary. Mention of the north pole and “the pole” will mean the south pole instead.

South pole, secondary

See discussion at North pole, secondary. Mention of the north pole and “the pole” will mean the south pole instead.

Graticule advanced options
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Prime meridian

Some maps, particularly historical maps, do not use the Greenwich meridian as the prime meridian. You can draw 
then entire graticule to be referred against some other prime meridian. In the Graticule advanced options illustra-
tion above, the meridian at Ferro in the Canary Islands is given as the prime meridian, which was Claudius Ptolemy’s 
choice of prime meridian. The given value is the modern meridian of Ferro.  

This setting only affects the drawing of the graticule. It has no bearing on the map projection’s coordinates. If, for 
example, you hover the mouse pointer over a coordinate, the Information palette will deliver the map projection coor-
dinate for that point, not the graticule coordinate.

Origin of latitude spacing

If your graticule’s parallel spacing is not evenly divisible into 360°, then which parallels should be drawn becomes 
ambiguous. For example, if your map spanned 30°N to 42°N, and you specified 4° parallel spacing, does that mean 
you want the 30°N, 34°N, 38°N, and 42°N parallels drawn? By default, the 32°N, 36°N, and 40°N parallels will be 
drawn instead, because, considering the progression of parallels all the way from the equator, that is how they fall out 
with 4° spacing. Using this setting, you can change where parallel drawing starts. In this example, you could specify 
to start it at 2°N or 30°N; the effect would be the same because the difference between 30°N and 2°N is 28°, which is 
evenly divisible by 4°.

Origin of longitude spacing

If your graticule’s meridian spacing is not evenly divisible into 360°, then which meridians should be drawn becomes 
ambiguous. For example, if your map spanned the globe, and you specified 20° meridian spacing, does that mean you 
want the 170°W, 150°W ... 10°W, 10°E ... meridians drawn? By default, the 180°W, 160°W ... 20°W, 0°W ... merid-
ians will be drawn instead, because, considering the progression of meridians all the way from the prime meridian, 
that is how they fall out with 20° spacing. Using this setting, you can change where meridian drawing starts. In this 
example, you could specify to start it at 170°W, or any meridian an even multiple of 20° away from it.

Additional parallels

You may need to have other parallels drawn than would be generated automatically by the parallel spacing you set. For 
instance, if you want to have the latitude of some special city drawn as a parallel, you can specify that here. The values 
in this field are a list of parallels separated by semicolons (;). So, for example, if you wished to draw 42°30′N and 
51°19′S in addition to the regular graticule, you would type 42/30; 51/19S into this field.

Additional meridians

You may need to have more meridians drawn than would be generated automatically by the meridian spacing you set. 
For instance, if you want to have the longitude of some special city drawn as a meridian, you can specify that here. The 
formatting follows the rules given in the explanation of Additional parallels.

Excluded parallels

You can prevent Geocart from drawing any of the regular parallels by listing them here. The formatting follows the 
rules given in the explanation of Additional parallels. If you list parallels that would not have been drawn in any case, 
the spurious entries will be ignored.

Excluded meridians

You can prevent Geocart from drawing any of the regular meridians by listing them here. The formatting follows the 
rules given in the explanation of Additional parallels. If you list meridians that would not have been drawn in any case, 
the spurious entries will be ignored.
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Line Styles

This command functions when one map is selected.

You control how computed lines and vectors from vector databases get 
drawn using this command. (Computed lines include the graticule and the 
outside border of the map.) You can specify the color, transparency, width, 
and dash-line attributes of these lines. In aggregate the attributes are called 
the line style. You specify line styles by coverage. Coverage is the geographic 
meaning of the line, such as coastline or international border.

In Geocart, coverages are hierarchical. For example, a map has a graticule. 
The graticule consists of parallels and meridians. Graticule is a coverage, 
and so are parallels and meridians, but the latter are lower in the hierarchy. 
Usually you will want the color and thickness of the parallels and meridians 
to be the same, so you would set the line style at the level of the graticule. 
However, if you need to set them separately, you can instead set the line 
style at the level of parallels or meridians. Further, you may want yet a dif-
ferent style for the equator specifically, even though it is a parallel. Since 
equator is lower down in the hierarchy, you can set its line style indepen-
dently of parallels without affecting them or the graticule at large.

The graticule and the outside border of the map are computed lines. They 
are always present in the Line Styles dialog and so are not listed under the 
Coverages umbrella, even though technically they are coverages. The cover-
ages of lines extracted from vector databases, on the other hand, are deter-
mined by descriptive files called coverage mapping files. (See Appendix D: 
Coverage mapping files.) What coverages show up in this dialog depends on 
the contents of those files. Geocart’s installer places a suite of coverage map-
ping files into your computer’s shared-use databases folder. You may create and add your own as well.

If you reached the Line Styles dialog from the Preferences > New Map Line Styles command, then all the coverages 
found in the all the coverage mapping files will be present in the Line Types / Coverage pane. If you reached it through 
the Line Styles command, then only the computed lines and the coverages from the databases present in the map will 
show up. This keeps the clutter down.

When you select a coverage in the Line Type / Coverage pane, the Definition for this coverage pane to the right updates to 
reflect the present line style settings for that coverage. The pane has three states:

•	 Define new attributes. This lets you set the attributes of the coverage and all its descendents in the hierar-
chy who otherwise have not specified their own attributes.

•	 Use parent’s attributes. This disables any attributes that you have set for this coverage, and instead uses 
the parent’s attributes. This does not affect descendents if they have specified their own attributes.

•	 Hide coverage and all children. This turns off drawing the coverage and any descendents of the coverage.

The rightmost panel, Final style coverage, describes how, ultimately, the coverage will get drawn, regardless which state 
of the Definition for this coverage pane is active. It could differ from the Define new attributes settings because you are 
free to leave any of those attributes blank, for example, so that some of the parent’s settings come through. You cannot 
change the values in the Final style coverage pane. They are an effect, not a control.

Stroke color

Clicking on the Stroke color well brings up the Color Picker. You can choose any RGB value; the Red, Green, Blue 
fields below will update in response. Or, you may fill in those fields directly. A value of 0 means no contribution of 
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that color; a value of 255 means maximal contribution. Red, Green, Blue all set to 0 make black. Red, Green, Blue all 
set to 255 make white.

Alpha is the amount of transparency the color will have. An alpha of 
0 means the color is completely transparent, resulting in no color, not 
even black. An alpha of 255 means the color is completely opaque; 
nothing below will show through.

You may freely set the alpha value for most coverages. The graticule, 
however, must be a uniform transparency throughout its hierarchy. You 
can set differing values, but if you do the dialog will warn you at the 
time you confirm the dialog and will only use the top-most level’s value.

Stroke width

You set the width, or weight, of the coverage’s vector stroke here. Units 
are points (= 0.3528 mm = 1/72 in). The stroke is drawn centered along 
on the line’s definition.

Dash pattern

You may instruct the stroke to be dashed rather than solid. In this case 
you supply a sequence of lengths to describe a repeating pattern for the 
dashed line. Each length is in points. The first is the length of a visible 
stroke. If there is no second value, then the gap between visible strokes 
will be the same as the length of the strokes. Otherwise: The second 
value is the length of the gap between visible strokes. The meaning of 
each successive value alternates between stroke length and gap length as 
long as there are any values left. So, for example, the sequence 12 2 4 
6 yields the following dashed line:

Clear coverage AND children

This command resets all the values in the Definition for this coverage pane, with the effect of inheriting the line style 
attributes from the parent in the hierarchy. It also clears all descendents in the hierarchy, so that they, too, inherit the 
same parent’s attributes.

Distortion Visualization

This command functions when one map is selected.

Distortion is inevitable in a map. It affects the accuracy of a map. How distortion is distributed across a map is an 
important matter in map projections. (See Chapter 3: Essentials, distortion.) You can get precise readings on the distor-
tion at any point on the map by opening the Information palette and hovering the mouse pointer over the point of 
interest. Using this Distortion Visualization command, you can create a univariate or bivariate color representation 
of the map’s distortion characteristics so that you can understand the map’s distortion holistically.

(Other methods of displaying map distortion characteristics in Geocart are the Tissot Indicatrices command and 
Metric line databases. Use Distortion Visualization when you want to see the distortion as patterns, particularly in 
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comparing angular deformation against areal inflation/deflation. Use Tissot Indicatrices when you want to compare 
areas on a map to each other or to another map. Use a metric line database in order to draw Tissot indicatrices and 
distortion isopleths, much like contour lines, whose measures you have explicit control over.)

You may draw the raster databases on the map, or you may render its distortion characteristics. They are mutually 
exclusive. Turn on raster database rendering by clicking the Draw the raster database on the map button. Turn on distor-
tion visualization by clicking any of the other radio buttons.

You can show angular deformation, areal inflation/deflation, or a combined “scale factors” as univariate maps using 
gradations. Or, you can show a bivariate representation of angular deformation and areal inflation/deflation using 
continuous tones. Regardless of how you configure your distortion map, lighter hues mean less distortion. Darker hues 
mean more distortion.

Gradations vs. continuous tones

To understand what these diagrams mean, note that angular deformation is absolute. It does not depend on the scale 
of the map. Angular deformation of 0° means no angular deformation, and you cannot get any less than that. Areal 
inflation/deflation, on the other hand, are relative to whatever area is considered to be correct. Normally that would be 
a region whose area measurement matches the nominal scale’s square area. If an infinitesimal region’s area exceeds the 
nominal area, then it is inflated. If is smaller than the nominal area, then it is deflated. A region with double the nomi-
nal area is as “bad” as one with half the area. But since the choice of nominal region is in some sense arbitrary (because 
the nominal scale itself is arbitrary), merely changing the choice of the nominal region will change which regions of 
the map are deemed more and less distorted. This same freedom of choice does not exist with areal deformation, which 
is absolute. Therefore you must understand that a bivariate map comparing areal inflation/deflation to angular defor-
mation comes with this arbitrary element that compromises the meaning of the comparison.

Put another way, to compare the angular deformation of two locations on a map, you would subtract one angular 
deformation from the other. That tells you how different they are. To compare areal in-/deflation of two locations on 
a map, a better method is to divide one by the other. The ratio tells you how severely the inflation varies between the 
two. Comparing differences (angular deformation) to ratios (areal in-/deflation) is an apples and oranges proposition.

Dialog options

Now we can meaningfully describe the operation of the dialog. Regardless of which options you choose, the color 
white will correspond to the Min or Pivot field, whichever is available. Black will correspond to Max or Limit, which-
ever is available. In the gradations section, the Gradations field describes how many distinct shades of color must repre-
sent the all the distortion values from white to black, inclusive.

The reason these values for min/pivot and max/limit can be set is so that you can achieve meaningful contrast and 
number of gradations regardless of the amount of distortion and the extent of the map. Some maps, if they are only of 
a tiny section of the earth, for example, will vary very little across the map. Hence Min and Max might be very close 
together in order to still represent the small range of distortion across the map as varying between white and black.
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Distortion Visualization dialog

You can choose between two color schemes. The explanatory text in the dialog box refers to Scheme A. It generalizes to 
Scheme B. Scheme B may be better for some forms of color vision deficiency.

•	 Angular displays the angular deformation across the map.

•	 Average scale factor displays an average scale factor at each point. On a conformal map this corresponds to 
scale factor. The resulting image is grayscale. “Average” means the average of scale factors in all directions 
distributed evenly on the sphere. While possible for a point with modest angular deformation to have an 
average scale factor of 1.0, even moderate angular deformation results in values away from 1.0 because 
angles on the sphere become disproportionately distributed toward the major axis of the Tissot ellipse.

•	 Areal (logarithmic) displays the relative inflation/deflation across the map. If Pivot is 1.0 then distortion 
is measured against the nominal scale. Other values of Pivot represent multiples of the nominal scale. This 
setting is unsuitable for maps with a vast range of distortion.

•	 Areal (finitized) allows unbounded distortion to be mapped into a finite range.

•	 Mixed Logarithmic combines the angular and areal metrics and maps them into a logarithmically advancing 
scale. This setting is unsuitable for maps with a vast range of distortion.

•	 Mixed Finitized combines the angular and areal metrics and maps zero to infinity into a finite scale.
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Tissot Indicatrices

This command functions on all selected maps. If all selected maps have the Tissot Indicatrices attribute set, then this 
command removes the attribute; otherwise it sets the attribute on all selected maps.

Tissot indicatrices

Maps distort the space they represent, as described in Chapter 3, Distortion. You can understand at a glance how a map 
distorts its space by having Geocart draw Tissot indicatrices. Geocart will choose a size for the indicatrices such that 
they generally will have a reasonable amount of space between them. The absolute sizes of the indicatrix ellipses are 
not important, but, rather, how their sizes change across the map. An indicatrix will get drawn at each regular graticule 
intersection, ignoring pruning, extra graticule lines, tropics, and polar circles.

A more oblong shape in an indicatrix indicates more angular deformation. A more circular shape indicates less angular 
deformation; where perfectly circular, the map has no angular deformation. A conformal map will display all Tissot 
indicatrices as circles, albeit of different sizes. An equal-area map, on the other hand, will show indicatrices of all the 
same area, but varying in how oblong they are.

Copy Attributes

You can selectively transfer attributes from one map to others using Copy Attributes and Paste Attributes. This com-
mand functions when you have one map selected in the front window. It copies attributes of the selected map.

Paste Attributes

After copying attributes, you may paste them to all selected maps. You can specify which attributes to paste, since you 
may only want some of them or some may be inappropriate for the destination projection. The paste operation will 
incite each map whose attributes have changed to redraw.

Select the attributes you want to past by clicking each. Holding down the mouse button and dragging will toggle the 



Map menu 9.21

status of each attribute entry you pass over. You may select all attributes for pasting by clicking the All button. You 
may clear out any selection so that you can start over by clicking None. 

The attributes in the list correspond to the attributes 
that can be set using the menu command of the 
same name. See the individual commands for details. 
Resolution means Map Size and Resolution.

Descriptions for Boundaries, Databases, Distortion 
Visualization, Generalization, Graticule, Line Styles, 
Nominal Scale, Quality, Resolution, and Tissot 
Indicatrices all can be found in the Map menu. 
Generalization includes both the generalization style 
and level.

Descriptions for Datum, Interruptions, Projection Center, 
Projection Parameters, and Stretch and Rotation all can 
be found in the Projection menu. Datum includes the 
auxiliary latitude, if any.

Projection means the map projection as found in any of 
the six projection menus.

Generalize Vectors

These commands operate on all selected maps. Bézier 
operates independently of the others. None, Douglas-Peucker, and Visvalingam-Whyatt all exclude each other. If any 
of the selected maps had the generalization style you chose off or in a mixed state, then all will go to on. Otherwise 
they will go to off.

Generalization is the technique of pruning out excess detail or of synthesizing accept-
able, less detailed replacements for excess detail. Vector databases, such as rivers or 
administrative boundaries, come with an inherent level of detail that might not closely 
match the detail you need for your maps. When a database carries too much detail, the 
wiggles in line caricatures pile up on top of each other to no benefit, cluttering the map 
and even making it useless.

Generalization Level

When you set the generalization level, you instruct Geocart to render vectors from vector databases at a specific level of 
detail relative to the map’s declared resolution (see Map Size and Resolution). A value of 1.0 means the line caricature 
can change meaningfully at the granularity of a pixel. The higher the value, the coarser the line caricature will become. 
Values lower than 1.0 generally result in too much detail for the resolution of the map, but can be useful in vector 
illustration editing programs, where the notion of “resolution” carries less meaning.

The amount of detail will be similar for all styles of generalization at a given generalization level, but the generalization 
level value is not precise in any local sense, since line segments will vary in length considerably regardless. Think of the 
generalization level as a way to specify about how much detail you wish the vector components of the map to have in 
relation to any raster imagery behind it. A value of 1.0 indicates parity.

Generalization styles

Many vector generalization algorithms have been proposed in the literature. Geocart 3.1 offers several; their properties 
are summarized in the table below the example here:
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	 No generalization	 Douglas-Peucker	 Visvalingam-Whyatt

Generalization type Description
None Turns off straight-line generalization but does not affect Bézier generaliza-

tion. All vectors present in the vector database will be rendered as line work 
in the map if the coverage settings permit (see Line Styles). Use this if the 
level of detail in the vector database closely matches the scale at which the 
map will be drawn and if you do not want anything removed from it (such 
as tiny islands). This setting is rarely appropriate for world maps because a 
world map is far, far from constant scale.

Douglas-Peucker This method retains extreme features and results in efficient line caricatures. 
Under generalization levels higher than 1.0, however, the the caricature will 
appear spiky in the presence of features like fjords. All points in the resulting 
paths will have come from the original database; none are synthesized.

Visvalingam-Whyatt This method achieves a good caricature without the objectionable spikiness 
of Douglas-Peucker, but discounts the importance of extreme features. All 
points in the resulting paths will have come from the original database; none 
are synthesized.

Bézier 
(May be used alone or in conjunction 
with another.)

When used alone, the Bézier method retains similar features as Douglas-
Peucker. However, its line caricatures differ qualitatively from the other 
methods. The others weed out excess points but still represent a path as a 
sequence of straight lines. Bézier conversion, on the other hand, replaces the 
original path of straight lines with a curved path approximating it.

There are two reasons to use Bézier curves. One, Bézier curves can impart a 
more natural look to a coastline under magnification. This does not mean 
more accurate; in fact it usually means less, since it is a caricature of a cari-
cature. However, as long as the original data comes at higher detail than the 
scale of the map you are drawing, this should not be a problem.

Two, Bézier curves represent line work efficiently. This could make the differ-
ence between being able to represent a continent as a single path, and having 
to split it due to point count limitations in PDF or an illustration program.

On the other hand, Bézier curves are not suitable for representing coverages 
likely to include long, straight lines, particularly when used in concert with 
other generalization methods. See the text for description.

You can specify the Bézier curve method alone or you can specify it with any of the others. If you select it with 
another, the basis for the Bézier curves will be the generalized line rather than the original. This can work well, or it 
can be disastrous, depending on the characteristics of the coverage. Consider:
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	 No generalization	 Generalization as Bézier curves

The image above, on the left, is the coverage as it ought to be drawn. On the right is the network after generalization 
with Bézier curves. How did this happen?

The image on the left consists of square-like polygons. Each is represented in the data set as a sequence of four points 
defining the vertices. The simplest thing to do is to draw straight lines between vertices. However straight lines don’t 
occur in a natural coverage, so we should not assume straight lines are best. On a real coastline the shore may meander 
arbitrarily between two sample points. Meanwhile in this example the only information presented to the Bézier gen-
eralization algorithm is the four vertices. If the coverage were a coastline instead of a square, then the proper angle a 
line would make through a point would be a compromise between the approach angles on either side of the point. The 
approach angles are shown in red on the left. The compromise is diagonal lines, as shown on the right. When the final 
shape is supposed to be curved, and the entire shape is defined by only four points, the result will approximate a circle.

Contrast the images above with these below, where Béziers yield a superior caricature. Notice the red “tangent” of the 
protuberance at the lower right. It is, in effect, the average of the angles formed by the two red lines in the original car-
icature at the left. The lesson is that Bézier generalization works well for natural lines, but poorly for deliberate angles.

	 No generalization	 Generalization as Bézier curves
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Draft Quality

Selecting this menu item will deselect Proof Quality and Final Quality. It applies to all selected maps. 

This setting yields the most rapid rendering of raster databases. It has no effect on other kinds of map databases. It 
uses a technique called nearest neighbor to select the best pixel in the source database to place into the projected map. 
The method does not blend pixels, and therefore can result in considerable aliasing. Aliasing corresponds to speckling 
caused by adjacent pixels being unrelated to each other in color.

If the respective map projections of the source image and the destination map are similar throughout the map, and the 
resolutions are similar, results of draft quality may be acceptable for many uses. These conditions are met most com-
monly in very large scale maps.

Proof Quality

Selecting this menu item will deselect Draft Quality and Final Quality. It applies to all selected maps.

This setting yields results intermediate between draft and final quality, improving the rendering but at the cost of ren-
der time. While quality will always exceed that of draft, and render time will always be faster than final, where along 
the line each falls depends on the vagaries of the respective projections of the source image and destination map.

If the respective map projections of the source image and the destination map are similar throughout the map, and the 
resolutions are similar, results of proof quality likely suffice for any use. These conditions are met most commonly in 
very large scale maps.

Final Quality

Selecting this menu item will deselect Draft Quality and Proof Quality. It applies to all selected maps.

This setting yields the most accurate rendering of raster databases, at or near the theoretical optimum. The drawback 
is that many pixels in the source could get blended to create a single pixel in the map you are creating. Even thousands 
of pixels might get blended. The number of pixels that get blended depends on how much more detailed the source 
image is than the destination pixel, and how different the characteristics of the source and destination projections are 
at the pixel being rendered. Each source pixel costs some computation to blend.

Because of the high quality this setting yields, you may find that you can convert publication quality maps from one 
projection to another with acceptable results, even if they include text, and even if the projections differ significantly. 
The method is not complete magic, however. It cannot manufacture detail from nothing, and it cannot correct 
warpage and spread in text and line work that arise when the projections differ too much. Whether a result is usable 
depends upon use and tolerance.
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Chapter 10: Projection menu
The Projection menu offers settings for adjusting the projections of your maps. If you need to choose a projection, use 
the six projection menus instead:

Cylindric Pseudocylindric Conic

Azimuthal Lenticular Miscellaneous

�

Change Projection

This command changes the projection of all selected 
maps to one projection you pick. The list view you pick 
from contains information about and illustrations of 
each projection to help you choose. At the top of the 
information pane you can see all synonymous names for 
the projections. Geocart’s preferred name is at the top, 
but the preferred name has no particular significance 
within the Geocart application. A projection’s listing in 
Appendix B: Projection gazetteer can be found under its 
preferred name.

The operational portion of the dialog lets you select the kinds of attributes to retain when changing projections. All 
are selected when you enter the dialog. If you don’t want to carry over some attribute, then uncheck the box for that 
attribute.

Parameters

If you leave Parameters checked, Geocart will try to carry over parameters from the old projection to the new one 
to the extent they seem meaningful in the new context. If the old and new projection are both a typical conic, for 
example, then the parameters will match well. If you change from an azimuthal projection to a conic projection, on 
the other hand, typically there won’t be anything useful to carry over in the projections. Parameters in the new projec-
tion not having evident analogues in the old projection will take default values.

All

Click this button to check all attributes.

None

Click this button to uncheck all attributes.
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Reset Projection

This command resets the projections all selected maps in the front window, such that each projection takes default set-
tings known to work well for that projection. These settings include any parameters the projection has, the projection 
center, any interruptions recommended for the projection, boundaries, and stretch and rotation.

A common time to use this command is after changing projections. Sometimes the new projection differs so radically 
from the old that it’s best to just start fresh.

Projection Center

Map projections are formulated with a specific presentation in mind. That presentation varies according to the class of 
projection. Cylindric and pseudocylindric projections, for example, are normally formulated for equatorial aspect. That 
is, the map will be oriented so that the equator is straight and horizontal. Azimuthal projections, on the other hand, 
are most simply formulated in polar aspect. However, there is no reason a cylindric projection cannot be presented in 
polar aspect, and no reason an azimuthal projection cannot be presented in equatorial aspect. It is just a matter of rota-
tion the globe before projecting. This kind of rotation is called coordinate system rotation.

Projection Center dialog

The controls in this dialog let you perform coordinate system rotations. There are many reasons you may want to do 
this. For instance, most projections have a region of lowest distortion. If you limit yourself to the default presentation 
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of the projection, the region you are mapping may not fall into a low distortion region on the projection you want to 
use. You can correct this using coordinate system rotations to bring the region you are mapping to the low-distortion 
region of the map projection. Another reason might be to bring some particular country or region to the center of 
a world map. It is common in Japan, for example, to center world maps on a meridian through Japan. It used to be 
common in the United States to center world maps on a meridian through the USA.

If you model the earth on a sphere, you can rotate the coordinate system freely. A sphere is symmetric in all directions, 
so any point on its surface can be rotated to any other point. If you model the earth on an ellipsoid, however, you can 
only rotate the earth around its natural axis while keeping any particular surface point on the surface. Any other rota-
tion would move points off the surface and into space, or beneath the surface. Hence only longitudinal rotations are 
normal in ellipsoidal projections.

Warning: Do not recenter your projection indiscriminately. Understand the projection and how it is used. For exam-
ple, in normal usage you would not change any rotation except longitudinal in a conic projection. The correct usage 
is to center the projection’s longitude in the region of interest but leave the latitude alone. Then change the standard 
parallels to reasonable values within in the region of interest, using the Parameters command.

Latitudinal

Consider the axis formed by the center of the earth and the 90° meridian at the equator. The value in this field 
describes how far the globe is to be rotated northward around this axis before projecting. A value of ±90° results in 
a standard polar projection. The rotation brings the supplied parallel front and center. That is, a value of 23°N will 
bring the 23°N parallel to the center of the projection.

Longitudinal

The value in this field describes how far the globe is to be rotated westward on its natural axis before projection. It 
brings the supplied meridian value to front and center. That is, a value of 23°W will bring the 23°W parallel to the 
center of the projection.

Transversal

Consider the axis formed by the center of the earth and the prime meridian at the equator. The value in this field 
describes how far the globe is to be rotated counterclockwise around that axis before projecting. A value of ±90° when 
the Latitudinal field is 0° results in a standard transversal projection.

Aspect

The projection’s aspect is determined completely by its latitudinal, longitudinal, and transversal rotations. The radio 
buttons in the Aspect group update according to your entries in the Latitudinal, Longitudinal, and Transversal fields. 
However, you may also force the latitudinal, longitudinal, and transversal rotations by pressing a radio button in this 
Aspect group.

•	 Equatorial. This button is selected when the Latitudinal and Transversal fields are both 0°. If this button 
is not selected, then you may select it to force the Latitudinal and Transversal fields to 0°.

	 vs.

•	 Polar. This button is selected when the Latitudinal field is either 90°N or 90°S. If this button is not 
selected, then you may select it to force the Latitudinal field to be 90°N and Transversal to 0°.

	 vs.

•	 Transverse. This button is selected when the Latitudinal field is 0° and the Transversal field is 90° or 
–90°. If this button is not selected, then you may select it to force the Latitudinal field to 0° and the 
Transversal field to 90°.
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	 vs.

•	 Oblique. This button is selected when none of the other three in the group are. If you select another but-
ton, the dialog will remember the previous settings and restore them the next time you select the Oblique 
button. 

Projection boundaries

As described in Boundaries, a projection’s boundaries may be referred to the graticule or to the projection center. It 
is common to change the projection center without changing the boundaries. It is also true that not changing the 
Defined relative/Move with setting here when you change the projection center could cause your map to be unable to 
draw. Therefore you may change the setting here. It is the same as setting it in the Boundaries dialog.

View type

Select Physiographic or Political, whichever is convenient to your work.

Parameters

This command is active when one map is selected in the front window, and only if the map’s projection has any 
parameters.

Parameters are specific to the projection. See the projection’s entry in Appendix B: Projection gazetteer for information 
about any given projection’s parameters. See Projection parameters at the beginning of Appendix B for a discussion of 
projection parameters in general.

Stretch and Rotation

This command is active when one map is selected in the front window.

Using the settings in this dialog, you can increase the width and height 
of the projection independently of each other, and you can rotate the 
map in the document. There are two primary reasons for changing the 
width or height: You wish to change the distortion characteristics of 
the map; or you need to match your projection to a scanned image you 
have placed into the document. The latter reason is also a reason you 
might need to rotate the map. If you change the width or height and 
also rotated the map, Geocart first applies the width/height changes 
and then the rotation.

Changing the width or height of a projection implies changing the scale 
of the map in those directions. However, Geocart computes distortion 
as referred against the nominal scale of the map. Hence these settings 
can affect the calculation of distortion even if the scaling is uniform for 
width and height. If the scaling is uniform, angular deformation will 
not be affected, but scalar and areal metrics for distortion will be.

You can constrain the width and height values against each other by pressing the Equal-area or Conformal radio but-
tons. With one of those buttons selected, changing the value in the Width or Height field will automatically update the 
value in the other field.

If the Equal-area radio button is selected, then the field you do not edit will take the reciprocal value of the field you 
do edit. This ensures that an equal-area map will remain equal-area after your adjustments.
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If the Conformal radio button is selected, then the field you do not edit will take the same value as the field you do 
edit. This ensures that a conformal map will remain conformal after your adjustments.

Width Multiplier

Set this value directly, or let it update automatically as you change the Height Multiplier field with either of the Equal-
area or Conformal radio buttons selected.

Height Multiplier

Set this value directly, or press the Equal-area or Conformal radio buttons to compute the value from the Width field, 
or let it update automatically as you change the Width Multiplier field with either of the Equal-area or Conformal radio 
buttons selected.

Rotation (CCW)

Specify any rotation in degrees. The rotation will be counterclockwise if positive and clockwise if negative. Geocart 
applies rotation after width/height adjustments.

Datum

This command operates on all selected maps of the front window’s document. The map created earliest is the one 
whose values populate the dialog upon entry.

The settings in the Datum dialog are largely unnecessary unless you are working with maps on a scale of 1: 1,000,000 
or larger, such as 1: 5,000 or 1: 50,000. Coordinates for drawing maps at large scale are generally given on some spe-
cific datum. If you do not use the proper datum, distortion figures will not be correct, and you may not be able to use-
fully aggregate geographic data from different datums.

An ellipsoid is a squashed sphere, symmetric around its axis of 
rotation. It is characterized by its major axis and minor axis. With 
judicious choices of those axes, an ellipsoid can be a fairly accurate 
description of the shape of the earth, considerably more accurate 
than a sphere. The major axis is the diameter at the equator, and 
the minor axis is the length from pole to pole.

A datum is a model of the earth or a portion of the earth. A datum 
consists of an ellipsoid chosen to model the earth’s surface, and a 
description of how that ellipsoid relates to the real earth’s surface. 
Hundreds of datums (datums is the correct plural in this context) 
have been developed over the centuries. They use scores of ellip-
soidal models. Each datum has a slightly different notion of where 
the prime meridian is and how the ellipsoid is oriented against 
the earth’s surface. These differences were inevitable because there 
was no way to measure absolute positions on the earth’s surface 
accurately. The best surveyors could do was declare, on the basis of 
the best evidence available, that a survey station had a particular 
coordinate. Then they would base the local survey around it.

Geocart lets you select a datum for your map here. Your choice of 
datum normally depends on the datum of the source data you will 
use to draw your map. It is best not to use a different datum if you 
have no reason to. If you do use a different datum than the datum 
of your sources, Geocart will convert the source datum to your map’s datum. See Database, Assign Datum to learn 
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how to declare the datum of your source data.

How do you know the datum of your source data? That depends on the source data. Most locales historically had some 
standard datum in use at the time the map was made. You will have to find that out for yourself.

Datum

You can select a datum by name or by EPSG code. The EPSG database is maintained by the OGP at http://epsg-
registry.org/. Geocart knows about a lot of datums, but no attempt has been made to support every datum ever used 
or described. You may enter the ellipsoidal and transform parameters manually if you cannot find the datum you 
seek. When you select a datum, the ellipsoid at left will be updated as well, since the ellipsoid it part of the datum 
specification.

Transform

In isolation a datum is little more than an ellipsoidal description for Geocart’s purposes. The transform describes how 
to convert from the datum to the WGS 84 coordinate system, which is the Global Positioning Satellite (GPS) coordi-
nate system. You should find the location that most closely matches the location of your source data in the drop-down 
list. Or, you may enter transform parameters directly if you know them. If you enter your own parameters, please 
understand the conventions involved. Geocart requires “Position Vector” convention for rotations. 

In performing datum conversions, Geocart will compute the equivalent of a Molodensky 3-parameter shift, but 
slightly more accurate, if only the local ellipsoid center to WGS 84 parameters are given. If the datum contains seven 
parameters for center translation, scaling and 3-axis rotation, then Geocart will perform a "Bursa-Wolf" transforma-
tion using the EPSG Operation Method 9606 "Position Vector 7 parameter transformation". Presently Geocart does 
not perform any other kinds of more specialized datum shifts, but for maps at 1:5,000 scale or smaller, nothing else 
should be required anyway.

Ellipsoid

Normally the ellipsoid will get chosen for you when you 
select a datum. However, you may choose any ellipsoid 
or specify parameters for one not listed. The pop-up list 
contains dozens of ellipsoids, including several spherical 
models at the top. Like the datum, you can choose by 
name or by EPSG code. While Geocart comes with many 
ellipsoids, no attempt has been made to supply all of them 
ever developed.

If you enter your own ellipsoidal parameters, you will 
select one of semimajor axis, semiminor axis, or flattening 
to hold constant. Then as you edit one of the other two 
parameters, the third will update automatically. Normally 
an ellipsoid is specified as semimajor axis and semiminor 
axis, or else as semimajor axis and inverse flattening. To 
enter the semimajor axis, first select the Semiminor axis or 
Flattening radio button so that you will be able to edit the Semimajor axis field. Once you have entered the semimajor 
axis value, click on the Semimajor axis radio button to lock it down. Next, if you have a semiminor axis value, click in 
the Semiminor axis field to type it in. Or, if you have a flattening value, click in the 1 ÷ field to type it in. The remain-
ing values will update automatically.

The eccentricity field is informational only; you cannot change it directly.

http://
http://
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Auxiliary latitude

When you specify an ellipsoidal datum, Geocart uses ellipsoidal formulæ tailored for 
preserving crucial properties of the projection on the ellipsoid if it can. For example, 
consider the spherical form of the transverse Mercator. Its relevant properties are that 
it is conformal and that the central meridian is straight and of constant scale. There is 
no transverse form of the ellipsoidal Mercator in exactly the same sense as the spherical 
because coordinate rotations other than axial are not possible on the ellipsoid. However, 
an ellipsoidal projection that fulfills the same conditions can be developed: that is, con-
formal and having a straight central meridian of constant scale.

But other forms of the transverse Mercator are possible on the ellipsoid, unlike on the 
sphere. On the sphere, constant scale along a straight central meridian coincides with equally spaced parallels along 
a straight central meridian. That is not true on the ellipsoid; the two properties diverge there. Hence, it is possible to 
construct a conformal map with straight central meridians such that the parallels are equally spaced along the central 
meridian. Such a map would differ from the one described in the preceding paragraph. Yet it would have just as rea-
sonable a claim to being a transverse Mercator on the ellipsoid. There are other possibilities.

In point of fact, the version of the transverse Mercator with constant scale along the central meridian is the one gener-
ally considered most useful, since constant scale relates directly to the measurement of distances. This is the form that 
Geocart programs specifically and chooses when you pick an ellipsoidal transverse Mercator. Those projections which 
have been used historically for large-scale mapping generally have specific properties that need to be preserved when 
moving to an ellipsoidal form, properties beyond just being equal-area or conformal. Such specificity requires explicit 
and generally quite complex formulæ.

However, most of Geocart’s projections were not developed for survey work but rather for small-scale mapping. Most 
of them were developed for the spherical model and have no ellipsoidal development because they have no particular 
property that must be preserved on the ellipsoid. Yet any spherical projection can also be used for ellipsoidal projection 
work because you can project an ellipsoid onto a sphere. In fact, you can do so while preserving important properties. 
The usual technique for this is to use an auxiliary latitude in place of the coordinate’s geodetic latitude. The auxiliary 
latitude amounts to projecting the ellipsoid onto the sphere.

Several auxiliary latitudes are available. Which you choose depends on your use.

•	 None. This option is only available of Geocart has explicit ellipsoidal formulæ to project directly from the 
ellipsoid. If this option is available, normally you should choose it.

•	 Conformal. This converts geodetic latitude to the conformal latitude. Choose this if the spherical form of 
the projection is conformal; that property will be preserved when mapping from the ellipsoid.

•	 Authalic. This coverts geodetic latitude to the authalic latitude. Choose this if the spherical form of the 
projection is equal-area; that property will be preserved when mapping from the ellipsoid.

•	 Rectifying. This converts geodetic latitude to the rectifying latitude. Choose this if the spherical form of the 
projection has constant scale along meridians; that property will be preserved when mapping from the 
ellipsoid.

•	 Geocentric. This converts geodetic latitude to the geocentric latitude, which is what satellites measure. In the 
context of Geocart it is of more academic interest than practical.

•	 Parametric. This converts geodetic latitude to the reduced latitude, such any parallel on the ellipsoid will 
have the same radius on the sphere. In the context of Geocart it is of more academic interest than practical.
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Interruptions

This command operates on all selected maps of the front window’s document.

Interruptions carve up a map into segments, adding gaps to the map so that it isn’t the map that fills the gaps. The 
gaps soak up distortion that would otherwise have been present. In essence, interruptions reduce distortion within the 
segments by increasing it between them. The disadvantage is the fragmented presentation.

You should not use interruptions indiscriminately. Their purpose is to reduce distortion in specific regions for specific 
reasons. For example, a map of the world’s oceans would be a good candidate for interruption, and so would thematic 
maps which display global data having no intercontinental meaning, such as highway networks or forests.

Geocart provides two basic classes of interruption: equatorial and polar. Equatorial lays the equator out straight in 
equatorial aspect. Polar lays the projection out in two hemisphere, as wheels with spokes. Only one of the interruption 
schemes is polar, that being Rosette. The remainder are equatorial. (While the Philbrick is obliqued, it is based on 
equatorial mathematics.)

Only some projections are interruptible using Geocart’s interruption schemes. Most notably, all pseudocylindrics can 
be interrupted using the equatorial interruption schemes. More generally, most projections with a straight equator and 
equally-spaced meridians along the equator can be interrupted successfully using the equatorial interruption schemes. 
Projections interruptible by the rosette scheme are those with pointed pole in equatorial aspect and meridians equally 
spaced around the pole in polar aspect.

Geocart does not decide a priori what maps may be interrupted. You are free to try to apply interruptions to any map. 
Usually, if the operation is nonsensical, Geocart will simply notify you of the failure and return your map to the previ-
ous state. Sometimes Geocart will succeed “well enough” by its own assessment, but the results will be bizarre.

Choosing an interruption scheme will also reset the central meridian to the default for that interruption scheme. This 
is because the interruption schemes have a purpose that is defeated by other choices of central meridian. However, you 
are free to change the central meridian again after you select the interruption scheme.

Interruption scheme Example Description

None

This is the default state for most 
projections. Though considered unin-
terrupted, every map is interrupted at 
least one point. In this example the 
interruption is an entire meridian at 
the left and right edges of the map.

Boggs

This interruption scheme is most 
commonly associated with the Boggs 
eumorphic projection, which it inter-
rupts by default in Geocart. It is for 
presenting the continents with low 
distortion.

Goode continental

This interruption scheme is most 
commonly associated with the Goode 
homolosine projection, which it inter-
rupts by default in Geocart. It is for 
presenting the continents with low 
distortion.
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Interruption scheme Example Description

Good oceanic

This interruption scheme is most 
commonly associated with the 
Goode homolosine projection. It is 
for presenting the oceans with low 
distortion.

Gores

This is the usual interruption for 
creating globe gores. It interrupts the 
globe gores projection by default. The 
number of gores can be set, ranging 
between 3 and 45. For two gores, see 
Hemispheric.

Hemispheric

This is the classic double hemisphere 
interruption scheme.

McBryde

This interruption scheme is most 
commonly associated with the 
McBryde S3 projection. It is for 
presenting the oceans with low dis-
tortion, moving the central meridian 
into the Pacific.

Philbrick

This interruption scheme was created 
for the Philbrick Sinu-Mollweide 
projection.
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Interruption scheme Example Description

Rosette

The number of petals of the two 
polar roses can be set between 2 and 
45. Projections interruptible with this 
scheme include, for example:

sinusoidal
equidistant conic (φ2 = 90°)
Albers (φ2 = 90°)
Werner
American polyconic
rectangular polyconic
Bonne
isoperimetric cordiform
lateral equidistant

Segmented

This scheme is for presenting the 
continents with low distortion and 
symmetry about the equator. It splits 
the Eurasian landmass approximately 
at the conventional division of 
Europe and Asia.

Sinoidal

This is a simple, symmetric inter-
ruption scheme useful for presenting 
most of the continents with low 
distortion. South America does not 
fare well, however, and neither do the 
extremes of the Eurasian landmass.
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Chapter 11: Projection menus
See Appendix B: Projection gazetteer for information about individual projections and about how the projection menus 
are structured.

Cylindric Pseudocylindric Conic

Azimuthal Lenticular Miscellaneous

Selecting a projection from one of the projection menus sets all selected maps on the document of the front window 
to have that projection. Geocart will try to retain as many of the attributes of the original map as possible, including 
boundaries, for example. Sometimes that is not possible, forcing Geocart to prohibit the projection change. In such 
cases, use Change Projection, deselecting Boundaries in the Retain these attributes pane. If that still does not work, 
deselect all of the attributes to retain. The resulting map will still carry the databases, graticule, and line attributes of 
the original map.

The projections of all selected maps are marked on the menus that hold their projections. If the selected maps are 
all the same projection, then the projection menu holding the projection name will have a check mark next to it. 
Otherwise, each of the projections will have a dash next to its name, wherever it might be in the six projection menus.

Many projections have alternate names, or synonyms. In such cases, all synonyms of the projections of the selected 
maps will be marked on the menu of the relevant projection class. The mark will be a check mark if only one projec-
tion is present amongst the selected maps. Otherwise it will be a dash. You can find all synonyms of a projection in the 
Change Projection dialog.
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Chapter 12: Object menu
The Object menu offers control over document objects, each treated as a graphical element in its entirety without 
respect to content. This includes how document objects are positioned relative to each other. 

�

Bring to Front

This command brings the selected document objects to the front of the stack of document objects so that they render 
last, and therefore are the most visible when overlapping. The relative order of the selected objects in the stack, if more 
than one is selected, does not change; only their order with respect to the unselected objects.

Send to Back

This command sends the selected document objects to the back of the stack of objects so that they render first, and 
therefore are the least visible when overlapping. The relative order of the selected objects in the stack, if more than one 
is selected, does not change; only their order with respect to the unselected objects.

Bring Forward

This command brings each of the selected document objects one position frontward in the stack of document objects 
so that they render later, and therefore are more visible when overlapping.

Send Backward

This command sends each of the selected document objects one position backward in the stack of document objects so 
that they render earlier, and therefore are less visible when overlapping.
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Group

This command works if you have two or more document objects selected in the front window. It groups the selected 
document objects so that subsequently they can be selected and positioned as if they were a single object. In com-
posing the group, all selected document objects will be brought to a front-back position just behind the frontmost 
selected object.

A grouped object works as any other document object for the purposes of grouping. Therefore, you may further group 
two groups, for example, or a group and a map.

Ungroup

This command works if you have one or more document objects selected, where each document object is a group. The 
command releases each grouping. It does not release groups of groups.

Align Multiple

This command works if you have two or more document objects selected in the front window. It repositions the 
selected document objects so that their upper left corners coincide.

Center in Window

Use this command to reposition the selected document objects so that their centers coincide with the center of the 
front window.

Center in Document

Use this command to reposition the selected document objects so that their centers coincide with the center of the 
document.

Cancel Drawing

Use this command to cancel rendering of all selected maps.

To avoid using computer resources inefficiently, Geocart only draws one map at a time. It will devote all processors to 
the map it is drawing. If more maps are pending to draw, they will be drawn serially. Cancelling one map’s drawing 
means the next pending map will begin drawing. Hence you can use this command to change the order of drawing if 
you decide you need one map to finish rendering before another, for example.

Redraw

This causes all selected maps of the front document to redraw. You may want to do this because, for example, outside 
of Geocart you have made changes to a geographic database that the map uses to draw with. Geocart does not auto-
matically detect changes in files that a map is dependent on.
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Chapter 13: View menu
The view menu controls how Geocart documents are presented to you.

�

New

A window is just a view into a document, not the document itself. You may want several windows into a document so 
that you can view it different ways at the same time. For example, you may need to see the entire document at a time, 
so you would want one window for that. You may need to see the individual pixels of your map at the same size as 
your screen’s pixels, so you would want another window for that. You may need to see a zoomed-in view of some piece 
of the map you are interested in, so you would want another window for that. These windows can all coexist.

Use this command to create a new window into the front window’s document. The new window will have a zoom level 
of 100%. All operations you perform on the document will be reflected in all windows into the document.

Zoom In

Use this command to increase the zoom level, or magnification, of the front window. The amount of the increase 
depends on the present zoom level. You cannot increase the zoom level beyond 4,000%.

Other ways of changing the zoom level are the zoom control of the Navigator palette, Fit in Window, Actual Size, 
and Actual Pixels of Selected Objects.

Zoom Out

Use this command to decrease the zoom level, or magnification, of the front window. The amount of the decrease 
depends on the present zoom level. You cannot decrease the zoom level below 5%.

Other ways of changing the zoom level are the zoom control of the Navigator palette, Fit in Window, Actual Size, 
and Actual Pixels of Selected Objects.

Fit in Window

Your document area may be larger than the window you are viewing it in. With this command you can set the front 
window’s zoom level so that its entire document’s area is visible within the window.
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Actual Size

You must have one document object selected for this command to be available. This command may not work well if 
you have not calibrated Geocart’s understanding of your display’s resolution (see Display panel of Preferences).

You can specify a map to be any reasonable resolution you like (see Map Size and Resolution.). You may set a placed 
image to be any reasonable resolution you like (see Set Placed Image Resolution). You may have multiple docu-
ment objects, each of different resolution. You may set the zoom level to any value you like (see Zoom In). Hence 
a document object’s size within a window may be very different than the size it will ultimately print to or export 
to. Use this command to zoom the front window’s view so that document object is viewed at its real-world size.

Actual Pixels of Selected Object

You must have one document object selected for this command to be available.

You can specify a map to be any reasonable resolution you like (see Map Size and Resolution.). You may set a placed 
image to be any reasonable resolution you like (see Set Placed Image Resolution). You may have multiple document 
objects, each of different resolution. You may set the zoom level to any value you like (see Zoom In). Hence a docu-
ment object’s pixels within a window may be a very different size than your computer display’s pixels. If you want to 
view a particular document object, whether map or placed image, such that one pixel of the document object coin-
cides with one pixel of your display, use this command. This gives the clearest, most accurate representation.

Rulers

This command is a toggle switch. If the front window 
presently does not display rulers, then it will turn on ruler 
display. Otherwise it will turn off ruler display. The ruler’s 
measurement units are controlled by your setting in the 
General panel of the Preferences dialog.

The ruler system consists of two rulers: horizontal and verti-
cal ruler. The horizontal runs along the top of the content 
area. The vertical runs along the left edge of the content area.

By default the upper left corner of the document is the ruler 
origin, where the measurement starts. You can change the 
origin by clicking in the upper left corner of the window, 
where there is a crosshairs, and dragging the crosshairs to the 
point within the window where you want the origin to be. In 
the illustration, the top left corner shows where to drag from. 
The lower right red circle shows the crosshairs that drags along with your mouse pointer. Releasing the mouse button 
as shown sets London as the origin, so that both the horizontal and vertical rulers would start measuring from there. 
You can restore the origin to the upper left corner by double-clicking on crosshairs in the upper left corner.

Page Boundaries

Using Page Setup (Mac) or Print (Windows) you can choose the size of paper you intend to print to. The paper size 
need not coincide with the document area. If the document area is larger than the paper size, your document will print 
on several pages. This command will show the page boundaries as gray lines in the document area. If the document 
already displays page boundaries, this command turns them off.
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Chapter 14: Window menu
The Window menu offers window controls standard for the operating system and manipulations of Geocart windows. 
Besides the commands described below, at the bottom of the Window menu you will find an entry for each document 
window you have open. Selecting a window name from the list will make it the front document window.

For instructions specific to Windows, see the Windows section. For instructions specific to Macintosh, see Macintosh. 
The Navigator and Information palettes are common to both and are described first.

Navigator

If the Navigator palette is not presently displayed, this command will dis-
play it.

The Navigator palette gives you a view of the entire area of the front win-
dow’s document, in a size that you can set. The red rectangle corresponds to 
the portion of the document visible in the front window.

Besides showing the entire document, the Navigator lets you quickly pan 
the front window’s view to wherever you want in the document. Clicking 
anywhere on the palette will center the red rectangle there. The front win-
dow’s view will pan to match. You may also click and hold on the rectangle, 
dragging it around in order to change the front window’s view into the 
document.

The lower border of the palette contains a slider for zooming in and out. The zooming applies to the front window, not 
to the Navigator palette. Therefore in the Navigator palette, the effect is to change the red rectangle’s size. The zoom is 
the same as the View menu’s zoom functions, but you can control the zoom level in much finer increments here.

Information

If the Information palette is not presently displayed, this command will 
display it. 

The Information palette notes information about the front window’s docu-
ment (only). Specifically, it describes what is under the mouse pointer. In 
the case of a placed image, it describes the image format, color space, pixel 
dimensions, and the resolution.

If the pixel the pointer hovers over is within the bounding box of a map, 
but outside the map’s boundaries, then the palette will describe the map 
projection, any special properties, nominal scale, any parameters, the ellip-
soidal datum, the projection aspect, and the x,y coordinate of the mouse 
pointer. The coordinate is given in meters, computed from the nominal 
scale applied to the pixel distance of the mouse pointer from the projection’s origin. This is not a distance on the earth’s 
surface except in very limited cases.

If the pixel the pointer hovers over (called the reference point) is within the boundaries of a map, the info palette will 
further state the geographic coordinate under the mouse pointer along with distortion characteristics of the projection 
at the reference point.

Angular deformation means how much the map is “twisted” at the reference point. A value of 0° means the map 
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has no twisting or shearing at the point. Conformal maps show a value of 0° everywhere. (See Types of distortion, 
Chapter 3: Essentials.) The value may range between 0° and 180°, with 180° meaning, in essence, infinite twisting. 
Angular deformation will vary over the map if it is not conformal.

Areal inflation means how much larger or smaller than nominal scale the reference point is. A value of 1.0 means that 
the projection, at that point, neither inflates or deflates areas. Equal-area maps show a value of 1.0 everywhere. (See 
Types of distortion, Chapter 3: Essentials.) Values larger than 1.0 mean the map is inflated at that point; less than 1.0 
means it is deflated. Areal inflation will vary over the map if it not equal-area.

Scalar distortion is a measure that combines angular deformation and areal inflation into a single metric. There are 
many ways to do this, and none of them are “correct” in any absolute sense. The purpose is to give a reasonable basis 
for comparison. A value of 0° means the map has no angular deformation and no inflation or deflation at the reference 
point. An infinite value means the distortion is unbounded at that point, whether as angular deformation or inflation/
deflation, or both.

Scale factor range gives you more specific information about how the scalar distortion is composed. Distortion can 
vary by direction at a single point. Knowing what the greatest amount of stretching is and the least amount completely 
characterizes distortion at the point. If the greatest and least values are both 1.0, then the point is undistorted. If the 
greatest and least are the same value, then the point has no angular deformation. If the greatest is the reciprocal of the 
least, then the point has no inflation or deflation.

You can copy the contents of the Information palette onto the clipboard so that you can paste into a text editor by 
using the Copy Info Palette Text command.

Macintosh

Minimize

Minimizing means moving the front window out of the way and putting an icon for it into the dock. The next win-
dow down in the stack of windows becomes the front window. You can restore the window to full size and functional-
ity by clicking on its icon in the dock. For information about the dock, how to configure it, and how to use it, see 
your Mac OS documentation.

Zoom

Zooming increases the front window’s size as large as it can get while still fitting on the screen. Or, if the window 
has already been zoomed, Zoom reduces it to its previous size. This command is unrelated to the View menu’s zoom 
functions.
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Bring All to Front

This brings all Geocart windows to be in front of any other application’s windows, while leaving the relative order of 
the Geocart windows the same. On the Mac OS, windows from different applications can be interleaved in front-back 
order. That is a natural consequence of working with several applications, clicking on their visible windows to switch 
from application to application. Usually it is what you want, but sometimes you might want to sort the windows by 
application. This command is useful because it eliminates the interleaving when you need to.
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Windows

�

Cascade

This resizes all document windows to the same size and arranges them in a staggered overlap so that each window has 
its top and left side exposed. The window that was in front will remain in front.

Tile

This resizes all document windows to arrange them in an array so that no part of any window overlaps any other. If 
you have many windows, each could end up quite small. The window that was in front will appear as the upper left 
window and will still be the front window.

Arrange Icons

This command applies only to windows that have been minimized. (See your Windows operating system documenta-
tion for information about minimizing windows.) Arrange Icons arranges the minimized icons so that they progress 
from left to right, bottom to top, with no gaps. There is no effect if the icons are already arranged or if no windows 
have been minimized.

Close All

This closes all open document windows. For each document that has never been saved or has changes that have not 
been saved, you will be asked if you want to save it first.

Navigator

See the Macintosh Navigator palette description.

Information

See the Macintosh Information palette description.
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Chapter 15: Help menu
The Help menu supplies information and licensing operations.

�

Search (Mac only)

This is a Mac OS service with no function in Geocart. Please see your Macintosh documentation for explanation.

About Geocart (Windows)

About Box
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The Macintosh form of this command is found in the Geocart menu.

This command displays the About Box, which gives information about the Geocart product. You may need any or all 
of this information if you contact Mapthematics for support. In the upper right, you can find the version number of 
Geocart, which operating system, and which computer processor architecture the Geocart application was created for. 
At lower right, the name of the license holder appears, as recorded by the person who entered the license key. Beneath 
that is the serial number, and beneath that is the type of license tied to the license key.

User’s Manual

This command finds the Geocart User’s Manual installed with your Geocart files, and launches it for display in a suit-
able PDF reader if available. The manual is installed here:

(Mac) 
Library/Application Support/Mapthematics/Geocart/Version 3/Geocart Manual.pdf

(Windows XP) 
C:\Documents and Settings\All Users\Application Data\Mapthematics\Geocart\Version 3\ 
� Geocart Manual.pdf

(Windows Vista+) 
C:\ProgramData\Mapthematics\Geocart\Version 3\Geocart Manual.pdf

Available Fonts

One kind of database you can add to maps is a typesetting database. This is a database that places text at projected coor-
dinates. The typesetting database format contains instructions about what typefaces (fonts) to use when drawing text. 
In order to work properly for print and export to PDF, Geocart does not support all the different formats and format 
variants that the operating system might allow or provide. It only supports TrueType™ and OpenType™ fonts.

When you modify or create a typesetting database, you will need to provide the names of the fonts you want the text 
to draw in. Fonts have many names. The menu name often differs from the file name. The PostScript™ name usu-
ally differs from the menu name. The font may have family and style names. The font may have names in different 
languages.

Only the PostScript name will work in typesetting databases. So that you know what TrueType and OpenType fonts 
are available, and what their PostScript names are, you can access a list of the eligible fonts using this command. Any 
of the fonts you find in this list should work properly for typesetting databases.

Sample Documents

Selecting this command will switch the front application to the Finder (Macintosh) or Explorer (Windows) and open 
Geocart’s Sample Documents folder. In this folder you can find Geocart documents for each of the examples in 
Chapter 5: Examples. You can also find files to use as source images for general reprojection databases.

Release Notes

Selecting this command will switch away from Geocart and into your default Web browser, and load a status page that 
supplies the release notes for your version of Geocart. The URL depends on the version of Geocart you are running.
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Check for Updates

Selecting this command will switch away from Geocart and into your default Web browser, and load a status page that 
will tell you of any updates to Geocart. The URL depends on the version of Geocart you are running.

Geocart Forums

Selecting this command will switch away from Geocart and into your default Web browser, and load the Geocart 
Forums Web page if your computer is connected to the Internet. The URL is:

http://mapthematics.com/geocart3weblinks/forums/

Report a Bug

Selecting this command will switch away from Geocart and into your default Web browser, and load the Geocart bug 
report Web page if your computer is connected to the Internet. The URL is:

http://www.mapthematics.com/geocart3weblinks/reportabug.html

Credits

Selecting this command will display a dialog box that credits the Geocart authors along with the various open-source 
technologies used in Geocart.

License

Use this command to enter your license key when you receive one. You will be asked for a name to register the product 
to. However, the license will be tied to the machine, not the person. This means that people with different accounts on 
the machine are allowed to use the Geocart license as long as only one uses it at a time. Please see Licensing Terms for 
details of the Geocart license.

Relinquish License

Use Relinquish License to remove the Geocart license from your computer. Subsequent launches will run in demon-
stration mode. Reasons for relinquishing your license are to move your license to another computer or to transfer it to 
someone else. You may use License to restore the license to your computer or insert a new one.

Licensing Terms

Selecting this command displays a dialog box with the complete terms of your Geocart license.

http://mapthematics.com/forums/
http://www.mapthematics.com/geocart3weblinks/reportabug.html
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Appendix A: Which projection is best?
When you are crafting a map it is important that you choose the projection that is best suited for the job. This chapter 
can help inform your decision.

Kinds of Maps

Usually your map will fall into one or more of these categories:

•	 Technical

•	 Graphic

•	 Decorative

The lower you go on the list the more freedom you have to choose.

Technical maps include general reference maps of the world and of specific regions. They also include topographic 
maps, meteorological maps, planetary maps, distance maps, physiography maps, globe gores, satellite tracking maps, 
galactic maps, ocean current maps, shoal maps, military range maps, direction maps, forestry maps, navigational maps, 
road maps, drainage maps, land ownership maps, and many others.

Technical maps must be strictly correct because the people who use them depend very much on the map’s detailed 
information.

Graphic maps present their information in a more visual, less measurement-oriented fashion. They often rely on the 
brain’s ability to roughly compare areas, shapes, and colors. The major category of graphic maps is the thematic map. 
It is used to display statistical information such as population or production, or geologic information such as mineral 
deposits or climate. Sometimes it comes in the form of cartograms, which show relative data by distorting land areas, 
so that China, for example, would cover almost 1/5 of the earth’s surface and Canada only 1/200 of it by virtue of their 
respective populations. Other graphic maps may come in the form of unlabeled outline maps for educational use, 
puzzles, travel or tour maps, or posters.

The remaining maps are classified as decorative maps. These could be almost anything imaginable: posters, logos, 
tiles, T-shirts—even shower curtains. They are not designed or used for information but rather for art. The choice of 
projections then becomes an æsthetic question rather than a technical one.

Projections for Technical Maps

In designing technical maps your choice of projections is considerably restricted but that does not make it easier. 
Choosing the correct projection becomes a delicate dance of conflicting demands that necessarily forces you to 
compromise something desirable.

But you must choose. You cannot even presume that you should copy the projections that you find in published works 
because often they are inappropriate, especially those in wall maps.

Generally you can start by classifying the map according to its size of the area it will display. Whole-world maps have 
different needs than hemispheric maps, which have entirely different needs than larger scale maps of continents or 
huge nations, which in turn have different needs than national maps, which are themselves different from local maps.

World Maps

Reference maps of the entire earth present the most vexing cartographic problem. The amount of distortion inherent 
in any global projection is much higher than the minimum that the eye can discern and therefore all of them fail to a 
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large degree. Some, however, fail worse than others, so there are some guidelines that can be used.

First, no conformal projection should be used for world reference maps. The Mercator has been used for centuries 
but, while it has navigational value, it is unsuited to reference maps because it cannot display the poles and because it 
horribly exaggerates scale away from the equator. All conformals suffer from the problem of exaggerated scale.

The past century has seen a push toward equal-area maps. While the size of any area is correct in relation to any other, 
shapes are always badly distorted somewhere, particularly in those projections having some other constraint, such as 
straight parallels or meridians. Nevertheless many professionals agree that size is more important than shape because 
correct sizes prevent people from getting funny ideas about how important or unimportant some piece of land is.

A number of projections are compromises, neither equal-area nor conformal. These maps were created in the belief 
that relaxing the constraint of area or shape could produce a map with better overall qualities. While this is open to 
question, some of these maps have proven histories and can be relied on.

Some scholars prefer maps with straight parallels, ostensibly because they show latitudinal information which can be 
important for contrasting climate and vegetation. We think, however, that most map viewers know that the parallels 
indicate latitude and naturally use them to reference the latitude. Furthermore, altitude, prevailing winds, surrounding 
land forms, and oceans all contribute strongly to a region’s climate, reducing the importance of latitude. Therefore we 
believe that maps with moderately curved parallels are better because they reduce the amount of shearing in the map. 
However, if your map will not show the graticule then you should consider using a projection with straight parallels.

Some projections, most notably the pseudocylindrics, can be interrupted. This usually means cutting the globe from 
the poles to the equator in several places and then projecting the slices individually as if each were at the center of 
the globe. An interrupted map is not really a world map, but rather an assemblage of more local maps. It reduces 
distortion inside a slice by tremendously distorting the area between slices. Sometimes such projections are appropriate 
for physiography and thematic maps.

Then there is the problem of pole-lines: in order to reduce a form of shape distortion called shearing, many projections 
stretch the poles into lines from their original points. While this can help other areas of the map quite a bit, many map 
viewers cannot picture what has happened to the pole.

Use the decision tree at the end of the chapter to help you select a projection for your technical world map.

Hemispheric Maps

Hemispheric maps can be much more accurate than whole world maps and involve fewer compromises. Strangely, 
there are only a few projections suitable for this purpose. You should decide which of conformality, area, scale 
distortion, perspective, distance, or direction is important, and once you have done so you can use the decision tree at 
the end of the chapter to mechanically pick a projection since there are clear bests in each of these categories. Normally 
only azimuthal projections are suitable for hemispheres.

Huge nation, continental, oceanic, national, regional, local

This is another difficult category. Historically there have been rules of thumb based on the position of the region on 
the sphere—was it polar, temperate, or equatorial?

These rules restricted the number of suitable projections and made it easy to construct the graticule. But now we have 
computers and programs like Geocart that can easily rotate the globe however we like before projecting it. This means 
that the correctness of the map can take priority over its ease of computation, but it also means we need a new set of 
rules to handle the new freedom.

These maps deal with areas greater than the size of Brazil, about 5,000,000 km2 (2,000,000 mi2). First, what is the 
shape of the region? Is it roughly circular, like Antarctica or Australia? Is one direction much longer than the other, like 
the former Soviet Union or South America?

Second, are there parts of the area of interest whose accuracy is not so important? For instance, many map designers 
would be willing to sacrifice strict accuracy in the Queen Elizabeth Islands of Canada’s Northwest Territory if they 
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could achieve more accuracy in the economically important areas of the country. Eastern Siberia would sometimes be 
considered less important than south-central or western Asia. The Pacific Ocean south of Alaska and west of North 
America may need less accuracy than the continent and Hawaii itself. How does the shape of the region change when 
these less-important areas are subtracted?

A major issue here is shape versus area. A trained observer will immediately spot shearing or stretching on any equal-
area map of Eurasia. On the other hand, a well-planned conformal map of the same area will not show objectionable 
area distortion, even though it is substantial. For this reason, conformal maps are often chosen for these kinds of 
regions. But a map of the entire Pacific Rim will show shape or area distortion no matter what projection is chosen, so 
many recent maps have used non-conical equal-area projections or minimum error compromise projections.

In general, conic projections should not be used when the region covers more than about 70° in both directions, but 
they are very useful for long regions along a small circle. Some cylindrics can be used in oblique form for long but very 
narrow areas along a great circle. Except, perhaps, for the sinusoidal, pseudocylindrics are not appropriate for anything 
other than world maps.

National and Provincial Maps

These maps have areas greater than about 50,000 km2 (20,000 mi2) and less than 5,000,000 km2 (2,000,000 mi2), 
and are easy to choose projections for. At this scale you need not worry about equal-area versus conformal since the 
difference between the two is often less than the warpage of the paper the map is printed on. Perhaps your most 
important task is to reduce overall scale error to a minimum. 

You can get the most accurate maps by using projections which project the globe onto a surface slicing through the 
earth at a distance about 1/5 the distance from the center to the outside boundary of the area of interest.

If the map’s scale will be very large, you should consider modeling the earth as an ellipsoid rather than a sphere if you 
know the ellipsoidal datum that your coordinate or pixel data are referred against.

Local Maps

Local maps, such as county and city maps, show areas less than about 50,000 km2 (20,000 mi2). You can choose any 
projection which has true scale at the center of the map. At this size, however, you should consider the earth to be an 
ellipsoid if you want truly accurate maps, and you should choose data sets based on a known ellipsoid.

Projections for Graphic Maps

Typically you should use an equal-area projection for thematic maps of the world. If you will not be showing the 
graticule then you might restrict your choice to a pseudocylindric projection. You may choose to interrupt your map 
since you can gain more accuracy in land shapes that way, and often you are not interested in the spatial relationship 
between countries, but only in the graphic information within each country.

Geocart cannot construct cartograms for you, but it can help you prepare base maps that you can then piece together 
yourself. You will most likely use the Stretch and Rotation command from the Projection menu. To ease your work 
you might choose a cylindric projection so that you don’t have to worry about matching the edges of adjacent local 
maps, since the graticule is a network of straight lines.

Unlabeled regional or national maps should have correct shapes, so you should use a conformal projection centered on 
the area of interest. Puzzle and game maps follow the rules for technical maps, but you can choose projections that are 
easy to deal with since the accuracy of the map is not so critical. The same goes for travel or tour maps and posters. For 
all these types you can use the decision tree at the end of the chapter to help you.
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Projections for Decorative Maps

The most enjoyable group of projections for some people is the decorative maps that may not be so useful but that fit 
some shape or have an unusual property. You may need a world map that you can duplicate and fit together in every 
direction for tiling. Or one in the shape of a triangle or star or heart. You may need to fit the world into a circle. All of 
these shapes, and others, are available.

Using the Decision Tree

The decision tree can help you decide what map projection to use when making a map. Sometimes your choices need 
not be restricted by what is in this chart, but in general the chart provides a comprehensive guide for most usual needs. 
Keep in mind that sometimes there are no best choices.

At each level of the tree, ask yourself about the map’s requirements. If the requirements match one of the headers at 
that level then proceed to the next level.

Once you have selected a projection, use Appendix B: Projection gazetteer to help you correctly prepare the map. Often 
you will need to recenter the map to attain the desired effect, but some maps should not be recentered. The Gazetteer 
can help you in such cases.

For example, let’s say you need a map of the Pacific Ocean that measures distance and direction to Honolulu, Hawaii, 
from anywhere in the ocean. First, decide which of technical, graphic, or decorative the map will be. In this case, the 
map is clearly technical. Under the [(1) Technical] heading we find five items:

a.	 World – section 1.1

b.	 Hemisphere – section 1.2

c.	 Continent, ocean, huge nation – section 1.3

d.	 Nation/province – section 1.4

e.	 Local – section 1.5

Our map is an oceanic map, so we choose the [(c) Continent, ocean, huge nation] header. From there we see the 
following fourteen choices:

	 1.3.1	 Aerial view

	 1.3.2	 Circles on sphere are circles on map

	 1.3.3	 Distance chart

	 1.3.4	 Direction chart

	 1.3.5	 Navigational chart

	 1.3.6	 North and South America

	 1.3.7	 Region is vaguely circular in shape

	 1.3.8	 Region is vaguely elliptical shape

	 1.3.9	 Region lies along meridian or equator (or follows great circle)

	 1.3.10	 Region lies along a parallel (or follows small circle)

	 1.3.11	 Great circles are straight (shortest route)

	 1.3.12	 Rhumbs are straight lines

	 1.3.13	 Triangulating chart
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	 1.3.14	 USA map

Our map is concerned with distance and direction, so we can choose either. If we arbitrarily choose [(2.3.3) Distance] 
Chart we see the following four choices:

	 i.	 Azimuths from center are straight, correctly scaled, and have radially measurable directions.

	 ii.	 Azimuths to center have radially measurable directions, and distances to center are correct.

	 iii.	 Distances are correct from two centers.

	 iv.	 Rhumbs from center are straight and correctly scaled.

The second choice, [(ii) Azimuths to center have radially measurable directions, and distances to center are correct] is 
exactly what we are looking for. It points us to the Hammer retroazimuthal projection.

From here we refer to the Appendix B: Projection gazetteer for information about the Hammer retroazimuthal. We 
discover that we are supposed to center the projection on the meridian of interest using the Projection Center menu 
command, and then use the Parameters menu command to specify the center latitude. Looking at a globe we find 
that Honolulu is at 21°18′N, 157°54′W.

First we open a new document. Then we select Hammer retroazimuthal from the projections presented by the 
retroazimuthal submenu of the Azimuthal menu. We don’t want a whole-earth map, so we use the Boundaries 
command from the Map menu to select the Pacific region—65°N, 99°E, 86°S, 67°W for NWSE coordinates will do. 
As per the Projection Gazetteer, after selecting the Projection Center command from the Projection menu, we type 
157°54′W into the Longitudinal field, and click OK. Then we select the Parameters command from the same menu 
and type 21°18′N to specify the standard parallel. We now have finished the basic map and can embellish it however 
we like from here.
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Map projection selection tree
Use this key to decide which projection is most appropriate for your map.

Is the main purpose of your map —

a.	 Technical - Go to Section 1.

b.	 Graphic - Go to Section 2.

c.	 Decorative - Go to Section 3.

Section 1. Technical Maps

What is the extent of your map?

a.	 World – section 1.1

b.	 Hemisphere – section 1.2

c.	 Continent, ocean, huge nation – section 1.3

d.	 Nation/province – section 1.4

e.	 Local – section 1.5

1.1 Technical world maps

Does your map need to be a – 

		  1.1.1	 Coordinate chart

		  1.1.2	 Direction chart

		  1.1.3	 Distance chart

		  1.1.4	 Edge-matchable along meridians (providing greater than 360° coverage)

		  1.1.5	 Extruded globe (flat map on plastic to heat and form into hemisphere)

		  1.1.6	 General reference

		  1.1.7	 Globe gores (for making a globe)

		  1.1.8	 Navigational chart

		  1.1.9	 Oceanic chart

		  1.1.10	 Recenterable map

		  1.1.11	 Time zone map

	1.1.1	 Coordinate chart (coordinates linearly measurable)

	 “Geographic” projection

1.1.2	 Direction chart

	 i.	 Azimuths to center have radially measurable directions, and distances to center are correct

	 Hammer retroazimuthal
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	 ii.	 Azimuths from center/s are straight and have radially measurable directions

			   Distances from center are correct

			   Azimuthal equidistant

			   Two centers

			   Two-point azimuthal

	 iii.	 Rhumbs have radially measurable directions

			   All rhumbs are straight

			   Mercator

			   Rhumbs from center are straight and correctly scaled

			   Loximuthal

1.1.3	 Distance chart

	 i.	 Azimuths from center are straight, correctly scaled, and have radially measurable directions

		  Azimuthal equidistant

	 ii.	 Azimuths to center have radially measurable directions, and distances to center are correct

	 	 Hammer retroazimuthal

	 iii.	 Distances from two centers are correct

	 	 Two-point equidistant

	 iv.	 Azimuths from center are straight and have linearly measurable directions

		  Plate carrée (point of interest moved to a pole)

	 v.	 Equal-area

			   Parallels are correctly scaled

			   Sinusoidal

			   Distances from center point are correct

			   (Oblique) Werner

	 vi.	 Rhumbs from center are straight, correctly scaled, and have radially measurable directions

		  Loximuthal

1.1.4	 Edge-matchable along meridians (providing greater than 360° coverage)

	 Equal-area cylindric

	 Miller

1.15	 Extruded globe (flat map on plastic to heat and form into hemisphere)

	 Extruded globe
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1.1.6	 General reference

	 Strebe 1995

	 Wagner VII

	 Strebe-Kavrayskiy (centered on 11°E, 11°S)

	 Winkel tripel

	 Robinson

1.1.7	 Globe gores (for making a globe)

	 (Transverse) plate carrée (by piercing together twelve 30° segments)

	 Rectangular polyconic (standard parallel 0°)

	 American polyconic

1.1.8	 Navigational chart

	 i.	 Azimuths from center/s are straight and have radially measurable directions

			   Distances are correct from center

			   Azimuthal equidistant

			   Two centers

			   Two-point azimuthal

	 ii.	 Distances from center/s are correct

			   Azimuths from center are straight and have radially measurable directions

			   Azimuthal equidistant

			   Two centers

			   Two-point equidistant

	 iii.	 Straight rhumbs

			   Rhumbs from center are straight, correctly scaled, and have radially measurable directions

			   Loximuthal

			   All rhumbs are straight

			   Mercator

1.1.9	 Oceanic chart

	 McBryde S3 (central meridian 180°W) See patent information in Notices.

	 Mollweide (central meridian 180°W)
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1.1.10	 Recenterable map

	 Equal-area cylindric

	 Miller

1.1.11	 Time zone map

	 Plate carrée

	 Miller cylindric

1.2 Technical hemisphere maps

Does your map need to be a – 

		  1.2.1	 Circles on sphere are circles on map

		  1.2.2	 Conformal map

		  1.2.3	 Direction chart

		  1.2.4	 Distance chart

		  1.2.5	 Equidistant map

		  1.2.6	 Equal-area map

		  1.2.7	 Extruded globe (flat map on plastic to heat and form into hemisphere)

		  1.2.8	 General reference

		  1.2.9	 Minimum scale error

		  1.2.10	 Rhumbs from center point are straight

		  1.2.11	 Solar eclipses

		  1.2.12	 Space view

1.2.1	 Circles on sphere are circles on map

	 Stereographic

1.2.2	 Conformal map

	 Stereographic

1.2.3	 Direction chart

	 i.	 Azimuths to center have radially measurable directions

			   Distances to center are correct

			   Hammer retroazimuthal

			   Meridians are straight

			   Craig retroazimuthal

	 ii.	 Azimuths from center have radially measurable directions

			   Azimuths from center are correctly scaled
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			   Azimuthal equidistant

			   Conformal

			   Stereographic

			   Equal-area

			   Lambert azimuthal equal-area

			   Minimum error

			   Airy

	 iii.	 Rhumbs from center are correctly scaled and have radially measurable directions

	 Loximuthal

			   All rhumbs are straight

			   Mercator

1.2.4	 Distance chart

	 i.	 Azimuths from center are straight, correctly scaled, and have radially measurable directions

	 Azimuthal equidistant

	 ii.	 Azimuths to center have radially measurable directions, and distances to center are correct

	 Hammer retroazimuthal

	 iii.	 Distances are correct from two centers

	 Two-point equidistant

	 iv.	 Equal-area

			   Parallels are correctly scaled

			   Sinusoidal

			   All distances from center point are correct

			   (Oblique) Werner

	 v.	 Rhumbs from center are straight, correctly scaled, and have radially measurable directions

	 Loximuthal

1.2.5	 Equidistant map

	 Azimuthal equidistant

1.2.6	 Equal-area map

	 Lambert azimuthal equal-area
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1.2.7	 Extruded globe (flat map on plastic to heat and form into hemisphere)

	 Extruded globe

1.2.8	 General reference

	 Airy (Minimum error range from center = 90°)

	 Lambert azimuthal equal-area

1.2.9	 Minimum scale error

	 Airy (Minimum error range from center = 90°)

1.2.10	 Rhumbs from center point are straight

	 Loximuthal

1.2.11	 Solar eclipses

	 Stereographic	

1.2.12	 Space view

	 Orthographic

1.3 Technical continent, ocean, huge nation maps

Does your map need to be a – 

		  1.3.1	 Aerial view

		  1.3.2	 Circles on sphere are circles on map

		  1.3.3	 Distance chart

		  1.3.4	 Direction chart

		  1.3.5	 Navigational chart

		  1.3.6	 North and South America

		  1.3.7	 Region is vaguely circular in shape

		  1.3.8	 Region is vaguely elliptical in shape

		  1.3.9	 Region lies along meridian or equator

		  1.3.10	 Region lies along a parallel

		  1.3.11	 Great circles are straight

		  1.3.12	 Rhumbs are straight lines

		  1.3.13	 Triangulating chart

		  1.3.14	 USA map

1.3.1	 Aerial view

	 i.	 Deep space

	 Orthographic
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	 ii.	 High altitude or orbit

	 Vertical perspective

	 iii.	 Lateral view

	 Tilted perspective

1.3.2	 Circles on sphere are circles on map

	 Stereographic

1.3.3	 Distance chart

	 i.	 Azimuths from center are straight, correctly scaled, and have radially measurable directions.

	 Azimuthal equidistant

	 ii.	 Azimuths to center have radially measurable directions, and distances to center are correct.

	 Hammer retroazimuthal

	 iii.	 Distances are correct from two centers.

	 Two-point equidistant

	 iv.	 Rhumbs from center are straight and correctly scaled.

	 Loximuthal

1.3.4	 Direction chart

	 i.	 Azimuths from center(s) are straight and have radially measurable directions

			   Conformal

			   Stereographic

			   Distances from center are correct

			   Azimuthal equidistant

			   Equal-area

			   Lambert azimuthal equal-area

			   Minimum Error

			   Airy

			   Two centers

			   Two-point azimuthal

	 ii.	 Azimuths to center have radially measurable directions

			   Distances to center are correct

			   Hammer retroazimuthal

			   Meridians are straight
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			   Craig retroazimuthal

			   Conformal

			   Littrow

	 iii.	 Rhumbs from center are straight and have radially measurable directions

	 Loximuthal

	 iv.	 All rhumbs are straight

	 Mercator

1.3.5	 Navigational chart

	 i.	 Azimuths from center(s) are straight and have radially measurable directions

			   Distances from center are correct

			   Azimuthal equidistant

			   Straight great circles

			   Gnomonic

			   Two-point azimuthal

			   Two centers

			   Two-point azimuthal

	 ii.	 Azimuths to center have radially measurable directions

			   Distances to center are correct

			   Hammer retroazimuthal

			   Meridians are straight

			   Craig retroazimuthal

			   Conformal

			   Littrow

	 iii.	 Distances from center(s) are correct

			   Azimuths from center are straight and have radially measurable directions

			   Azimuthal equidistant

			   Two centers

			   Two-point equidistant

	 iv. 	 Great circles are straight

	 Gnomonic

	 Two-point azimuthal
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	 v.	 Rhumbs are straight

			   Rhumbs from center are straight, correctly scaled, and have radially measurable directions

			   Loximuthal

			   All rhumbs are straight

			   Mercator

1.3.6	 North and South America

	 Bipolar oblique conic conformal

	 Transverse (oblique) Mercator

1.3.7	 Region is vaguely circular in shape

	 i.	 Conformal

	 Stereographic

	 ii.	 Equal-area

	 Lambert azimuthal equal-area

	 iii.	 General

	 Airy

	 iv.	 Minimum scale error

	 Airy

1.3.8	 Region is vaguely elliptical in shape

	 Chamberlin trimetric

	 Miller stereographic

1.3.9	 Region lies along meridian or equator (or follows great circle)

	 Transverse, standard (or oblique) Mercator	

1.3.10	 Region lies along a parallel (or follows small circle)

	 Equidistant conic

	 Albers

	 Lambert conformal conic

1.3.11	 Great circles are straight (shortest route)

	 i.	 Azimuths from center are straight and have radially measurable directions

	 Gnomonic
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	 ii.	 Azimuths from two centers are straight and have radially measurable directions

	 Two-point azimuthal	

1.3.12	 Rhumbs are straight lines

	 i.	 Rhumbs from center point are straight and correctly scaled

	 Loximuthal

	 ii.	 All rhumbs straight

	 Mercator

1.3.13	 Triangulating chart

	 Two-point azimuthal

1.3.14	 USA map

	 i.	 50 states

	 GS50

	 Lambert conformal conic

	 ii.	 48 states

	 Equidistant conic

	 Albers

	 Lambert conformal conic

1.4 Technical nation, province map

Does your map need to be a – 

		  1.4.1	 Aerial view

		  1.4.2	 Edge-matching

		  1.4.3	 Region is vaguely circular in shape

		  1.4.4	 Region is long, slender and curved

		  1.4.5	 Region is long, slender and straight

		  1.4.6	 Region is vaguely oval

1.4.1	 Aerial view

	 i.	 Straight down

		  Vertical perspective

	 ii.	 Lateral view

		  Tilted perspective
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1.4.2	 Edge-matching

	 i.	 East-west edge-matching (match along a small circle)

		  Equidistant conic

		  Albers

		  Lambert conformal conic

	 ii.	 North-south edge-matching (match along a great circle)

			   Conformal

			   Transverse (oblique) Mercator

			   General

			   American polyconic

			   Rectangular polyconic

			   Transverse (oblique) loximuthal (central parallel at 0°)

1.4.3	 Region is vaguely circular in shape

	 Airy

	 Stereographic

1.4.4	 Region is long, slender and curved

	 Equidistant conic

	 (Oblique or standard) Lambert conformal conic

	 (Oblique or standard) Albers

1.4.5	 Region is long, slender and straight

	 (Transverse, standard, or oblique) Mercator

	 (Transverse, standard, or oblique) sinusoidal

1.4.6	 Region is vaguely oval

	 Chamberlin trimetric

1.5 Technical local map

Does your map need to be a – 

		  1.5.1	 Aerial view

		  1.5.2	 General (any well-bahaved projection with unity scale factor in center)

		  1.5.3	 Edge-matching

		  1.5.4	 Survey chart
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	1.5.1	 Aerial view

			   Straight down

			   Perspective

			   Lateral view

			   Tilted perspective

	1.5.2	 General (any well-behaved projection with unity scale factor in center)

	 Plate carrée

	 Mercator

	 Sinusoidal

	 American polyconic

	 Stereographic

	1.5.3	 Edge-matching (See National, provincial map Edge Matching)

	1.5.4	 Survey chart

	 Stereographic

	 Miller stereographic

	 Mercator

	 Lambert conformal conic
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Section 2. Graphic Maps

What is the extent of your map?

a.	 World – section 2.1

b.	 Hemisphere – section 2.2

c.	 Continent, ocean, nation, region, local map – Section 2.3

2.1 Graphic world map

Does your map need to be a – 

		  2.1.1	 Climate, forestry or geology map

		  2.1.2	 Comparative statistics display

		  2.1.3	 Distance map

		  2.1.4	 Trade routes

		  2.1.5	 Time zones

		  2.1.6	 Unmarked base map

2.1.1	 Climate, forestry and geology maps

	 Boggs eumorphic

	 Goode homolosine

	 Eckert IV

2.1.2	 Comparative statistics display (population, manufacturing, birth rates, etc.)

	 Eckert IV

	 Boggs eumorphic

	 Goode homolosine

2.1.3	 Distance map

	 Azimuthal equidistant

2.1.4	 Trade routes

	 Mercator

2.1.5	 Time zones

	 Miller cylindric

	 Plate carrée

2.1.6	 Unmarked base map

	 Winkel tripel
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	 Mollweide

	 Robinson

2.2 Graphic hemisphere map

Does your map need to be a – 

		  2.2.1	 General view

		  2.2.2	 Moon or planet view

		  2.2.3	 Space view

2.2.1	 General view

	 Lambert azimuthal equal-area

	 Airy

2.2.2	 Moon or planet view

	 Orthographic

2.2.3	 Space view

	 Orthographic

2.3 Graphic continent, ocean, nation, region, local map

Does your map need to be a – 

		  2.3.1	 Aerial view

		  2.3.2	 Air flight routes

		  2.3.3	 Direction map

		  2.3.4	 Distance map

		  2.3.5	 General map

		  2.3.6	 Portolan chart

		  2.3.7	 Unlabelled base map

2.3.1	 Aerial view

	 i.	 From deep space

	 Orthographic

	 ii.	 From high altitude or orbit

	 Vertical perspective

	 iii.	 Laterally from high altitude

	 Tilted perspective
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2.3.2	 Air flight routes

	 Gnomonic

2.3.3	 Direction map

	 i.	 Direction from somewhere to anywhere

	 Azimuthal equidistant

	 ii.	 Direction from anywhere to somewhere

	 Craig retroazimuthal

2.3.4	 Distance map

	 Azimuthal equidistant

2.3.5	 General map

	 Lambert equal-area

2.3.6	 Portolan chart

	 Mercator

2.3.7	 Unlabelled base map

	 Stereographic
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Section 3. Decorative Maps

What is the extent of your map?

a.	 World – section 3.1

b.	 Hemisphere – section 3.2

c.	 Continent, ocean, nation, region, or local map– section 3.3

3.1 Decorative world map

Does your map need to be a – 

		  3.1.1	 Antique look

		  3.1.2	 General map

		  3.1.3	 Live view

		  3.1.4	 Schoolroom wall map

		  3.1.5	 Shaped map

		  3.1.6	 Tiled map

3.1.1	 Antique look

	 Al-Bīrūnī (paired for both hemispheres)

	 Stereographic (paired for both hemispheres)

	 Ortelius oval

	 Werner

3.1.2	 General map

	 Robinson

	 Armadillo

	 Hammer

	 Briesemeister

	 Strebe-Snyder pointed-pole

3.1.3	 Live view

	 Orthographic (paired for both hemispheres)

3.1.4	 Schoolroom wall map

	 Denoyer semi-elliptical

3.1.5	 Shaped map

	 Apple:		  Quaziazimuthal equal-area apple
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	 Circle:		  Lagrange; Van der Grinten I, II, III

	 Clam:		  August epicycloidal; Eisenlohr; American polyconic

	 Diamond:	 Adams world in a square II; Lateral equidistant

	 Heart:		   Heart; Bonne; amulet; shield

	 Orange peel:	 Goode homolosine (interrupted)

	 Ornament:	 Strebe-sinusoidal (cartouche); Foucaut stereographic

	 Oval:		  Elliptic conformal; Mollweide; Apian II

	 Pinwheel:	 Wiechel

	 Pumpkin:	 Loximuthal; van der Grinten IV

	 Rectangle:	 Miller; plate carrée; Guyou

	 Square:	 Peirce quincuncial; Adams world in a square I

	 Star:		  Berghaus star

	 Tire:		  Armadillo

	 Triangle:	 Collignon

	 UFO:		  Goode homolosine (uninterrupted)

3.1.6	 Tiled map

	 Diamond:	 Adams world in a square II

	 Rectangle:	 Guyou; Adams hemisphere in a square

	 Square:	 Peirce quincuncial; Adams world in a square I

3.2 Decorative hemisphere map

Does your map need to be a – 

		  3.2.1	 Antique look

		  3.2.2	 Real view

		  3.2.3	 Shaped map

3.2.1	 Antique look

	 Al-Bīrūnī

	 Ptolemy II

	 Stereographic

	 Werner
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3.2.2	 Real view

	 Orthographic

3.2.3	 Shaped map

	 Apple:		  Quasiazimuthal equal-area apple (half )

	 Circle:		  Al-Bīrūnī; stereographic; orthographic

	 Pinwheel:	 Wiechel (half )

	 Square:	 Adams hemisphere in a square; Guyou (half )

	 Diamond:	 Peirce quincuncial (northern hemisphere)

3.3 Decorative continent, ocean, nation, region, local map

Does your map need to be a – 

		  3.3.1	 Aerial view

		  3.3.2	 Anything else

3.3.1	 Aerial view

	 i.	 From deep space

	 Orthographic

	 ii.	 Aerial, orbital

	 Vertical perspective

	 Tilted perspective

3.3.2	 Anything else

	 Plate carrée

	 Sinusoidal

	 Airy

	 Azimuthal equidistant

	 Lambert azimuthal equal-area

	 Orthographic

	 Stereographic



A.24
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Appendix B: Projection gazetteer
This chapter describes the map projections in Geocart and how to use them. Map projections are grouped within the 
six Geocart classes of projections:

Cylindric Pseudocylindric Conic

Azimuthal Lenticular Miscellaneous

 …and then alphabetically within each. All projections and their synonyms are listed. The informational entry 
for a projection is given at Geocart’s preferred name for that projection. Keep in mind that projection names are 
not standardized. Even what ought to be considered a separate, named projection is open to debate. Menu names 
sometimes deviate from formal names. Menu names appear in brackets to the right of the preferred name.

You can create a new map directly by holding down the shift key while selecting a map projection from one of the six 
menus. A map with default parameters and projection center appropriate to that projection will be drawn.

Special properties of the projections are noted. Beware that many of these properties apply only in certain aspects of 
the projection. For instance, the sinusoidal has correct scale along each parallel but only when the map is centered 
along the equator. In any other aspect the scale is correct along any line parallel to the long axis, but the parallels 
follow paths of varying scale. Some projections have only historical or academic value and are noted as such.

Descriptions and information for many of the projections are adapted in part from: Snyder, J.P. And Voxland, P.M. 
1989. An Album of Map Projections. US Geological Survey Professional Paper 1453. US Government Printing Office.

Projection parameters

Some projections have parameters, or settings to control the appearance of the projection. The purposes of these 
parameters vary from projection to projection. All are controlled from the Parameters item in the Projection menu.

Conic projections have one or two standard parallels which control the accuracy of the projection over the region you 
want to map. A cone can sit on a globe like a hat, and when a conic has one standard parallel, that parallel tells at what 
latitude the cone contacts the globe. When the projection has two standard parallels it means the cone slices through 
the globe instead of sitting on it. The two parallels tell where the cone cuts into the globe and where it comes back out. 
Normally you will choose standard parallels within the region you are mapping.

Other projections can have standard parallels as well. The exact purpose differs between projections, but it usually 
means the latitude at which the scale is correct.

Some projections have a point whence a special property, such as correct direction, emanates. You must specify both 
a latitude and longitude, in that order. Other projections have a range over which a special property is effective, and 
usually you must specify the range in degrees of arc. A degree of arc is about 111 km (69 mi) on the earth’s surface. A 
hemisphere is 90° of arc, and the entire earth is 180° of arc. There are other kinds of parameters as well; they will be 
explained as needed for each projection.

The notations << and >> are used to mean that a parametric value should be well away from some forbidden value. 
Although there is no measurably precise meaning for them, in general you can take it to mean that the map is not 
very useful when the parameters are near the forbidden value. In contrast, < and > are normally used to mean that the 
forbidden value is a singularity. Any value not equal to the forbidden value is mathematically allowable, but keep in 
mind that the computer only works with a finite number of decimal places and cannot always distinguish between two 
values that are very close together.

The symbol φ (phi) always refers to a latitude and λ (lambda) always refers to a longitude.
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 Cylindric projections

Б.С.А.М.—See B.S.A.M. 

Карченко-Шабанова—See Karchenko-Shabanova 

Павловa—See Pavlov

Урмаева III—See Urmayev III

B.S.A.M.

Description Similar to the Gall stereographic, but with standard parallels at 30°N/S.
Use Historical.

B.S.A.M

Balthasart

Description Is equal-area cylindric with standards parallels of 50°N/S.

Balthasart
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Behrmann equal-area

Description Cylindric, equal-area, perspective.

The same as the Lambert cylindric equal-area projection, except for horizontal compression 
and vertical expansion to achieve no distortion at latitudes 30°N and 30°S instead of at the 
equator. It is equivalent to a projection of the globe using parallel lines of projection onto a 
cylinder secant of 30°N and 30°S.

Similar projections Lambert cylindric equal-area
Gall orthographic
Trystan Edwards
Gall-Peters 
Hobo-Dyer 
Smyth equal-surface 
Balthasart

Graticule Meridians: Equally-spaced, straight parallel lines 0.42 as long as the equator.

Parallels: Unequally-spaced straight lines, farthest apart near the equator, perpendicular to 
the meridians.

Poles: Straight lines equal in length to the equator.

Symmetry: About any meridian or the equator.
Scale True along latitudes 30°N and 30°S. Too small along the equator, and too large at the 

equator along the meridians. The scale is the same at the parallel of opposite sign.

Scale increases with distance from the equator in the direction of parallels and decreases in 
the direction of meridians to maintain equal-area.

Use Historical. Presented by Walter Behrmann (1822-1955) of Berlin in 1910.

Behrman equal-area

Braun cylindric

Description Similar to the Miller cylindric or Mercator, depending on parameter.
Parameters One enumeration for selecting the projection perspective point. Antipodal results in a 

Miller-like presention; From 2/5R results in a Mercator-like presention, but with finite poles.
Use Historical.
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Braun

Cassini—See transverse plate carrée

Cassini-Soldner—See transverse plate carrée

central—See central cylindric

central cylindric [central]

Description Cylindric, perspective, neither conformal nor equal-area.

This projection is produced geometrically by projecting the earth’s surface perspectively 
from its center onto a cylinder tangent at the equator. It should not be confused with the 
Mercator, which is not perspective.

Synonyms perspective cylindric 
simple perspective cylindric

Similar projections Mercator, which is not perspective, also cannot show the poles, but the poleward increase 
in the spacing of the parallels does not occur as rapidly as it does on the central cylindric 
projection.

Gall and other perspective cylindric projections can be produced by moving the point of 
perspective away from the center of the earth. The poles can then be shown.

Gnomic projection is projected perspectively from the center of the earth onto a tangent 
plane rather than a cylinder and is very different in appearance.

Graticule Meridians: Equally-spaced, straight parallel lines.

Parallels: Unequally-spaced, straight parallel lines, closes near the equator, but spacing 
increases poleward at a much greater rate than it does on the Mercator. Perpendicular to 
meridians.

Poles: Cannot be shown.

Symmetry: About any meridian or the equator.
Scale True along the equator. Increases with distance from the equator to infinity at the poles. 

Changes with direction at any given point, except at the equator, but scale in a given 
direction is constant at any given latitude or at the latitude of opposite sign.

Distortion Shape, area, and scale distortion increase rapidly away from the equator where there is no 
distortion.

Use Academic. The distortion is too great for any usage except for showing the appearance of 
the earth when so projected and contrasting with the Mercator.

Limitations Cannot show the poles.
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central cylindric

Craster equal-area—See Smyth equal-surface

ellipsoidal Mercator

Description Ellipsoidal development the equatorial Mercator projection. Cylindric and conformal.
Scale True along equator. Becomes infinite at the poles. 
Use Large-scale mapping along the equator.

ellipsoidal Mercator

ellipsoidal oblique Mercator—See Hotine
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ellipsoidal transverse Mercator

Description Ellipsoidal transverse aspect of the Mercator projection. Cylindric and conformal.
Synonyms Gauß (Gauss) conformal

Gauß-Krüger
transverse cylindric orthomorphic

Other features Cannot be geometrically (or perspecively) projected.

Unlike equatorial Mercator, rhumb lines generally are not straight lines.
Parameters Scale factor along central meridian.
Graticule Meridians and parallels: Central meridian, each meridian 90° from the central meridian, 

and the equator are straight lines. Other meridians and parallels are complex curves, 
concave toward the central meridian and the nearest pole, respectively.

Poles: Points along the central meridian.

Symmetry: About any straight meridian or the equator.
Scale Constant along the central meridian.

Increases with distance from central meridian, but unlike spherical form, remains finite.
Origin Spherical form of the transverse Mercator presented by Johann Heinrich Lambert (1728-

1777) of Alsace in 1772. Formulas for ellipsoidal use developed by Carl Freidrich Gauß of 
Germany in 1822 and by L. Krüger of Germany, L.P. Lee of New Zealand, and others in 
the 20th century.

Use Many of the topographic and planimetric map quadrangles throughout the world at scales 
of 1: 24,000 to 1: 250,000.

Basis for Universal Transverse Mercator (UTM) grid and projection.

Basis for State Plane Coordinate System in US states having largely north-south extent.

Recommended for conformal mapping of areas having predominantly north-south extent.

ellipsoidal transverse Mercator

equal-area—See equal-area cylindric
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equal-area cylindric  [equal-area]

Description Equal-area.
Parameters One standard parallel φ1 for setting the latitude along which the scale will be correct. A 

higher latitude will make a narrower, taller map.
Specializations Balthasart (φ1 = 50°)

Behrmann cylindric equal-area (φ1 = 30°)
Gall orthographic (= Gall-Peters = Peters) (φ1 = 45°)
Hobo-Dyer (φ1 = 37°30′)
Smyth equal-surface (= Craster rectangular) (φ1 = 37°4′)
Trystan Edwards (φ1 = 37°24′)

Range 0° << φ1 << 90°N.
Usual 30°N ≤ φ1 ≤ 50°N.
Use When an equal-area, rectangular world map is needed. Set the standard parallel to the 

latitude at which you want correct scale. 

equal-area cylindric

equidistant—See equidistant cylindric
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equidistant cylindric [equidistant]

Description Cylindric and equidistant.
Synonyms equirectangular 

rectangular 
la carte Parallelogrammatique 
die Rechteckige Plattkarte 
projection of Marinus

Other features Simple modification of plate carrée having east-west compression.

Conceptually projected onto a cylinder secant to the globe along the chosen standard 
parallels. 

Not perspective.
Parameters One standard parallel φ1 for setting the latitude along which the scale will be correct. A 

higher latitude will make a narrower, taller map.
Range 90°S << φ1<< 90°N.
Usual 0°N ≤ φ1 ≤ 50°N.
Specializations Plate carrée (φ1 = 0°)

Gall isographic (φ1 = 45°)
Scale True along two standard parallels ±φ1 and along all meridians. 

Too small along the equator, but increases with distance from the equator along the 
parallels. 

Constant along any given parallel; same scale at the parallel of opposite sign.
Graticule Meridians: Equally-spaced, straight parallel lines more than half as long as the equator.

Parallels: Equally-spaced, straight parallel lines, perpendicular to, and having wider spacing 
than, meridians.

Poles: Straight lines equal in length to the equator.

Symmetry: About any meridian or the equator.
Origin Marinus of Tyre in about AD 100.
Use Simple outline maps of regions, or of the world, or for index maps. Used only in the 

spherical form.

equidistant cylindric

equirectangular—See equidistant cylindric
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Gall isographic

Description Cylindric and not perspective.

Equidistant along meridians.

Is equidistant cylindric with standard parallels at ±45°.
Graticule Meridians: Equally-spaced, straight parallel lines 0.707 as long as the equator.

Parallels: Equally-spaced, straight parallel lines. Perpendicular to meridians. 

Poles: Straight lines equal in length to the equator.

Symmetry: About any meridian or the equator.
Scale True along latitudes 45°N/S in all directions. Constant along any parallel in any given 

direction.
Distortion None at latitudes 45°N and S. Shape, area and scale distortion increase moderately away 

from these latitudes, but become severe at the poles.
Origin Presented by James Gall of Edinburgh in 1855 as his isographic (equidistant), along with 

his stereographic and orthographic cylindric projections, all secant at latitudes 45°N and S.

Gall isographic
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Gall orthographic

Description Cylindric and not perspective.

Equal-area.

Is equal-area cylindric with standard parallels at ±45°.
Synonyms Gall-Peters

Peters
Similar projections Smyth equal-surface, Trystan Edwards, Hobo-Dyer, and Balthasart are closely related, being 

scaled moderately in height and width from this projection.
Aspects Only the equatorial aspect is used.
Graticule Meridians: Equally-spaced, straight parallel lines 0.64 as long as the equator.

Parallels: Unequally-spaced, straight parallel lines, closest near the standard parallels. 
Perpendicular to meridians. 

Poles: Straight lines equal in length to the equator.

Symmetry: About any meridian or the equator.
Scale True along latitudes 45°N and S in all directions. Constant in any given direction along 

any other given latitude or the latitude of opposite sign.

Changes with latitude and direction, but is always too small between latitudes 45°N and S, 
and too large beyond them.

Distortion None at latitudes 45°N and S. Shape, area and scale distortion increase moderately away 
from these latitudes, but becomes severe at the poles.

Origin Presented by James Gall of Edinburgh in 1855 as his orthographic, along with his 
stereographic and isographic (equidistant) cylindric projections, and also based on cylinders 
secant at latitudes 45°N and S.

Reintroduced in 1972 by Arno Peters as an new invention and promoted as the map 
projection of social justice. Adopted by several social advocacy organizations.

Use Can be found in world maps involving social advocacy.

Gall orthographic
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Gall stereographic

Description Cylindric and perspective. Neither conformal nor equal-area.

Earlier versions of Geocart referred to this projection as just Gall.
Similar projections Miller cylindric projection has different spacing of the parallels, and the line of no distortion 

is the equator rather than latitudes 45°N and S.

B.S.A.M. (Great Soviet World Atlas) projection of 1937 is the same, except that the 
cylinder is secant at latitudes 30°N and S.

VA Kameneskiy used an identical projection for Russian population density in 1929, 
except that the cylinder was made secant at latitudes 55°N and S.

Guy Bomford of Oxford University in England about 1950 devised a modified Gall 
projection, which is like the regular Gall in spacing, except meridians are slightly curved at 
higher latitudes to decrease scale exaggeration at the poles.

Moir devised The Times projection in which the straight parallels are spaced as they are on 
the Gall projection, but the meridians are distinctly curved.

Other features Projection is produced geometrically by projecting the earth perspectively from the point 
on the equator opposite a given meridian onto a secant cylinder, cutting the globe at 
latitudes 45°N and S.

Aspects Only the equatorial aspect is used.
Graticule Meridians: Equally-spaced, straight parallel lines 0.77 as long as the equator.

Parallels: Unequally-spaced, straight parallel lines, closest near the equator, but spacing does 
not increase poleward as fast as it does on the Mercator. Perpendicular to meridians. 

Poles: Straight lines equal in length to the equator.

Symmetry: About any meridian or the equator.
Scale True along latitudes 45°N and S in all directions. Constant in any given direction along 

any other given latitude or the latitude of opposite sign.

Changes with latitude and direction, but is always too small between latitudes 45°N and S, 
and too large beyond them.

Distortion None at latitudes 45°N and S. Shape, area and scale distortion increase moderately away 
from these latitudes, but becomes severe at the poles.

Origin Presented by James Gall of Edinburgh in 1855 as his stereographic, which he preferred to 
his orthographic (equal-area), and isographic (equidistant) cylindric projections presented at 
the same time, and also based on cylinders secant at latitudes 45°N and S.

Use Historical. World maps in British atlases and some other atlases, as a projection somewhat 
resembling the Mercator, but having less distortion of area and scale near the poles.
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Gall stereographic

Gall-Peters—See Gall orthographic

Gauß conformal (Gauss conformal)—See ellipsoidal transverse Mercator

Gauß Krüger (Gauss Krüger)—See ellipsoidal transverse Mercator

geographic projection

Description Parallels are evenly spaced along the meridians, regardless of ellipsoidal model. Spacing of 
parallels is the same as the spacing of meridians, so each graticule “cell” is a square.

Similar projections Identical to plate carrée when the earth is modeled as a sphere. Very similar to plate carrée 
when the earth is modeled as an ellipsoid, but plate carrée keeps correct distances along 
meridians, where as the “geographic” projection keeps equal spacing of parallels.

Aspects Equatorial only, since the important trait for Use evaporates in other aspects.
Use Imagery (such as satellite imagery), so that the latitude and longitude can be determined 

from the pixel position by nothing more than multiplying by nominal scale.

“geographic” projection

Hobo-Dyer

Description Is the equal-area cylindric with standards parallels of ±37°30′. Created for ODT Maps as 
an alternative to the Peters projection. Generally presented south-up.

Similar projections Trystan Edwards and Smyth equal-surface are nearly identical, and Behrmann equal-area and 
Gall orthographic are close.
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Hobo-Dyer

Hotine

Description Ellipsoidal oblique aspect of the Mercator projection. Cylindric and conformal.
Synonyms ellipsoidal oblique Mercator 

rectified skew orthomorphic
oblique cylindric orthomorphic

Similar projections Laborde, a very similar development specifically for Madagascar.
Limiting forms Mercator, if the equator is the central plane.

Transverse Mercator, if a meridian is the central line.
Other features Conceptually projected onto a cylinder wrapped around the globe tangent to an oblique 

great circle, or secant along two small circles equidistant from and straddling the central 
great circle.

Cannot be geometrically (or perspectively) projected.

There are various means of adapting to the ellipsoid, but none can simultaneously maintain 
both perfect conformality and constant scale along the central line.

Parameters Central scale factor.
Scale True along a chosen central line (a great circle at an oblique angle), or along two straight 

lines on the map parallel to the central line. Constant along any straight line parallel to the 
central line. (The scale for the projection of the ellipsoid varies slightly from these patterns).

Increases with distance from the central line.

Becomes infinite 90° from the central line. 
Origin Developed for various applications, chiefly large-scale mapping of the ellipsoid, by M. 

Rosenmund of Switzerland in 1903, J. Laborde of France in 1928, Martin Hotine of 
England in 1947 and others during the 20th century.

Use Large-scale mapping in Switzerland, Madagascar and Borneo.
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Hotine

Karchenko-Shabanova

Native name цилиндрическая Карченко-Шабанова
Description Similar to Miller cylindric away from the poles.
Use Historically, in the Soviet Union.

Karchenko-Shabanova

Lambert equal-area—See Lambert equal-area cylindric
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Lambert equal-area cylindric [Lambert equal-area]

Description Cylindric, equal-area, and perspective.

Created by stretching each parallel to the same length as the equator and then locally 
shrinking each meridian by the same factor.

Is equal-area cylindric with the equator as standard parallel.
Similar projections See specializations of the equal-area cylindric.
Other features Simple graticule, perspectively projected in lines perpendicular to the axis onto a cylinder 

wrapped around the globe, tangent to the equator.
Aspects Equatorial is described here.

Transverse and oblique aspects are rarely used, but are recommended for equal-area 
mapping of predominantly north-south regions, or regions extending obliquely.

Graticule Meridians: Equally-spaced, straight parallel lines 0.32 as long as the equator.

Parallels: Unequally-spaced, straight parallel lines, farthest apart near the equator, 
perpendicular to meridians.

Poles: Straight lines equal in length to the equator.

Symmetry: About any meridian or the equator.
Scale True along the equator.

Increases with distance from the equator in the direction of parallels and decreases in the 
direction of meridians to maintain equal area.

Same scale at the parallel of opposite sign.
Distortion Infinitesimally small circles (indicatrices) of equal size on the globe are ellipses, except at 

the equator, where they are circles. The areas of all the indicatricices are the same. Thus, 
there is shape distortion, but no area distortion. Shape distortion in polar regions is 
extreme.

Origin Presented by Johann Heinrich Lambert (1728-1777) of Alsace in 1772.
Use Academic. 

Minimal, except to describe basic principles in map projection texts.

Prototype for Behrmann and other modified cylindric equal-area projections.

Recommended for equal-area mapping of regions predominantly bordering the equator.

Lambert equal-area cylindric

Mercator

Description Cylindric and conformal.
Synonyms Wright (rare), after Edward Wright of England, who developed the mathematics in 1599.
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Similar projections Central cylindric projection also cannot show the poles, but it is not conformal, and the 
spacing of parallels changes much more rapidly. 

Miller cylindric and Gall projections show the poles, are not conformal, and have more 
gradual spacing of parallels.

Special properties In equatorial aspect, loxodromes are shown as straight lines.
Other features All loxodromes or rhumb lines (lines that make equal angles with all meridians and are 

therefore lines of constant true bearing) are straight lines.

Meridians can be geometrically projected onto a cylinder, the axis of which is the same as 
that of the globe. Parallels cannot be geometrically (or perspectively) projected. Meridians 
cannot be compressed relative to parallels, as they can on equal-area cylindric and 
equirectangular projections, since conformality would be lost.

Aspects Equatorial is described here.

Transverse and oblique aspects are listed separately because of importance and common 
treatment as separate projections.

Limitations Cannot show the poles: typically cut off in the high arctic.
Graticule Meridians: Equally-spaced, straight parallel lines.

Parallels: Unequally-spaced, straight parallel lines, closest near the equator, perpendicular to 
meridians.

Poles: Cannot be shown.

Symmetry: About any meridian or the equator.
Scale True along the equator, or along two parallels equidistant from the equator.

Increases with distance from the equator to infinity at the poles.

Constant along any given parallel; same scale at parallel of opposite sign (north +, south -).

Same in all directions near any given point.
Distortion Infinitesimally small circles (indicatrices) of equal size on the globe appear as circles on 

the map (indicating conformality), but increase in size away from the equator (indicating 
area distortion). Great distortion in polar regions. Conformality (and therefore local angle 
preservation) fails at poles.

Origin Presented by Gerardus Mercator (1512-1594) of Flanders in 1569 on a large world map 
‘for use in navigation’.

Use When a map is needed to show paths of constant bearing (equatorial aspect only). Also, 
conformal mapping along a great circle path. Center the projection on the point of 
interest and rotate the projection to the azimuth of the great circle path. With Stretch 
and Rotation, shrink the projection slightly to minimize the scale error in the region of 
interest.

Designed and recommended for navigational use because of straight rhumb lines; standard 
for marine charts. (Equatorial aspect only.)

Recommended and used for conformal mapping of regions neighboring the equator.

Often and inappropriately used as a world map in atlases and for wall charts. It presents a 
misleading view of the world due to excessive distortion of area.
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Mercator

Miller—See Miller cylindric

Miller cylindric [Miller]

Description Cylindric.

Neither conformal nor equal-area.
Other features Almost identical to Mercator near the equator.
Aspects Equatorial aspect is commonly used.

Oblique aspect has been used by the National Geographic Society.
Similar projections Gall projection has different spacing of parallels; its lines of no distortion are at latitudes 

45°N and S rather than at the equator. Miller proposed other alternatives in 1942, 
including one identical with his preferred cylindric, but using two-thirds instead of 0.8.

Graticule Meridians: Equally-spaced, straight parallel lines 0.73 as long as the equator.

Parallels: Unequally-spaced, straight parallel lines, closest near the equator, but spacing does 
not increase poleward as fast as it does on the Mercator. Perpendicular to meridians. 

Poles: Straight lines equal in length to the equator.

Symmetry: About any meridian or the equator.
Scale True along the equator in all directions.

Constant in any given direction along any other given latitude; same scale at the latitude of 
opposite sign.

Changes with latitude and direction.
Distortion None at the equator. Shape, area and scale distortion increases moderately away from the 

equator, but becomes severe at the poles.
Origin Presented by Osborn Maitland Miller (1897 -1979) of the American Geographical Society 

in 1942.
Use When a rectangular map of the world is needed.

World maps in numerous American and some other atlases, as a projection resembling the 
Mercator, but having less distortion of area and scale, especially near the poles. 
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Miller cylindric

Pavlov—See Pavlov cylindric

Pavlov cylindric [Pavlov]

Native name цилиндрическая Павлова
Description An intermediate between the Lambert cylindric equal-area and the plate carrée.
Use Historical.

Pavlov cylindric

perspective cylindric—See central cylindric

Peters—See Gall orthographic

plane chart—See plate carrée
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plate carrée

Description Cylindric and equidistant.

Created by plotting the latitude and longitude as if they were x, y coordinates.
Synonyms plate carée 

plane chart 
simple cylindric

Similar projections If meridians are compressed relative to parallels, the equidistant cylindric projection results.
Other features Most simply constructed graticule of any projection.

Conceptually projected onto a cylinder wrapped around the globe tangent to the equator.

Not perspective.
Aspects Equatorial is described here.

Transverse aspect is the trasnverse plate carrée projection, described separately.
Graticule Meridians: Equally-spaced, straight parallel lines half as long as the equator.

Parallels: Equally-spaced, straight parallel lines, perpendicular to, and having same spacing 
as, meridians.

Scale True along the equator and along all meridians.

Increases with distance from the equator along parallels.

Constant along any given parallel; same scale at the parallel of opposite sign.
Distortion Infinitesimally small circles of equal size on the globe (indicatrices) are ellipses, except 

along the equator, where they remain circles. Areas of the ellipses also vary. Thus, there is 
distortion of both shape and area.

Origin May have been originated by Eratosthenes (275?-195? BC). Marinus of Tyre also credited 
with its invention in about AD 100.

Use Many maps during the 15th and 16th centuries. 

Simple outline maps of regions, or of the world.

In equatorial aspect for maps from which the latitude and longitude are easily measured or 
indexed.

By moving a point of interest to one of the poles (whereupon the point becomes a line), 
an equidistant map can be made such that all points a given distance from that point are 
shown by a straight line parallel to the (untransformed) pole line, and azimuths from that 
point are shown by straight lines perpendicular to the untransformed pole line.

plate carrée

simple cylindric—See plate carrée

simple perspective cylindric—See central cylindric
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Smyth equal-surface

Description Is equal-area cylindric with standard parallels of ±37°4′.
Synonyms Craster rectangular equal-area
Similar projections Hobo-Dyer and Trystan Edwards are nearly identical, and Behrmann equal-area and Gall 

orthographic are close.
Use World maps showing statistical distributions.

Smyth equal-surface

transverse plate carrée

Description Transverse aspect of the plate carrée. Cylindric, equidistant.

Conceptually projected onto a cylinder tangent to the globe at the central meridian. Can 
be compressed north-south to provide a transverse equirectangular projection, but this is 
rarely done.

Synonyms Cassini, though this normally applies only to the ellipsoidal form.
Cassini-Soldner, though this normally applies only to the ellipsoidal form.

Graticule Meridians: The central meridian, each meridian 90° from the central meridian, and the 
equator, are straight lines.

Other meridians and parallels are complex curves, concave toward the central meridian and 
the nearest pole, respectively.

Poles: Points along the central meridian.

Symmetry: About any straight meridian or the equator.
Scale True along the central meridian, and along any straight line perpendicular to the central 

meridian. Scale increases with distance from the central meridian, along a direction parallel 
to the central meridian.

Distortion A function of the distance from the central meridian. No distortion occurs along the 
central meridian, but there is area and local shape distortion elsewhere.

Use Historical. Developed by Cesar Francois Cassini de Thury (1714-1784) for topographic 
mapping of France in the middle 18th century.

Topographic mapping (ellipsoidal form) of British Isles before the 1920s, replaced by the 
transverse Mercator. A few countries still use this projection for topographic mapping.
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transverse plate carrée

Trystan Edwards

Description Is equal-area cylindric with standard parallels of ±37°24′.
Similar projections Hobo-Dyer and Smyth equal-surface are nearly identical, and Behrmann equal-area and Gall 

orthographic are close.
Use Academic.

Trystan Edwards

Universal Transverse Mercator—See UTM

Urmayev III

Native name цилиндрическая Урмаева III
Description Quite similar to Mercator, but shows the poles.
Use Historical use in the Soviet Union.

Urmayev III
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UTM

Description Earth is divided into a grid of zones for large-scale mapping. Based on ellipsoidal transverse 
Mercator, zones are scaled down slightly so that its central meridian has scale 0.9996.

Synonyms Universal Transverse Mercator
Parameters UTM zone, a number/letter combination such as “10T”. See chart below.
Use Topographic mapping in the United States; US military mapping of the world.

UTM Zones
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UTM

Wallis 1 transverse Mercator

Description Ellipsoidal transverse Mercator variant with equally-spaced parallels along central meridian.
Other names complex latitude plane
Origin R. König & K.H. Weise, 1951
Use Academic.

Wallis 1 transverse Mercator
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Wallis 2 transverse Mercator

Description Ellipsoidal transverse Mercator variant with parallels spaced along the central meridian such 
that supplying the projection’s coordinates as complex-valued parameters to the rectifying 
latitude results in the the standard ellipsoidal transverse Mercator.

Use Academic.

Wallis 2 transverse Mercator

Web maps Mercator
Description Formulæ for the spherical Mercator are used for ease of calculation, but the ellipsoid is the 

WGS 84 model. Hence the projection is not quite conformal.
Similar projections Mercator in equatorial aspect is very similar.
Aspects Equatorial only, which is the aspect deployed in Use.
Use Web maps, such as Google™ Maps, Bing™ Maps, Yahoo!™ Maps, OpenStreetMap. Its 

near-conformality provides for nearly undistorted presentation in large-scale maps while 
affording continuity across all scales.

Web maps Mercator

Wright—See Mercator
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 Pseudocylindric projections

Урмаева I—See Urmayev I

Урмаева II—See Urmayev II

Apian II

Description Pseudocylindric. Created by stretching each parallel to fit a 2:1 ellipse. Similar to 
Mollweide, but not equal-area.

Use Historical.

Apian II

Apianus II—See Apian II

Babinet—See Mollweide

Boggs eumorphic

Description Pseudocylindric, equal-area.
Similar projections Several pseudocylindrics, such as the sinusoidal and Craster parabolic.
Other features Designed as the arithmetic mean of the sinusoidal and Mollweide projections for north-

south (y) coordinates only, when drawn with the same area scale.
Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 

are equally-spaced complex curves intersecting at the poles and concave toward the central 
meridian.

Parallels: Unequally-spaced, straight parallel lines perpendicular to the central meridian.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 40°15′N and S. Constant along any given latitude; same for the 

latitude of opposite sign.
Distortion Distortion is severe near outer meridians at high latitudes, but can be substantially reduced 

by interruption. Free of distortion only at latitudes 40°15′N and S at the central meridian.
Origin Presented by S. Whittemore Boggs (1884-1954) of the US Department of State in 1929.
Use Thematic world maps in atlases and textbooks, usually in interrupted form.
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Boggs eumorphic

Collignon

Description Pseudocylindric, equal-area.
Similar projections Eckert I and II also use straight lines for both meridians and parallels, but meridians are 

broken at the equator.

The trapezoidal projection has equidistant straight parallel lines for parallels and converging 
straight meridians equally-spaced along each parallel (top and bottom parallels, and 
perpendicular central meridians true to scale). It was used for numerous maps from the 15th 
to 18th centuries, but is neither equal-area nor conformal.

Polyhedric projection, formerly used for large-scale mapping in various parts of central 
Europe. There were various forms, all resembling the trapezoidal projection, but applied to 
the ellipsoid.

Graticule Meridians: Equally-spaced straight lines converging at the north pole.

Parallels: Unequally-spaced, straight parallel lines, farthest apart near the north pole, closest 
near the south pole. Perpendicular to the central meridian.

Poles: north pole is a point; south pole is a line 1.41 times as long as the equator.

Symmetry: About the central meridian.
Scale True along latitudes 15°51′N. Constant along any given latitude, different for each latitude.
Distortion Severe in many regions. Free of distortion only at latitude 15°51′N at the central meridian.
Origin Presented by Edouard Collignon of France in 1865.
Use Academic, decorative. 

Collignon
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Craster parabolic

Description Pseudocylindric, equal-area.
Synonyms Putniṇš P4, independently presented in Latvia in 1934.
Similar projections Several pseudocylindrics, such as the sinusoidal and the Boggs eumorphic. 

Putniṇš P3 projection (1934) has meridians, poles, and equator identical to those of the 
Craster, but parallels are equally-spaced.

Aspects Oblique aspect used for map of Asia by National Geographic Society.
Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 

are equally-spaced parabolas intersecting at the poles and concave toward the central 
meridian. 

Parallels: Unequally-spaced, straight parallel lines, farthest apart near the equator, spacing 
changes very gradually, perpendicular to the central meridian.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 36°46′N and S. Constant along any given latitude, same of latitude of 

opposite sign.
Distortion Distortion is severe near outer meridians at high latitudes, but somewhat less than that of 

the sinusoidal projection. Can be substantially reduced by interruption. Free of distortion 
only at latitudes 36°46′N and S at the central meridian.

Origin Presented by John Evelyn Edmund Craster (1873-?) of England in 1929. Developed 
further by Charles H. Deetz and O.S. Adams in 1934.

Use Academic and thematic world maps in text books.

Craster parabolic
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Eckert I

Description Pseudocylindric, equally-spaced parallels. Neither conformal nor equal-area.
Similar projections Eckert II positions all meridians identically, but its parallels are spaced for equal-area.
Graticule Meridians: Equally-spaced converging straight lines broken at the equator. Central 

meridian is half as long as the equator.

Parallels: Equally-spaced, straight parallel lines, perpendicular to the central meridian.

Poles: Lines half as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 47°10′N and S. Constant along any given latitude, same for the 

latitude of opposite sign. Constant along any given meridian.
Distortion No point free of distortion. Break at the equator introduces excessive distortion there. 

Discontinuous ellipses are shown there owing to the plotting algorithm. The shape is 
indeterminate on the equator.

Origin Presented by Max Eckert (1868-1938) of Germany in 1906.
Use Novelty showing straight line graticule.

Eckert I

Eckert II

Description Pseudocylindric, equal-area.
Similar projections Eckert I positions all meridians identically, but its parallels are equidistant.

Collignon projection has straight meridians and is equal-area, but meridians are not broken 
at the equator, and the poles are different.

Graticule Meridians: Equally-spaced straight lines broken at the equator. Central meridian is half as 
long as the equator.

Parallels: Unequally-spaced, straight parallel lines, widest separation near the equator. 
Perpendicular to the central meridian.

Poles: Lines half as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 55°10′N and S. Constant along any given latitude, same for the 

latitude of opposite sign.
Distortion Free of distortion only at latitudes 55°10′N and S at the central meridian. Break at the 

equator introduces excessive distortion there. Discontinuous ellipses are shown there owing 
to the plotting algorithm. The shape is indeterminate on the equator.

Origin Presented by Max Eckert (1868-1938) of Germany in 1906.
Use Novelty showing straight line equal-area graticule.
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Eckert II

Eckert III

Description Pseudocylindric, equally-spaced parallels. Neither conformal nor equal-area.
Similar projections Eckert IV positions all meridians identically, but its parallels are spaced for equal-area. 

Putniṇš P1′ has meridians that are only portions of semi-ellipses, but parallels are 
equidistant.

Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 
are equally-spaced semi-ellipses, concave toward the central meridian. The outer meridians 
(180° east and west of the central meridian) are semi-circles.

Parallels: Equally-spaced, straight parallel lines. Perpendicular to the central meridian.

Poles: Lines half as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 35°58′N and S, if the world map retains correct total area (area varies 

locally). Constant along any given latitude, same for latitude of opposite sign.
Distortion No point is free of all scale distortion, but the equator is free of angular distortion.
Origin Presented by Max Eckert (1868-1938) of Germany in 1906.
Use Academic.

Eckert III

Eckert III + Eckert IV

Description Pseudocylindric. Arithmetic average of Eckert III and Eckert IV.
Similar projections Resembles Robinson, but has slightly more rounded shape in the outer meridians.
Use Reference world maps.
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Eckert III + IV

Eckert IV

Description Pseudocylindric, equal-area.
Similar projections Eckert III positions all meridians identically identically, but its parallels are equally spaced.

Putniṇš P2′ has meridians that are only portions of semi-ellipses, but parallels are also 
spaced for equal-area.

Aspects Like most projections, transverse and oblique aspects can be prepared, although they are 
seldom used in this case.

Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 
are equally-spaced semi-ellipses, concave toward the central meridian. The outer meridians 
(180° east and west of the central meridian) are semi-circles.

Parallels: Unequally-spaced, straight parallel lines, widest separation near the equator.

Poles: Lines half as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 40°30′N and S. Constant along any given latitude, same for the 

latitude of opposite sign.
Distortion Free of distortion only at latitudes 40°30′N and S at the central meridian.
Origin Presented by Max Eckert (1868-1938) of Germany in 1906.
Use Thematic and other world maps in numerous atlases and text books, and for sheet maps.

Eckert IV
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Eckert V

Description Pseudocylindric, equally-spaced parallels. Neither conformal nor equal-area.
Similar projections Eckert VI positions all meridians identically, but its parallels are spaced for equal-area.

Winkel I is an average of coordinates of the sinusoidal and equirectangular projections.

Wagner III projection uses part rather than all of the sinusoidal curve for meridians.
Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 

are equally-spaced sinusoids, concave toward the central meridian.

Parallels: Equally-spaced straight, parallel lines, perpendicular to the central meridian.

Poles: Lines half as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 37°55′N and S is the world map retains correct total area. Constant 

along any given latitude, same for latitude of opposite sign.
Distortion No point free of all distortion, but the equator is free of angular distortion.
Origin Presented by Max Eckert (1868-1938) of Germany in 1906. The projection is an 

arithmetical average of the x and y coordinates of the sinusoidal and plate carrée projections.

Eckert V
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Eckert VI

Description Pseudocylindric, equal-area.
Similar projections Eckert V positions all meridians identically, but its parallels are equally-spaced. 

Wagner I projection (1932) is almost identical Eckert VI, but Wagner I uses only part of 
the sinusoidal curve.

Kavrayskiy VI projection (1936) is identical to Wagner I. Werenskiold II projection (1944) 
is the same as Wagner I, except for scale.

McBryde-Thomas flat-polar sinusoidal uses the full sinusoid and is equal-area, but the poles 
are one-third the length of the equator.

Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 
are equally-spaced sinusoids, concave toward the central meridian.

Parallels: Equally-spaced straight, parallel lines, widest separation near the equator. 
Perpendicular to the central meridian.

Poles: Lines half as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 49°16′N and S. Constant along any given latitude, same for the 

latitude of opposite sign.
Distortion Free of distortion only at latitudes 49°16′N and S at the central meridian.
Origin Presented by Max Eckert (1868-1938) of Germany in 1906.
Use Thematic world maps in Soviet World Atlas. Some recent use for climatic maps by US 

publishers.

Eckert VI

elliptical—See Mollweide

Foucaut equal-area

Description Pseudocylindric. Equal-area.

An average of the Lambert cylindric equal-area and the sinusoidal.
Use Academic.
Parameters One parameter β which describes the weight of the sinusoidal with respect to the Lambert 

cylindric equal-area.
Range 0 ≤ β ≤ 1
Usual None. When β = 0, the projection is the Lambert cylindric equal-area. When β = 1, the 

projection is the sinusoidal.
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Foucaut equal-area

Foucaut stereographic

Description Pseudocylindric, equal-area.

Parallel spacing along the central meridian corresponds to that of the equatorial aspect of 
the stereographic.

Use Academic.

Foucaut stereographic

Fournier II

Description Pseudocylindric.
Use Historical

Fournier II
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Goode homolosine

Description Pseudocylindric, composite, equal-area.
Graticule Meridians: In the interrupted form, there are six central meridians, each a straight line 0.22 

as long as the equator, but not crossing the equator. Other meridians are equally-spaced 
sinusoidal curves between latitudes 40°44′N and S and elliptical arcs elsewhere, all concave 
toward the central meridian. There is a slight bend in meridians at the 40°44′ latitudes.

Parallels: Straight parallel lines, perpendicular to the central meridians. Equally-spaced 
between latitudes 40°44′N and S. Gradually closer together beyond these latitudes as a pole 
is approached.

Poles: Points.

Symmetry: None in the usual interrupted form. If uninterrupted, there is symmetry about 
the central meridian or equator.

Scale True along every latitude between 40°44′N and S and along the central meridian within 
the same latitude range. At higher latitudes, scale varies but is the same for the latitude of 
opposite sign.

Distortion Same as sinusoidal projection between latitudes 40°44′N and S. Same as Mollweide 
projection beyond this range. 

The Goode homolosine projection is almost always presented interrupted, as the inventor 
originally intended.

Origin Developed in 1923 by J. Paul Goode (1862-1932) at the University of Chicago as a 
merging of the Mollweide (or homolographic) with the sinusoidal at the parallels of identical 
scale, latitudes 40°44′N and S, hence the name homolosine. Frequently plotted with some 
northern regions repeated on different interrupted sections to reduce discontinuities of 
land.

Use Numerous world maps, especially in Goode’s Atlas (Rand McNally).

Goode homolosine

Hatano—See Hatano asymmetric
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Hatano asymmetric [Hatano]

Description Pseudocylindric, equal-area.

Northern and southern hemispheres are composed of two different custom projections 
joined at the equator.

Similar projections Mollweide projection uses full symmetrical semi-ellipse for meridians, and poles are points. 

Putniṇš P2′ projection uses arcs less than semi-ellipses for meridians, but they are 
symmetrical about the equator, and poles are lines half the length of the equator.

Hatano symmetrical equal-area projection (1972) uses the same graticule for the northern 
hemisphere. The southern hemisphere is symmetrical (the south pole is also two-thirds the 
length of the equator).

Graticule Meridians: The central meridian is a straight line 0.48 as long as the equator. Other 
meridians are equally-spaced elliptical arcs, concave toward the central meridian, but the 
eccentricity of each ellipse changes at the equator.

Parallels: Unequally-spaced straight, parallel lines. Perpendicular to the central meridian. 
Spacing not symmetrical about the equator.

Poles: Lines. The north pole is two-thirds as long, and the south pole is three-quarters as 
long as the equator.

Symmetry: About the central meridian but not about the equator.
Scale True along latitudes 40°42′N and 38°27′S. Constant along any given latitude, normally 

different for the latitude of opposite sign.
Distortion Free of distortion only at latitudes 40°42′N and 38°27′S at the central meridian.
Origin Presented by Masataka Hatano of Japan in 1972 as a modification of the Mollweide and 

Putniṇš P2′ projections.
Use Japanese world thematic maps, usually centered in the Pacific.

Hatano asymmetric
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HEALPix

Description Pseudocylindric, equal-area.

Latitudes above 41°48′37″N/S are equivalent to portions of Collignon projection. The 
lower latitudes are on the equal-area cylindric projection.

Parameters One parameter H giving the number of interruptions in the high latitudes of one 
hemisphere.

Range 1 ≤ H ≤ 12
Usual H = 4
Graticule Meridians: Straight and parallel from equator to 41°48′37″N/S. Straight and angling 

inward to the poles from there.

Parallels: Equally spaced, straight parallel lines between 41°48′37″N/S. Unequally spaced, 
straight parallel lines above those latitudes.

Poles: Each pole consists of H points.

Symmetry: About the central meridian and the Equator.
Scale If H = 3, scale is true along the 37°4′ parallels N/S. If H = 4, scale is true along the 22°53′ 

parallels N/S. Otherwise, nowhere true.
Distortion Free of distortion nowhere.
Origin The projection evolved out of a spherical pixelization scheme presented by K. M. Górski, 

E. Hivon, A.J. Banday, B.D. Wandelt, F.K. Hansen, M. Reinecke, & M. Bartelman in 
2005 and further elaborated on by M. R. Calabretta in 2008. The name means Hierarchical 
Equal Area and isoLatitude Pixelisation.

Use Used by NASA for processing and storing large cosmological data sets. Satellites collect 
radiation measurements all across the celestial sphere. The data are saved on a raster grid for 
analysis.

HEALPix

homalographic—See Mollweide

homolographic—See Mollweide



Projection gazetteer B.37

hyperelliptical

Description Pseudocylindric, equal-area.
Use Thematic world maps; reference world maps. 
Parameters Three parameters: weighting α of the Lambert cylindric equal-area projection; the portion 

γ of the hyperellipse to use in the meridional curves; and the polynomial order κ of the 
meridional curves.

Range α is not limited; γ > 1.0; κ >> 0. Minimum value of γ depends on κ and α; computing it in 
advance is impractical. Try and err... or succeed.

hyperelliptical

Kavrayskiy V

Description Pseudocylindric, equal-area.
Use World maps with points for poles. 

Kavrayskiy V

Kavrayskiy VI—See Wagner I

Kavrayskiy VII

Description Pseudocylindric.
Use Reference world maps. 

Kavraiskiy VII
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loximuthal

Description Pseudocylindric, equally-spaced parallels, neither conformal nor equal-area.
Similar projections Loxodromes are shown straight and at the correct azimuth between any two points on the 

regular Mercator projection, but they are not at true scale.

The Bordone oval projection of 1520 is similar to the loximuthal projection having the 
equator as the central latitude.

Parameters Latitude of origin.

One parameter φ1 which, along with the central meridian, form a point from which all 
loxodromes (rhumb lines) are shown as straight lines and at correct scale (in equatorial 
aspect).

Special properties A higher latitude produces an increasingly triangular map with a shorter base line.

Loxodromes (rhumb lines) from the central point (at the intersection of the central 
meridian and the central parallel) are shown straight, true to scale, and correct in azimuth 
from the center. Because of angular distortion on the map projection, the azimuths with 
respect to other points along a rhumb line are not shown correctly.

Range 90°S << φ1 << 90°N.
Graticule Meridians: Central meridian is a straight line generally over half as long as the equator, 

depending on the central latitude. If the central latitude is the equator, the ratio is 0.5, 
if it is 40°N or S, the ratio is 0.65. Other meridians are equally-spaced complex curves 
intersecting at the poles and concave toward the central meridian.

Parallels: Equally-spaced straight, parallel lines. Perpendicular to the central meridian. 

Poles: Points.

Symmetry: About the central meridian. Symmetry occurs about the equator if the specified 
central latitude is the equator.

Scale True along the central meridian. Constant along any given latitude, normally different for 
the latitude of opposite sign.

Distortion Distortion is moderate to extreme, but the projection is intended for the special property of 
the loxodromes, not as a normal world map. Free of distortion only at the central latitude 
on the central meridian.

Origin Presented by Karl Siemon (?-1937) of Germany in 1935.

Independently presented as loximuthal by Waldo R. Tobler (1930-) of the University of 
Michigan (1966).

Use Maps that show constant bearing and distance from a particular point. Using the 
Projection Center command set the center point of the projection to the meridian of 
interest and the equator (not the parallel of interest). Then use the Parameters command 
to set φ1 to the point of interest. 

loximuthal
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McBryde S3

Description Pseudocylindric, equal-area, composite.
Similar projections Identical to the sinusoidal between latitudes 55°51′N and S, identical to the McBryde-

Thomas flat-polar sinusoidal poleward of those latitudes, except that those portions are closer 
to the equator than they are on the McBryde-Thomas flat-polar sinusoidal projection.

McBryde merged projections in several other similar combinations, also in 1977.
Graticule Meridians: Where the central meridian extends across the equator, it is a straight line 0.44 

as long as the equator. Other central meridians in the usual interrupted form are straight 
and half as long. Other meridians are equally-spaced sinusoidal curves, bending slightly at 
latitudes 55°51′N and S, and all are concave toward the local central meridian.

Parallels: Straight parallel lines, perpendicular to the central meridian(s). Equally-spaced 
between latitudes 55°51′N and S. Gradually closer together beyond these latitudes.

Poles: Interrupted straight lines totaling 0.31 the length of the equator.

Symmetry: About the central meridian or the equator (in uninterrupted form).
Scale True along every latitude between 55°51′N and S and along the central meridian within 

the same latitude range. Constant along any given latitude, same for the latitude of 
opposite sign.

Distortion Same as the sinusoidal projection between latitude 55°51′N and S. Same as the McBryde-
Thomas flat-polar sinusoidal projection beyond this range. McBryde S3 is almost always used 
in the interrupted form and has several central meridians.

Origin Developed by F. Webster McBryde (1908-) of Potomac, Md, in 1977 as a merging of 
the sinusoidal with the McBryde-Thomas flat-polar sinusoidal projection at the parallels of 
identical scale on the two projections, latitudes 55°51′N and S. US patent by McBryde.

Use World map interrupted to show oceans or land masses, by McBryde. 

Note: Use of this projection may be restricted. See Notices for details. 

McBryde S3
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McBryde-Thomas flat-polar parabolic

Description Pseudocylindric, equal-area.
Similar projections Craster parabolic projection, equal-area with parabolic meridians but with pointed poles 

and a central meridian that is half the length of the equator.

Putniṇš P4′ projection (1934), equal-area with parabolic meridians but with poles and a 
central meridian that are all half the length of the equator.

Werenskiold I (1944) is identical to Putniṇš P4′ except for the scale. Putniṇš P3 projection 
(1934) has meridians, poles and equator identical to those of Putniṇš P4′, but parallels are 
equally-spaced.

Graticule Meridians: Central meridian is a straight line 0.48 as long as the equator. Other meridians 
are equally-spaced parabolic curves, concave toward the central meridian.

Parallels: Unequally-spaced straight, parallel lines, farthest apart near the equator. 
Perpendicular to the central meridian.

Poles: Lines one-third as long as the equator.

Symmetry: About the central meridian or equator.
Scale True along latitudes 45°30′N and S. Constant along any given latitude, same for latitude of 

opposite sign.
Distortion Distortion is severe near the outer meridians at high latitudes, but less than the 

corresponding distortion on pointed-polar projections. Free of distortion only at latitudes 
45°30′N and S at the central meridian.

Origin Presented by F. Webster McBryde and Paul D. Thomas through the US Coast and 
Geodetic Survey in 1949.

Use Academic. Basis of merged projections by McBryde.

McBryde-Thomas flat-polar parabolic
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McBryde-Thomas flat-polar quartic

Description Pseudocylindric, equal-area.
Synonyms Flat-polar quartic projection
Similar projections Quartic authalic projection, the basis of this projection, has pointed poles.

Other McBryde-Thomas projections also have poles one-third the length of the equator 
and otherwise resemble this projection.

Graticule Meridians: Central meridian is a straight line 0.45 as long as the equator. Other meridians 
are equally-spaced curves fitting a fourth-order (quartic) equation and concave toward the 
central meridian.

Parallels: Unequally-spaced straight, parallel lines, farthest apart near the equator. 
Perpendicular to the central meridian.

Poles: Lines one-third as long as the equator.

Symmetry: About the central meridian or equator.
Scale True along latitudes 33°45′N and S. Constant along any given latitude, same for latitude of 

opposite sign.
Distortion Distortion is severe near outer meridians at high latitudes, but less than the corresponding 

distortion on pointed-polar projections. Free of distortion only at latitudes 33°45′N and S 
at the central meridian.

Origin Presented by F. Webster McBryde and Paul D. Thomas through the US Coast and 
Geodetic Survey in 1949.

Use Examples in various geography text books. Basis of merged projections by McBryde.

McBryde-Thomas flat-polar quartic
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McBryde-Thomas flat-polar sinusoidal

Description Pseudocylindric, equal-area.
Similar projections Sinusoidal projection uses sinusoids for meridians, but poles are points.

Eckert VI projection uses sinusoids for meridians and is equal-area, but the poles are lines 
half as long as the equator.

Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 
are equally-spaced sinusoids concave toward the central meridian.

Parallels: Unequally-spaced straight, parallel lines, farthest apart near the equator. 
Perpendicular to the central meridian.

Poles: Lines one-third as long as the equator.

Symmetry: About the central meridian or equator.
Scale True along latitudes 55°51′N and S. Constant along any given latitude, same for latitude of 

opposite sign.
Distortion Free of distortion only at latitudes 55°51′N and S at the central meridian.
Origin Presented by F. Webster McBryde and Paul D. Thomas through the US Coast and 

Geodetic Survey in 1949.
Use Basis of merged projections by McBryde (see McBryde S3).

McBryde-Thomas flat-polar sinusoidal

McBryde-Thomas I

Description Pseudocylindric, equal-area.
Use Thematic world maps.

McBryde-Thomas I

McBryde-Thomas II

Description Pseudocylindric, equal-area.
Use Thematic world maps.
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McBryde-Thomas II

Mercator equal-area—See sinusoidal

Mollweide

Description Pseudocylindric.
Equal-area map in an ellipse.

Synonyms Mollweide 
homolographic 
homalographic 
elliptical

Similar projections Goode homolosine (Mollweide merged with sinusoidal)

Boggs Eumorphic (Mollweide averaged with sinusoidal)

Bromley by Robert H. Bromley in 1965 (Mollweide compressed from north to south with 
east-west expansion to achieve no distortion along the equator).

Hyperelliptical by Waldo R. Tobler in 1973 (equal-area pseudocylindric having 
‘hyperelliptical’ meridians that lie between the Mollweide ellipses and have a circumscribed 
rectangle).

Aspects For educational purposes, it has been shown in various aspects as examples of equatorial, 
transverse, and oblique aspects of almost any pseudocylindric projection. The transverse 
aspect has also been used by John Bartholomew in The Times Atlas in England in 1958.

Graticule Meridians: Central meridian is a straight line half as long as the equator. Meridians 90° 
E and W of the central meridian form a circle. Others are equally-spaced semi-ellipses 
intersecting at the poles and concave toward the central meridian.

Parallels: Unequally-spaced straight, parallel lines, farthest apart near the equator, spacing 
changes gradually. Perpendicular to the central meridian.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 40°44′N and S. Constant along any given latitude, same for the 

latitude of opposite sign.
Distortion Severe near outer meridians at high latitudes, but can be substantially reduced if 

interrupted with several central meridians. Free of distortion only at latitudes 40°44′N and 
S on the central meridian.

Origin Presented by Carl B. Mollweide (1774-1825) of Germany in 1805.
Use Occasional world maps, especially thematic maps. Combined with sinusoidal projection to 

develop other projections such as the Goode homolosine and the Boggs.
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Mollweide

Nell

Description Pseudocylindric, equal-area.
Use Historical.

Nell

Nell-Hammer

Description Pseudocylindric.
Use Historical.

Nell-Hammer

Philbrick Sinu-Mollweide

Description Pseudocylindric.
Origin Presented by Allen K. Philbrick in 1953 as an oblique fusion of the Mollweide and 

sinusoidal projections.
Use For thematic maps displaying distributions across the world.

Philbrick Sinu-Mollweide



Projection gazetteer B.45

Putniṇš P1

Description Pseudocylindric.
Use Academic.

Putniṇš P1

Putniṇš P1′

Description Pseudocylindric.
Use Reference world maps.

Putniṇš P1′

Putniṇš P2

Description Pseudocylindric, equal-area.
Use Academic.

Putniṇš P2

Putniṇš P2′—See Wagner IV

Putniṇš P3

Description Pseudocylindric.
Use Academic.
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Putniṇš P3

Putniṇš P3′

Description Pseudocylindric.
Use Academic.

Putniṇš P3′

Putniṇš P4—See Craster parabolic

Putniṇš P4′

Description Pseudocylindric. Equal-area.
Use Thematic world maps.

Putniṇš P4′
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Putniṇš P5

Description Pseudocylindric. Equally-spaced parallels. Neither conformal nor equal-area.
Similar projections Putniṇš P6 equal-area projection (1934) has hyperbolic meridians identical in shape to 

those of the pointed-polar P2; parallels are straight but are spaced for equal-area. 

Putniṇš P2′ projection (1934) has hyperbolic meridians, but the poles are straight lines half 
the length of the equator. Parallels are equally-spaced. The projection is not equal-area.

Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 
are equally-spaced portions of hyperbolas, concave toward the central meridian. 

Parallels: Equally-spaced straight, parallel lines, perpendicular to the central meridian.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 21°14′N and S. Constant along any given latitude, same for latitude of 

opposite sign. Constant along the central meridian.
Distortion Distortion is similar to other pointed-polar pseudocylindrics, but not free of distortion at 

any point.
Origin Presented by Reinholds V. Putniṇš of Lavia in 1934.

Putniṇš P5

Putniṇš P5′

Description Pseudocylindric.
Use Academic.

Putniṇš P5′

Putniṇš P6

Description Pseudocylindric. Equal-area.
Similar projections Quite similar to the sinusoidal.
Use Academic.
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Putniṇš P6

Putniṇš P6′

Description Pseudocylindric. Equal-area.
Similar projections Very similar to Eckert VI.
Use Thematic world maps.

Putniṇš P6′

quartic authalic

Description Pseudocylindric, equal-area.
Similar projections Several pseudocylindrics, such as the sinusoidal.

Eckert-Greifendorff has slightly curved parallels.
Graticule Meridians: Central meridian is a straight line 0.45 as long as the equator. Other meridians 

are equally-spaced curves fitting a fourth-order (quartic) equation and concave toward the 
central meridian.

Parallels: Unequally-spaced straight, parallel lines, farthest apart near the equator. Spacing 
changes gradually. Perpendicular to the central meridian.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along the equator. Constant along any given latitude, same for latitude of opposite 

sign.
Distortion Distortion is severe near outer meridians at high latitudes, but somewhat less than that of 

the sinusoidal projection. Distortion can be substantially reduced by interruption. Free of 
distortion along the equator.

Origin Presented by Karl Siemon (?-1937) of Germany in 1937. Independently presented by 
Oscar Sherman Adams (1874-1962) of the US Coast and Geodetic Survey in 1945.

Use Basis for McBryde-Thomas flat-polar quartic projection.
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quartic authalic

Robinson

Description Pseudocylindric, neither conformal nor equal-area.
Synonyms orthophanic (“right appearing”).
Similar projections Putniṇš P2′, an equal-area projection on which meridians are elliptical arcs.

Eckert III+EckertIV

In 1968, Janos Baranyi presented seven pseudocylindric projections characterized by 
various graduated tabular spacings of the parallels. The poles are usually points but 
occasionally are lines, and the outer meridians 180° from the central meridian are circular 
arcs combined in some cases with straight lines. His projections are neither equal-area nor 
conformal.

Parameters An enumeration to describe the interpolation model.
Range interpolation, spline, polynomial
Usual interpolation for maps; polynomial for distortion analysis.
Graticule Meridians: Central meridian is a straight line 0.51 times as long as the equator. Other 

meridians resemble elliptical arcs, are equally spaced, and are concave toward the central 
meridian.

Parallels: Straight parallel lines, equally-spaced between latitudes 38°N and S, space 
decreases beyond these limits.

Poles: Lines 0.53 as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 38°N and S. Constant along any given latitude, same for the latitude 

of opposite sign.
Distortion No point is completely free of distortion, but distortion is very low within about 45° of the 

center and along the equator. Considerable distortion near the poles.
Origin Presented by Arthur H. Robinson (1915-) of the University of Wisconsin in 1963, at the 

request of Rand McNally and Company.

Uses tabular coordinates rather than mathematical formulas to make the world map “look” 
right.

Use By Rand McNally in Goode’s Atlas for thematic world maps, and in numerous other 
publications.
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Robinson

Sanson-Flamsteed—See sinusoidal

Sinu-Mollweide—See Philbrick Sinu-Mollweide

sinusoidal

Description Pseudocylindric, equal-area, equally-spaced parallels.
Synonyms Mercator equal-area 

Sanson-Flamsteed
Similar projections Several other pseudocylindric projections, such as Craster parabolic and Boggs eumorphic, 

are very similar, but parallels are not equally-spaced, and meridians are curved differently. 
Eckert V and VI have sinusoidal meridians but have lines for poles.

Special properties In equatorial aspect, scale is correct along all parallels and along the central meridian.
Aspects For educational purposes, it has been shown in various aspects as examples of equatorial, 

transverse and oblique aspects of almost any pseudocylindric projection.
Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 

are equally-spaced sinusoidal curves intersecting at the poles and concave toward the 
central meridian.

Parallels: Equally-spaced straight, parallel lines perpendicular to the central meridian.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along every parallel and along the central meridian.
Distortion Severe near outer meridians at high latitudes, but can be substantially reduced by 

interruption with several central meridians. Free of distortion along the equator and along 
the central meridian.

Origin Developed in the 16th century. Used by J. Cossin in 1570 and by J. Hondius in Mercator 
atlases of the early 17th century. Often called Sanson-Flamsteed projection after later users. 
Oldest current pseudocylindric projection.

Use Atlas maps of South America and Africa. Occasionally used for world maps. Formerly used 
for other continental maps and star maps. Combined with Mollweide projection to develop 
other projections such as the homolosine and the Boggs eumorphic.
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sinusoidal

Snyder minimum-error flat-pole

Description Pseudocylindric. A minimum-error pseudocylindric with flat pole lines.
Use Thematic maps of the world requiring straight parallels.

Snyder minimum-error flat-pole

Snyder minimum-error pointed-pole

Description Pseudocylindric. A minimum-error pseudocylindric with points for poles.
Use Thematic maps of the world requiring straight parallels.

Snyder minimum-error pointed pole 

The Times

Description Pseudocylindric.
Use Historical.
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The Times

trapezoidal

Description Pseudocylindric.
Use Historical.
Parameters Two standard parallels φ1 and φ2 along which scale will be correct. If both standard parallels 

are in the same hemisphere the map will reflect around the equator and the scales along the 
parallels of the opposite sign also will be correct.

Range 90°S ≤ φ1, φ2 ≤ 90°N.
Usual None. When φ1 = φ2 the projection is equivalent to equirectangular.

trapezoidal

Urmayev I

Native name цилиндрическая Урмаева I
Description Pseudocylindric. Equal-area.
Use Academic.
Parameters Length of the pole-line 0.0 ≤ β ≤ 1.0
Range 0 ≤ α ≤ 1
Usual None.

Urmayev I
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Urmayev II

Native name цилиндрическая Урмаева II
Description Pseudocylindric.
Use Historical
Parameters Length of the pole-line 0.0 ≤ β ≤ 1.0

Scale along the equator 0.0 << s << 1.0
Range 0 ≤ β ≤ 1; 0 ≤ s ≤ 1
Usual None.

Urmayev II

Wagner I

Description Pseudocylindric. Equal-area.
Synonyms Kavraiskiy VI
Use Thematic world maps.

Wagner I

Wagner II

Description Pseudocylindric.
Use Academic.

Wagner II
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Wagner III

Description Pseudocylindric.
Use Academic.
Parameters One parameter φ1, a parallel along which scale will be correct.
Range 90°S << φ1 << 90°N

Wagner III

Wagner IV

Description Pseudocylindric, equal-area.
Synonyms Putniṇš P2′
Similar projections Werenskiold III projection (1944) is very similar, except that true scale is maintained along 

the equator by enlarging the map.

Putniṇš P2 equal-area projection (1934) uses the same portions of ellipses, but the poles are 
points.

Putniṇš P1 and P1′ projections (1934) have meridians identical in shape and position 
to those of Putniṇš P2 and P2′ respectively, but parallels are equally-spaced, and the 
projections are not equal-area.

Robinson projection is not equal-area, meridians are not elliptical and parallels are spaced 
differently.

Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 
are equally-spaced portions of ellipses (less than semi-ellipses) that would intersect beyond 
the poles and are concave toward the central meridian. The meridians at 103°55′ east and 
west of the central meridian are circular arcs.

Parallels: Unequally-spaced straight, parallel lines, widest separation near the equator. 
Perpendicular to the central meridian.

Poles: Lines half as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 42°59′N and S. Constant along any given latitude, same for latitude of 

opposite sign.
Distortion Distortion is not as extreme near outer meridians at high latitudes as it is on pointed polar 

pseudocylindric projections, but there is considerable distortion throughout polar regions. 
Free of distortion only at latitudes 42°59′N and S at the central meridian.

Origin Presented by Reinholds V. Putniṇš of Lavia in 1934.
Use Thematic world maps.
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Wagner IV

Wagner V

Description Pseudocylindric.
Use Academic.

Wagner V

Wagner VI

Description Pseudocylindric.
Use Academic.

Wagner VI
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Winkel I

Description Pseudocylindric. Equally-spaced parallels, neither conformal nor equal-area.
Limiting forms Eckert V, if the equator is the standard parallel.
Parameters One parameter φ1, a parallel along which scale will be correct.
Range 90°S << φ1 << 90°N.
Graticule Meridians: Central meridian is a straight line 0.61 (or other value) as long as the equator. 

Other meridians are equally-spaced sinusoidal curves, concave toward the central meridian. 

Parallels: Equally-spaced straight, parallel lines. Perpendicular to the central meridian.

Poles: Line 0.61 (or other value) as long as the equator.

Symmetry: About the central meridian or the equator.
Scale True along latitudes 50°28′N and S (or other chosen value). Constant along any given 

latitude, same for latitude of opposite sign.
Distortion Not free of distortion at any point.
Origin Developed by Oswalk Winkel (1873-1953) of Germany in 1914 as the average of the 

sinusoidal and equirectangular projections in both x and y coordinates. When the standard 
parallels of the Equirectangular projection are varied, the standard parallels and appearance 
of Winkel I vary. Use of latitudes 50°28′N and S results in a map at the correct total-area 
scale, but the local-area scale varies.

Winkel I

Winkel II

Description Pseudocylindric.
Use Academic.
Parameters One parameter φ1, a parallel along which scale will be correct.
Range 90°S << φ1 << 90°N.
Usual None.

Winkel II
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 Conic projections

Albers—See Albers equal-area conic

Albers equal-area conic [Albers]

Description Conic, equal-area.
Similar projections Various methods of determining optimum standard parallels have been proposed by N.A. 

Tissot in 1881, V.V. Vitkovskiy (projection 11) in 1907, N. Y.A. Tsinger in 1916, and 
F.N. Krasovskiy (projection 1) in 1922. Once the standard parallels are selected, all these 
projections are constructed by using the same formulas used for the Albers equal-area conic 
with two standard parallels.

Limiting forms Polar Lambert azimuthal equal-area projection, if a pole is made the single standard parallel. 
The cone of projection thereby becomes a plane.

Lambert equal-area conic projection if the pole and another parallel are made the two 
standard parallels.

Lambert cylindric equal-area projection if the equator is the single standard parallel. The 
cone of projection thereby becomes a cylinder.

Behrmann or other cylindric equal-area projections if the two standard parallels are 
symmetrically placed north and south of the equator. 

Standard conic formulas must be rewritten for the third and fourth limiting forms.
Parameters Latitude of origin φ0, the latitude whose intersection with the central meridian forms the 

origin of the projection. Has no effect except on cartesian coordinates in the Info palette.

Two standard parallels φ1 and φ2 along which scale will be correct. Although the attributes 
of the map are determined by both parallels, in general the higher of the two latitudes 
controls the length of the pole-line: the higher it is the shorter the pole line.

The lower of the two controls the angle that the final map will have from the pole to the 
west and east boundaries: the lower it is the more squarish the map.

Range 90°S ≤ φ1, φ2 ≤ 90°N.
Aspects Rarely used in oblique aspect, but occasionally proposed in journal articles.
Usual None. When φ1 = ±90° and φ2 ≠ ±90°, the projection is Lambert equal-area conic. When φ1 

= φ2 = ±90°, the projection is Lambert azimuthal equal-area. When φ1 approaches -φ2 the 
projection approaches cylindric equal-area.

Graticule Meridians: Equally-spaced straight lines converging at a common point, which is normally 
beyond the pole. The angles between them are less than the true angles.

Parallels: Unequally-spaced concentric circular arcs centered on the point of convergence 
of the meridians. The meridians are therefore radii of the circular arcs. Spacing of parallels 
decreases away from the central latitudes.

Poles: Normally circular arcs enclosing the same angle as that enclosed by other parallels of 
latitude for a given range of longitude.

Symmetry: About any meridian.
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Scale True along one or two chosen standard parallels, usually, but not necessarily, on the same 
side of the equator. As a rule of thumb, these parallels can be placed at one-sixth and 
five-sixths of the range of latitudes, but there are more refined means of selection. Scale is 
constant along any given parallel. The scale factor at any given point along the meridian is 
the reciprocal of that along the parallel, to preserve area.

Distortion Free of angular and scale distortion only along one or two standard parallels. Distortion is 
constant along any given parallel.

Origin Presented by Heinrich Christian Albers (1773-1833) of Germany in 1805.
Use Frequently used in the ellipsoidal form for maps of the United States in the National Atlas 

of the United States, for thematic maps and for world atlases.

Also used and recommended for equal-area maps of regions that are predominantly east-
west in extent.

Low distortion of regions between two concentric small circles. 

For simple maps, use the Boundaries command to select the region of interest. Then use 
the Parameters command to set φ1 and φ2 so that they are about 1/6th the distance from the 
northern-most and southern-most parallels of interest. 

In oblique maps, the projection should be centered 90° away from the center of the small 
circles with the central meridian at the longitude of the center of the small circle for ease of 
computation. The two standard parallels should be about 1/6th the distance from the north 
and south small circles. For example, a map of Australia can be made by selecting 58°S, 
122°E as the center of two standard parallels that meet the 122°E meridian at 30°S and 
16°S. The projection should be centered on 58°S + 90° = 32°N, 122°E. Since 58°S is being 
used as the south pole, α1 would be at 90°S - (58°S - 30°S) = 62°S, and α2 would be at 90°S 
- (58°S - 16°S) = 48°S. Also see Lambert conformal conic notes.

Albers equal-area conic
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American polyconic

Description Polyconic, neither conformal nor equal-area.
Synonyms polyconic
Similar projections Rectangular polyconic projection has identical parallels of latitude, but meridians are plotted 

to intersect parallels at right angles.

The modified polyconic projection for the International Map of the World series has two 
meridians that are true to scale.

An equidistant polyconic projection was used by the US Coast and Geodetic Survey for 
coastal charts in the 19th century. Its construction is unclear, but it was apparently different 
from other polyconics.

Equal-area polyconic projections were presented by Hans Maurer in 1935 in Germany and 
by Albert H. Bumstead of the National Geographic Society in 1937.

Other modified polyconics have been presented by G.T. McCaw in England in 1921, by 
G.A. Ginzburg and T.D. Salmanova in the Soviet Union in 1949 and 1951, and by G.E. 
Bousfield in Canada in 1950. 

Polyconic is a term sometimes applied to all projections having circular arcs for parallels of 
latitude, including regular conics and the stereographic, but this usage is not common.

Parameters Latitude of origin φ0, the latitude whose intersection with the central meridian forms the 
origin of the projection. Has no effect except on cartesian coordinates in the Info palette.

Aspects Transverse aspect was proposed by Charles H. Deetz of the US Coast and Geodetic Survey 
in the early 20th century. 

The National Geographic Society has used the transverse aspect for maps of Eurasia and the 
Soviet Union.

Graticule Meridians: Central meridian is a straight line. All other meridians are complex curves, 
spaced equally along the equator and along each parallel and concave toward the central 
meridian.

Parallels: equator is a straight line, poles are points, and all other parallels are non-
concentric circular arcs spaced at true distances along the central meridian. Each parallel 
has a curvature identical to its curvature on a cone tangent at that latitude. Many cones are 
involved, hence the name polyconic.

Scale True along the central meridian and along each parallel.
Distortion Free of distortion only along the central meridian. Extensive distortion if the range extends 

very far east or west.
Origin Apparently originated in about 1820 by Ferdinand Rudolph Hassler (1770-1843), first 

director of the Survey of the Coast (later the US Coast and Geodetic Survey).
Use The sole projection used for large-scale mapping in the ellipsoid form (topographic 

quadrangles) of the United States by the US Geological Survey until the 1950s. 

Basis for Progressive Military Grid used by the US Army until the 1940s.

Projection for many early coast charts by the US Coast and Geodetic Survey.

Not recommended for regional maps, because there are better projections.

Can be used for local maps requiring edge-matching in the north-south direction (or along 
a great circle in oblique form), in which case the center meridian should be moved to the 
meridian at the middle of the area of interest, and the center parallel should be left at 0°. 
Also can be used for model globes when projecting in interrupted form.
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American polyconic

amulet

Description Equal-area.

Created by joining the Albers equal-area conic and Bonne projections along the parallel of 
correct scale.

Use Decorative maps.
Parameters One standard parallel α1 along which scale is correct.
Range 90°S ≤ φ1 ≤ 90°N.
Usual About 40° ≤ φ1 ≤ 60°. When φ1 = 90°N the projection is Werner. When φ1 = 90°S, 

the projection is Lambert azimuthal equal-area, centered on the south pole. When φ1 
approaches 0°, the northern hemisphere approaches Lambert cylindric equal-area, and the 
southern hemisphere approaches sinusoidal.

Origin Developed by Daniel “daan” Strebe in 1991.

amulet

bipolar oblique conformal—See bipolar oblique conic conformal
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bipolar oblique conic conformal [bipolar oblique conformal]

Description Conic, conformal.
Graticule Meridians: Unequally-spaced curved lines, except for two straight meridians from the 

transformed poles to the nearest geographic pole.

Parallels: Unequally-spaced curved lines.

Poles: Points.

Symmetry: None.
Scale True along four circular arcs joined to form two S curves. These arcs do not follow any 

parallel or meridian. Scale is constant along circular arcs centered on each transformed pole 
for part of the map. The pole for most of North America is in the North Atlantic, and that 
for South America is in the South Pacific.

Distortion Low throughout North and South America. None along the lines of true scale and constant 
along circular arcs centered on the transformed pole for the given part of the map. Slight 
non-conformality near the line joining the two transformed poles.

Origin Presented by Osborn Maitland Miller (1897-1979) and William A. Briesemeister of the 
American Geographical Society in 1941.

Use Designed specifically for a low-error map of North and South America, constructed by the 
American Geographical Society.

Other organizations, including the US Geological Survey, have used the American 
Geographical Society map as a base for maps of North and South America alone, but since 
the advent of computer plotting, other projections are preferable and practical for regional 
maps.

bipolar oblique conic conformal



B.62

Bonne

Description Pseudoconic, equal-area.
Limiting forms Werner projection if a pole is made the standard parallel.

Sinusoidal projection if the equator is made the standard parallel. The pseudoconic 
projection thereby becomes a pseudocylindric projection, but the Bonne formulas must be 
rewritten.

Similar projections John Bartholomew combined the Bonne projection with the equidistant conic projection 
with two standard parallels. In his 1942 kite and 1958 regional projections, the equidistant 
conic is used in the north temperate zone, and the Bonne is used south of the Tropic of 
Cancer in interrupted form. The more northern regions are based on the Bonne (kite) 
and conic (regional) projections. These two projections emphasize land masses, and 
Bartholomew’s 1958 lotus projection emphasizes the oceans by using a southern version of 
the regional projection.

Parameters One standard parallel φ1 along which scale is correct.
Range 90°S ≤ φ1 ≤ 90°N.
Usual About 40° ≤ φ1 ≤ 60°. When φ1 = 90°N or 90°S the projection is Werner. When φ1 

approaches 0° the projection approaches sinusoidal.
Graticule Meridians: Central meridian is a straight line. Other meridians are complex curves 

connecting points equally-spaced along each parallel of latitude and concave toward the 
central meridian. 

Parallels: Concentric circular arcs spaced at true distances along the central meridian. The 
curvature of the central or standard parallel is identical to its curvature on a cone tangent at 
that latitude.

Poles: Points.

Symmetry: About the central meridian.
Scale True along the central meridian and along each parallel. Free of all distortion along the 

central meridian and the central parallel.
Origin Developed in rudimentary form by Claudius Ptolemy (about AD 100). Further developed 

by Barnardus Sylvanus in 1511. Used considerably by Rigobert Bonne (1727-1795) of 
France, especially in 1752; the name is taken from him.

Use Frequently used until recently for atlas maps of continents. Used in the ellipsoidal form for 
topographic mapping of France in the early 19th century.

Bonne
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Boole—See ellipsoidal Lambert conformal conic

Braun stereographic conic

Description Conic projection in a semicircle. Neither equal-area nor conformal.
Origin Presented by Carl Braun (1831–1907) in 1867.

Braun stereographic conic

conical orthomorphic—See Lambert conformal conic

ellipsoidal Lambert conformal conic

Description Ellipsoidal form of Lambert conformal conic.
Synonyms Gauss conformal conic, Gauß conformal conic, Boole
Parameters Latitude of origin φ0, the latitude whose intersection with the central meridian forms the 

origin of the projection. Has no effect except on cartesian coordinates in the Info palette.

Two parameters φ1 and φ2, which are parallels along which scale will be correct.
Range 90°S << φ1, φ2 < 90°N.
Usual None. When φ1 and φ2 approach ±90°, the projection approaches stereographic. When φ1 

approaches -φ2 the projection approaches Mercator.
Use See notes for Lambert conformal conic. 

Extensively used for large-scale mapping of regions of predominantly east-west extent, 
including topographic quadrangles (1:24,000 and 1: 62,000 scale) for many of the US 
State Plane Coordinate System zones, many maps in the International Map of the World 
(1: 1,000,000 scale) series, the US State Base maps (1: 500,000 scale) and topographic 
mapping in many other nations.

ellipsoidal Lambert conformal conic
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equidistant—See equidistant conic

equidistant conic [equidistant]

Description Conic, equally-spaced parallels, neither conformal nor equal-area.
Synonyms simple conic
Similar projections Various methods of determining optimum standard parallels have been proposed by Patrick 

Murdoch (projections I, III) in 1758, Leonhard Euler in 1777, British Ordnance in the 
late 19th century, Dmitir I. Mendeleev in 1907, Wilhelm Schjerning (projection I) in 1882, 
V.V. Vitkovskiy (projection I) in 1907, and V.V. Kavrayskiy (projections II, IV) in 1934. 
Once the standard parallels are selected, all these projections are constructed by using 
formulas used for the equidistant conic with two standard parallels.

John Bartholomew combined the equidistant conic with the Bonne projection.
Limiting forms Polar azimuthal equidistant projection if a pole is made the single standard parallel. The 

cone of projection thereby becomes a plane.

Plate carrée if the single standard parallel is the equator. The cone of projection thereby 
becomes a cylinder.

Equirectangular (cylindric) projection if two standard parallels are symmetrically placed 
north and south of the equator.

Standard conic formulas must be rewritten for the second and third limiting forms.
Parameters Latitude of origin φ0, the latitude whose intersection with the central meridian forms the 

origin of the projection. Has no effect except on cartesian coordinates in the Info palette.

Two standard parallels φ1 and φ2 along which scale is correct. Although the attributes of the 
map are determined by both parallels, in general the higher of the two latitudes controls 
the length of the pole-line: the higher it is the shorter the pole line.

The lower of the two controls the angle that the final map will have from the pole to the 
west and east boundaries: the lower it is the more squarish the map.

Range 90°S ≤ φ1, φ1 ≤ 90°N.
Special properties The scale along all meridians is correct in equatorial aspect.
Usual None. When φ1 approaches -φ2 the projection approaches equirectangular. When φ1 and φ2 

approach ±90° the projection approaches azimuthal equidistant.
Graticule Meridians: Equally-spaced straight lines converging at a common point, which is normally 

beyond the pole. The angles between them are less than the true angles.

Parallels: Equally-spaced concentric circular arcs centered on the point of convergence of 
the meridians, which are therefore radii of the circular arcs.

Poles: Normally circular arcs enclosing the same angle as that enclosed by the other 
parallels of latitude for a given range of longitude.

Symmetry: About any meridian.
Scale True along each meridian and along one or two chosen standard parallels, usually but not 

necessarily on the same side of the equator. As a rule of thumb, these parallels can be placed 
at one-sixth and five-sixths of the range of the latitudes, but there are more refined means 
of selection. Scale is constant along any given parallel.

Distortion Free of distortion only along the two standard parallels. Distortion is constant along 
any given parallel. Compromise in distortion between equal-area and conformal conic 
projections.
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Origin Rudimentary forms developed by Claudius Ptolemy (about AD 100). 

Improvements by Johannes Ruysch in 1508, Gerardus Mercator in the late 16th century, 
and Nicolas de L’Isle in 1745.

Use The most common projection in atlases for small countries. Also used by the Soviet Union 
for mapping that nation.

Low distortion maps along small circle routes with meridians of correct scale. Since the 
chief virtue is the constant scale along the meridians the projection normally is pointless 
with a center point away from the equator. See usage notes for Albers equal-area conic.

equidistant conic

Gauss conformal conic—See ellipsoidal Lambert conformal conic

Gauß conformal conic—See ellipsoidal Lambert conformal conic

globe gores

Description Optimized for construction of globe gores.
Similar projections Rectangular polyconic with standard parallel of 0° is similar.
Parameters Warpage k, such that 1≤ k ≤ 3. This value must be determined empirically according to the 

paper medium. Set the gore count via Projection > Interruptions > Gores.

globe gores

Harding—See Lambert conformal conic



B.66

heart

Description Equal-area.
Use Decorative maps.
Parameters A standard parallel φ1 which relates to the amount of poleward curvature, and a meridian 

duplication factor x which describes a countering bend toward the equator.
Range φ1 90°S ≤ φ1 ≤ 90°N.
Usual φ1 About 55° < φ1 < 90°.
Range x 0 << x < ∞.
Usual x 1.1 < x < 2.0. When x = 1.0 the projection is Bonne.
Origin Developed by Daniel “daan” Strebe in 1991.

heart

Herschel conformal conic

Description Equivalent to Lambert conformal conic in spherical development with a cone constant of ⅓, 
yielding a standard parallel of 19°28′16″.

Parameters Latitude of origin φ0, the latitude whose intersection with the central meridian forms the 
origin of the projection. Has no effect except on cartesian coordinates in the Info palette.

Origin Presented by John F.W. Herschel (1792–1871) in 1859.

Herschel conformal conic

isoperimetric—See isoperimetric cordiform
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isoperimetric cordiform [isoperimetric]

Description Scale is correct along all parallels and along all meridians. 
Similar projections Isoperimetric azimuthal is another projection on which scale is correct along both parallels 

and meridians.
Origin Presented by Leszek Pernarowski in conceptual form with approximate formulæ, 1970.

isoperimetric cordiform

Lambert conformal—See Lambert conformal conic

Lambert conformal conic [Lambert conformal]

Description Conic, conformal.

The projection’s pole is always a point.
Synonyms conical orthomorphic, Harding, Gauss conformal conic (ellipsoidal development), Boole 

(ellipsoidal development)
Similar projections Various methods of determining optimum standard parallels have been proposed by John 

Herschel in 1860, V.V. Vitkovskiy (projection III) in 1907 N.Y.A. Tsinger in 1916, and 
V.V. Kavrayskiy (projection III) in 1934. Once the standard parallels are selected, all these 
projections are constructed by using the same formulas used for the Lambert conformal 
conic with two standard parallels.

Bipolar oblique conic conformal projection consists of oblique aspects of two Lambert 
conformal conic projections laid end-to-end.
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Limiting forms Polar stereographic projection if a pole is the single standard parallel. The cone of projection 
thereby becomes a plane.

Mercator projection if the single standard parallel is the equator, or if two standard parallels 
are symmetrically placed north and south of the equator. The cone of projection thereby 
becomes a cylinder. Standard conic formulas must be rewritten.

Aspects Bipolar oblique conic conformal projection is the only common oblique aspect.
Limitations Can only show one pole; should be used for no more than a hemisphere.
Parameters Latitude of origin φ0, the latitude whose intersection with the central meridian forms the 

origin of the projection. Has no effect except on cartesian coordinates in the Info palette.

Two parameters φ1 and φ2, which are parallels along which scale will be correct.
Range 90°S << φ1, φ2 < 90°N.
Usual None. When φ1 and φ2 approach ±90°, the projection approaches stereographic. When φ1 

approaches -φ2 the projection approaches Mercator.
Graticule Meridians: Equally-spaced straight lines converging at a common point, which is one of 

the poles. The angles between them are less than the true angles.

Parallels: Unequally-spaced concentric circular arcs centered on the pole of convergence of 
the meridians, which are therefore radii of the circular arcs. Spacing of parallels increases 
away from the central latitudes.

Poles: The pole nearest a standard parallel is a point, the other pole cannot be shown. 

Symmetry: About any meridian.
Scale True along one or two chosen standard parallels, usually, but not necessarily, on the same 

side of the equator. As a rule of thumb, these parallels can be placed at one-sixth and five-
sixths of the range of the latitudes, but there are more refined means of selection. Scale is 
constant along any given parallel and is the same in all directions at any given point.

Distortion Free of distortion only along the one or two standard parallels. Distortion is constant along 
any given parallel. Conformal everywhere except at the poles.

Origin Presented by Johann Heinrich Lambert (1728-1777) of Alsace in 1772.
Use For low distortion of regions between two concentric small circles. See notes for Albers 

equal-area conic. 

Extensively used in ellipsoidal form for large-scale mapping of regions of predominantly 
east-west extent, including topographic quadrangles (1:24,000 and 1: 62,000 scale) for 
many of the US State Plane Coordinate System zones, many maps in the International 
Map of the World (1: 1,000,000 scale) series, the US State Base maps (1: 500,000 scale) 
and topographic mapping in many other nations.

Also used for atlas maps of some countries.

Recommended for conformal mapping of regions of predominantly east-west extent.

If neither equivalence nor conformality are a concern, then either the Lambert conformal 
conic or the Albers equal-area conic can be used, because for small regions the difference is 
negligible. 

For large regions differences are visible but the choice depends on the scope of the map. In 
general very large regions should use Lambert, because the shape distortion of Albers equal-
area conic is more obvious than the area distortion of Lambert. 

For a map of the continental U.S. or smaller, either will work well.
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Lambert conformal conic

Lambert equal-area—See Lambert equal-area conic

Lambert equal-area conic [Lambert equal-area]

Description Conic, equal-area.
Similar projections Albers equal-area conic projection also has concentric circular arcs for parallels and straight 

meridians, but it has two standard parallels close to the latitudes of interest. If just one of 
its standard parallels is made a pole, it becomes the Lambert equal-area conic projection, but 
that pole is not free of distortion, as the usual standard parallel is.

Limiting forms Polar Lambert azimuthal equal-area projection if the central pole is the standard parallel. 
The cone of projection thereby becomes a plane.

Parameters One parameter φ1 which is a parallel along which scale will be correct.
Range 90°S << φ1 << 90°N.
Usual None. When φ1 approaches 90°N, the projection approaches Lambert azimuthal equal-area. 

See Albers equal-area conic.
Graticule Meridians: Equally-spaced straight lines converging at a common point, which is one of 

the poles. The angles between them are less than the true angles.

Parallels: Unequally-spaced concentric circular arcs centered on the pole of convergence 
of the meridians. The meridians are therefore radii of the circular arcs. Spacing of parallels 
decreases away from the pole of convergence.

Poles: One pole is a point, the other pole is a circular arc enclosing the same angle as that 
enclosed by the other parallels of latitude for a given range of longitudes. 

Symmetry: About any meridian.
Scale True along the chosen standard parallel. Scale is constant along any given parallel. The scale 

factor at any given point along the meridian is the reciprocal of that along the parallel, to 
preserve area.

Distortion Free of scale and angular distortion only along the standard parallel. Severe stretching near 
each pole. Scale distortion and angular distortion are constant along any given parallel.

Origin Presented by Johann Heinrich Lambert (1728-1777) of Alsace in 1772.
Use Academic.

Note: Albers Equal-Area Conic always produces a better map.
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Lambert equal-area conic

optimized Albers—See Tissot equal-area conic

périgonale equal-area conic—See Tissot equal-area conic

perspective—See perspective conic
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perspective conic [perspective]

Description Conic, perspective, neither conformal nor equal-area.
Similar projections A sterographic perspective conic was presented by Carl Braun in 1867. The map is 

projected from the south pole onto a cone tangent at latitude 30°N.
Limiting forms Polar gnomonic projection, if the pole is the single standard parallel. The cone of projection 

thereby becomes a plane. 

Central cylindric projection if the equator is the single standard parallel. The cone of 
projection thereby becomes a cylinder.

 Standard conic formulas must be rewritten.
Other features The projection is produced geometrically by projecting the earth perspectively from 

the center (or from some other point) onto a cone tangent or secant along the standard 
parallels.

Limitations Can only show one pole.
Parameters Latitude of origin φ0, the latitude whose intersection with the central meridian forms the 

origin of the projection. Has no effect except on cartesian coordinates in the Info palette.

Two parameters φ1 and φ2, which are parallels along which scale will be correct.
Range 90°S << φ1, φ2 < 90°N.
Usual None. When φ1 and φ2 approach ±90°, the projection approaches gnomonic. When 

φ1approaches -φ2 the projection approaches central cylindric.
Graticule Meridians: Equally-spaced straight lines converging at a common point, which is one of 

the poles. The angles between them are less than the true angles.

Parallels: Unequally-spaced concentric circular arcs centered on the pole of convergence 
of the meridians. The meridians are therefore radii of the circular arcs. Spacing of parallels 
increases away from the central latitudes.

Poles: One pole is a point, the other pole cannot generally be shown, but under some 
conditions, it is a circular arc.

Symmetry: About any meridian.
Scale True along one to two chosen standard parallels, which may be on the same side, or both 

sides of the equator.

Scale is constant along any given parallel.
Distortion Free of distortion only along one or two standard parallels. Distortion is constant along 

any given parallel, but changes more rapidly in a north-south direction than it does on 
conformal or equal-area conics, and the perspective conic has no compensating advantage. 
Other projections should be used instead.

Use Academic.
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Perspective conic

polyconic—See American polyconic

Ptolemy I

Ptolemy I

Ptolemy II

Synonyms Ptolemy’s homeotheric

Ptolemy II

Ptolemy’s homeotheric—See Ptolemy II
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rectangular polyconic

Description Polyconic. Meridians meet parallels at right angles, but not conformal.
Synonyms War Office (British)
Similar projections American polyconic projection has identical parallels of latitude, but meridians do not 

intersect parallels at right angles except along central meridian.

The modified polyconic projection for the International Map of the World series has two 
meridians that are true to scale.

An equidistant polyconic projection was used by the US Coast and Geodetic Survey for 
coastal charts in the 19th century. Its construction is unclear, but it was apparently different 
from other polyconics.

Equal-area polyconic projections were presented by Hans Maurer in 1935 in Germany and 
by Albert H. Bumstead of the National Geographic Society in 1937.

Other modified polyconics have been presented by G.T. McCaw in England in 1921, by 
G.A. Ginzburg and T.D. Salmanova in the Soviet Union in 1949 and 1951, and by G.E. 
Bousfield in Canada in 1950. 

Polyconic is a term sometimes applied to all projections having circular arcs for parallels of 
latitude, including regular conics and the stereographic, but this usage is not common.

Parameters Latitude of origin φ0, the latitude whose intersection with the central meridian forms the 
origin of the projection. Has no effect except on cartesian coordinates in the Info palette.

One standard parallel φ1 along which scale is correct.
Range 90°S << φ1 << 90°N.
Usual None. When φ1 approaches ±90° the projection approaches two hemispheric circles, but 

balloons in size.
Graticule Meridians: Central meridian is a straight line. All other meridians are complex curves, 

equally-spaced along the equator or along two chosen parallels symmetrical about the 
equator. Meridians intersect all parallels at right angles.

Parallels: equator is a straight line, poles are points, and all other parallels are non-
concentric circular arcs spaced at true distances along the central meridian. Each parallel 
has a curvature identical to its curvature on a cone tangent at that latitude. Many cones are 
involved, hence the name Polyconic projection.

Scale True along the central meridian and along the equator, or two chosen parallels of true scale.
Distortion Free of distortion only along the central meridian. Although meridians intersect parallels 

at right angles, there is some angular distortion at all points other than along the central 
meridian.

Use Model globes and large-scale military mapping in Great Britain. See notes for American 
polyconic.

rectangular polyconic
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rectangular polyconic gores

Parameters Gore count

rectangular polyconic gores

shield

Description Equal-area.

Created by joining Albers equal-area conic and Bonne projections along the equator.
Use Decorative maps.
Parameters Standard parallel.
Origin Developed by Daniel “daan” Strebe in 1991.

shield

Stab-Werner—See Werner

Tissot equal-area conic [Tissot]

Description A formulation yielding the optimal Albers for given northern and southern limits.
Other names périgonale equal-area conic, optimized Albers
Similar projections See notes for Albers equal-area conic.
Parameters Two parallels θ1 and θ2 giving the northern and southern limits of the portion of the map 

to be optimized.
Range 90°S ≤ θ1, θ2 ≤ 90°N.
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Graticule Meridians: Equally-spaced straight lines converging at a common point, which is normally 
beyond the pole. The angles between them are less than the true angles.

Parallels: Unequally-spaced concentric circular arcs centered on the point of convergence 
of the meridians. The meridians are therefore radii of the circular arcs. Spacing of parallels 
decreases away from the central latitudes.

Poles: Normally circular arcs enclosing the same angle as that enclosed by other parallels of 
latitude for a given range of longitude.

Symmetry: About any meridian.
Scale True along one or two chosen standard parallels, usually, but not necessarily, on the same 

side of the equator. Scale is constant along any given parallel. The scale factor at any given 
point along the meridian is the reciprocal of that along the parallel, to preserve area.

Distortion This is the optimal Albers for a chosen northern and southern latitude limit. Free of angular 
and scale distortion only along one or two standard parallels. Distortion is constant along 
any given parallel.

Origin Presented by Nicolas Auguste Tissot (1824–1897) of France in 1881.

Tissot equal-area conic
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Werner

Description Pseudoconic, equal-area, cordiform (heart-shaped). Bonne with φ1 of 90°. 
Synonyms Werner
Similar projections Bonne projection is a general form on which the parallels are also circular arcs, but are not 

generally centered on a pole. The Werner is the polar limiting form.

In 1904, Wilhelm Schjerning interrupted the Werner projection, centered on the south 
pole, with three central meridians and three ‘petals’ for a world map emphasizing the 
oceans.

Goode polar equal-area projection, presented by John Paul Goode in 1928, is an interrupted 
Werner projection, centered on the north pole and using several central meridians to 
display continents in a flower-like pattern.

Tetrahedral projection, presented by John Bartholomew in 1944, is a combination of 
the Polar azimuthal equidistant projection from the pole to the tropic line of the same 
hemisphere and an interrupted Werner from there to the opposite pole, some adjustment 
being made to obtain a fit. The north pole is the center for a map of land masses, and the 
south pole is the center for an ocean map.

In 1968, W. William-Olsson of Sweden combined the northern Polar Lambert azimuthal 
equal-area projection, extending to latitude 20°N with four identical lobes extending to the 
south pole. The lobes are based on the Werner projection, but are compressed north-south 
and expanded east-west to fit the Lambert and to retain equality of area.

Graticule Meridians: Central meridian is a straight line. Other meridians are complex curves 
connecting points equally-spaced along each parallel of latitude and concave toward the 
central meridian.

Parallels: Concentric circular arcs spaced at true distances along the central meridian. One 
pole (usually the north pole) is the center for these circular arcs.

Poles: Points.

Symmetry: About the central meridian.
Scale True along the central meridian and along each parallel.
Distortion Free of all distortion only along the central meridian.
Origin Developed by Johanned Stabius (Stab) (?-1522) of Vienna in about 1500, and promoted 

by Johannes Werner (1466-1528) of Nuremberg in 1514.
Use Frequently used for world maps and some continental maps of the 16th and 17th centuries. 

Replaced by the Bonne projection for continental maps. 

No longer used except as a novelty.
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Werner
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 Azimuthal projections

Airy

Description Azimuthal, minimum-error, non-perspective, neither conformal nor equal-area.
Similar projections Clarke and James minimum-error perspective azimuthal projections were inspired by Airy’s 

work.

The azimuthal equidistant projection closely resembles the Airy, but scale is constant along 
radii from the center.

In 1892, A. Breusing proposed the low-error geometric mean of the stereographic and 
Lambert azimuthal equal-area projections.

In 1920, A.E. Young of England modified the Breusing (geometric mean) projection to 
provide a balance between the stereographic and azimuthal equidistant projections, called the 
Breusing harmonic projection.

In 1950, N.A. Urmayev of the Soviet Union proposed two other low-error azimuthal 
projections.

Limitations Should not be used for more than about ⅔ of the globe.
Parameters One parameter β which describes the small circle within which scale error is to be 

minimized.
Range -180° << β << 180°; β ≠ 0.
Graticule Polar aspect

Meridians: Equally-spaced straight lines intersecting at the central pole. Angles between 
them are the true angles.

Parallels: Nearly, but not quite, equally-spaced circles, centered at the pole, which is a 
point. Spacing increases slightly away from the center.

Symmetry: About any meridian.

Equatorial aspect

Meridians: Central meridian is a straight line. Meridians 90° away are circles. Other 
meridians are complex curves, unequally-spaced along the equator and intersecting at each 
pole. Spacing increases slightly away from the central meridian.

Parallels: equator is a straight line. Other parallels are complex curves concave toward the 
nearest pole. They are unequally-spaced along the central meridian, and spacing increases 
slightly away from the equator. At the meridian 90° from the central meridian, parallels are 
equally-spaced.

Symmetry: About the central meridian or the equator.

Oblique aspect

Meridians: Central meridian is a straight line. Other meridians are complex curves 
intersecting at each pole.

Parallels: Complex curves unequally-spaced along the central meridian, spacing increases 
slightly away from the center of projection.

Symmetry: About the central meridian.
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Scale Scale increases gradually in all directions with distance from the center, but there is no 
point at which the scale is correct in all directions.

Distortion Distortion is moderate throughout the range chosen. No point is completely free of 
distortion, although the center is free of shape distortion.

Origin Presented by George Biddell Airy (1801-92), British astronomer and geodesist, in 1861.
Use Medium-scale Ordnance Survey map of the United Kingdom.

Low-distortion maps of circular regions of hemisphere or less size, such as the Pacific Basin. 
Center the projection in the area of interest and set the β parameter to the size in degrees of 
the small circle, centered in the same place, that circumscribes the area of interest. 

Airy

AMS lunar

Description Azimuthal, perspective, neither conformal nor equal-area (except in stereographic form).
Graticule See far-side perspective.
Scale True at the center. Scale varies away from the center.
Distortion Only the center is free of distortion. Distortion is severe near the outer limit of the 

projection, but moderate within a wide range of the center.
Use The Army Map Service AMS lunar projection is a far-side perspective  formulated by Albert 

L. Nowicki in 1963 to show slightly more than a hemisphere of the moon, as seen over a 
period of time from Earth. The point of projection is 1.53748 times the radius from the 
center.
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AMS lunar

apple—See quasiazimuthal equal-area apple

azimuthal equidistant [equidistant]

Description Azimuthal, equidistant, non-perspective.
Synonyms Postel (in France and Russia, for Guillaume Postel, who was considered an originator, 

although he first used it in 1581).

zenithal equidistant
Similar projections Two-point azimuthal shows correct azimuths (but not distances) from either of two points 

to any other point.

Two-point equidistant shows correct distances (but not azimuths) from either of two points 
to any other point.

Chamberlin trimetric shows approximately true distances from three chosen points to any 
other points (cannot be exact). The three points are placed near the edges of the region 
being mapped to reduce overall distortion.

Airy and Breusing azimuthal projections have spacings similar to those of the azimuthal 
equidistant if the extent is less than one hemisphere.

Berghaus star projection uses the polar azimuthal equidistant projection for the northern 
hemisphere.

Tetrahedral projection combines the polar azimuthal equidistant projection with an 
interrupted Werner projection.

Special properties The distance between any two points on a straight line passing through the center of 
projection is shown at true scale. This feature is especially useful if one point is the center. 
Compromise in distortion between stereographic (conformal) and Lambert azimuthal equal-
area projections.
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Graticule Polar aspect

Meridians: Equally-spaced straight lines intersecting at the central pole. Angles between 
them are the true angles.

Parallels: Equally-spaced circles, centered at the pole, which is a point. The entire Earth 
can be shown, but the opposite pole is a bounding circle having a radius twice that of the 
equator.

Symmetry: About any meridian.

Equatorial aspect

Meridians: Central meridian is a straight line. Meridian 90° away is a circle. Other 
meridians are complex curves, equally-spaced along the equator and intersecting at each 
pole. 

Parallels: equator is a straight line. Other parallels are complex curves concave toward the 
nearest pole and equally-spaced along the central meridian and the meridian 90° from the 
central meridian.

Symmetry: About the central meridian or the equator.

Oblique aspect

Meridians: Central meridian is a straight line. Other meridians are complex curves 
intersecting at each pole.

Parallels: Complex curves equally-spaced along the central meridian.

Symmetry: About the central meridian.
Scale True along any straight line radiating from the center of projection. Increases in a direction 

perpendicular to the radius as the distance from the center increases.
Distortion Only the center is free from distortion. Distortion is moderate for one hemisphere, but 

becomes extreme for a map of the entire Earth.
Origin Possibly developed in the polar aspect by Egyptians for star charts. Used in China by the 

11th century for star charts. Several users during the 16th century.
Use Distance maps. Center the projection on the location from which distances are to be 

measured. 

Commonly used in the polar aspect for maps of polar regions, the northern and southern 
hemispheres, and the ‘aviation-age’ Earth. The oblique aspect is frequently used for world 
maps centered on important cities, and occasionally for maps of continents. The ellipsoidal 
form is used for topographic mapping of Micronesia and Guam.
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azimuthal equidistant

azimuthal extruded globe [extruded globe]

Parameters Radius of 85° parallel (any scale, any units)

Radius of 80° parallel (same scale & units as 85°)

Radius of 75° parallel (same scale & units as 85°)

Radius of 70° parallel (same scale & units as 85°)

Radius of 65° parallel (same scale & units as 85°)

Radius of 60° parallel (same scale & units as 85°)

Radius of 55° parallel (same scale & units as 85°)

Radius of 50° parallel (same scale & units as 85°)

Radius of 45° parallel (same scale & units as 85°)

Radius of 40° parallel (same scale & units as 85°)

Radius of 35° parallel (same scale & units as 85°)

Radius of 30° parallel (same scale & units as 85°)

Radius of 25° parallel (same scale & units as 85°)

Radius of 20° parallel (same scale & units as 85°)

Radius of 15° parallel (same scale & units as 85°)

Radius of 10° parallel (same scale & units as 85°)

Radius of 5° parallel (same scale & units as 85°)

Radius of equator (same scale & units as 85°)
Use For printing on flat plastic for extruding into a globe. This projection provides the inverse 

of the deformation caused by extruding, cancelling it out on the finished hemisphere. Set it 
up by measuring how the extrusion process deforms the plastic.
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azimuthal extruded globe
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Berghaus star

Description Equidistant, composite, modified azimuthal, interrupted. 5-point case of regular star.
Similar projections Peterman star (Germany, 1865) has eight unequal points, parallels are concentric circular 

arcs.

Jager star (Austria, 1865) has eight unequal points, parallels are in straight segments.

Azimuthal equidistant is the projection for the northern hemisphere for the Berghaus star.
Other features The northern hemisphere is a polar azimuthal equidistant projection. The southern 

hemisphere is divided into five equal triangular lobes.
Aspects Polar only.
Graticule Meridians: Straight lines, broken at the equator.

Parallels: Concentric circular arcs, north pole at the center.

Poles: Points.

Symmetry: Radial about the north pole.
Scale Correct along meridians in the northern hemisphere and along the central meridians of 

triangular points in the southern hemisphere.
Distortion Moderate throughout.
Origin Presented by Heinrich Berghaus (1797-1884) of Germany in 1879.
Use Largely for artistic map forms. Landforms do not readily fit into the lobes or arms of the 

star pattern. Used for the logo of the Association of American Geographers.

Berghaus star

Breusing geometric

Description Geometric mean of Lambert azimuthal equal-area and stereographic.
Use Historical.
Limitations Should not be used for more than about two-thirds of the globe.
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Breusing geometric

Breusing harmonic

Use Academic.
Parameters One parameter β which describes the small circle within which scale error is to be 

minimized.
Range -180° << β << 180°; β ≤ 0.
Usual None.

Breusing harmonic

Canters EU

Description Equal-area projection optimized for the European Union.
Use Equal-area maps of the European Union.
Parameters Enumeration describing the polynomial order.
Range First order, second order, third order, fifth order.
Usual Fifth order gives lowest distortion specific to the EU.
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Canters EU

Chamberlin trimetric

Description Modified azimuthal, modified equidistant, neither conformal nor equal-area.
Similar projections Azimuthal equidistant projection, true distance and direction from one point.

Two-point equidistant projection, true distance but not direction from two points.
Limitations Cannot show entire globe.
Parameters Three anchor points that describe an oval within which distortion is to be minimized. The 

exact relationship of the oval to the anchors has not been well studied.
Range The points should all be in the same hemisphere.
Graticule Meridians: Complex curves.

Parallels: Complex curves.

Poles: Points.

Symmetry: Normally none.
Scale Approximately correct from three selected widely-spaced points on the map to any point 

on the map. Cannot be exactly correct.
Distortion Low distortion throughout map if the anchors are properly placed near map limits.
Origin Presented by Wellman Chamberlin (1908-1976) of National Geographic Society in 1946.
Use Low-distortion maps of any region roughly oval in shape and of hemisphere or less size, 

such as North America or Africa. The three points should be chosen so that they enclose 
the region of interest.

Chamberlin trimetric
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Clarke twilight

Description Azimuthal, perspective, neither conformal nor equal-area.
Graticule See far-side perspective.
Scale True at the center. Scale varies away from the center.
Distortion Only the center is free of distortion. Distortion is severe near the outer limit of the 

projection, but moderate within a wide range of the center.
Use The Clarke twilight projection is a far-side perspective formulated by Alexander Ross Clarke 

(1828–1914) in 1879 to show the range of astronmical twilight. The point of projection is 
1.4 times the radius from the center, and the boundary is cut to 108° from center because 
astronomical twilight officially ends when the sun is 18° below the horizon, or 108° from 
zenith. The projection and some variants appeared in some British weather maps prior to 
1955.

Clarke twilight

Close—See two-point azimuthal
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Craig retroazimuthal

Description Retroazimuthal, modified azimuthal, neither conformal nor equal-area.
Synonyms Mecca
Similar projections Hammer retroazimuthal has curved, unequally-spaced meridians.

Hans Maurer of Germany in 1919 and J.E. Jackson of England in 1968 devised 
retroazimuthal projections characterized by straight, parallel, unequally-spaced meridians. 

Carl Schoy presented a projection in 1913 having meridians that are straight, equidistant, 
and parallel, but the parallels are curved so that all great circles passing through the central 
point are straight lines at their true azimuths from center. It is not retroazimuthal, nor is its 
distortion only a function of distance from the center, unlike most azimuthal projections.

Other features The direction is correct from any location on the map to a central point. Considerable 
overlapping when the entire sphere is shown.

Limitations Should not be used for more than half a hemisphere.
Parameters One parameter φ0 that describes the latitude of the central point to which all directions will 

be measured.
Range -90° << φ0 << 90°.
Special properties In equatorial aspect, the direction from any point of interest to the central point can be 

measured as the angle formed by the meridian of the point of interest and a line connecting 
the two points.

Graticule Meridians: Equally-spaced, straight parallel lines.

Parallels: Curved.

Poles: Curved lines.

Symmetry: About the central meridian.
Distortion Extreme distortion of shape and area.
Origin Presented by James Ireland Craig (1868-1952) of the Survey of Egypt in 1909.
Use To show, for example, the correct direction toward Mecca, from any point on the map, by 

measuring the angle from north. As the meridians are straight parallel lines, this angle can 
be readily measured.

Use the Boundaries command to select the region of interest. Using the Projection Center 
command set the projection center to the meridian of the central point and the equator 
(not the parallel of the central point). Use the Parameters command to set φ0 to the 
latitude of the central point to which all directions will be correct.
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Craig retroazimuthal 

doubly azimuthal—See two-point azimthal

doubly equidistant—See two-point equidistant

equidistant—See azimuthal equidistant

extruded globe—See azimuthal extruded globe

far-side perspective

Description Azimuthal, perspective, neither conformal nor equal-area (except in stereographic form, 
which is conformal). It is the same as the vertical perspective, but slightly reformulated to 
represent the height as multiples of the radius originating at the center of the sphere, and 
moving toward the far side. The vertical perspective, on the other hand, accepts the height 
from the surface, with positive moving toward the near side.

Limiting forms Gnomonic projection, if the point of perspective is at the center of the earth.

Stereographic projection if the point of perspective is on the surface of the earth opposite 
the center of projection (perspective point = 1).

Orthographic projection if the point of perspective is at infinity.

In turn, the far-side perspective is a limiting form of the tilted perspective projection.
Specializations In 1701, Philippe de la Hire of France suggested a point of projection at 1.7071 times the 

radius. This distance is measured from the center in a direction away from the surface of 
projection and gives the equator of the polar aspect twice the radius of 45° latitude.

Antoine Parent in 1702, Ernst Hammer about 1890, H.F. Gretschel in 1873, and 
Hans Maurer in 1935 were among others proposing points of projection for low-error 
perspectives.

A.R. Clarke and Henry James, in 1862 and later, calculated points of projection (on the far 
side, below the surface of projection) for minimum-error perspective azimuthal projections 
of regions, such as continents, bounded by a given great or small circle on the earth.

The Army Map Service AMS Lunar projection is a far-side perspective selected by Albert 
L. Nowicki in 1963 to show slightly more than a hemisphere of the Moon, as seen over a 
period of time from the earth. The point of projection is 1.53748 times the radius from the 
center. See also the Airy non-perspective azimuthal projection.
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Special properties The far-side perspective projection shows the sphere geometrically as it appears from any 
point above or below the surface when it is projected onto a tangent or secant plane 
perpendicular to the straight line connecting the point of perspective with the center of the 
earth.

Parameters One parameter v, the distance from center of sphere in multiples of the radius, with 
positive values directed toward the far side of the surface. A value less than -1 indicates a 
near-side perspective above the surface.

Range 1 << v < ∞; v << 0 or v >> 0.
Usual 1 << v < 2.
Graticule Polar aspect

Meridians: Equally-spaced straight lines intersecting at the central pole. Angles between 
them are the true angles.

Parallels: Unequally-spaced circles centered at the pole, which is a point. If v < -1, the 
spacing of parallels decreases away from the pole, and the equator cannot be shown. 
Otherwise, the spacing may increase or decrease away from the pole, and part of the 
opposite hemisphere can be shown.

Symmetry: About any meridian.

Equatorial aspect

Meridians: Central meridian is a straight line. Other meridians are generally unequally-
spaced elliptical arcs intersecting at the poles (which may not be visible).

Parallels: equator is a straight line. Other parallels are usually elliptical arcs. If point of 
perspective is beneath the surface, the parallels can be elliptical, parabolic, or hyperbolic 
arcs.

Symmetry: About the central meridian or the equator.

Oblique aspect

Meridians: Central meridian is a straight line. Other meridians are generally unequally-
spaced elliptical arcs intersecting at each pole.

Parallels: Generally elliptical arcs.

Symmetry: About the central meridian.
Scale True at the center, if the projection is onto a tangent plane. Scale varies away from the 

center, depending on the point of perspective.
Distortion Only the center is free of distortion, if projection is onto a tangent plane. Distortion 

is severe near the outer limit of the projection, although v > 1 can result in moderate 
distortion within a wide range of the center.

Origin Aside from the earlier limiting forms listed above, the projection was studied in the 18th 
and 19th centuries as a source of low-distortion projections having geometric construction.

Use Stylized perspective views, generally of regions greater than a hemisphere.
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far-side perspective

fisheye

Description The center of the map can be emphasized or de-emphasized by proportionally increasing 
or decreasing its scale. The region of magnification steeply drops off until there is no 
magnification at the edge of the map, and the extent of the region of magnification can be 
controlled.

Use Maps required to show the whole earth but emphasizing some portion of it. 
Parameters A scale factor β for the center of the map, and the range of the magnification µ.

Central magnification: 0 << β << ∞, spread (integer) 0 ≤ µ << ∞
Range β 0 << β < ∞. When β < 1.0, the center is de-emphasized; when β > 1.0, center is 

emphasized. When β = 1.0, the azimuthal equidistant results.
Usual β About 2 < β < 10.0.
Range µ An integer µ ≤ 0. The greater µ’s value, the smaller the region of magnification. Very high 

values can localize the region of magnification to tiny areas, but such values require more 
computation time.

Usual µ None.

fisheye
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Fischer far-side perspective

Description Azimuthal, perspective, neither conformal nor equal-area (except in stereographic form).
Graticule See far-side perspective.
Scale True at the center. Scale varies away from the center.
Distortion Only the center is free of distortion. Distortion is severe near the outer limit of the 

projection, but moderate within a wide range of the center.
Use Proposed by Philipp Fischer (1818–1887) around 1850. It is a far-side perspective  with 

a radius of perspective chosen as 2/(π-2) ≈ 1.7519, so that the bounding circle of a 
hemispheric map would be placed at its true distance form the center.

Fischer far-side perspective
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gnomonic

Description Azimuthal, perspective, neither equal-area nor conformal.
Synonyms central
Similar projections Two-point azimuthal projection is a gnomonic projection that has been compressed in one 

direction.
Special properties All great-circles (including all meridians and the equator) are shown as straight lines. 

Therefore, the path of the shortest distance between any two points on the map is a straight 
line.

Perspective projection from the center of the globe onto a plane tangent at the central point 
of projection.

Less than a hemisphere can be shown on a map.
Graticule Polar aspect

Meridians: Equally-spaced straight lines intersecting at the central pole. Angles between 
them are the true angles.

Parallels: Unequally-spaced circles centered at the pole, which is a point. The equator and 
the opposite hemisphere cannot be shown. Spacing increases rapidly away from the pole.

Symmetry: About any meridian.

Equatorial aspect

Meridians: Unequally-spaced, straight parallel lines. Only meridians within 90° of the 
central meridian can be shown. Spacing increases away from the central meridian.

Parallels: equator is a straight line perpendicular to the meridians. Other parallels are 
hyperbolic arcs concave toward the nearest pole. Spacing increases rapidly away from the 
equator. Poles cannot be shown.

Symmetry: About the central meridian or the equator.

Oblique aspect

Meridians: Unequally-spaced straight lines intersecting at the pole nearest the center of the 
projection.

Parallels: equator is a straight line perpendicular to the central meridian. If the central 
parallel is a north latitude, its co-latitude (90° minus the central latitude) is shown as 
a parabolic arc, more northern parallels are ellipses, and more southern parallels are 
hyperbolas, all concave toward the nearest pole. If the central parallel is a south latitude, 
opposite signs apply.

Symmetry: About the central meridian.
Range Less than one hemisphere centered on a given pole of projection or map origin.
Scale True only where the central parallel crosses the central meridian. Increase rapidly with the 

distance from the center.
Distortion Only the center is free from distortion. Distortion increases rapidly away from the center.
Origin Possibly developed by Thales (c. 580 BC) of Greece. Name derived from the gnomon of a 

sundial, since meridians radiate like the hour markings on a sundial.
Use To show great-circle paths as straight lines and thus to assist navigators and aviators 

in determining appropriate courses. Too much distortion of many kinds for regular 
geographic maps. Used in the past for some star maps and for world globes in the shapes of 
polyhedra.
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gnomonic

Gretschel

Description Azimuthal, perspective, neither conformal nor equal-area (except in stereographic form).
Graticule See far-side perspective.
Scale True at the center. Scale varies away from the center.
Distortion Only the center is free of distortion. Distortion is severe near the outer limit of the 

projection, but moderate within a wide range of the center.
Use Proposed by Heinrich Friedrich Gretschel (1830–1892) in 1873. It is a far-side perspective 

with a radius of perspective chosen as ½ (1 + √5) ≈ 1.6180.

Gretschel
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Hammer retroazimuthal back hemisphere

Description Retroazimuthal, modified azimuthal, neither conformal nor equal-area.

This is the back hemisphere of the complete Hammer retroazimuthal, which would 
otherwise overlap itself.

Similar projections Craig retroazimuthal has straight, equally-spaced meridians.
Other features The direction from any point to the center of the map is the angle that a straight line 

connecting the two points makes with a vertical line. This feature is the basis of the term 
‘retroazimuthal’. Scimitar-shaped boundary. Considerable overlapping when the entire 
sphere is shown.

Parameters Latitude of origin.
Graticule Meridians: Central meridian is straight. Other meridians curved.

Parallels: Curved.

Poles: Curved lines.

Symmetry: About the central meridian.
Distortion Extreme distortion of area and shape.
Origin Presented by H.H. Ernst von Hammer (1858-1925) of Germany in 1910. Independently 

presented by Edward A. Reeves (1862-1945) and Arthur R. Hinks (1874-1945) of England 
in 1929.

Use To determine the direction of a central point from a given location.

Hammer retroazimuthal back hemisphere

Hammer retroazimuthal front hemisphere

Description Is the front hemisphere of the complete Hammer retroazimuthal, which would otherwise 
overlap itself. See Hammer retroazimuthal back hemisphere for complete description.
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Hammer retroazimuthal front hemisphere

Immler—See two-point azimuthal

isoperimetric—See isoperimetric azimuthal

isoperimetric azimuthal [isoperimetric]

Description Scale is correct along all parallels and along all meridians. 
Similar projections Wiechel is the same geometry applied to the entire sphere instead of hemisphere; hence the 

spiral of the meridians is half as tight in Wiechel.

Isoperimetric cordiform is another projection on which scale is correct along both parallels 
and meridians.

Origin Presented by Leszek Pernarowski, 1970.

isoperimetric azimuthal
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James far-side perspective

Description Azimuthal, perspective, neither conformal nor equal-area (except in stereographic form).
Parameters One enumeration to select either the original James perspective radius (= 1.5) or Clarke’s 

corrected radius (= 1.368).
Graticule See far-side perspective.
Scale True at the center. Scale varies away from the center.
Distortion Only the center is free of distortion. Distortion is severe near the outer limit of the 

projection, but moderate within a wide range of the center.
Use The James far-side perspective projection is a far-side perspective formulated by Henry James 

(1803–1877) in 1857 to lower distortion of the ⅔ of surface area showing in the map, 
which he limited to a range of 113°30′. (Actual area is 0.699, not the ⅔ he quoted.) He 
chose 1.5 times the radius from the center as the point of perspective, but his colleague 
A.R. Clarke later showed 1.368 to be better. James published maps on his projection, 
generally centered on 23°30′N, 15°E to show most continents except Australia and parts of 
Antarctica.

James far-side perspective
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Lambert azimuthal equal-area [Lambert equal-area]

Description Azimuthal, equal-area, non-perspective.
Synonyms Lorgna (for polar aspect, due to independent derivation, 1789)

zenithal equal-area 
zenithal equivalent

Similar projections W. William-Olsson’s projection combines the Lambert azimuthal equal-area with a 
modified Werner.

Range Entire Earth.
Graticule Polar aspect

Meridians: Equally-spaced straight lines intersecting at the central pole. Angles between 
them are the true angles.

Parallels: Unequally-spaced circles centered at the pole, which is a point. Spacing of the 
circles gradually decreases away from the pole. The entire Earth can be shown, but the 
opposite pole is a bounding circle having a radius 1.41 time that of the equator.

Symmetry: About any meridian.

Equatorial aspect

Meridians: Central meridian is a straight line. Meridian 90° away is a circle. Other 
meridians are complex curves, unequally-spaced along the equator and intersecting each 
pole. Spacing decreases away from the central meridian.

Parallels: equator is a straight line. Other parallels are complex curves concave toward the 
nearest pole. They are unequally-spaced along the central meridian, and spacing decreases 
away from the equator. Along the meridian 90° from the central meridian, parallels are 
equally-spaced.

Symmetry: About the central meridian or the equator.

Oblique aspect

Meridians: Central meridian is a straight line. Other meridians are complex curves 
intersecting at each pole shown.

Parallels: Complex curves unequally-spaced along the central meridian, spacing decreases 
away from the center of projection.

Symmetry: About the central meridian.
Scale True only at the center in all directions. Decreases with distance from the center along 

radii. Increases with distance from the center in a direction perpendicular to radii.
Distortion Only the center is free from distortion. Distortion is moderate for one hemisphere but 

becomes extreme for a map of the entire Earth.
Origin Presented by Johann Heinrich Lambert (1728-1777) of Alsace in 1772.
Use Frequently used in the polar aspect in atlases for maps of polar regions and of northern 

and southern hemispheres. The equatorial aspect is commonly used for atlas maps of the 
eastern and western hemispheres. The oblique aspect is used for atlas maps of continents 
and oceans. The equatorial and oblique aspects are used by the US Geological Survey in 
cooperation with others for maps of the Circum-Pacific Map Project. 

Recommended for equal-area maps of regions approximately circular in extent. 
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Lambert azimuthal equal-area

Lambert equal-area—See Lambert azimuthal equal-area

Littrow

Description Retroazimuthal, conformal.
Similar projections Littrow projection is the transverse aspect of a Lagrange projection having certain 

parameters.
Special properties In equatorial aspect, the direction from any point of interest to any point on the central 

meridian can be measured as the angle formed by a vertical line at the point of interest and 
a line connecting the two points.

Other features Cannot show the entire sphere. Shows the correct direction from any point on the map to 
any point along the central meridian as the angle between a straight line connecting the 
two points and a vertical straight line parallel to the central meridian.

Graticule Meridians: Central meridian and meridians 90° away are straight. Other are hyperbolas 
convex toward the central meridian.

Parallels: equator is straight. Other parallels are ellipses, the equator lies along their major 
axes.

Poles: Not shown.

Symmetry: About the central meridian and the equator.
Scale Varies rapidly.
Distortion Extreme distortion of area.
Origin Presented by J.J. Littrow of Austria in 1833.
Use Maps showing the correct direction from anywhere to a particular place, such as Mecca. 

Used by the British Navy in the 19th century to determine directions to a central point 
from other locations.

Using the Boundaries command select the region of interest. 

Using the Projection Center command set the projection center to the desired meridian 
and the equator.
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Littrow 

Lorgna—See Lambert azimuthal equal-area

Lowry

Description Azimuthal, perspective, neither conformal nor equal-area (except in stereographic form).
Graticule See far-side perspective.
Scale True at the center. Scale varies away from the center.
Distortion Only the center is free of distortion. Distortion is severe near the outer limit of the 

projection, but moderate within a wide range of the center.
Use Proposed by John Lowry in 1825. It is a far-side perspective with a radius of perspective 

chosen as 1.6858, which is the geometric mean of the eighteen values of the perspective 
radius required at each 5° increment of latitude from 0° to 85° to place the parallel at its 
true proportionate distance from the north pole.

Lowry

McCaw—See two-point azimuthal

Mecca—See Craig retroazimuthal
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Miller oblated stereographic [oblated stereographic]

Description Modified azimuthal, conformal.
Synonyms Miller prolated stereographic 

oblated stereographic 
prolated stereographic

Similar projections Stereographic projection has lines of constant scale that are concentric circles.
Limitations Should not be used for more than a hemisphere.
Parameters Two parameters β1 and β2 to describe the ellipse that circumscribes the area of interest; β1 is 

the east-west arc distance of the ellipse and β2 is the north-south.
Range -180° << β1, β2 << 180°. Negative values are the same as positive.
Graticule Meridians: Complex curves.

Parallels: Complex curves.

Poles: Points.

Symmetry: About the central meridian as applied to the map of Europe and Africa.
Scale A line of constant scale bounds an oval region.
Distortion Scale variations within the oval-shaped region covered are less than variation on standard 

conformal projections, such as an oblique Mercator or oblique stereographic projection.
Origin Osborn Maitland Miller (1897-1979) of the American Geographical Society in 1953.
Use Used for oval regions to minimize the scale distortions in the region. 

Applied by O.M. Miller to Africa and Europe in 1953, and to other eastern hemisphere 
regions in conjunction with several non-conformal fill-in projections in 1955. 

Used by L.P. Lee for the Pacific Ocean in 1974.

Maps of oval regions smaller than a hemisphere when shape is more important than 
area. Center the projection in the region of interest. Choose an ellipse on the globe that 
completely surrounds the region of interest. Set β1 to the east-west arc distance in degrees 
of the oval, and set β2 to the north-south arc distance in degrees.

Miller oblated stereographic
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oblated stereographic—See Miller oblated stereographic

orthodromic—See two-point azimthal

orthographic

Description Azimuthal, perspective, neither conformal nor equal-area.
Similar projections Vertical perspective, when projected from more than a few thousand kilometers above Earth.
Special properties Perspective projection of the globe onto a tangent plane from an infinite distance (that is, 

orthogonally); thus the map has a look of a globe. All great or small circles (including all 
meridians and parallels) are shown as elliptical arcs or straight lines.

Range No more than one hemisphere at a time.
Graticule Polar aspect

Meridians: Equally-spaced straight lines intersecting at the central pole. Angles between 
them are the true angles.

Parallels: Unequally-spaced circles centered at the pole, which is a point. Spacing decreases 
away from the pole.

Symmetry: About any meridian.

Equatorial aspect

Meridians: Central meridian is a straight line. Outer meridians 90° away are circles. Other 
meridians are unequally-spaced elliptical arcs intersecting at each pole and concave toward 
the central meridian. Spacing decreases away from the central meridian.

Parallels: Unequally-spaced, straight parallel lines perpendicular to the central meridian. 
Spacing decreases away from the equator. Parallels intersect the outer meridian, however, at 
equal intervals.

Symmetry: About the central meridian or the equator.

Oblique aspect

Meridians: Central meridian is a straight line. Other meridians are semi-ellipses intersecting 
at each pole. Spacing decreases away from the central meridian.

Parallels: Complete or partial ellipses, all of the same shape (or eccentricity); their minor 
axes lie along the central meridian. Spacing decreases away from the center of projection.

Symmetry: About the central meridian.
Scale True at the center and along any circle having its center at the projection center, but only in 

the direction of the circumference of the circle. Scale decreases radially with distance from 
the center.

Distortion Only the center is free of distortion, which increases rapidly away from the center. Extreme 
distortion near the edge of the hemisphere.

Origin Apparently developed by Egyptians and Greeks by the 2nd century BC.
Use Hemispheric maps showing the earth as it is seen from space.
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orthographic

Postel—See azimuthal equidistant

quasiazimuthal equal-area apple [apple]

Description Equal-area.
Special properties Quasiazimuthal: the great-cricles emanating from the center follow straight-line paths, but 

the angles between them are not constant.
Use Decorative. Note: Use of this projection is restricted. See Your Rights for details.
Origin Developed by Daniel “daan” Strebe in 1993.

quasiazimuthal equal-area apple
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regular star

Description Equidistant, composite, modified azimuthal, interrupted.
Similar projections Berghaus star is the five-point case.

Peterman star (Germany, 1865) has eight unequal points, parallels are concentric circular 
arcs.

Jager star (Austria, 1865) has eight unequal points, parallels are in straight segments.

Azimuthal equidistant is the projection for the northern hemisphere for the Berghaus star.
Other features The northern hemisphere is a polar azimuthal equidistant projection. The southern 

hemisphere is divided into equal triangular lobes.
Parameters One parameter n to specify the number of points. 3 ≤ n ≤ 18.
Aspects Polar only.
Graticule Meridians: Straight lines, broken at the equator.

Parallels: Concentric circular arcs, north pole at the center.

Poles: Points.

Symmetry: Radial about the north pole.
Scale Correct along meridians in the northern hemisphere and along the central meridians of 

triangular points in the southern hemisphere.
Distortion Moderate throughout.
Use Largely for artistic map forms.

regular star

retroazimuthal: Craig retroazimuthal—See Craig retroazimuthal

retroazimuthal: Hammer back hemisphere—See Hammer retroazimuthal back hemisphere

retroazimuthal: Hammer front hemisphere—See Hammer retroazimuthal front hemisphere

retroazimuthal: Littrow—See Littrow
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retroazimuthal: Mecca—See Craig retroazimuthal

stereographic

Description Azimuthal, conformal, perspective, polyconic (general).
Special properties All great or small circles (including all meridians and parallels) on the globe are shown as 

circular arcs or straight lines. Perspective projection of the globe onto a tangent (or secant) 
plane from a point on the surface just opposite the point of tangency or the projection 
center. The straight parallel of latitude passes through this point.

Range One hemisphere conveniently, most, but not all, of the other hemisphere at accelerating 
scale.

Graticule Polar aspect

Meridians: Equally-spaced straight lines intersecting at central pole. Angles between them 
are the true angles.

Parallels: Unequally-spaced circles centered at the pole, which is a point. Opposite pole 
cannot be shown. Spacing gradually increases away from the pole.

Symmetry: About any meridian.

Equatorial aspect

Meridians: Central meridian is a straight line. Other meridians are unequally-spaced 
circular arcs intersecting at each pole. Spacing gradually increases away from the central 
meridian.

Parallels: equator is a straight line. Other parallels are unequally-spaced circular arcs 
concave toward the nearest pole. Spacing gradually increases away from the equator 
along the central meridian, but spacing is equal along the meridians 90° from the central 
meridian.

Symmetry: About the central meridian or the equator.

Oblique aspect

Meridians: Central meridian is a straight line. Other meridians are circular arcs intersecting 
at each pole and having their centers on the straight parallel opposite in sign to the central 
latitude. Spacing gradually increases away from the central meridian.

Parallels: The parallel opposite in sign to the central latitude is a straight line perpendicular 
to the central meridian. All other parallels are circular arcs concave toward the pole on the 
same side of the straight parallel.

Symmetry: About the central meridian.
Scale True only where the central latitude crosses the central meridian, or alternatively, along 

a circle concentric about the projection center (or a parallel on the polar aspect). Scale 
is constant along any circle having its center at the projection center, but scale increases 
moderately with distance from the center within a hemisphere.

Distortion Only the center or the circle of true scale (if not the center) is free from all distortion.
Origin Apparently developed in polar aspect by Egyptians and Greeks in the 2nd century BC.
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Use Conformal maps of regions approximately circular in shape. Also, radio transmission 
and other ranges on a sphere that have circular boundaries will map to circles on this 
projection. 

Commonly used in the polar aspect for topographic maps of polar regions. 

The equatorial aspect was used regularly for maps of the eastern and western hemispheres 
in the 17th and 18th centuries. 

Oblique aspects are used to show paths of solar eclipses. 

Recommended for conformal mapping of regions approximately circular in shape. Basis 
of modified Stereographic conformal projections using complex algebra, such as the Miller 
oblated stereographic.

Use the Boundaries command to select the region of interest. 

Use Stretch and Rotation to decrease both the width and height of the map by equal 
amounts to minimize the scale error measurement. 

stereographic
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tilted perspective

Description Modified azimuthal, perspective, neither conformal nor equal-area.
Limiting forms Vertical perspective projection.

Orthographic projection, if the point of perspective is at infinite distance.
Special properties Projection shows the earth geometrically as it appears when photographed or otherwise 

imaged onto a plane from any point in space with any pointing of the ‘camera’.
Limitations At maximum can show less than one hemisphere.
Parameters Three parameters:

•	 λ1 that describes the meridian which is tilted enough to intersect the top of the 
map at its center.

•	 d which is the distance of the view from the surface of the earth, in kilometers.

•	 ψ which is the number of degrees that the view is tilted from vertical.
Range λ1 Depends on d. λ1 must be visible.
Usual λ1 None.
Range d 0 << d < ∞.
Usual d None.
Range ψ Depends on d. As d approaches ∞, ψ may approach 90°. The higher ψ’s value, the more 

vertically oblong the projection becomes. ψ of 0° and λ1 of 0° results in vertical perspective.
Usual φ None.
Graticule Meridians: Central meridian is straight, the point of perspective is in its plant, but this 

meridian may not appear on the map. Other meridians are normally elliptical arcs, but for 
certain angles of tilt or centers, they may be straight lines, parabolas, or hyperbolas.

Parallels: One parallel, normally nearer to the pole than is the center of projection 
(depending on the position of the point of perspective), is a straight line. Other parallels 
are normally elliptical arcs, but for certain angles of tilt, may be parabolas or hyperbolas.

Poles: Points.

Symmetry: Normally none, but there is symmetry about the central meridian if the 
direction of view is north or south.

Scale Normally varies widely if a large area is covered.
Distortion Substantial distortion of shape, area and scale if a large area is covered.
Origin Developed primarily during the 20th century to relate to aerial and space photography and 

photogrammetry.
Use Pictorial views of the earth, resembling those seen from space.
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tilted perspective
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two-point azimuthal

Description Modified azimuthal, neither conformal nor equal-area.
Synonyms Close 

McCaw 
Immler 
doubly azimuthal 
orthodromic

Similar projections Gnomonic, which can be compressed to produce the two-point azimuthal projection.
Other features Great circles are shown as straight lines. This projection can be obtained by compressing a 

gnomonic projection in the direction parallel to the line joining the two central points.
Parameters Two “anchor points” from which all directions are correct.
Aspects Typically oblique.
Limiting forms If the two central points are identical, the gnomonic projection results.
Graticule Meridians: Straight lines.

Parallels: equator is straight. Other parallels are ellipses, parabolas, or hyperbolas.

Poles: Points (if shown).

Symmetry: Generally none.
Scale Varies considerably. Projection should not be used for measuring distance.
Distortion Direction is correct to all other points from two central points at which there is no 

distortion.
Origin Presented by Hans Maurer (1868-1945) of Germany in 1914 and Charles F. Close (1865-

1952) of England independently in 1922.
Use Could be used to located a ship at sea, for example, if the exact location of two radio 

transmitters and the direction from the ship to the transmitters are known.

two-point azimuthal
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two-point equidistant

Description Modified azimuthal, neither conformal nor equal-area.
Synonyms doubly equidistant
Similar projections Azimuthal equidistant, on which distance is correct from only one point.

Donald elliptical, developed by Jay K. Donald of the American Telephone and Telegraph 
Company in 1956. Used by telephone companies to establish long-distance rates, the 
Donald is a Two-point equidistant projection specially modified for the ellipsoid and 
confined to the United States and southern Canada.

Chamberlin trimetric, an approximate three-point equidistant projection.

Two-point azimuthal equidistant, presented by Charles F. Close in 1922, has true azimuths 
from one point and true distances from a second point to all other points.

Limiting forms If the two central points are identical, the azimuthal equidistant projection results.

Parameters Two “anchor points” from which all distances are correct.
Aspects Typically oblique.
Graticule Meridians: Complex curves.

Parallels: Complex curves.

Poles: Normally points.

Symmetry: Normally none.
Scale True along a straight line from either of two central points.
Distortion No point is free of distortion.
Origin Presented by Hans Maurer (1868-1945) of Germany in 1919, and Charles F. Close (1865-

1952) of England independently in 1921.
Use Map of Asia by the National Geographic Society.

Could be used to determine the distance of a ship at sea at a known location from the start 
and end of a voyage.

two-point equidistant
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vertical perspective

Description Azimuthal, perspective, neither conformal nor equal-area (except in stereographic form, 
which is conformal).

Limiting forms Gnomonic projection, if the point of perspective is at the center of the earth.

Stereographic projection if the point of perspective is on the surface of the earth opposite 
the center of projection.

Orthographic projection if the point of perspective is at infinity.

In turn, the vertical perspective is a limiting form of the tilted perspective projection.
Specializations In 1701, Philippe de la Hire of France suggested a point of projection at 1.7071 times the 

radius. This distance is measured from the center in a direction away from the surface of 
projection and gives the equator of the polar aspect twice the radius of 45° latitude.

Antoine Parent in 1702, Ernst Hammer about 1890, H.F. Gretschel in 1873, and 
Hans Maurer in 1935 were among others proposing points of projection for low-error 
perspectives.

A.R. Clarke and Henry James, in 1862 and later, calculated points of projection (on the far 
side, below the surface of projection) for minimum-error perspective azimuthal projections 
of regions, such as continents, bounded by a given great or small circle on the earth.

The Army Map Service AMS Lunar projection is a far-side perspective selected by Albert 
L. Nowicki in 1963 to show slightly more than a hemisphere of the Moon, as seen over a 
period of time from the earth. The point of projection is 1.53748 times the radius from the 
center. See also the Airy non-perspective azimuthal projection.

Special properties The vertical perspective projection shows the earth geometrically as it appears from any 
point above or below the surface when it is projected onto a tangent or secant plane 
perpendicular to the straight line connecting the point of perspective with the center of the 
earth.

Parameters One parameter d giving the altitude of the viewpoint in kilometers. Negative values give 
views from the interior of the earth.

Range -6400 << d < ∞; d << 0 or d >> 0.
Usual d >> 0.
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Graticule Polar aspect

Meridians: Equally-spaced straight lines intersecting at the central pole. Angles between 
them are the true angles.

Parallels: Unequally-spaced circles centered at the pole, which is a point. If the usually 
perspective from above the surface is projected, the spacing of parallels decreases away 
from the pole, and the equator cannot be shown. If point of perspective is beneath the 
surface, the spacing may increase or decrease away from the pole, and part of the opposite 
hemisphere can be shown.

Symmetry: About any meridian.

Equatorial aspect

Meridians: Central meridian is a straight line. Other meridians are generally unequally-
spaced elliptical arcs intersecting at the poles (which may not be visible).

Parallels: equator is a straight line. Other parallels are usually elliptical arcs. If point of 
perspective is beneath the surface, the parallels can be elliptical, parabolic, or hyperbolic 
arcs.

Symmetry: About the central meridian or the equator.

Oblique aspect

Meridians: Central meridian is a straight line. Other meridians are generally unequally-
spaced elliptical arcs intersecting at each pole.

Parallels: One parallel, normally nearer the pole than is the center of projection, depending 
on the position of the point of perspective, is a straight line. Other parallels are normally 
elliptical arcs.

Symmetry: About the central meridian.
Scale True at the center, if the projection is onto a tangent plane. Scale varies away from the 

center, depending on the point of perspective.
Distortion Only the center is free of distortion, if projection is onto a tangent plane. Distortion is 

severe near the outer limit of the projection, although special locations for the points of 
projection on the opposite side of the earth’s center result in moderate distortion within a 
wide range of the center.

Origin Aside from the earlier limiting forms listed above, the perspective projection from a point on 
the opposite side of the earth’s center was studied in the 18th and 19th centuries as a source 
of low-distortion projections having geometric construction.

Use Pictorial views of the earth, resembling those seen from space.

Maps showing regions of the earth smaller than a hemisphere as they appear from high 
altitudes. The smaller the region to be viewed, the lower the value that d should take. As d 
approaches ∞, the projection approaches orthographic.
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Vertical perspective

Wiechel

Description Modified azimuthal, pseudoazimuthal, equal-area.
Similar projections Lambert azimuthal equal-area projection has the same spacing of parallels in the polar 

aspect, but the meridians are straight.

Ginzburg III is a general series of pseudoazimuthal projections developed by C.A. Ginzburg 
of the Soviet Union in 1952. The lines of constant distortion are ovals rather than the 
usual circles of azimuthal projections. This feature is achieved by the manner in which the 
lines of constant initial azimuth are curved. The projection series has been used only in the 
oblique or equatorial aspect.

Isoperimetric azimuthal has the same amount of twist applied to just one hemisphere.
Aspects Generally only polar.
Graticule Polar aspect

Meridians: Semicircles if extended to a world map.

Parallels: Concentric circles.

Poles: Central pole is a point, other pole is a circle.

Symmetry: Radial about the central pole.
Scale Correct along meridians.
Distortion Considerable distortion of shape at the map edge.
Origin Presented by H. Wiechel in 1879.
Use A novelty map that in its polar aspect, has semicircular meridians arranged in a pinwheel.
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Wiechel

zenithal equal-area—See Lambert azimuthal equal-area

zenithal equidistant—See azimuthal equidistant

zenithal equivalent—See Lambert azimuthal equal-area
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 Lenticular projections

Aitoff

Description Modified azimuthal, neither conformal nor equal-area.
Similar projections Hammer (elliptical) equal-area mistakenly called Aitoff in the early 20th century.

Briesemeister, an oblique modification of the Hammer.

Eckert-Greifendorff, a modification of the Lambert azimuthal equal-area projection inspired 
by the Hammer.

Winkel tripel is a combination of the Aitoff and equidistant cylindric projections.
Other features Elliptical border. An equatorial aspect of one hemisphere of the azimuthal equidistant 

projection, on which horizontal coordinates have been doubled and meridians have been 
given twice their original latitudes.

Graticule Meridians: Central meridian is a straight line half the length of the equator. Other 
meridians are complex curves, equally-spaced along the equator and concave toward the 
central meridian.

Parallels: equator is straight. Other parallels are complex curves, equally-spaced along the 
central meridian and concave toward the nearest pole. 

Poles: Points.

Symmetry: About the equator and central meridian.
Scale True along the equator and central meridian.
Distortion Moderate shape and area distortion.
Origin David Aitoff (or Aitow) (1854-1933) in 1889.
Use Design inspired H.H. Ernst von Hammer to develop his elliptical projection.

Aitoff
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Aitoff-Wagner

Use Reference world maps.

Aitoff-Wagner

Briesemeister

Description Modified azimuthal, equal-area.
Similar projections Hammer, the equatorial aspect of the Briesemeister, but having an axis ratio of 2:1.

Nordic, by John Bartholomew, is the same as the Briesemeister projection, except that the 
axis ratio is 2:1 and the central meridian is 0°.

Other features An oblique Hammer projection centered at latitude 45°N and longitude 10° E and 
bounded by an ellipse having an axis ratio of 1.75:1 instead of 2:1, after the vertical 
coordinates are expanded and the horizontal coordinates are contracted.

Graticule Meridians: Central meridian is straight. Other meridians are complex curves.

Parallels: Complex curves.

Poles: Points.

Symmetry: About the central meridian.
Scale True scale at latitudes 3.6° and 86.4°N at central meridian.
Distortion None at latitudes 3.6° and 86.4°N at central meridian.
Use Whole-world maps showing continents grouped near the center.

Breisemiester

cartouche—See Strebe-sinusoidal

Dietrich-Kitada

Description Equal-area. Meridians are circular arcs in equatorial case.
Use Thematic world maps.
Origin Map appears in Bruno Dietrich’s 1927 text. Formulæ published by Kōzō Kitada, 1958.
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Dietrich-Kitada

Eckert-Greifendorff

Description Modified azimuthal, equal-area.
Similar projections Hammer, a different modification of the Lambert azimuthal equal-area projection.

Quartic authalic has straight parallels.
Other features An equatorial aspect of the Lambert azimuthal equal-area projection for 90° of longitude, 

on which the horizontal coordinates have been quadrupled and the meridians have been 
given four times their original longitudes.

Graticule Meridians: Central meridian is a straight line 0.46 of the length of the equator. Other 
meridians are curved, unequally-spaced along the equator and concave toward the central 
meridian.

Parallels: equator is straight. Other parallels are curved, unequally-spaced along the central 
meridian and concave toward the nearest pole.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale Decreases steadily along the equator and the central meridian with distance from the center 

of the projection.
Distortion Moderate near center, but considerable shape distortion near outer meridians.
Origin Max Eckert-Greifendorff (formerly Max Eckert) (1868-1938) of Germany in 1935.
Use Whole-world map.

Eckert-Greifendorff

Gott elliptical—See Gott elliptical equal-area
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Gott elliptical equal-area [Gott elliptical]

Description Equal-area.
Use Thematic world maps.
Origin Presented by J. Richard Gott, III, Charles Mugnolo, and Wesley N. Colley in 2006.

Gott elliptical equal-area

Gott-Mugnolo elliptical—See Gott-Mugnolo elliptical equal-area

Gott-Mugnolo elliptical equal-area [Gott-Mugnolo elliptical]

Description Equal-area.
Use Thematic world maps.
Origin Presented by J. Richard Gott, III, Charles Mugnolo, and Wesley N. Colley in 2006.

Gott-Mugnolo elliptical equal-area
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Hammer

Description Modified azimuthal, equal-area.
Synonyms Hammer-Aitoff

Mistakenly called Aitoff projection in the early 20th century.
Similar projections Briesemeister, a modified oblique Hammer. Eckert-Greiffendorf, with parameter w = 0.25.
Other features Elliptical border. An equatorial aspect of one hemisphere of the Lambert azimuthal equal-

area projection, on which horizontal coordinates have been doubled and meridians have 
been given twice their original longitudes.

Parameters Parallel curvature W, with Hammer describing the case of W = 0.5. 0 << W ≤ 0.5.
Aspects Equatorial and oblique are both in use.
Graticule Meridians: Central meridian is a straight line half the length of the equator. Other 

meridians are complex curves, unequally-spaced along the equator and concave toward the 
central meridian.

Parallels: equator is straight. Other parallels are complex curves, unequally-spaced along the 
central meridian and concave toward the nearest pole.

Poles: Points.

Symmetry: About the central meridian and the equator.
Scale Decreases along the central meridian and the equator with distance from the center.
Distortion Moderate. Less shearing action on the outer meridians near the poles than there is on 

pseudocylindric projections.
Origin Presented by H.H. Ernst von Hammer 91858-1925) of Germany in 1892.
Use Reference world maps where poles need to be shown as points. Also in interrupted and 

condensed forms.

Hammer

Hammer-Aitoff—See Hammer

Strebe—See Strebe 1995 

Strebe 1995

Synonyms Strebe
Description Equal-area.
Parameters Fitting factor γ, determining the amount of curvature.
Range 0.963 ≤ γ ≤ 2.0
Usual γ = 1.35
Origin Daniel “daan” Strebe, presented at NACIS 1995.
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Strebe 1995

Strebe equal-areas: cartouche—See Strebe-sinusoidal

Strebe equal-areas: Hammer—See Strebe-Hammer

Strebe equal-areas: Kavrayskiy V—See Strebe-Kavrayskiy V

Strebe equal-areas: Mollweide—See Strebe-Mollweide

Strebe equal-areas: sinusoidal—See Strebe-sinusoidal

Strebe equal-areas: Snyder flat-pole—See Strebe-Snyder flat-pole

Strebe equal-areas: Snyder pointed-pole—See Strebe-Snyder pointed-pole

Strebe-Hammer

Description Equal-area.
Use Academic.
Parameters Parameter W, which controls the parallel curvature.

Parameter µ which controls the curvature of the pole line.
Range W 0 << W ≤ 0.5.
Usual W W = 0.5.
Range µ 29°S ≤ µ ≤ 42°N.
Usual µ 10°N ≤ µ ≤ 20°N.
Origin Developed by Daniel “daan” Strebe in 1991.

Strebe-Hammer
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Strebe-Kavrayskiy V

Description Equal-area.
Use Academic.
Parameters One parameter µ which controls the curvature of the pole-line.
Range 29°S ≤ µ ≤ 44°N.
Usual 10°N ≤ µ ≤ 20°N.
Origin Developed by Daniel “daan” Strebe in 1991.

Strebe-Kavrayskiy V

Strebe-Mollweide

Description Equal-area.
Use Academic.
Parameters One parameter µ which controls the curvature of the pole-line.
Range 29°N ≤ µ ≤ 43°N.
Usual 10°N ≤ µ ≤ 20°N.
Origin Developed by Daniel “daan” Strebe in 1991.

Strebe-Mollweide

Strebe-sinusoidal

Description Equal-area.
Synonyms cartouche
Use Academic.
Parameters One parameter µ which controls the curvature of the pole-line.
Range 29°S ≤ µ ≤ 36°N.
Usual 15°N ≤ µ ≤ 26°N.
Origin Developed by Daniel “daan” Strebe in 1991.
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Strebe-sinusoidal

Strebe-Snyder flat-pole

Description Equal-area.
Use Academic.
Parameters One parameter µ which controls the curvature of the pole-line.
Range 33°S ≤ µ ≤ 63°N.
Usual 13°N ≤ µ ≤ 22°N.
Origin Developed by Daniel “daan” Strebe in 1991.

Strebe-Snyder flat-pole

Strebe-Snyder pointed-pole

Description Equal-area.
Use Academic.
Parameters One parameter µ which controls the curvature of the pole-line.
Range 35°S ≤ µ ≤ 90°N.
Usual 13°N ≤ µ ≤ 25°N.
Origin Developed by Daniel “daan” Strebe in 1991.

Strebe-Snyder pointed-pole
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Wagner VII

Description Modified azimuthal, equal-area.
Synonyms Hammer-Wagner
Similar projections Hammer (elliptical) truncated and otherwise modified for the Wagner VII.
Other features A modification of the Hammer projection, the poles correspond to the 65th parallels on the 

Hammer, and meridians are repositioned.
Graticule Meridians: Central meridian is straight and half the length of the equator. Other meridians 

are curves, unequally-spaced along the equator and concave toward the central meridian.

Parallels: equator is straight. Other parallels are curves, unequally-spaced along the central 
meridian and concave toward the nearest pole.

Poles: Curved lines.

Symmetry: About the central meridians or the equator.
Scale Decreases along the central meridian and the equator with distance from the center of the 

projection.
Distortion Considerable shape distortion in polar areas.
Origin Presented by Karlheinz Wagner of Germany in 1941.
Use World maps, such as climatic maps prepared by the US Department of Commerce.

Wagner VII
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Winkel tripel

Description Modified azimuthal, neither conformal nor equal-area.
Other features Equally-spaced central meridian and equator.
Parameters Enumeration which describes the style of the projection.
Range Winkel’s style

Bartholomew’s style
Graticule Meridians: Central meridian is straight. Other meridians are curved, equally-spaced along 

the equator and concave toward the central meridian.

Parallels: equator and the poles are straight. Other parallels are curved, equally-spaced along 
the central meridian and concave toward the nearest pole.

Poles: Straight lines about 0.4 as long as the equator, depending on the latitude of the 
standard parallels of the base Equidistant cylindric projection.

Symmetry: About the central meridian or the equator.
Scale True along the central meridian. Constant along the equator.
Distortion Moderate except near outer meridians in polar regions.
Origin Presented by Oswald Winkel (1873-1953) of Germany in 1921. Obtained by averaging 

coordinates of equidistant cylindric and Aitoff (not Hammer-Aitoff) projections. Winkel 
applied the name ‘tripel’, normally meaning triple.

Use Whole world maps.

Winkel tripel
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 Miscellaneous projections

ЦНИИГАиК—See TsNIIGAiK

Adams: hemisphere in a square—See Adams hemisphere in a square

Adams: world in a square I—See Adams world in a square I

Adams: world in a square II—See Adams world in a square II

Adams hemisphere in a square

Description Conformal.
Similar projections One transverse aspect is the Peirce quincuncial, another is a rotation of the original 

projection. 

An oblique aspect is the Guyou projection.
Other features Hemisphere is enclosed in a square. World can be enclosed in a 2 x 1 rectangle.
Aspects One transverse aspect is the Peirce quincuncial, another is a rotation of the original 

projection.
Graticule Meridians: Central meridian is straight. The 90th meridians are straight lines bend at the 

equator. Other meridians are curved.

Parallels: equator is straight. Other parallels are curved.

Poles: Points, in opposite vertices of a square.

Symmetry: About the central meridian or the equator.
Scale Varies along each meridian and each parallel.
Distortion Great distortion of the area at the poles or the intersection of the 90th meridians with the 

equator. At these four points, conformality fails.
Origin Presented by Oscar Sherman Adams (1874-1962) of the US Coast and Geodetic Survey in 

1925.
Use Novelty map of a hemisphere.

Adams hemisphere in a square
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Adams world in a square I

Description Conformal.
Similar projections A general formula for representing the whole sphere or a segment of the sphere conformally 

in a regular polygon of three or more sides can be used to create this map and other 
conformal maps.

Graticule Meridians: Central meridian is straight. The 180th meridians are straight lines bent at the 
latitudes 70°31′N and S. Other meridians are complex curves.

Parallels: equator is straight. Other parallels are complex curves.

Poles: Points in midpoints of opposite sides.

Symmetry: About the central meridian or the equator.
Scale Varies along each meridian and each parallel.
Distortion Great area distortion at the higher latitudes. Conformality fails at the poles and at two 

points on each of the 180th meridians.
Origin Presented by Oscar Sherman Adams (1874-1962) of the US Coast and Geodetic Survey in 

1925.
Use Novel whole-world maps.

Adams world in a square I
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Adams world in a square II

Description Conformal.
Similar projections One transverse aspect is the Peirce quincuncial, another is a rotation of the original 

projection. 

An oblique aspect is the Guyou projection.
Graticule Meridians: Central meridian is straight. The 180th meridians are straight lines bent at the 

equator. Other meridians are complex curves.

Parallels: equator is straight. Other parallels are complex curves.

Poles: Points in opposite vertices.

Symmetry: About the central meridian or the equator.
Distortion Great area distortion near the 180th meridians or at higher latitudes. Conformality fails at 

the poles and at the intersections of the 180th meridians with the equator.
Origin Presented by Oscar Sherman Adams (1874-1962) of the US Coast and Geodetic Survey in 

1925.
Use Novel whole-world maps.

Adams world in a square II
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Al-Bīrūnī

Description Globular, polyconic, neither conformal nor equal-area.
Native name
Synonyms Arrowsmith globular 

Nicolosi globular
Similar projections Van der Grinten IV has parallels of different curvature and is extended to a world map. 

Azimuthal equidistant (equatorial aspect) has complex curves for meridians and parallels.

Fournier globular I has elliptical arcs for meridians.
Graticule Meridians: Central meridian is straight. Other meridians are circular arcs, equally-spaced 

along the equator, but not along other parallels.

Parallels: Parallel straight lines equally-spaced on the meridians 90° from the center.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along the central meridian and the equator.
Distortion Moderate for a hemisphere. Considerable area and shape distortion if used beyond the 90th 

meridians.
Origin Presented by Giambattista Nicolosi (1610-1670) of Rome in 1660.
Use Hemispheric maps, common in atlases between 1850 and 1925.

Al-Bīrūnī
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Apian globular I

Description Globular, neither conformal nor equal-area.
Similar projections Glareanus (Loritz) has identical meridians, but straight parallels are equally-spaced on the 

90th meridians.

Apian globular II has identical parallels, central meridian, and 90th meridians, but other 
meridians are equally-spaced ellipses.

Ortelius oval is identical within 90° of the central meridian.
Graticule Meridians: Central meridian is straight. Other meridians are circular arcs equally-spaced 

along the equator but not along other parallels.

Parallels: Straight lines, equally-spaced along the central meridian.

Poles: Points.

Symmetry: Along the central meridian or the equator.
Scale True along the central meridian and the equator.
Distortion Moderate.
Origin Presented by Peter Apian (Petrus Apianus or Peter Bienewitz) (1495-1552) of Saxony in 

1524.
Use Early maps of hemispheres.

Apian globular I
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Apian globular II

Description Neither conformal nor equal-area. Hemispheric version of pseudocylindric Apian II.
Similar projections Apian globular I has identical parallels, central meridian, and 90th meridians, but other 

meridians are arcs of circles.
Graticule Meridians: Central meridian is straight. Other meridians are elliptical arcs equally-spaced 

along all parallels.

Parallels: Straight lines, equally-spaced along the central meridian.

Poles: Points.

Symmetry: Along the central meridian or the equator.
Scale True along the central meridian and the equator.
Distortion Moderate.
Origin Presented by Peter Apian (Petrus Apianus or Peter Bienewitz) (1495-1552) of Saxony in 

1524.
Use Early maps of hemispheres.

Apian globular II 

Apianus globular I—See Apian globular I

Apianus globular II—See Apian globular II

armadillo

Description Orthoapsidal (term coined by originator), neither conformal nor equal-area.
Synonyms Raisz
Similar projections Other ‘orthoapsidal’ projections proposed by Raisz in 1943. Raisz coined this term from 

orthographic and apsidal.
Other features An oblique orthographic projection of the world plotted with equidistant meridians and 

parallels onto a portion of a torus ring (similar to a doughnut). Antarctic region cannot be 
shown, but the projection was claimed to have ‘more land in proportion to sea than any 
other world map’. Often plotted with New Zealand, normally hidden from view, appended 
to Australia as a ‘pigtail’.

Aspects Oblique is the basic aspect.
Graticule Meridians: Central meridian (10° or 15°E) is straight. Other meridians are elliptical arcs, 

concave toward the central meridian.

Parallels: Elliptical arcs of the same eccentricity, concave toward the north pole.

Poles: north pole is a semi-ellipse, south pole cannot be shown.

Symmetry: About the central meridian.
Scale Gradually decreases with distance from the center.
Distortion Distortion is moderate in central positions.
Origin Presented by Erwin J. Raisz (1893-1968) of Harvard University in 1943.
Use Pictorial maps of the world.
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armadillo

August epicycloidal

Description Conformal.
Synonyms August
Similar projections Eisenlohr has a boundary of constant scale.

Van der Grinten IV is not conformal and has circular arcs for meridians and parallels.
Other features Boundary of the world map is a two-cusped epicycloid. Like the Eisenlohr projection, this 

projection has no ‘singular’ point at which conformality fails. Unlike the Eisenlohr, the map 
boundary as a varying scale.

Graticule Meridians: Central meridian is straight. Other meridians are curved and concave toward 
the central meridian.

Parallels: equator is straight. Other parallels are curved and concave toward the central 
meridian.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale Increases rapidly with distance from the center.
Distortion Great distortion of area toward the 180th meridians in comparison with the center.
Aspects Transverse oblique aspect used by Athelstan F. Spilhaus in 1942 to show a map of the world 

oceans.
Origin Presented by F. August and G. Bellerman in Germany in 1874.
Use Novelty world maps.

August epicycloidal

Bacon—See Bacon globular
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Bacon globular [Bacon]

Description Globular, neither conformal nor equal-area.
Similar projections Glareanus (Loritz globular) projection of 1527 is identical.

Apian globular I hemisphere of 1524 has straight parallels equally-spaced along the central 
meridian.

Graticule Meridians: Central meridian is straight. Other meridians are circular arcs equally-spaced 
along the equator but not along other parallels.

Parallels: Parallel straight lines equally-spaced on the meridians 90° from center.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along the equator.
Distortion Extreme area and shape distortion near the poles.
Origin Presented by Roger Bacon (1214-1294) of England, about 1265, but unclear.
Use Early hemispheric maps.

Bacon globular

conformal world in an ellipse [elliptic conformal]

Description Conformal.
Similar projections Lagrange would result with a β parameter of 0°, but that value is prohibited in Geocart.
Use Academic, decorative.
Parameters A parameter β describing the flatness of the ellipse.
Range 0° << β << 90°. Negative values produce an upside-down, reversed map.
Usual 20 << β << 50.
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conformal world in an ellipse

Denoyer—See Denoyer semi-elliptical

Denoyer semi-elliptical [Denoyer]

Description Modified pseudocylindric, equally-spaced parallels, neither conformal nor equal-area.
Graticule Meridians: Central meridian is a straight line half as long as the equator. Other meridians 

are curves that are nearly elliptical areas and nearly equally-spaced, with some spreading 
near the outer limits; all are concave toward the central meridian.

Parallels: Equally-spaced, straight parallel lines. Perpendicular to the central meridian.

Poles: Lines about 0.31 times the length of the equator.

Symmetry: About the central meridian or the equator.
Scale True along the central meridian and the equator. Constant along any given latitude, same 

for latitude of opposite sign.
Distortion Free of distortion along the equator.
Origin Developed by L. Philip Denoyer of Chicago about 1920. Exact design basis not known. 

Empirical approximations are used for computer plots.
Use By Denoyer-Geppert in thematic maps and atlases of the early and middle 20th century.

Denoyer semi-elliptical
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Eisenlohr

Description Conformal.
Similar projections August epicycloidal has a boundary of varying scale.

Van der Grinten IV is not conformal and has circular arcs for meridians and parallels.
Other features Because the boundary of a world map is at a constant scale, the projection provides the 

minimum overall scale variation for a conformal world map. Like the August epicycloidal 
projection, the Eisenlohr has no ‘singular’ points at which conformality fails.

Graticule Meridians: Central meridian straight. Other meridians are curved and concave toward the 
central meridian.

Parallels: equator is straight. Other parallels are curved and concave toward the nearest 
pole.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale Increases rapidly with distance from the center. Constant scale around the boundary of a 

world map.
Distortion Great distortion of area near the 180th meridians in comparison with the center.
Origin Presented by Friedrich Eisenlohr of Germany in 1870.
Use Novelty whole-world maps.

Eisenlohr

elliptic conformal—See conformal world in an ellipse
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Fournier globular I

Description Globular, neither conformal nor equal-area.
Similar projections Nicolosi globular has circular arcs for meridians.

Mollweide has straight parallels and is used for world maps, but meridians within one 
hemisphere are the same as those on Fournier I.

Azimuthal equidistant (equatorial aspect) has complex curves for meridians and parallels.
Limitations Unsuitable for more than a hemisphere.
Graticule Meridians: Central meridian is straight. Other meridians are semi-ellipses equally-spaced 

along the equator but not along other parallels.

Parallels: Parallel straight lines equally-spaced on the meridians 90° from center.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along the central meridian and the equator.
Distortion Moderate for a hemisphere.
Origin Presented by Georges Fournier of France in 1643.
Use Early whole-world or hemispheric maps.

Fournier globular I

Gilbert two-world—See Gilbert two-world perspective
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Gilbert two-world perspective [Gilbert two-world]

Description Neither conformal nor equal-area. Presentation of nearly the entire globe in a perspective-
looking circle.

Use World maps.
Origin Described by E.N. Gilbert of the USA around 1973. Expounded on by DeLucia & Snyder.

Gilbert two-world perspective

Ginzburg VIII—See TsNIIGAiK

Glareanus—See Bacon globular

great circle equal-area tetrahedron

Description Equal-area.
Similar projections small circle equal-area tetrahedron, Snyder equal-area tetrahedron
Use Fold-up tetrahedral “globe”.
Origin Presented by Diederik van Leeuwen and Daniel “daan” Strebe in 2006.

great circle equal-area tetrahedron
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GS50

Description Conformal.
Similar projections Oblated (or prolated) stereographic projections by O.M. Miller in 1953 and by L.P. Lee 

in 1974 are equivalent to third-order complex-algebra polynomial modifications of the 
oblique stereographic, applied to continents or the Pacific Ocean.

New Zealand Map Grid presented by W.I. Reilly in 1973 is a sixth-order complex-algebra 
polynomial modification of the Mercator, applied to New Zealand.

Modified stereographic conformal projection developed by Snyder in 1983 is a sixth-order 
complex-algebra modification of the oblique stereographic, applied to Alaska.

Limitations Unsuitable for areas outside of the default boundaries.
Special properties Portrays irregular region of 50 States at about one-fourth the variation in scale of the 

best standard projections. Uses tenth-order complex-algebra polynomials to modify the 
Stereographic projection and is practical only with a computer. Conformality is precise in 
these cases even though finite polynomial series are used. The coefficients are useful only for 
this design of a 50-state map.

Graticule Meridians: Complex curves at slightly varying intervals.

Parallels: Complex curves at slightly varying intervals.

Poles: Points beyond the useful range of the map.

Symmetry: None.
Scale True along an irregular line approximately encompassing the regions of the 50 States of the 

United States. 

Varies less than 2% from true scale throughout the 50 States and adjacent bodies of water.
Distortion Shape and scale distortion is very low for 50-State region. Greater distortion for regions 

away from 50 States.
Origin Developed by John P. Snyder (1926-) of the US Geological Survey in 1982.
Use Very low distortion maps of the entire United States. 

GS50
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Guyou

Description Conformal.
Similar projections The Peirce quincuncial in transverse aspect.

The Adams hemisphere in a square in oblique aspect.
Other features Shows hemisphere conformally in a square and the world in a 2 x 1 rectangle. Hemispheres 

can be applied in mosaic form to form a continuous map indefinitely.
Graticule Meridians: Central meridian is straight. The 90th meridians are straight, but bent at the 45th 

parallels N and S. Other meridians are complex curves.

Parallels: equator is straight. Other parallels are complex curves. 

Poles: Points, in the midpoint of opposite sides of a square bounding a hemisphere.

Symmetry: About the central meridian and the equator.
Scale Varies considerably along each meridian and parallel.
Distortion Great distortion of area, especially near the 90th meridian at latitudes 45°N or S where 

conformality fails.
Aspects A transverse aspect is the Peirce quincuncial projection. An oblique aspect is the Adams 

hemisphere in a square.
Origin Presented by Emile Guyou of France in 1887.
Use Novelty maps of a hemisphere or the world.

Guyou

Loritz globular—See Bacon globular
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Lagrange

Description Polyconic, conformal.
Similar projections Van der Grinten I is not conformal.
Special forms Equatorial or oblique stereographic projection.

Littrow projection.
Other features The general formula can be used to create a variety of conformal maps.
Parameters Two parameters, φ1 giving the parallel of the center line, and β describing the ±longitude 

that forms a circle.
Range φ1 -90 << φ1 << 90.
Usual φ1 φ1 = 0°.
Range β -180° ≤ β ≤ 180°; β ≠ 0. A negative value results in an upside-down map. β = 90° results in 

Stereographic. With |β| ≤ 90° the outside boundary must be decreased from the full globe 
because the map’s size becomes infinite.

Usual β 90° << β ≤ 180°.
Graticule Meridians: Central meridian is straight. Other meridians are circular arcs, concave toward 

the central meridian.

Parallels: One parallel, often the equator, is straight. Other parallels are circular arcs, 
concave toward the pole which is on the same side of the straight parallel.

Poles: Points.

Symmetry: About the central meridian. Also about the equator, if the equator is straight.
Scale Increases rapidly with distance from the center.
Distortion Great distortion of area and scale when the center is compared with poles and other outer 

limits. Conformality fails at the poles.
Origin Johann Heinrich Lambert 91728-1777) of Alsace presented the world conformally in 

a circle in 1772. However, this projection is usually called the Lagrange projection after 
Joseph Louis Lagrange (1736-1813) of France, who generalized Lambert’s concept in 1779.

Use Whole-world maps and conformal maps within a circle of smaller portions of the world.

Lagrange
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Larrivée

Description Neither conformal nor equal-area.
Use Reference world maps.

Larrivée

lateral equidistant

Description Academic, decorative.
Special properties In equatorial aspect, distances from any point on the central meridian to a second point at 

the same latitude are correct.

Lateral equidistant

Loritz globular—See Bacon globular
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Nicolosi globular—See Al-Bīrūnī

Ortelius oval

Description Oval, modified pseudocylindric, neither conformal nor equal-area.
Synonyms Often confused with Eckert III, which has elliptic arcs for meridians.

Apian globular I is the same for one hemisphere.

Bordone oval projection of 1528 has points for poles and near-ellipses or ovals for 
meridians, but is otherwise very similar.

Graticule Meridians: Central meridian is straight. Other meridians are circular arcs, becoming 
semicircles between the meridians 90° and 180° from the central meridian. Equally-spaced 
along the equator, but not along other parallels.

Parallels: Straight lines, equally-spaced on the central meridian.

Poles: Lines half the length of the equator.

Symmetry: Along the central meridian or the equator.
Scale True along the central meridian and the equator.
Distortion Moderate.
Origin Battista Agnese (1514-1564) used the projection in 1544, but the name comes from 

Abraham Ortelius (1527-1598) of Flanders, who used it in 1570.
Use 16th century whole-world maps.

Ortelius oval
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Peirce quincuncial

Description Conformal.
Synonyms Quincuncial, name applied by Peirce, because there are normally five parts within a square 

(the northern hemisphere is in the center, and four parts of the southern hemisphere are in 
the corners).

Similar projections Guyou

Adams hemisphere in a square (refer to Aspects section below).
Other features A ‘star’ projection in the polar aspect. Shows a polar hemisphere conformally in a square 

and the world in a larger square. The first use of elliptic functions for a map projection.
Graticule Meridians: Every 90th meridian is straight but bent at the equator. Other meridians are 

complex curves.

Parallels: equator is a square, bent at the straight meridians. Other parallels are complex 
curves.

Poles: Points at the center of each hemispherical map.

Symmetry: About the central meridian or the equator.
Scale Varies considerably along each meridian and parallel.
Distortion Great distortion of area, especially near each 90th meridian at the equator, where 

conformality fails.
Aspects In polar form, the pole is at the center of a square. In transverse form, placing the pole at 

the midpoint of one side of a square results in the Guyou projection. Placing the pole at the 
corner of the square results in the Adams projection of a hemisphere in a square.

Origin Presented by Charles Sanders Peirce (1839-1914) of the US Coast and Geodetic Survey in 
1879.

Use Novelty whole-world maps.

Peirce quincuncial
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small circle equal-area tetrahedron

Description Equal-area. One instance of the more general van Leeuwen projection.
Similar projections great circle equal-area tetrahedron, Snyder equal-area tetrahedron
Use Fold-up tetrahedral “globes”.
Origin Presented by Diederik van Leeuwen and Daniel “daan” Strebe in 2006.

small circle equal-area

Snyder equal-area tetrahedron

Description Equal-area. One instance of the more general van Leeuwen projection.
Similar projections great circle equal-area tetrahedron, small circle equal-area tetrahedron
Use Fold-up tetrahedral “globes”.
Origin Presented by John P. Snyder in 1992.

Snyder equal-area tetrahedron

tri-optimal

Description A good balance between equivalence, conformality, and scale fidelity.
Use Academic.
Origin Presented by Piotr Laskowski, 1991.
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tri-optimal

TsNIIGAiK

Native name ЦНИИГАиК
Synonyms Ginzburg VIII
Description Called TsNIIGAiK pseudocylindric in Russia, the projection is not actually pseudocylindric 

because meridian spacing along parallels is inconstant. The name is the initials of the 
Tsentral’nyy Nauchno-issledovatel’skiy Institut Geodezii, Aerofotos’emki i Kartografii = Central 
Scientific Research Institute of Geodesy, Aerial Photo Survey and Cartography.

Origin Presented by G.A. Ginzburg in 1944.
Use Maps from the Soviet Union with central meridian set to 70°E.

TsNIIGAiK
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van der Grinten I

Description Polyconic, neither conformal nor equal-area.
Synonyms van der Grinten
Similar projections Lagrange is conformal.

Van der Grinten II has parallels curved to intersect meridians at right angles. 

Mercator is conformal and has straight meridians and parallels.
Other features The world is enclosed in a circle.
Graticule Meridians: Central meridian is straight. Other meridians are circular, equally-spaced along 

the equator and concave toward the central meridian.

Parallels: equator is straight. Other parallels are circular arcs, concave toward the nearest 
pole.

Poles: Points.

Symmetry: Along the central meridian or the equator.
Scale True along the equator. Increases rapidly with distance from the equator.
Distortion Great distortion of area near the poles.
Origin Presented by Alphons J. van der Grinten (1852-?) of Chicago in 1898. US patent obtained 

in 1904.
Use World maps by the US Department of Agriculture, the US Geological Survey, the National 

Geographic Society and others. Usually a frame limits the north/south extent of the map. 

van der Grinten I
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van der Grinten II

Description Polyconic, neither conformal nor equal-area.
Similar projections Lagrange is conformal.

Van der Grinten I has parallels that do not intersect meridians at right angles.
Other features The world is enclosed in a circle. All meridians intersect parallels at right angles, but 

projection is not conformal. Spacing of parallels along the central meridian is the same as 
that for van der Grinten I.

Graticule Meridians: Central meridian is straight. Other meridians are circular, equally-spaced along 
the equator and concave toward the central meridian.

Parallels: equator is straight. Other parallels are circular arcs, concave toward the nearest 
pole.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True on the equator. Increases rapidly with distance from the equator.
Distortion Great distortion of area near the poles.
Origin Presented by Alphons J. van der Grinten (1852-?) of Chicago in 1904.
Use World maps, but rarely.

van der Grinten II
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van der Grinten III

Description Modified pseudocylindric, neither conformal nor equal-area.
Similar projections Van der Grinten I has curved parallels.

The Times by Moir, has nearly elliptical meridians, but straight parallels are spaced like 
those of the Gall projection.

Other features The world is enclosed in a circle. Spacing of parallels along the central meridian is the same 
as that for van der Grinten I.

Graticule Meridians: Central meridian is straight. Other meridians circular, equally-spaced along 
the equator but unequally-spaced along other parallels and concave toward the central 
meridian.

Parallels: Straight lines.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along the equator. Increases rapidly with distance from the equator.
Distortion Great distortion of area near the poles.
Origin Presented by Alphons J. van der Grinten (1852-?) of Chicago in 1904.
Use World maps, but rarely.

van der Grinten III
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van der Grinten IV

Description Polyconic, globular, neither conformal nor equal-area.
Synonyms apple-shaped
Similar projections Eisenlohr is conformal.

August epicycloidal is conformal.
Other features The 90th meridians form a complete circle.
Graticule Meridians: Central meridian is straight. Other meridians are circular, equally-spaced along 

the equator and concave toward the central meridian.

Parallels: equator is straight. Other parallels are circular, equally-spaced on the central 
meridian and concave toward the nearest pole.

Poles: Points.

Symmetry: About the central meridian or the equator.
Scale True along the central meridian and the equator.
Distortion Great distortion of area near the 180th meridians at higher latitudes.
Origin Presented by Alphons J. van der Grinten (1852-?) of Chicago in 1904.
Use World maps, but rarely.

van der Grinten IV
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van Leeuwen

Description Equal-area.
Use Fold-up tetrahedral “globes”.
Parameters Enumeration of variants: small-circle, great circle, and Snyder.
Usual Great-circle yields mildest kinks at the quadrant boundaries, and low distortion.
Origin Presented by Diederik van Leeuwen and Daniel “daan” Strebe, 2006.

van Leeuwen
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Appendix C: Working with Adobe Illustrator®
Geocart’s primary purpose is to provide you with the best possible base map so that you can complete your map using 
whatever graphics program suits your map’s needs. If you will be manipulating the line work of the map to add extra 
details such as area coloring and place names, you will probably finish your map using an illustration program such as 
Adobe Illustrator.® This appendix describes how to work with such illustration programs.

To edit the line work in your map, you need to export it to PDF format. The graphics editing program must be able to 
edit PDF files.

Resolution

Before exporting, you should change the horizontal and vertical resolution of the map to the final values you need by 
modifying the values in the Resolution section of the Map Size and Resolution dialog from the Map menu. Larger 
values will give more detail, up to the limit of the detail in the database. Larger numbers will also take proportionately 
longer to save and will create bigger files. In choosing an appropriate resolution, you may have to experiment to find 
the correct balance between the detail you need and a file size you can tolerate. Usually, when exporting for completion 
in an illustration program, you will want to leave the Generalize Vectors option checked in the Map menu.

Exporting

You may export selected maps, or you may export the entire document. To export maps for use in an illustration 
program:

1.	 Select the map or maps you wish to export. On the File menu, select Export Selected Items. That will 
cause the Choose a file name and type to export to dialog to be displayed.

	 – OR –

	 On the File menu, select Export Document. That will cause the Choose a file name and type to export 
to dialog to be displayed.

2.	 In the file browser, navigate to the folder in which you want to save your document.

3.	 In the Export as field, enter a file name (Geocart will give it a default file name of Untitled).

4.	 In the Export Format section, select the PDF export data format. Click OK.

You should experiment to find line weights that work best with your printing or imaging environment. What works 
well on a published map is unlikely to suit a Web JPEG image, for example. You have complete control over line 
weights for the vector database coverages and computed lines that you tell Geocart to draw. Please see the description 
of the Line Styles facility in Chapter 9: Map menu.

Geocart does not participate in a color-managed workflow. It does not embed color profiles in the TIFF and JPEG 
images it produces; nor does it utilize the profiles in imagery it consumes. This omission stems largely from the lack 
of color management in most source imagery that Geocart works with. You should treat output from Geocart as if it 
had the same color profile as the input, and assume by default that output created from input lacking a color profile is 
best treated as sRGB colorspace, and adjust your downstream workflow accordingly. When using multiple sources of 
imagery in a single map, ensure all inputs are in the same colorspace for best results. Please see the documentation for 
your illustration software if you need managed color.
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Cleaning up the PDF

Because Geocart cannot write files in the native Illustrator format, you might find the structure of the raw PDF file 
cumbersome to work with inside of Illustrator. Geocart’s installation includes a script that, when applied to PDF files 
created by Geocart, rearranges their structure. Specifically, each group is moved into its own layer and clipping masks 
are removed. You can find the script here (Macintosh):

	 /Library/Application Support/Mapthematics/Geocart/Version 3/
� Sample Documents/GeocartLayers.jsx

Windows XP:

	 C:\Documents and Settings\All Users\Application Data\Mapthematics\
� Version 3\Sample Documents\GeocartLayers.jsx

Windows Vista/Windows 7:

	 C:\ProgramData\Mapthematics\Geocart\Version 3\
� Sample Documents\GeocartLayers.jsx

To run the script, from Illustrator, open the PDF you exported from Geocart. If you have more than one document 
open in Illustrator, make sure the document you want to clean up is the current document that you are editing. From 
Illustrator’s File menu, select Scripts -> Other Script… . Navigate to the the GeocartLayers.jsx file and select it. The 
script should complete momentarily, and the document will be restructured. You may commence editing it.

Creating closed polygons before filling a shape with color

Except for islands or lakes, the shapes you want to color may not be completely connected all the way around. For 
instance, when you use the intl borders database, the borders between countries are not explicitly connected to the 
shoreline. In the example below, the lines defining the state of California are unconnected segments. If you want to fill 
the state with color, you must connect the lines to form a closed path.

One method for doing this using Adobe Illustrator is shown below. 

1.	 Copy all the lines that make up the shape.

2.	 Create a new document and place the lines into it by using Paste in Front. This will ensure that the objects 
in the new document are in register with the old. 

3.	 Use the scissors tool to cut off all the lines that are not part of the border of the shape.

As you are working, you may be confronted with the following error message:

Can’t split the path. Please use the scissors tool on a segment or an anchor point (but not an endpoint) of a 
path.

The problem is that the end of one line is in front of the line you are trying to cut. 

1.	 Select the line you want to cut with the arrow tool.

2.	 On the Object»Arrange menu, select Bring to Front.

Result: You should now be able to cut the line.

After deleting all the unwanted line segments, you must join the lines to form a closed shape. 

1.	 Start by clicking on a line segment. You will be able to see where it starts and ends. 

2.	 As in the example below, use the arrow tool to draw a marquee around one end of the selected line. This 
will select the end points of the two lines. 



Working with Adobe Illustrator® C.3

3.	 You can now use the Join command from the Arrange menu to join the two lines. If the two end points 
happen to be exactly in the same spot, you will get a dialog box asking which type of corner point to use. 
The default is usually the one you should choose.

4.	 Continue until you have closed all the shapes.

When you have finished one shape, use Cut on the Edit menu and paste it into another document to store it and the 
other shapes you will be finishing. You may find that working with three documents is very efficient. The first holds 
the original map, the second holds each shape as you edit it, and the third is for storing the finished shapes. Be sure to 
clear the second document every time you start a new shape. In this particular example, it takes about half an hour for 
an experienced user to color and assemble all the states.
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Appendix D: Coverage mapping files
Vector databases come from a variety of sources. You might even make your own. Geocart needs to know what line 
styles, such as the line thickness and color, to use when drawing the objects from a vector database. Line styles are 
assigned by data coverage. Coverages are the various kinds of lines with distinct geographic semantics, such as “rivers”, 
“contours”, “coastlines”, “national boundaries” and so forth. You can control how Geocart interprets the coverage of 
a vector database either by forcing it to a specific coverage in the Database dialog using the Assign Coverage… button, 
or by matching the file name to a pattern in a coverage mapping file. This appendix describes how to make and use 
coverage mapping files.

As described in Chapter 9: Map menu, the Line Styles dialog presents a hierarchy of coverages to assign line styles to. 
A sample of a coverage hierarchy might look like this:

	 Rivers	
	 	 Perennial	
	 	 	 Major rivers	
	 	 	 Minor rivers	
	 	 	 Streams	
	 	 Seasonal	
	 	 	 Rivers	
	 	 	 Streams	
	 	 Subterranean

Geocart installs a standard set of coverage mapping files that reflect the databases Mapthematics supplies. You may edit 
these files if wish, or you may add new files that reflect the attributes of databases from other sources. In aggregate, 
these files determine the coverage schema, meaning the complete set of coverages with their hierarchical relationship, 
recognized by Geocart at the time it launches.

Consider this first set of database file names:
	 10m-admin-0-boundary-disputed-areas.shp	
	 10m-admin-0-boundary-lines-land.shp	
	 10m-admin-0-boundary-lines-map-units.shp	
	 10m-admin-0-boundary-lines-maritime-indicator.shp	
	 10m-admin-0-boundary-lines-maritime.shp	
	 10m-admin-0-breakaway-disputed-areas-with-scale-ranks.shp	
	 10m-admin-0-breakaway-disputed-areas.shp	
	 10m-admin-0-countries.shp	
	 10m-admin-0-map-subunits.shp	
	 10m-admin-0-map-units.shp	
	 10m-admin-0-pacific-groupings.shp	
	 10m-admin-0-scale-ranks-with-minor-islands.shp	
	 10m-admin-0-scale-ranks.shp	
	 10m-admin-0-sovereignty.shp	
	 10m-admin-1-states-provinces-lines-shp.shp	
	 10m-admin-1-states-provinces-shp.shp	
	 10m-populated-places.shp	
	 10m-urban-area.shp	
	 50m-admin-0-boundary--breakaway-disputed-areas.shp	
	 50m-admin-0-boundary-lines-land.shp	
	 50m-admin-0-boundary-lines-maritime-indicator.shp	
	 50m-admin-0-boundary-map-units.shp	
	 50m-admin-0-breakaway-disputed-areas.shp	
	 50m-admin-0-countries.shp	
	 50m-admin-0-map-subunits.shp	
	 50m-admin-0-map-units.shp	
	 50m-admin-0-pacific-groupings.shp	
	 50m-admin-0-scale-ranks.shp	
	 50m-admin-0-sovereignty.shp	
	 50m-admin-0-tiny-countries.shp	
	 50m-admin-1-states-provinces-lines-shp.shp	
	 50m-admin-1-states-provinces-shp.shp	
	 50m-populated-places.shp	
	 50m-urban-area.shp
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The 10m- designation refers to data suitable for mapping at 1:10,000,000 scale. Likewise the 50m- designation refers 
to data suitable for mapping at 1:50,000,000 scale. But stripping off those prefixes, we see identical file names, and we 
can tell they mean the same coverage.
Now consider this second set of database file names as well:

	 Noamer folder	
	 	 PO-88-9 Connect, tile	
	 	 PO-11-2 Ocean/Ice, approx	
	 	 PO-13-9 Date, tile	
	 	 PO-10-2 Coast, approx	
	 	 PO-10-6 Coast, ice cliff	
	 	 PO-9-2 Ice, approx	
	 	 PO-10-1 Coast, def	
	 	 PO-7-9 Coast closure, tile	
	 	 PO-8-8 Ocean, connect	
	 	 PO-6-1 DMZ, def	
	 	 PO-4-7 Prov, riv bound	
	 	 PO-4-8 Prov, connect	
	 	 PO-4-2 Prov, approx	
	 	 PO-4-1 Prov, def	
	 	 PO-1-8 Nation, connect	
	 	 PO-1-7 Nation, riv bound	
	 	 PO-1-2 Nation, approx	
	 	 PO-1-1 Nation, def	
	 	 PO-?-9 Misc, tile	
	 Eurnasia folder	
	 	 PO-?-9 Misc, tile	
	 	 PO-1-1 Nation, def	
	 	 PO-1-2 Nation, approx	
	 	 PO-1-3 Nation, indef	
	 	 PO-1-7 Nation, riv bound	
	 	 PO-1-8 Nation, connect	
	 	 PO-4-1 Prov, def	
	 	 PO-4-7 Prov, riv bound	
	 	 PO-4-8 Prov, connect	
	 	 PO-5-1 Sub Prov, def	
	 	 PO-5-7 Sub Prov, riv bound	
	 	 PO-5-8 Sub Prov, connect	
	 	 PO-6-1 DMZ, def	
	 	 PO-6-3 DMZ, indef	
	 	 PO-7-4 Coast closure	
	 	 PO-7-9 Coast closure, tile	
	 	 PO-8-8 Ocean, connect	
	 	 PO-9-2 Ice, approx	
	 	 PO-10-1 Coast, def	
	 	 PO-10-2 Coast, approx	
	 	 PO-10-3 Coast, indef	
	 	 PO-10-4 Coast	
	 	 PO-11-2 Ocean/Ice, approx	
	 	 PO-12-4 Seawall	
	 	 PO-13-9 Date, tile	
	 	 PO-88-9 Connect, tile

These two sets of files are from different sources. They have their own internal logic for how files get named and 
completely different notions of coverages, but in both cases the filenames reflect the coverage. Coverage mapping 
files express how to map a file name to a coverage. In both sets we see that there is more in the name than just the 
coverage. 10m-admin-0-, for example, reflects other information that is (perhaps) irrelevant to coverage; it is what 
comes afterward that is important. Likewise in the second set, we see some identical file names in both folders. Those 
coverages are the same. The basic idea in a coverage mapping file is that a pattern appearing in a file name gets mapped 
to a named coverage. So, for example, these two lines in a coverage file...

	 “Coverage|Political|Countries”, “*countries.shp”	
	 “Coverage|Political|Countries”, “*Nation, def”

...state that files with names that end in countries.shp and Nation, def are to be treated as Countries within the 
taxon of Political coverages. The asterisks (*) are “wildcards”, meaning they will match any sequence of characters in 
that position as long as the file name ends in countries.shp.
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Coverage mapping files are found in a folder called Coverages within either or both of the installed database location 
or the user database location, as follows.

Macintosh user-specific:
	 /Users/<account name>/Library/Application Support/Mapthematics/Geocart/Databases/Coverages/

Macintosh all users:
	 /Library/Application Support/Mapthematics/Geocart/Databases/Coverages/

Windows XP user-specific:
	 C:\Documents and Settings\<account name>\Application Data\Mapthematics\Databases\Coverages\

Windows XP all users:
	 C:\Documents and Settings\All Users\Application Data\Mapthematics\Databases\Coverages\

Windows Vista+ user-specific:
	 C:\Users\<account name>\AppData\Local\Mapthematics\Databases\Coverages\

Windows Vista+ all users:
	 C:\ProgramData\Mapthematics\Databases\Coverages\

Geocart aggregates all coverage files in both the user-specific location and the all-users location in order to create the 
schema. When editing the New Map Line Style preference, the entire schema will appear in the Line Styles dialog. 
However, when editing line styles for a given map, only the coverages that show up in that map’s databases will appear 
in the Line Styles dialog. This keeps the list of styles manageable and relevant.

Coverage mapping file syntax

A coverage mapping file is a UTF-8-encoded text file consisting of lines of text. A line may end in CR (U+0D), 
LF (U+0A), or both. A line may be a comment or a declaration or empty. A comment is denoted with a line whose first 
character is colon (:); such a line is ignored by Geocart.

If a non-empty line does not start with colon, then it is a declaration. A declaration may have one or two fields. Each 
field is a string of characters within straight double quotes (“). If there are two fields, they are separated by a comma 
(,). Any whitespace before, between, or after each field is ignored up until the line ending. If a double quote is needed 
within a field, it must be “escaped” by using two double quotes in succession (“”).

The first field is the coverage declaration. The text between double quotes declares a coverage lineage, with the most 
general taxon to the left and progressing to the most specific taxon at the right. Taxons are separated by the vertical bar 
(|).

If there is a second field, then it is the file name pattern. The text between double quotes declares a pattern to match in 
file names. Any file that matches the pattern will be assigned the coverage declared in the first field. A pattern consists 
of literals, single-character wild cards, and arbitrary-length wild cards. Literals are simply the characters that are to 
match a portion of the file name exactly. The single-character wild card, question mark (?), will match any single 
character. The arbitrary-length wild card, asterisk (*), will match any number of characters.

A coverage mapping file’s name in the file system must end with .coverage.txt.
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Appendix E: Creating vector databases
You can create your own line work (vector) databases to use with Geocart. The databases are written as a text file, with 
records in a strict format. The records typically describe polygonal regions. You can assign the coverage trait for a text 
database just like any other database; see the Databases functionality described in Chapter 9: Map menu. If you do 
not assign a coverage there, it will have the Coverage/Unspecified coverage by default.

You can use any standard text editor or word processor to create such file, but you must save the resulting file as a text 
(.txt) file, rather than in the native format of the word processor. Refer to your word processor or text editor manual 
for details on how to do this.

Each record begins with two names:

1.	 The first name is an identifier composed of 16 characters or less that is shared by no other object in any file 
that you will be using at the same time. A tab follows the identifier. 

2.	 The second name is whatever title you would like the feature to have when it is printed on a map. A tab 
also follows the second name. At present, Geocart ignores both of these names, but future versions may 
make use of them.

3.	 Following the second tab is the number n of line segments in the polygon that defines the named region. 

•	 If n < 0, then the region is unclosed (such as a river), rather than a polygon. 

•	 If n = 1, then the region is a point, but Geocart does not treat it specially. 

•	 If n = 2, then the region is a circle with the radius given by the second point, but at present Geocart 
handles this case incorrectly; rather it interprets the radius as another coordinate, giving unpredictable 
results. 

•	 If n ≥ 3, then the region is a polygon, in which case the final coordinate should equal the initial. 
Geocart does not treat polygons any differently than unclosed regions at present. 

4.	 After n comes the end-of-line character eol (character 13 = 0D
16

) or line-feed lf (character = 0A
16

) or both. 
Typing return in any text editor should be usable.

5.	 The next n lines hold the longitude/latitude coordinates of the line segments in the polygon. The left 
number gives the longitude and the right number gives the latitude, and the two are separated by a tab. 
The numbers are in floating point format (not ° ′ ″) with any number of digits, and west and south are 
denoted by negative values. The first coordinate of a record will have the pen moved to it and following 
coordinates will all be drawn to.

A file consists of a consecutive set of these records. The final coordinate of the final record must be followed by an eol. 

The following illustrates two simple records:

continent:Hexland	 Hexland	 7 
-6.0	 -10.3923 
-12.0	 0.0 
-6.0	 10.3923 
6.0	 10.3923 
12.0	 0.0 
6.0	 -10.3923 
-6.0	 -10.3923 
city: Triangle	 Triangle	 4 
0.0	 0.0 
-6.0	 -10.3923 
6.0	 -10.3923 
0.0	 0.0
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Appendix F: Typesetting databases
Geocart 3 can read typesetting databases: files that contain text to be placed on a map. The databases contain the 
coordinates at which to place the text, details for the typeface, font size, color, and other attributes. This section 
documents the database format. Geocart will be able to read files that follow these conventions, but the subset of 
features actually supported is less. Currently unsupported features are marked with [INOPERATIVE].

Geocart supports only TrueType and OpenType fonts. These generally have filename extensions of .ttf or .otf. Refer to 
Available Fonts on the Help menu in Geocart for a list of fonts in your environment that Geocart can use.

A typesetting database consists of ASCII text. Line ends may be carriage return or carriage return + line feed. The 
first line must be as follows:

	 Geocart Typesetting Data Base Version x 

This specification constitutes Version 1.

Fonts may be declared as a header to the file by using a “%” annunciator as the first character of the line. Each font 
declaration consumes one line, and the fields of the declaration are separated by white space. Fields may not be 
omitted.

fontCode An identifying code for this font declaration [Integer ≥ 0]. Consecutive ordering is not 
required.

typeface The PostScript name of the typeface for the name or symbol. The PostScript name can be 
found by clicking Available fonts on the Help menu in Geocart. Correct names can be 
obtained by having the printer print a font list. [“Quoted string”]

fontSize Point size of the name or symbol. [Floating point]
fontStyle A code for the style of the geographic name. [Bit field]

 0 = no style

 1 = all capitals

 2 = outline characters

 4 = underline

 8 = dashed underline

16 = follow curvature of parallel [INOPERATIVE]
fontColor Color for the name or symbol. Four integers separated by white space in CMYK order 

representing CMYK values, each 0 ≤ color ≤ 100.
fontTracking The amount of space between characters of the name or symbol. [Floating point]

The body of the database also has fields separated by white space and each field consumes one line. Fields may be 
omitted starting with the field to the furthest right, but the coordinate and the place name are required. Omitted fields 
assume values of the last declared values in that field. A line may be declared to be a comment by setting a colon “:” to 
be the leading character.

l Longitude in degrees expressed as a decimal; negative is west.
j Latitude in degrees expressed as a decimal; negative is south.
name The geographic name to be placed. [“Quoted string”] 

Note: The text encoding of geographic names must be in Unicode UTF-8.
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pos Position of name with respect to coordinate. 1 is top left, and digits proceed from 
left to right, top to bottom. A value of 0 signifies automatic placement, which is 
[INOPERATIVE]. [Single digit]

nameFont The code of the styled font to be used for the geographic name. [Integer]
symbol Actual symbol to place at pos with respect to the coordinate. Unquoted String or “” to 

signify no symbol. Back-slash “\” (without quote marks) to render a point location for a 
city. Size and color of the point is controlled by the Coverage/Cities coverage in the Line 
Styles dialog box on the Map menu in Geocart. 

Note: The text encoding must be in Unicode UTF-8.
symbolFont The code of the styled font for the symbol. [Integer] Style and tracking values are ignored.
rotation Degrees to rotate text counterclockwise using pos as a pivot. This setting overrides the 

parallel curvature setting of the font. [INOPERATIVE]
arc Radius of arc to weld text to, measured in millimeters. A value of 0.0 defeats the setting. 

This setting overrides the parallel curvature setting of the font. [INOPERATIVE]

Example database

Geocart typesetting Data Base Version 1

%0	 "Times-Roman"				   9.5	 17	 0	 0	 0	 100	 3 
%1	 "AvantGarde-BookOblique"		 16	 16	 100	 100	 0	 0	 5 
%2	 "Symbol"				    12	 0	 0	 0	 0	 100	 0 
: End of font declarations 
0	 -90.0	 "South Pole"		  1	 2	 +	 2 
17.32	 23.492	 "Africa"			   3	 0	 "" 
-180	 30.0	 "North Pacific Ocean"	 5	 1	 ""	 0	 0	 200
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Appendix G: Managing your databases
Database files contain the raster imagery and vector data that Geocart uses for drawing maps. You can select a file 
from anywhere on your computer to use as a database by clicking Add Any Database in Geocart’s Databases dialog. 
However, Geocart recognizes two special places for databases on your computer:

•	 A system-wide folder, where databases can be installed for all users. This is the folder you’ll first see if you 
click Add Installed Database in the Databases dialog.

•	 A per-user folder appropriate for personal databases. This is the folder you’re taken to when you click Add 
User Database in the Databases dialog.

The advantage of keeping database files in these special folders is that it helps Geocart find databases used in saved 
Geocart documents. Geocart can find those databases automatically even when you move documents between 
machines. If instead you use a database from some arbitrary folder on your computer, and then move the document 
to another machine, Geocart will not be able to find the database unless it is in an identical location on the other 
machine. In that case, Geocart will tell you the database is missing and you will have to use the Relink option in the 
Databases dialog to show Geocart new location.

The remainder of this appendix will explain where these two folders are located are on your computer, and how 
to make them visible on Windows (they’re not hidden on the Mac). If you know where they are, you will be able 
to manage the files manually from the Macintosh Finder or Windows Explorer. In particular, if you want to make 
changes to the coverage definition files, you will need to be able to find them. Unlike databases, they must reside in the 
Coverages folder of system or user database folder, and not in an arbitrary location.

Macintosh Information

Databases Installed for All Users

The database files in the folder:

/Library/Application Support/Mapthematics/Databases

are available to all user accounts on the computer. This is the folder displayed when you click Add Installed Database 
in the Databases dialog. Geocart’s Required Databases installer (see Installing Required Databases, Chapter 1: Setup) 
installed its database files here, and so did any Supplemental Databases installers that you opted to install for all users. 
You can add other databases and coverage mapping files for all users here, or delete databases that you no longer need.

To reach this folder from the Finder:

1.	 Select Go to Folder from the Go menu on the Finder’s menu bar.

2.	 Type: 
/Library/Application Support/Mapthematics/Databases

3.	 Click Go.

If you know for certain which volume is your system start-up disk, you can also simply double-click the icon for the 
disk, and then:

1.	 Double-click the Library folder.

2.	 Double-click the Application Support folder.

3.	 Double-click the Mapthematics folder.
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4.	 Double-click the Databases folder.

Personal Databases

Any database files in the folder:

/Users/YourUserName/Library/Application Support/Mapthematics/Databases

are accessible only to you because of the file permissions set up by OS X. This is the folder displayed when you click 
Add User Database in the Databases dialog. If you opted to install Supplemental Databases for your use only (see 
Installing Supplemental Databases, Chapter 1: Setup), the database files were placed here. You can add new databases 
for yourself here, or add coverage mapping files whose contents will override those present in the system-wide folder. 

To reach this folder from the Finder:

1.	 Select Home from the Go menu on the Finder’s menu bar.

2.	 Double-click the Library folder.

3.	 Double-click the Application Support folder.

4.	 Double-click the Mapthematics folder.

5.	 Double-click the Databases folder.

Windows XP Information

Databases Installed for All Users

The database files in the directory:

C:\Documents and Settings\All Users\Application Data\Mapthematics\Databases

are available to all users on the system. This is the directory displayed when you click Add Installed Database in the 
Databases dialog. Geocart’s Required Databases installer (see Installing Required Databases, Chapter 1: Setup)installed 
its database files here, and so did any Supplemental Databases installers that you opted to install for all users. You can 
add other databases and coverage mapping files for all users here, or delete databases that you no longer need.

To reach this directory from the Windows Explorer:

•	 On the Start menu, select My Computer.

The directory where databases are stored is hidden by default on Windows. If you don’t want to change any settings 
but instead just navigate there directly, then:

1.	 Double-click the Address field at the top (it will default to My Computer).

2.	 In the Address field, type:
C:\Documents and Settings\All Users\Application Data\Mapthematics\
� Databases

3.	 Press ENTER to display the directory.

If you’d like to make this folder visible, then:

1.	 From the Tools menu, select Folder Options.

2.	 In the Folder Options tabbed dialog, select the View tab.

3.	 Under Advanced Settings, click the Show hidden files and folders radio button.

4.	 Click OK.
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Now you can navigate to the databases directory more easily, like this:

1.	 Double-click your C: drive icon.

2.	 Double click Documents and Settings.

3.	 Double-click All Users.

4.	 Double-click Application Data.

5.	 Double-click Mapthematics.

6.	 Double-click Databases.

Personal Databases

Any database files in the directory:

C:\Documents and Settings\YourAccountName\Local Settings\Application Data\
� Mapthematics\Databases

are accessible only to you because of the file permissions set up by Windows. This is the directory displayed when you 
click Add User Database in the Databases dialog. If you opted to install Supplemental Databases for your use only (see 
Installing Supplemental Databases, Chapter 1: Setup), the database files were placed here. You can add new databases 
for yourself here, or add coverage mapping files whose contents will override those present in the system-wide folder. 

To reach this directory from the Windows Explorer:

•	 On the Start menu, click My Computer.

The directory where databases are stored is hidden by default on Windows. If you don’t want to change any settings 
but instead just navigate there directly, then:

1.	 Double-click the Address field at the top (it will default to My Computer).

2.	 In the Address field, type:
C:\Documents and Settings\YourAccountName\Local Settings\Application �Data\
� Mapthematics\Databases

3.	 Press ENTER to display the directory.

If you’d like to make this folder visible, then:

1.	 Select Folder Options from the Tools menu.

2.	 In the Folder Options tabbed dialog, select the View tab.

3.	 Under Advanced Settings, click the Show hidden files and folders radio button.

4.	 Click OK.

Now you can navigate to the databases directory more easily, like this:

1.	 Double-click your C: drive icon.

2.	 Double-click Documents and Settings.

3.	 Double-click the folder with your account name.

4.	 Double-click Local Settings.

5.	 Double-click Application Data.

6.	 Double-click Mapthematics.

7.	 Double-click Databases.
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Windows Vista and Windows 7 Information:

Databases Installed for All Users

The database files in the directory:

C:\ProgramData\Mapthematics\Databases

are available to all users on the system. This is the directory displayed when you click Add Installed Database in the 
Databases dialog. Geocart’s Required Databases installer (see Installing Required Databases, Chapter 1: Setup)installed 
its database files here, and so did any Supplemental Databases installers that you opted to install for all users. You can 
add other databases and coverage mapping files for all users here, or delete databases that you no longer need.

To reach this directory from the Windows Explorer:

•	 On the Start menu, click Computer.

The directory where databases are stored is hidden by default on Windows. If you don’t want to change any settings 
but instead just navigate there directly, then:

1.	 Double-click the Location field at the top (it will default to > Computer >)

2.	 In the Location field, type:
C:\ProgramData\Mapthematics\Databases

3.	 Press ENTER to display the directory.

If you’d like to make this folder visible, then:

1.	 Press and release the ALT key to reveal the menu bar for the window.

2.	 From the Tools menu that appears, select Folder Options.

3.	 In the Folder Options tabbed dialog, select the View tab.

4.	 Under Advanced Settings, click the Show hidden files and folders radio button.

5.	 Click OK.

Now you can navigate to the databases directory more easily, like this:

1.	 Double-click your C: drive icon.

2.	 Double click ProgramData.

3.	 Double-click Mapthematics.

4.	 Double-click Databases.

Personal Databases

Any database files in the directory:

C:\Users\YourAccountName\AppData\Local\Mapthematics\Databases

are accessible only to you because of the file permissions set up by Windows. This is the directory displayed when you 
click Add User Database in the Databases dialog. If you opted to install Supplemental Databases for your use only (see 
Installing Supplemental Databases, Chapter 1: Setup), the database files were placed here. You can add new databases 
for yourself here, or add coverage mapping files whose contents will override those present in the system-wide folder. 

To reach this directory from the Windows Explorer:

•	 On the Start menu, click Computer.
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The directory where databases are stored is hidden by default on Windows. If you don’t want to change any settings 
but instead just navigate there directly, then:

1.	 Double-click the Location field at the top (it will default to > Computer >)

2.	 Type: 
C:\Users\YourAccountName\AppData\Local\Mapthematics\Databases

3.	 Press ENTER to display the directory.

If you’d like to make this folder visible, then:

1.	 Press and release the ALT key to reveal the menu bar for the window.

2.	 From the Tools menu that appears, select Folder Options.

3.	 In the Folder Options tabbed dialog, select the View tab

4.	 Under Advanced Settings, click the Show hidden files and folders radio button.

5.	 Click OK.

Now you can navigate to the databases directory more easily, like this:

1.	 Double-click your C: drive icon.

2.	 Double-click Users.

3.	 Double-click the folder with your account name.

4.	 Double-click AppData.

5.	 Double-click Local.

6.	 Double-click Mapthematics.

7.	 Double-click Databases.
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Appendix H: Defining custom boundaries
Geocart’s Boundaries dialog offers the ability to specify the region of the earth to be projected when drawing a map. 
There are three simple options (already described in Chapter 9: Map menu, Boundaries) available: Unconstrained, 
Corners (for spherical quadrilaterals), and Small Circle. There is also a fourth option Custom, which allows you to 
define a region of more complex shape to be projected.

The region to be projected is defined in an XML syntax. When you click the Custom button in the Boundaries dialog, 
you are presented with an additional Custom Boundaries dialog that shows you the current definition for the custom 
boundaries, and allows you to edit them. The first time you do this for a map without custom boundaries, the dialog is 
populated upon entry with a commented example to explain how the mechanism works. You can select and delete all 
of that text, and type or paste in new XML for your own boundaries.

The XML that defines a region specifies:

1.	 A point on the earth that is inside the region to be projected.

2.	 One or more closed paths that define the region boundaries.

The region to be projected is then considered to be the set of all points p such that a path from p to the known interior 
point crosses the boundary an even number of times, or not at all. Let’s look at a simple example. Make a new Geocart 
document, place a new map, select Boundaries from the Map menu, and click Custom. Then enter the following 
XML into the dialog:

<boundary inside='90,0'> 
  <path> 
    <segment start='50,0' middle='50,90' end='50,180' /> 
    <segment start='50,180' middle='50,-90' end='50,0' /> 
  </path> 
  <!-- Hello, world! --> 
</boundary>

and click OK. By this you will have specified that the region of interest is everything north of the 50°N parallel:

Everything north of the 50th parallel

If there was a problem with the XML you’ve entered, Geocart will display an error message and allow you to go back 
and edit the XML until it’s correct. Let’s look at the XML line by line:
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1:	 <boundary inside='90,0'>

All definitions must begin with a boundary element (excepting XML comments, see below). The boundary element 
contains a single attribute, inside, which defines a coordinate that shall be considered to be inside the region.

2:	 <path>

The path element begins the definition of a closed path that provides a boundary for the region. A legal path is 
comprised of two or more segments, and each segment is a piece of a small or great circle. The endpoint of each 
segment must be the starting point of the next segment, and the endpoint of the final segment must be the starting 
point of the first segment; this ensures that the path is closed.

3:	 <segment start='50,0' middle='50,90' end='50,180' />

The segment element defines a piece of either a small or great circle. Any three unique points on the sphere lie along 
exactly one great or small circle. The segment element has three attributes start, middle, and end that specify 
these three unique points. The segment they define begins at start, passes through middle, and finishes at end. The 
coordinate you provide for middle need not lie exactly halfway between start and end; any point along the desired 
circle will suffice. This first segment element in the XML provides three points that lie on the small circle that is the 
50°N parallel. The segment starts at (50,0), passes through the eastern hemisphere and through (50,90), and finally 
ends at (50,180).

4:	 <segment start='50,180' middle='50,-90' end='50,0' />

Similar to the above, this segment element defines the part of the 50°N parallel that runs through the western 
hemisphere. Note that the start of this segment is the same as the end of the previous segment. Because the path only 
has two segments, the end of this segment is also the start of the prior one as well.

5:	 </path>

This ends the path element that contains the two segments above. Note that the segment elements above don’t need 
explicit closing tags like </segment> because they end in /> and not >, which is XML shorthand used to close 
elements that don’t contain other elements. 

6:	 <!-- Hello, world! -->

Anything that comes between <!-- and --> is an XML comment and is ignored (but retained) by Geocart. You 
can use comments to annotate parts of a complex boundary definition so you can remember the details later.

7:	 </boundary>

Ends the boundary definition.

Multiple Paths and Discontiguous Regions

You can provide more than one closed path to define the boundary region. To follow along, click Custom in the 
Boundary dialog and enter this boundary XML:

<boundary inside='0,0'> 
  <path> 
    <segment start='50,0' middle='50,90' end='50,180' /> 
    <segment start='50,180' middle='50,-90' end='50,0' /> 
  </path> 
  <path> 
    <segment start='-50,0' middle='-50,90' end='-50,180' /> 
    <segment start='-50,180' middle='-50,-90' end='-50,0' /> 
  </path> 
</boundary>

Click OK. You will see that you have specified the region that is south of the 50°N parallel, and north of the 50°S 
parallel:
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North of 50°S and south of 50°N

There is no requirement that the final region you have defined be contiguous. To continue, click Custom and change 
the first line to:

<boundary inside='90,0'>

Click OK. You will see that the region of the earth for projection is now comprised of two discontiguous parts:

North of 50°N and south of 50°S

The region to be projected is considered to be the set of all points p such that a path from p to the known interior 
point crosses the boundary an even number of times, or not at all. Paths from the known interior point (90, 0) to the 
area north of the 50°N parallel don’t cross a boundary path at all, so all of those points are considered to be within the 
region. Paths from (90,0) to the area between the two parallels cross one defined boundary path (the 50°N parallel) 
and so are considered outside the region. And paths from (90,0) to all points south of 50°S cross both boundary paths, 
and are once again considered inside the region.

Geocart can handle path definitions of moderate complexity, but the visualization for very complex regions will cause 
the Boundaries dialog and Projection Center dialog to become slow. Even on a fast machine, a path comprised of 
100 separate segments will add about a ten second delay to these dialogs.
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Specifying Coordinates

Coordinates in the XML boundary definition can be specified in most of the formats that Geocart accepts, and you 
can use single or double quotes around them. All of the examples below are legal and identical:

<boundary inside='-20.5, 30'>

<boundary inside="20/30S, 30E">

<boundary inside="-20/30, 30E">

<boundary inside='20.5S, +30'>

When specifying latitude or longitude in degrees/minutes/seconds, use slashes between the values to avoid confusion 
between the minutes or seconds mark and the quotes surrounding the coordinate. Lines like

<boundary inside='1°2'3N'>

will not work. Geocart does not currently support escaping minute or second marks with the standard XML escape 
sequences &quot; or &apos;.
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Appendix J: Metric line databases
Geocart can draw metric lines, which are points, paths, or symbols that describe analytic characteristics of the map 
projection or that show computed paths of geodetic interest. Geocart can draw the following kinds of metric lines:

• 	 Great circle: the shortest path between two points on the sphere.

• 	 Geodesic: the shortest path between two points on the ellipsoid.

• 	 Small circle: all the points of constant distance from a designated center point.

• 	 Rhumb: a path of constant bearing.

• 	 Point location: a dot at the designated coordinate.

• 	 Areal inflation/deflation isocol: all locations of the map having the designated amount of areal inflation 
or deflation. (This is meaningless on an equal-area map, where all points have the same area.)

•	 Angular deformation isocol: all locations of the map having the designated amount of angular 
deformation. (This is meaningless on a conformal map, where no points have angular deformation.)

•	 Average scale isocol: all locations of the map having the designated average scale.

•	 Tissot indicatrix: an ellipse whose flatness (eccentricity), area, and orientation depict the distortion at the 
designated coordinate.

You describe the metric lines you want Geocart to draw by recording their characteristics in a text file that you save 
and then add as a database using the Databases command. The file name of a metric line database must end in 
.metric.txt. The file must be saved as UTF-8 character encoding, but you do not need to do anything particular 
to mark it as such. You may add any number of metric line databases to a map. Metric lines are drawn on the same 
layer as the graticule.

A metric line’s line style is determined by one of three mechanisms.

•	 If the metric line database declares a style for the line within the database, then the line will be drawn in 
that style.

•	 If the metric line database declares a coverage for the line within the database, then the line will be drawn 
according to the line style for that coverage.

•	 Otherwise it will be drawn according to the style associated with that kind of metric line as shown in the 
Line Styles dialog.

The decision of which mechanism to use is yours. If you have created the metric line database purely for the geometry 
it represents, then you probably would not record line styles in it. If, on the other hand, you want different metric lines 
even of the same kind to draw differently, then you must record the line styles in the database. You might also record 
line styles in the database if the database is meant to convey a distinctive design style.

In all these descriptions, the azimuth convention sets north to 0°, increasing clockwise.

Metric line types

Great circle

A great circle is a path on a sphere showing the shortest route between any two points along the path. It goes all the 
way around the earth and returns to where it started. Its center is the center of the earth; the great circle path cuts the 
earth into two equal hemispheres. The highest latitude it rises to in the northern hemisphere is also the highest latitude 
it rises to in the southern hemisphere; that is, if 50°N is the highest latitude it rises to in the northern hemisphere, 
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then 50°S is the highest latitude it rises to in the southern hemisphere. Unless the great circle is the equator, the great 
circle will cross the equator twice. All meridians are great circles. The equator is the only parallel that is a great circle.

If the map you draw a great circle on uses an ellipsoidal datum instead of a spherical datum, the great circle route will 
have little meaning except for meridians. Use a geodesic metric line instead.

You can describe a great circle in different ways in a metric line database:

1.	 By giving a point on earth’s surface as the center of the great circle. Every point on the great circle thus 
described will be equally distant from the center point. In this case the entire great circle will be drawn.

2.	 By giving two points between which to draw the great circle. In this case, a great circle segment will be 
drawn, rather than the entire great circle. Use this when you want to show the shortest path between two 
points on the sphere. If the two points are antipodal (which means exactly on the other side of the globe), 
then you must give a third point between them in order to describe which of the infinite number of great 
circles you actually want.

3.	 By giving a center point, as described above, along with an azimuth (direction) to the start of the great 
circle segment and a sweep angle. In this case, a great circle segment will be drawn, rather than the entire 
great circle, unless the sweep angle is 360°.

Geodesic

A geodesic is a path on an ellipsoid (of which a sphere is a special case) showing the shortest route between any two 
points along the path. Unless the geodesic is the equator or a meridian, if drawn in its entirety, it would go around 
the ellipsoid at least twice but generally an infinite number of times. The highest latitude it rises to in the northern 
hemisphere is also the highest latitude it rises to in the southern hemisphere; that is, if 50°N is the highest latitude 
it rises to in the northern hemisphere, then 50°S is the highest latitude it rises to in the southern hemisphere. All 
meridians are geodesics. The equator is the only parallel that is a geodesic.

You may specify a sphere to be the surface upon which you draw the geodesic. However, in some situations the great 
circle metric line provides more convenient controls if you work with a spherical datum.

You can describe a geodesic in different ways in a metric line database:

1.	 By giving two points between which to draw the geodesic. Use this when you want to show the shortest 
route betwen two points on the ellipsoid. Generally there is more than one geodesic connecting two 
points, but Geocart will always draw the shortest.

2.	 By giving a starting point, an azimuth (direction), and a distance in meters. The distance means meters 
on the ellipsoidal surface given the semimajor and semiminor axis dimensions from the datum you have 
chosen for your map.

3.	 By giving a starting point, an azimuth, and a number of cycles. The cycle count means how many times 
the geodesic should return to the same latitude. (The cycle count is meaningless if the geodesic is the 
equator.) Because most geodesics do not return to the same point when going around the earth, a cycle 
count of greater than 1.0 results in a sinoidal pattern across the globe surface.

Small circle

A small circle is a path on the sphere or ellipsoid showing the points that are a specified distance from a specified 
center point. It is useful for showing the territory that is within a specific radius of a central location, for example.

You can describe a small circle in different ways in a metric line database:

1.	 By giving the center of the small circle and a radius in degrees. In this case, the entire small circle will be 
drawn. The degree value means arc distance on the sphere, or, on an ellipsoid, a distance corresponding to 
the degree value ÷ 360° along the equator.
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2.	 By giving the center of the small circle, a radius in degrees, an azimuth to start the small circle at, and a 
sweep angle in degrees. In this case, a segment of the small circle will get drawn unless the sweep angle is 
360°, in which case a full circle will get drawn. The description of the radius is as given above. The azimuth 
describes the direction from the center point in which the small circle segment will start. The start azimuth 
plus the sweep describes the azimuth of the endpoint from the center point.

3.	 By giving the center of the small circle and a radius in meters. In this case, the entire small circle will be 
drawn. The distance means meters on the ellipsoidal surface given the semimajor and semiminor axis 
dimensions from the datum you have chosen for your map.

4.	 By giving the center of the small circle, a radius in meters, a starting azimuth, and a sweep angle in degrees. 
In this case, a segment of the small circle will get drawn unless the sweep angle is 360°. The radius is as 
described in (3). The start azimuth and sweep are as described in (2).

5.	 By giving start, middle, and endpoints of the small circle. In this case, a segment of the small circle will get 
drawn. The location of the middle point along the path is not critical insofar as it is not extremely close to 
either endpoint. That is, it need not be in the exact middle of the segment.

Rhumb

A rhumb is a path of constant bearing. Though a rhumb between two points is generally longer than a great circle, 
traversing a rhumb is simpler because the navigator never needs to change direction. A rhumb starting at a point either 
follows a parallel if it runs due east or west, follows a meridian if it runs straight north or south, or spirals ever closer to 
a pole otherwise.

You can describe a rhumb in different ways in a metric line database:

1.	 By giving a start and endpoint. While generally an endless number of rhumbs can connect two points, 
Geocart draws the shortest in this case.

2.	 By giving a start point, a bearing in degrees, and a distance in meters. The bearing is the direction from the 
start point, in degrees clockwise from north. The distance means meters on the ellipsoidal surface given the 
semimajor and semiminor axis dimensions from the datum you have chosen for your map.

3.	 By giving a start point, a bearing in degrees, and a cycle count. A cycle means the point where the rhumb 
returns to the same meridian. (The cycle count is meaningless if the rhumb runs north or south.)

Point location

A point location places a circular dot at the coordinate you supply.

Areal inflation/deflation isocol

Unless your map is equal-area, the ratio of area on the map to area on the globe having the same nominal scale varies 
continuously across the map. An areal isocol shows a path of constant ratio. When you request an areal inflation/
deflation (or “flation”) isocol, Geocart seeks out and draws all paths on the map having the ratio you designate. A value 
of 1.0 means no inflation or deflation. A value of 2.0 means the paths on the map whose points have twice the size as 
the corresponding areas on the globe.

Angular deformation isocol

Unless your map is conformal, angles on the map get skewed in comparison to the globe. At any given point, the 
amount of skewing varies between none and some maximum amount, depending on which angle one examines. It is 
the maximum value that completely characterizes the deformation at that point, so it is used as the metric of angular 
deformation.

An angular deformation isocol shows a path of constant maximum angular skewing, or deformation. When you 
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request an angular deformation isocol, Geocart seeks out and draws all paths on the map having the maximum angular 
deformation that you designate. A value of 0.0 means no deformation. A value of 10 means the paths on the map 
whose points have maximum angular deformations of 10°. The greatest possible value for angular deformation is 180°, 
which means infinite distortion.

Average scale isocol

Some maps have no areal inflation or deflation (“flation”). Such maps always have angular deformation. Some maps 
have no angular deformation. Such maps always have areal inflation or deflation. Meanwhile all maps distort most 
distances, and this distortion depends upon the contributions of flation and deformation. Hence it can be convenient 
to combine the two into a single metric of “scale error”. Many different ways can be devised to compute the scale error 
metric. Geocart uses the average value of all unit radii evenly distributed on the sphere as projected onto the plane at 
each point.

An average scale isocol shows a path of constant average scale. When you request an average scale isocol, Geocart seeks 
out and draws all paths whose every point has the average scale that you designate. A value of 1.0 means the average 
unit vector through the point remains 1.0 and indicates low distortion in general, though does not necessarily mean 
no distortion. If the map is conformal, average scale corresponds to the scale factor. If the map is not conformal, large 
angular deformations tend to result in large average scale because the distribution of radii gets skewed toward the 
major axis of the Tissot ellipse.

Tissot indicatrix

A Tissot indicatrix is the elliptical result of projecting an infinitesimal circle from the sphere to the plane. Its flatness, 
area, and orientation characterize the distortion at the designated coordinate. If you want to show Tissot indicatrices in 
a regular network across the map, it is convenient to use the Tissot indicatrices functionality. If you want control over 
placement and line styles for individual Tissot ellipses, you should use a metric line database.

When you request a Tissot indicatrix, Geocart draws an ellipse centered at the geographic coordinate you supply. You 
can describe a Tissot indicatrix two different ways:

1.	 By giving a coordinate and a radius for the indicatrix in degrees. The degree value means arc degrees, a 
distance meaning the degree value ÷ 360° along the equator. The degree value represents the radius the 
projected circle would have if the point had no distortion. The resulting Tissot ellipse’s semimajor and 
semiminor axes will be scaled accordingly.

2.	 By giving a coordinate and a radius for the indicatrix in millimeters. The millimeter value means the radius 
the projected circle would have if the point had no distortion. The resulting Tissot ellipse’s semimajor and 
semiminor axes will be scaled accordingly.

Defining a metric line database

Metric lines and their styles are defined in an XML syntax and saved into a file whose name must end in metric.
txt. The XML that defines metric lines specifies:

1.	 A metric line type and its parameters.

2.	 Optionally, comments that annotate the XML code but which have no operational effect.

3.	 Optionally, directives to separate groups of metric lines into layers.

4.	 Optionally, line styles for drawing the metric line.

5.	 Optionally, directives to assign a database coverage to metric lines.

6.	 The type of metric line (great circle, Tissot ellipse, isocol &c.) and the parameters describing them, such as 
the center of the great circle or the measure of the isocol.
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	 <metric_lines>

		  <!-- Put all the lines in a layer with 50% transparency. -->

		  <layer alpha='0.5'>

			   <style stroke_color='255,0,0' width='2.7' dashes='3 1 2'>

				    <small_circle center='20,120' radius='15' />

				    <great_circle center='-45,45' azimuth='-45' sweep='90' />

				    <geodesic start='0,-135' azimuth='54' cycles='2' />

				    <rhumb start='-20,-20' end='60,130' />

				    <tissot_ellipse coord='0,-150' radius_mm='5' />

				    <style coverage='Coverage/Railroad'>

					     <isocol scale='1.2' />

				    </style>

			   </style>

		  </layer>

	 </metric_lines>

Let’s look at the XML line by line:

1:	 <metric_lines>

Definitions must begin with a metric_lines element (except XML comments, see below). The metric_lines 
element contains no attributes and is terminated by </metric_lines>, which is required.

2:	 <!-- Put all the lines in a layer with 50% transparency. -->

Anything that comes between <!-- and --> is an XML comment ignored by Geocart. You can use comments to 
annotate parts of a metric line data set so you can remember the details later. Use of comments is optional.

3:	 <layer alpha='0.5'>

The layer element begins the definition of a grouping of metric lines and assigns a transparency value to the group. 
The transparency value ranges between 0 (completely transparent; i.e., invisible) to 1.0 (completely opaque). The 
grouping is useful after exporting the document as PDF. When you edit the resulting PDF document in graphic 
editing software such as Adobe Illustrator, you can manipulate all of the elements within the group as if they are a 
single element. You might wish to group all metric lines of a single type, such as isocols, to distinguish them from all 
rhumb lines, for example. A layer declaration is terminated by </layer>, which is required. Use of layers is optional.

4:	 <style stroke_color='255,0,0' width='2.7' dashes='3 1'>

The style element defines a line style for the metric line elements that it brackets. The stroke_color parameter 
defines the RGBA (red, green, blue, alpha) values of the line to be drawn. It must consist of either three elements, in 
which case it represents the red, green, and blue components, or else four elements, in which case it represents RGB 
and alpha, or transparency. These elements, along with the width and dashes element, correspond to how you 
define line styles in the Line Styles dialog. In this case the XML declares a red line of with 2.7 points and a repeating 
dash sequence of 3 points drawing and one point gap.

Note that the transparency value you provide here ranges from 0…255, not the 0…1 that you would give for 
the layer element. The transparency effect of the layer is compounded by style definition; for example, a 
layer alpha='0.5' declaration in effect with a stroke_color='255,0,0,128' declaration would give 
translucence of 25%, since the layer alpha’s 0.5 declarations amount to a 50% transparency, and so does the stroke 
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color’s 128 alpha declaration.

Declaring line styles is optional. If you do not assign line styles explicitly in the XML, then the line style as set in 
the Line Styles dialog will get used for each corresponding type of metric line. A style declaration is terminated by 
</style>, which is required.

5:	 <style coverage='Coverage/Railroad'>

Another way the style element can be used is to declare a coverage for the enclosed metric lines. In this example, 
the coverage declaration overrides the earlier <style …> definition with respect to the <isocol …/> definition 
because the coverage declaration is the last style declared before reaching the <isocol …/> definition. The rendered 
line representing the isocol metric line will be drawn according to the instructions for 'Coverage/Railroad' as 
found in the Line Styles dialog.

6:	 <isocol scale='1.2' />

This element defines a metric line. The example above is for an average scale error isocol. The complete list of metric 
line elements is:

	 small_circle

	 great_circle

	 geodesic

	 rhumb

	 tissot_ellipse

	 isocol

	 point

These are examples of all the different declarations possible for small_circle:

	 <small_circle center='20,120' radius='15' />

	 A complete small circle centered on (20°N, 120°E) and having an arc radius of 15°.

	 <small_circle center='20,120' radius='15' azimuth='90' sweep='45' />

	 A portion of a small circle centered on (20°N, 120°E), having arc radius of 15°, starting due east (azimuth 
= 90°) of the center, and arcing an eighth of the way around the circle (sweep = 45°/360°).

	 <small_circle center='20,120' radius_meters='150000' />

	 A complete small circle centered on (20°N, 120°E) and having a radius of 150,000 meters.

	 <small_circle center='20,120' radius_meters='150000' azimuth='90' sweep='45' />

	 A portion of a small circle centered on (20°N, 120°E), having arc radius of 150,000 meters, starting due 
east (azimuth = 90°) of the center, and arcing an eighth of the way around the circle (sweep = 45°/360°).

	 <small_circle start='20,120' middle='30,130' end='20,140' />

	 The portion of the small circle defined by the three points, drawn from the start to end.

These are examples of all the different declarations possible for great_circle:

	 <great_circle center='20,120' />

	 A complete great circle such that all points on the great circle are the same distance from (20°N, 120°E), 
which is half a hemisphere away.

	 <great_circle center='20,120' azimuth='90' sweep='45' />

	 A portion of the great circle defined such that all points on the great circle are the same distance from 
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(20°N, 120°E). The portion starts due east (azimuth = 90°) of the center, and arcs an eighth of the way 
around the circle (sweep = 45°/360°).

	 <great_circle start='20,120' end='20,140' />

	 The portion of the great circle that runs through the two points (20°N, 120°E) and (20°N, 140°E), drawn 
from the start to end. This definition must not be used if the two points are antipodal or nearly antipodal, 
such as (20°N, 120°E) and (20°S, 60°W), since antipodal points do not uniquely specify a great circle. In 
this case, use the three-point form below.

	 <great_circle start='20,120' middle='0,30' end='-20,-60' />

	 The portion of the great circle that runs through the three points (20°N, 120°E), (0°N, 30°E), and (20°S, 
60°W), drawn from the start to end. This definition must be used only if the three points actually define 
a great circle, and need only be used if start and end are antipodal. If start and end are antipodal then any 
middle point will define a great circle as long as the middle point differs significantly from either endpoint.

These are examples of all the different declarations possible for geodesic:

	 <geodesic start='20,120' end='20,140' />

	 The portion of the shortest geodesic that runs through the two points (20°N, 120°E) and (20°N, 140°E), 
drawn from the start to end.

	 <geodesic start='20,120' azimuth='40' distance_meters='150000' />

	 The portion of the geodesic that runs from the point (20°N, 120°E) in the direction of 40° east of north, 
for a distance of 150,000 meters.

	 <geodesic start='20,120' azimuth='40' cycles='3.3' />

	 The portion of the geodesic that runs from the point (20°N, 120°E) in the direction of 40° east of north, 
for 3.3 cycles. One cycle means to go all the way around the globe, returning to the same latitude as the 
start. A portion of a cycle has no specific meaning for distance, other than a greater number means farther 
along the geodesic than a lesser number.

These are examples of all the different declarations possible for rhumb:

	 <rhumb start='20,120' end='20,140' />

	 The portion of the shortest rhumb that runs through the two points (20°N, 120°E) and (20°N, 140°E), 
drawn from the start to end.

	 <rhumb start='20,120' bearing='40' distance_meters='150000' />

	 The portion of the rhumb that runs from the point (20°N, 120°E) in the direction of 40° east of north, for 
a distance of 150,000 meters.

	 <rhumb start='20,120' bearing='40' cycles='3.3' />

	 The portion of the rhumb that runs from the point (20°N, 120°E) in the direction of 40° east of north, 
for 3.3 cycles. One cycle means to go all the way around the globe, returning to the same longitude as the 
start. A portion of a cycle has no specific meaning for distance, other than a greater number means farther 
along the rhumb than a lesser number.

These are examples of the two different declarations possible for tissot_ellipse:

	 <tissot_ellipse coord='20,120' radius='5' />

	 A tissot ellipse illustrating the distortion at (20°N, 120°E). If the point has no distortion, the ellipse would 
be a circle of radius 5° of arc as determined by the nominal scale of the map. For any other distortion 
measure, the circle will be squashed and scaled according to the characteristics of the distortion.

	 <tissot_ellipse coord='20,120' radius_mm='3' />
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	 A tissot ellipse illustrating the distortion at (20°N, 120°E). If the point has no distortion, the ellipse 
would be a circle of radius 3 mm. For any other distortion measure, the circle will be squashed and scaled 
according to the characteristics of the distortion.

These are examples of all the different declarations possible for isocol:

	 <isocol area='2' />

	 All isocols on the map illustrating all points with areal inflation of 2x.

	 <isocol max_deformation='20' />

	 All isocols on the map illustrating all points with a maximum angular deformation of 20°.

	 <isocol scale='1' />

	 All isocols on the map illustrating all points with average scale factor of 1.0.

This is an example of the point declaration:

	 <point coord='20,120' />

	 A point drawn centered on (20°N, 120°E).

Specifying Coordinates

Coordinates in the XML boundary definition can be specified in most of the formats that Geocart accepts, and you 
can use single or double quotes around them. All of the examples below are legal and identical:

<small_circle center='-20.5, 30' radius='15' />

<small_circle center=”20/30S, 30E” radius='15' />

<small_circle center=”-20/30, 30E” radius='15' />

<small_circle center='20.5S, +30' radius='15' />

When specifying latitude or longitude in degrees/minutes/seconds, use slashes between the values to avoid confusion 
between the minutes or seconds mark and the quotes surrounding the coordinate. Lines like

<small_circle center='1°2'3N' radius='15' />

will not work. Geocart does not currently support escaping minute or second marks with the standard XML escape 
sequences &quot; or &apos;. Instead write:

<small_circle center='1/2/3N' radius='15' />

Sample metric line database

You can find a sample metric line database in your Geocart installation at (Macintosh):

	 /Library/Application Support/Mapthematics/Geocart/Version 3/
� Sample Documents/Sample.metric.txt

Windows XP:

	 C:\Documents and Settings\All Users\Application Data\Mapthematics\
� Version 3\Sample Documents\Sample.metric.txt

Windows Vista/Windows 7:

	 C:\ProgramData\Mapthematics\Geocart\Version 3\
� Sample Documents\Sample.metric.txt
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